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Preface

As companies continue to integrate computer technology into their business operations,
it becomes increasingly important to properly administer the IT function, particularly
with respect to performance and cost.

CIMS Server provides an essential component of an effective financial management
system. The technology behind CIMS Server is based on CIMS Lab’s many years of
experience in the development and implementation of Resource Accounting, Capacity
Planning, and IT Chargeback products.

About CIMS Lab

Founded in 1974, CIMS Lab has focused on meeting the financial and resource reporting
requirements of Information Services Departments. CIMS has evolved with corporate IT
management requirements. Focused commitment to client service and support sets
CIMS apart from competing products. Our goal is to provide the best chargeback and
resource reporting software in the world at the lowest possible cost to our customers.

CIMS Lab strongly believes in and executes the concept of continuous product
improvement. Customers have access to CIMS product development personnel to
ensure that customer feedback and other critical issues are incorporated into the next
release of the product.
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Contacting CIMS Lab

To contact CIMS Lab with questions, comments or problems, please use one of the

B xiv

following methods:
For product assistance or information:

USA & Canada, toll free - (800) 283-4267
International - (916) 783-8525

FAX - (916) 783-2090

World Wide Web - http://www.cimslab.com

Mailing Address:

CIMS Lab, Inc.
3013 Douglas Blvd., Suite 120
Roseville, CA 95661-3842
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Preface W

About This Guide

This guide describes the installation procedures and administration functions and
features of CIMS Server.

The following table describes the chapters in this guide. If you are installing and setting
up CIMS Server for the first time, you should begin with Chapter 1, About CIMS Server
and then continue to Chapter 2, Installing CIMS Server and Getting Started before
continuing to the other chapters in the guide.

Ch.

No. Chapter Name Content Description

1 About CIMS Server Describes the overall structure and feature set of the
CIMS Server system.

2 Installing CIMS Server Discusses the installation of the CIMS Server system
and Getting Started components and provides a Getting Started section.

3 Setting Up the System Explains how to configure the various components of
the system. Also provides a Getting Started section.

4  Report Administration Describes how to administer and distribute reports.

5 Database Administration — Describes how to use CIMS Server Administrator to
create and administer CIMS Server databases.

6  Processing Data Provides an overview of the data processing cycle and
components and describes how to use CIMS Server
Administrator to set processing options.

7 Troubleshooting and Describes problems you may encounter while setting
Additional Information up and using the CIMS Server system and how to solve
them.
A Database Tables Describes the layout of key database tables used by
CIMS Server.
B  File Layouts Describes the file layout of important files used by the
CIMS Server system.
C  Scripts Describes the scripts that are included in the CIMS
Server installation.
D  Control and Processing Describes the control and processing statements used
Statements by CIMS Processing Engine.
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Conventions

Some or all of the following conventions appear in this guide:

Symbol or

Type Style Represents Example

Alternate hyperlinked cross-references to  ...see Data Migration.
color other sections in this guide; if you

are viewing this guide online, you
can click the cross-reference to
jump directly to its location

Italic words that are emphasized ...the entry after the current entry...
a new term ...called a source object.
the titles of other manuals CIMS Server Web Reporting User's
Guide
variables in file names or system [USR_computername
names
AcctExcp-yyyymmdd. txt
Bold names of interface items such as  Select the Use 13 Periods check box
tabs, boxes, buttons, lists, and B h hin the P
check boxes. nter the path in the Process

Definition Path box

Monospace directories, file names, command Processes folder
names, computer code, computer
screen text, system responses,
command line commands, what Type CIMSServer

BatchReport.wsf script

the user types
<> the name of a key on the Press <Enter>
keyboard
» navigating a menu or a folder File » Import » Object

Terminology: Reports, Spreadsheets, and Graphs

For simplicity, in this guide, the term “report” refers to reports, spreadsheets, and graphs.

Related Publications

As you use this guide, you might find it helpful to have these additional guides available
for reference:

m CIMS Server Web Reporting User's Guide

m CIMS Data Collectors for Microsoft Windows Installation and User Guide
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About CIMS Server

This chapter describes the overall structure, benefits, and features of the CIMS Server

system.

WHhat IS CIMS SEIVEI? ...uiniiiiiiiieieieienereeneuseeecsesesesssssasesscsssasasassssanns 1-2
Benefits Of CIMS Server . ... ... o e 1-4
System Features . ... ... .. . e 1-4
CIMS Data ColleCtOrS ..o vvtiiriteitiieieeeeiaeieeessasessssasssssssssessssssscassssssens 1-5
CIMS Data Collectors for WINdOWS ......... .. i i 1-5
CIMS Mainframe Data Collector and Chargeback System ................. .. ... ... ..... 1-6
CIMS Data Collector for UNIX . . . ... oo e 1-7
AbOUt CSRaNA CSRHFleS ....oviiiuiiiiiiiiiiiiiiiiiieitiiiiiieieneienesececncncncnenns 1-8
CIMS Server System COMPONENES .......iuiiiiiiiiiiiiitiieieiereetneeesesenessssncnnnns 1-9
CIMS Server Application SEIVer . ... ... e 1-9
Database SErVer . . ... ... 1-13
WD SOV .o 1-13
CIMS Server System Architecture Diagram .......... ... oot 1-14
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What Is CIMS Server?

What Is CIMS Server?

CIMS Server is a full-featured resource accounting and chargeback system that enables
users to consolidate accounting data from multiple IT resources into a common output
format for costing and reporting. This output may then be used for Web-based or static
invoicing and other reporting or as a feed to existing financial systems.

CIMS Server tracks usage data associated with:

Operating systems
Databases

Network systems
Storage systems
Internet systems
E-mail systems
E-commerce systems

Other applications or monitors that create usage metering data

As shown in Figure 1-1 on page 1-3, it is useful to think of CIMS Server as a funnel that
accepts usage data and returns organized information that can help IT s and staff to track
and allocate resources.
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Spreadsheets
Reports
Graphs

HTML

Resource Cost Chargeback
Usage Allocation and Billing

Figure 1-1 « CIMS Server Collects Usage Data and Organizes It As Reporting Information

CIMS Server runs on the Windows 2000 Server, Windows Server 2003, or Windows XP
operating system with a Microsoft SQL Server or Microsoft Desktop Engine (MSDE)
database and a Microsoft Internet Information Services (IIS) Web server.
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Benefits of CIMS Server

Keeping track of IT usage can be a formidable task for any organization. Most sizable
enterprises consist of many platforms, systems, and subsystems, each costly to own,
maintain and operate. In addition, each component has its own unique record format
and metrics.

With CIMS Server, you can process, access, and analyze IT resource usage metrics from
many IT resources and view the results right in your Web browser. CIMS Server helps you
to better understand who is using IT resources and how the resources are being used.

The following are just a few of the benefits of CIMS Server:

m Enterprise-wide cost analysis of IT systems. CIMS Server enables enterprise-wide
cost analysis of IT systems. CIMS Server allows you to allocate, distribute, or charge
IT costs to users, cost centers, and organizations in a manner that is fair,
understandable, reproducible, and easy to administer.

m Centralized data processing. CIMS Server centralizes the processing of your
accounting data on one computer and allows you to view the data on the Web via
extensive customizable reporting features. It is possible to view both high-level and
detailed information with a few clicks of a mouse.

m Full data access and reporting capabilities. CIMS Server integrates Crystal Reports
and SQL Server Reporting Services with any ODBC-compliant database to give your
enterprise full data access and reporting capabilities.

System Features
CIMS Server features include:
m Report, spreadsheet, and graph generation and viewing via the Web.

m Batch processing and report generation. (You can also run processes and reports
individually.)

m Crystal Reports and SQL Server Reporting Services integration. (You can use either
Crystal Reports or SQL Server Reporting Services to generate reports or you can use
both.)

m Multi-level drill down capabilities to view detailed cost and usage information in
reports.

m Integration with CIMS Data Collectors for Windows, Mainframe, and UNIX/Linux
systems.

m Up to 128-byte account code with powerful account code conversion.
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CIMS Data Collectors

CIMS Data Collectors read and convert usage metering data generated by applications
(usually standard usage metering files such as log files) and produce a common output
file that is used by CIMS Server.

CIMS Data Collectors include the following individual data collection applications:
m CIMS Data Collectors for Microsoft® Windows®

m CIMS Mainframe Data Collector and Chargeback System

m CIMS Data Collector for UNIX

The following sections provide a brief overview of these data collectors and describe the
files that the collectors produce for CIMS Server.

CIMS Data Collectors for Windows

The CIMS Server installation includes the option of installing CIMS Data Collectors for
Windows. (Contact CIMS Lab for licensing requirements.) These collectors run on the
Windows operating system, but collect usage data from Windows and Windows-
compatible applications (including older Windows operating systems such as Windows
NT) and non-Windows applications and operating systems. For more information about
CIMS Data Collectors for the Windows, refer to the CIMS Data Collectors for Microsoft
Windows Installation and User Guide.

Each Windows collector collects usage data for a specific application or system and
converts the data to an input file, the CIMS Server Resource (CSR) file, that can be
processed by CIMS Server or CIMS Mainframe Data Collector and Chargeback System.

The CSR file contains comma-delimited records that show the resource or resources that
were consumed and an identifier or identifiers that denotes the source of the resources.
For more information about this file, see About CSR and CSR+ Files on page 1-8.
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CIMS Mainframe Data Collector and Chargeback System

CIMS Mainframe Data Collector and Chargeback System provides comprehensive job
accounting, chargeback, resource utilization, and system performance reporting for
mainframe systems including z/OS, OS/390, MVS, CICS, DB2, VSE, storage systems/SAN
and many more.

You can use CIMS Mainframe to perform all of your mainframe data processing and
reporting or you can perform all or part of your processing and reporting using CIMS
Server. This flexibility enables you to view your mainframe data using CIMS Server’s
powerful Web-based reporting and report drill down capabilities.

CIMS Mainframe Data Collector and Chargeback System produces the following files for
integration with CIMS Server. The files differ depending on whether CIMS Server is used
to perform the processing and reporting of mainframe data or just reporting.

m CIMS Server Resource (CSR) file. This file is produced by CIMS Mainframe 11.6 and
earlier. The CSR file requires processing by CIMSACCT and CIMSBILL in CIMS Server
before it can be loaded into the CIMS Server database. For more information about
this file, see About CSR and CSR+ Files on page 1-8.

Or

m CIMS Server Resource Plus (CSR+) file. This file is produced by CIMS Mainframe
12.0 and later. The format of the CSR+ file is the same as the CSR file, with the
exception that the records in the CSR+ file contain an additional header at the
beginning of the record. For more information about this file, see About CSR and
CSR+ Files on page 1-8.

The CSR+ file requires processing by CIMSACCT and CIMSBILL in CIMS Server before
it can be loaded into the CIMS Server database.

Or

m CIMS Ident, Detail, and Summary files. These files are produced by CIMS
Mainframe 12.0 and later. These files do not require processing by CIMSACCT and
CIMSBILL. They are loaded directly into the CIMS Server database. For more
information about these files, see Chapter 6, Processing Data and Appendix B, File
Layouts.

For more information about the creation of these files and about data collection and
processing using CIMS Mainframe, refer to the CIMS Mainframe Data Collector and
Chargeback System User Guide.

For more information about integrating these files with CIMS Server, refer to the CIMS
Data Collectors for Microsoft Windows Installation and User Guide.
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CIMS Data Collector for UNIX

CIMS Data Collector for UNIX provides comprehensive job accounting, chargeback,
resource utilization, and system performance reporting for UNIX/Linux systems
including databases such as Oracle and DB2 and other software. CIMS UNIX collects
data such as disk storage, CPU time, connect time, I/Os, pages printed, and user sessions.

CIMS Data Collector for UNIX produces the CIMS Server Resource (CSR), which can be
processed by CIMS Server or the CIMS Mainframe Data Collector and Chargeback
System application. For more information about this file, see About CSR and CSR+ Files
on page 1-8 and CIMS Server Resource (CSR) File on page B-2.

For more information about the creation of the CSR file and about data collection using
CIMS UNIX, refer to the CIMS Data Collector for UNIX User Guide.

For more information about integrating the CSR file with CIMS Server, refer to the CIMS
Data Collectors for Microsoft Windows Installation and User Guide.
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About CSR and CSR+ Files

CSR files are created by CIMS Data Collectors for Windows, CIMS Data Collector for
UNIX, and CIMS Mainframe Data Collector and Chargeback System (11.6 and earlier).
CSR files can also be created by many other third-party applications.

CSR+ files are created by CIMS Mainframe Data Collector and Chargeback System 12.0
and later.

The format of the CSR and CSR+ file records is the same, with the exception that the
records in the CSR+ file contain an additional header at the beginning of the record.

For a complete description of the CSR and CSR+ file formats, see Appendix B, File Layouts.

Key pieces of information in the CSR and CSR+ records include the identifiers and
resources. All data collectors define the most useful identifiers and resources to be
collected from the usage data and provides this information in the records of the output
CSR or CSR+ file.

For example, the CIMS Data Collector for Microsoft Exchange Server produces CSR
records with one identifier and four resources as shown in the following example:
Exchange, 20040916, 20040916,01:00:47,01:00:47,,1,User, " joe" 4, EXEMRCY, 1, EXBYRCY, 3941, EXEMSNT 0, EXBYSNT, 0
Exchange, 20040916,20040916,01:00:47,01:00:47, ,1,User, "mary" 4, EXEMRCV, 1, EXBYRCV, 3863, EXEMSNT, 0, EXBYSNT , 0
Exchange, 20040916, 20040916,01:00:47,01:00:47, ,1,User, " joan", 4, EXEMRCV, 1, EXBYRCV, 2748, EXEMSNT, 0, EXBYSNT ,0

The identifier name, User, is followed by the identifier value designating the ID of the
user who consumed the resources. Examples of other identifier names and values that
might appear in a CSR or CSR+ record are those that designate device name, server name,
system ID, job name, user ID, phone number, state code, or building number.

The resources consumed are designated by the rate codes EXEMRCV (e-mails received),
EXBYRCV (bytes received), EXEMSNT (e-mails sent), and EXBYSNT (bytes sent).

Processing Identifiers and Resources

All identifiers and resources in the CSR or CSR+ records must be defined in the CIMS
Server database.

Because identifier names and values do not require additional definition, you do not
need to define the names and values for CIMS Server before the CSR or CSR+ records are
processed. All identifier names and values in the records are automatically loaded into
the CIMSIdent table when the CSR or CSR+ file is processed.

However, rate codes require a monetary value and other user-defined options that must
be defined before the CSR or CSR+ records are processed. CIMS Lab pre-loads the rate
codes produced by many of the data collectors (including the Exchange Server rate codes
in the preceding example) in the CIMSRate table. You can then use CIMS Server
Administrator to modify the monetary value and other options for the rate codes for
your site as described in Working With Rates on page 3-9.

Note ¢ The rate codes for some collectors are not pre-loaded in the CIMSRate table
and must be added. To determine whether the rate codes for a specific collector are
pre-loaded, refer to the documentation for that collector.
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CIMS Server System Component Overview

The CIMS Server system is composed of the following components:
m The CIMS Server application server

m A database server

m A Web server

You can install all components on one server or on separate servers. For more
information, see CIMS Server System Components on page 2-3.

The following sections describe each of the CIMS Server system components.

CIMS Server Application Server
The CIMS Server application server contains the following key components:
m CIMS Processing Engine
m CIMS Server Administrator

m CIMS Server Web Reporting

CIMS Processing Engine

CIMS Processing Engine is a fast, efficient data processing engine capable of handling
large volumes of data. CIMS Processing Engine consists of multiple programs. The four
main programs are CIMSACCT, CIMSSORT, CIMSBILL, and CIMSAdminLib:

m CIMSACCT processes the input sources provided by CIMS Data Collectors (see CIMS
Data Collectors on page 1-5) and performs functions such as account code conversion.
CIMSACCT produces an output file containing records that are properly formatted for
input into CIMSBILL.

m CIMSSORT sorts output from CIMSACCT and produces a sorted file that is ready to
be processed by CIMSBILL.

m CIMSBILL processes the output from CIMSACCT and builds output files that contain
the billing information that is used to generate invoices and reports.

m CIMSAdminLib contains the class CCIMSCBSLoad that loads the output files from
CIMSACCT and CIMSBILL into the CIMS Server database. CIMSAdminLib is the
central controlling library for all Windows-based CIMS Server functions. It contains
all the COM objects used to manipulate CIMS data.

For more information about CIMS Processing Engine, see Chapter 6, Processing Data.

CIMS Server's powerful data processing capability provides all the data needed to
produce complete, detailed reports, spreadsheets, and graphs. The actual generation of
reports, however, is completed by Crystal Reports or SQL Server Reporting Services (see
CIMS Server Web Reporting on page 1-12).
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CIMS Server Administrator

CIMS Server Administrator is the administration tool for the CIMS Server system. This
Windows-based GUI application allows the system administrator and CIMS Server
administrators to configure and maintain the information contained in the CIMS Server
database such as rates, users and groups, clients, system configuration settings, and
processing and reporting settings. CIMS Server Administrator also enables
administrators to perform real-time processing.

ans CIMSServer, - CIMS Administrator
File Wiew Help

CIMS

Server

£3 Chargeback nistration
= £3 Chargeback Takle Maintenance
B Clients
[ Rate Codes
[ Rate Groups
B Table Manager
B Account Code Structure
B Calendar
= £3 Processing
[ Process Defintions
[ CPU Normalization
[ Conversion Builder
[ Event Viewer
B £3 Database Loading
£3 System Administration
[l Select ODBC Data Source

Show Connection Information ==

Figure 1-2 « CIMS Server Administrator Main Window
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The following table shows the administrative tasks performed by the system
administrator and the CIMS Server administrator.

System Administrator Tasks CIMS Server Administrator Tasks

m Defining and configuring the CIMS m Defining account code structures

Server database ) o )
m Creating and maintaining rate, client,

m Selecting the Open Database and calendar definitions

Connectivity (ODBC) data source )
m Defining CIMS Server users and groups

m Creating, adding, and dropping ) ) )
database tables m Setting reporting options

m Configuring the CIMS Server system

m Creating, adding, and dropping ;
settings

database objects

m Loading and exporting data to and

m Performing database backup f be datab
rom the database

procedures

m Defining and categorizing input W Setting processing options

sources m Executing processing jobs

m Scheduling input selection B Setting CIMSACCT and CIMSBILL
options
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CIMS Server Web Reporting

The CIMS Server Web Reporting application provides comprehensive cost accounting,
chargeback, and resource reporting in an easy-to-use, browser-based environment. CIMS
Server Web Reporting includes the following features that ensure that users receive the
data they need in a clear, user-friendly format:

® Drill down. CIMS Server Web Reporting invoices and many other reports include
drill down that enables users to view detailed cost and usage information.

® Multiple report formats. CIMS Server Web Reporting provides reports in report,
graph, and spreadsheet format.

m User customization options. CIMS Server Web Reporting users can set up their own
list of favorite reports, spreadsheets, and graphs. Users can also create reports “on-the-
fly” within the CIMS Server Web Reporting Web site and publish reports for review
by other users.

CIMS Server Web Reporting works with both Crystal Reports and SQL Server Reporting
Services. Both tools provide a feature-rich environment for creating Web-based and
paper reports. However, a benefit of SQL Server Reporting Services is that it is provided
with your SQL Server 2000 license (for more information go to http://
www.microsoft.com/sql/reporting/howtobuy/). Crystal Reports 9 is provided with
CIMS Server 4.0; however, future Crystal Reports upgrades are not provided by

CIMS Lab.

Note  SQL Server Reporting Services is not available for SQL Server 7.0 or MSDE.

CIMS Server includes standard reports written in both Crystal Reports and the Report
Definition Language (RDL) for SQL Server Reporting Services. RDL is an XML-based
industry standard used to define reports.

Your report developer can use these standard reports as templates to create custom
reports for your organization. Reports created specifically for your organization are
referred to as “custom reports” in this guide to differentiate them from the CIMS
standard reports.

Note ¢ As of the release of CIMS Server 4.0, there are more standard Crystal reports
than Reporting Services reports. However, standard Reporting Services reports will
be added in future CIMS Server releases.

For more information about CIMS Server Web Reporting, including descriptions of the
standard reports that are provided with CIMS Server, refer to the CIMS Server Web
Reporting User’s Guide.
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Database Server

The database stores administration information as well as the Ident, Detail, and
Summary records that are produced by CIMS Processing Engine (see Chapter 6, Processing
Data, for more information about these records). These records are used by Crystal
Reports and SQL Server Reporting Services to provide robust Web reporting.

The Database Management System (DBMS) that you can use with CIMS Server depends
on the edition of CIMS Server that you are using as discussed in the following sections.

CIMS Server Enterprise Edition

If you are using CIMS Server Enterprise Edition, you can use either Microsoft SQL Server
2000 or 7.0 or MSDE 2000. MSDE 2000 is included with the CIMS Server installation.
However, the use of MSDE has some disadvantages as discussed in CIMS Server
Professional Edition.

Note ¢ Support is being added for other DBMS platforms such as Oracle and DB2 on
UNIX and z/OS.

CIMS Server Professional Edition

CIMS Server Professional Edition requires MSDE 2000. The use of MSDE provides the
following advantages and disadvantages:

Advantages

® No additional cost—MSDE 2000 is included with the CIMS Server installation
m Easy upgrade path from MSDE to Microsoft SQL Server 2000

Disadvantages

m Limit of 2 GB of storage

m Limit of two processors per computer

B Limited administrative tool

Web Server

CIMS Server uses IIS as the Web server. If you are using Crystal Reports, IIS and Crystal
Reports must be installed on the same server.

If you are using SQL Server Reporting Services, IIS can be on the same server or on a
separate server than Reporting Services. Regardless of which server you choose to install
Reporting Services, the server must have SQL Server 2000 installed. For more
information, see Installing and Configuring SQL Server Reporting Services on page 2-15.
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CIMS Server System Architecture Diagram

Figure 1-3 illustrates the relationship of the CIMS Server system components.
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Figure 1-3 « Architecture of the CIMS Server system
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Installing CIMS Server and
Getting Started

This chapter provides installation, configuration, and upgrade procedures for the CIMS
Server system. This chapter also provides a Getting Started section to help you to quickly
set up the system.

CIMS Server System COMPONENES .......iuiiiiiiitiirieirieeierecsasessassnssssossnsens 2-3
Suggested Software and Hardware ..........c.ccoeiiiiiiiiiiiiiiieiiieienienecneenencnens 2-3
Server Spedifications . ... ... ... 2-4
Client Spedcifications . . . ... 2-5
Report Design Specdifications ............. . i 2-6
Pre-Installation SetUP ... ..oviiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiitieitistesetnenssscscncnnes 2-7
Third-Party Software Licensing Requirements ........... ... ... e, 2-7
System Setup CheckIist ... ... 2-8
Internationalization Setup ......... ... 2-11
Installing and Enabling ASP.Net (Windows 2003 ONnly)........c.ccooiiuiieiinieiiniaennnnnns 2-14
Installing ASP.INET .. ... 2-14
Enabling ASP.INET .. ... . . 2-14
Installing and Configuring SQL Server Reporting Services ........ccoeveieieieieicnennes 2-15
About Licensing Reporting Services ................ ... ... i 2-15
Overview of Reporting Services COmponents . ...ttt iiinnneennn... 2-15
System Requirements for Reporting Services . . ............ . . . i i 2-16
Installing Reporting SErviCes . ... ...t e e 2-17
Configuring CIMS Server and Reporting Services ................ciiiiiiiinnennn... 2-17
Installing Crystal REPOIES .....ovniniiiniiiiiiiiiiiiiiiiiiitiiieiiieeeenencncncenencncnns 2-22
INStalliNG CIMS SEIVEL .. ...vuneninieieneinieneneneeseneececesessocesesescacssessnsncans 2-23
Performing a New Installation . .......... . ... . . 2-23
Modifying an Existing Installation ........... ... ... ... . 2-27
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2-2

Upgrading to aNew Release Of CIMS SE€IVer .......covieiiiiiiiieierieieienenienencnnenes 2-28
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CIMS Server System Components

Note ¢ For an overview of the architecture of the CIMS Server system,
see Chapter 1, About CIMS Server.

The CIMS Server system is composed of the following hardware/software components:

m CIMS Server application server. Contains the CIMS Server application (includes the
Processing Engine, Administrator, and Web Reporting components).

m Database server. Contains Microsoft SQL Server 2000 or a similar DBMS.

m Web server. Contains Microsoft IIS. If you are using Crystal reports for reporting,
Crystal Reports must also be installed on this server. If you are using SQL Server
Reporting Services reports for reporting, Reporting Services can be installed on any
server that has SQL Server 2000 installed (see Installing Reporting Services on
page 2-17).

You can install all components on one server or on separate servers. In general, a
configuration involving multiple servers might offer users superior performance.

Note ¢ If you install the CIMS Server application server and Web server on separate
servers, you need to install CIMS Server Administrator and CIMS Server Web
Reporting on the Web server (see Install CIMS Server Administrator and Web Reporting on
the Web Server (If Using a Separate Server) on page 2-48).

In addition, the system might include multiple clients containing the CIMS Server
Administrator application, terminal emulation software such as Microsoft Terminal
Services, or both.

If you have questions regarding setting up and configuring the CIMS Server system for
your organization, contact CIMS Lab (see Contacting Technical Support on page 7-10).

Suggested Software and Hardware

CIMS Lab recognizes that different organizations have unique existing enterprise systems
in place. As a result, this section describes suggested specifications, not absolute, rigid system
requirements. It is possible that CIMS Server can be run on components not matching
these suggestions, although the system was developed with these specifications in mind.

If you have any questions regarding compatibility of your existing system with
CIMS Server, contact CIMS Lab.
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Server Specifications

The following are the suggested server specifications for the CIMS Server system. Note
that the hard drive, processor, and memory specifications reflect the CIMS Server
application server, the database server, and the Web server on one computer.

m Microsoft Windows 2000 Server or Windows Server 2003 with the latest service pack

H 24

Note ¢ If the Web server is on a computer running Microsoft Windows XP
(unlikely), you might receive errors when attempting to run reports from the
CIMS Server Web Reporting Web site.

Microsoft SQL Server 2000 with the latest service pack (SQL Server 7.0 is also
acceptable) or MSDE 2000 (see Database Server on page 1-13)

Microsoft IIS 5.0 or later (included with Windows 2000 Server and Windows
Server 2003)

Crystal Reports 9 Advanced Developer Edition with Crystal Enterprise 9 Report
Application Server Edition (both provided by CIMS Lab for new CIMS Server 4.0
installations, see Installing Crystal Reports on page 2-22)

Note ¢ Crystal Reports 10 Advanced Developer Edition and Crystal Reports 8.5
Developer Edition are supported, but not supplied by CIMS Lab.

Or

SQL Server Reporting Services (included with SQL Server 2000, see Installing and
Configuring SQL Server Reporting Services on page 2-15)

Note ¢ SQL Server Reporting Services is not available for SQL Server 7.0 or MSDE.

Microsoft .NET Framework 1.1 (you can install the .NET Framework during the
installation of CIMS Server [see page 2-25] or you can download it from the Microsoft
Web site [see page 2-9])

80 GB available hard drive space, depending on particular data requirements
1 GHz processor or faster

1 GB of memory
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Client Specifications

The following are the specifications for installing CIMS Server Administrator on a client
and for viewing reports.

For Installing CIMS Server Administrator

CIMS Server Administrator is a Windows-based GUI application that enables
administrators to create and maintain the administrative and processing settings for
CIMS Server. Administrators can access CIMS Server Administrator remotely using
terminal emulation software to connect to the application on the server (recommended)
or directly by installing CIMS Server Administrator on a client.

The following are the suggested specifications for installation on a client:

m Microsoft Windows NT 4.0/2000/2003/XP with the latest service pack. Although not
recommended, it is also possible to use Windows 98.

m 40 MB available hard drive space
m 400 MHz processor or faster
m 128 MB of memory

You can also install and run CIMS Processing Engine on a client. However, if possible, it
is recommended that you run CIMS Processing Engine on the server using terminal
emulation software to connect to the engine.

For Viewing Reports

The following requirements apply to computers used to view reports in CIMS Server Web
Reporting:

m Internet Explorer 5.5 or later (if you are using Netscape Navigator, contact CIMS Lab
[see Contacting Technical Support on page 7-10]).

m Internet or network access with necessary security permissions
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Report Design Specifications

The following are the specifications for designing Crystal and SQL Server Reporting
Services reports.

For Designing Custom Crystal Reports

The following are the suggested specifications for computers used to design custom
Crystal reports for use with CIMS Server:

m Crystal Reports 9, any edition (or if you are using Crystal Reports 10 or 8.5, any
edition of those versions)

® Microsoft Windows 98/NT 4.0/2000/2003/XP
® 30 MB hard drive space minimum

m 128 MB of memory

For Designing Custom SQL Server Reporting Services Reports

The following are the specifications for computers used to design custom SQL Server
Reporting Services reports for use with CIMS Server:

B Reporting Services Report Designer (required)

m Microsoft Visual Studio .NET 2003 or another product that provides the Visual Studio
2003 shell (such as Visual Basic .NET 2003 or Visual C# .NET 2003) (required)

m SQL Server 2000 Service Pack 3 or later (required)
® 30 MB hard drive space minimum

m 128 MB of memory
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Pre-Installation Setup

Before you install CIMS Server, you should review the following sections to make sure
that you have all required third-party software licenses and have your system set up
correctly (including set up for internationalization if needed).

Third-Party Software Licensing Requirements

In addition to licensing CIMS Server, your organization must obtain the appropriate
licenses for the following products. These products are integral to the CIMS Server
system:

m Microsoft SQL Server 2000 or 7.0 (note that this is not applicable if you are
using MSDE).

B Microsoft Windows 2000 Server or Windows Server 2003.

m SQL Server Reporting Services. Reporting Services requires a valid license for SQL
Server 2000 (for license requirements, go to http://www.microsoft.com/sql/
reporting/howtobuy/).

Or

Crystal Reports 9 Advanced Developer Edition (CIMS Lab provides the appropriate
licensing).

Note ¢ Use of Crystal Reports may require specific licensing based on the number
and type of users. For more information or clarification about licensing issues,
contact CIMS Lab (see Contacting Technical Support on page 7-10).

CIMS Server Administrator's Guide 2-7 N


http://www.microsoft.com/sql/reporting/howtobuy/
http://www.microsoft.com/sql/reporting/howtobuy/

B Installing CIMS Server and Getting Started
Pre-Installation Setup

System Setup Checklist

Before installing CIMS Server, make sure that you have installed and configured the
components in the following list. Note that the Web server, database server, and CIMS
Server application server may be on one computer.

On the Web Server B Windows 2000 Server or Windows Server 2003.

m [IS 5.0 or later (included with Windows 2000 Server
and Windows Server 2003).

m If you are using Crystal Reports for reporting, Crystal
Reports 9 Advanced Developer Edition with Crystal
Enterprise 9 Report Application Server Edition (both
provided by CIMS Lab for new installations).

See Installing Crystal Reports on page 2-22 for the
steps required to install Crystal Reports 9 for CIMS
Server.

Note: Crystal Reports 10 Advanced Developer
Edition and Crystal Reports 8.5 Developer Edition
are also supported.

If you are using SQL Server Reporting Services
reports for reporting, Reporting Services can be
installed on the Web server or another server.
(Regardless of which server you choose to install
Reporting Services, the server must have SQL Server
2000 installed.) See Installing and Configuring SQL
Server Reporting Services on page 2-15 for the steps
required to install Reporting Services for CIMS
Server.

m Open Web access (and FTP access if necessary).
Server must have Port 80 open for HTTP access by
other client computers in the organization.

On the Database Server ® Microsoft SQL Server 2000/7.0 or MSDE 2000.

m Available SQL Server user ID (login) that has
permission to create tables, views, stored procedures,
and indices.
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On the CIMS Server
Application Server

On All Servers

On All Clients Accessing
CIMS Server Web Reporting

On All Clients Running
CIMS Server Administrator

CIMS Server Administrator's Guide

Pre-Installation Setup

Windows 2000 Server or Windows Server 2003.

ASP.NET. If you are using Microsoft Windows 2000
Server, ASP.NET is installed by default as part of the
IIS installation.

If you are using Windows Server 2003, you need to
install and enable ASP.NET as described in Installing
and Enabling ASP.Net (Windows 2003 Only) on
page 2-14.

Microsoft .NET Framework 1.1.

You can install the .NET Framework during the
installation of CIMS Server (see page 2-25) or you
can download it from the Microsoft Web site, http://
v4.windowsupdate.microsoft.com.

If you download the .NET Framework, on the
Windows Update page, click Pick updates to install
and then click your operating system. Microsoft .NET
Framework 1.1 appears in the Recommended
Updates list if it is not installed on your system.

Terminal emulation software such as Microsoft
Terminal Services or physical access to the server.

Servers are connected to the network and are visible
to each other—preferably on the same Windows
domain.

User has administrative access to the servers.

File share enabled (preferred) or FIP access to all
servers.

If using CIMS Mainframe, FTP access from the servers
to the z/OS system and vice versa.

If using CIMS UNIX, FIP or Secure Shell access from
the servers to the UNIX system and vice versa.

Internet Explorer 5.5 or later.

Administrative authority on the client to install
CIMS Server Administrator.
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On All Clients Running m Authority for the client computer and client user ID
Terminal Emulation Software to access the servers via terminal emulation software.

Other Tasks m Obtain the CIMS Server license key provided by
CIMS Lab. You will need to enter the license key in
CIMS Server Administrator after installation.

If you do not have your license key, contact CIMS
Lab (see Contacting Technical Support on page 7-10).
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Internationalization Setup

You can localize the following features in CIMS Server to reflect the language required
for your organization (the default is US English).

m Date and numeric formatting (such as numbers and currency) that appear in:
e The CIMS Server Web Reporting Web site
e CIMS Server Administrator
e Reports

m Headers and footers that appear in reports

You cannot localize the text that appears in CIMS Server Administrator or the Help text
in CIMS Server Administrator and CIMS Server Web Reporting. In addition, it is not
recommended that you change the text that appears on the CIMS Server Web Reporting
Web site. Changing this text requires changes to the Active Server Pages (ASP’) and
JavaScript code that runs the Web site.

Setting Up Your System for Internationalization
The language used by CIMS Server is determined by the following settings:

m Thelocale ID set in the Site Localization ID (LCID) box in the Configuration dialog
box (see Web Settings on page 3-47).

m On the Web server, the regional settings for the Windows user account set as the
Crystal Report Application Server (RAS) log on account. See Set the Crystal RAS User
Log On Account on page 2-12.

m On the CIMS Server application server, the language specified for the database ODBC
Data Source used by CIMS Server. See Select the Language for the ODBC Data Source on
page 2-12.

m On the server running CIMS Server Administrator, the regional settings for the
Windows user account logged on to the server running CIMS Server Administrator.
See Select the CIMS Server Administrator User’s Regional Settings on page 2-12.

m On a client accessing CIMS Server Web Reporting, the regional settings for the
Windows user account logged on to the client. See Select the CIMS Server Web
Reporting User’s Regional Settings on page 2-12.

The following sections provide the steps required to configure these settings for your
organization. In most cases, you will already have these settings set to the correct language.

Note ¢ The steps provided in this section are for the Microsoft Windows Server 2000
operating system. If you are using another operating system, refer to the Microsoft
documentation if needed.
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Set the Crystal RAS User Log On Account

If you are using Crystal Reports 9 or 10, the Crystal RAS uses the local system account for
the Web server by default.

If you do not want Crystal Reports to use the regional settings for the local system
account, you need to set the log on to an account with the correct regional settings. CIMS
Lab recommends that you create a user for use as the RAS log on. This user should have
a password that is never changed.

To set the Crystal RAS Log On:

1 In Windows Control Panel, double-click Administrative Tools » Services.
2 Double-click Crystal Report Application Server.

3 On the Log On tab, click This account.

4 Enter the account and password.

A message appears stating that the log on will not take affect until you restart the
service.

5 Click OK, and then restart the Crystal RAS service (right-click the service and click
Restart).

Select the Language for the ODBC Data Source

In the Windows ODBC Data Source Administrator, you need to select the language for
each ODBC Data Source used by CIMS Server. The steps for configuring a data source for
CIMS Server are provided in Select and Configure the Database As an ODBC Data Source
on page 2-36.

Note ¢ The change to the language source will not appear in reports until you restart
I1S. (To restart IIS, see page 7-4.)

Select the CIMS Server Administrator User’s Regional Settings

You need to select the regional settings for the user logged on to the server running CIMS
Server Administrator. To select the regional settings for the user:

1 In Windows Control Panel, double-click Regional Options.

The Regional Options dialog box appears.
2 On the General tab, click the language that you want from the list.
3 Click OK to save the change and close the dialog box.

Select the CIMS Server Web Reporting User’s Regional Settings

You need to set the correct regional setting for the user on each client that is using CIMS
Server Web Reporting. This enables Microsoft Excel to display dates, times, currency, and
numbers in the correct format when you view a report as a spreadsheet.

To select the regional settings for the user, follow the steps in Select the CIMS Server
Administrator User’s Regional Settings.
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Change the Report Text (Optional)

CIMS Server includes a variety of standard reports and spreadsheets for Crystal Reports,
SQL Server Reporting Service, and CIMS Advanced Spreadsheets. You can use these
reports and spreadsheets as templates to create custom reports/spreadsheets (see About
CIMS Server Reports on page 4-2), and then change the text as follows.

For Crystal reports:

1 In Crystal Reports, open the report that you want to change.

2 Right-click the text that you want to change, and then click Edit Text Option.

3 Save the report using the same file name in the Custom reports folder.

For SQL Server Reporting Services reports:

1 In Visual Studio .NET or another product that provides the Visual Studio 2003 shell,
2 Click File » New Project.

3 In Business Intelligence Projects, double click Report Projects.

4 Right-click the Reports folder in the Solution Explorer window, and then click Add
Existing [tem.

5 Browse to find the report file that you want to edit, and then open the report.
6 Right click the text that you want to change, and then click Expression.
7 In the Edit Expression dialog box, change the text in the Expression box.
8 Click OK.
9 Repeat steps 1 through 5 for each text area that you want to change.
10 Click File » Select Items when you are finished.

For CIMS Advanced Spreadsheets:

Contact CIMS Lab for assistance in changing the text and other culture-specific
information in CIMS Advanced Spreadsheets (see Contacting Technical Support on
page 7-10).
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Installing and Enabling ASP.Net (Windows 2003 Only)

If you are using Microsoft Windows 2000 Server, ASP.NET is installed by default as part
of the IIS installation.

If you are using Windows Server 2003, you need to install and enable ASP.NET as
described in this section.

Installing ASP.NET
To install ASP.NET on a computer running Windows Server 2003:
1 In Windows Control Panel, click Add/Remove Programs.

2 Click Add/Remove Windows Components, and then select the Application Server
check box if it is not selected.

3 Click Details, and then select the ASP.NET check box if it is not selected.

Enabling ASP.NET
To enable ASP.NET:
1 In IIS Manager, navigate to and click Web Service Extensions.

Note that you can easily start IIS Manager by clicking Start » Run. Type inetmgr in the
Open box, and then click OK.

2 Click Active Server Pages and then click Allow.
3 Click ASP.NETv<version number> and then click Allow.

4 Make sure that A1Towed appears in the status column for these features.
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Installing and Configuring SQL Server Reporting
Services

Note ¢ This section is applicable only if you want to use SQL Server Reporting
Services for reporting.

The installation steps in this section are preceded by a brief overview of the licensing
requirements, components, and system requirements for SQL Server Reporting Services.
For more detailed information about obtaining, licensing, installing, and using
Reporting Services, go to http://www.microsoft.com/sql/reporting/.

About Licensing Reporting Services

Reporting Services is part of the SQL Server 2000 license. There is not a separate license
for Reporting Services. If you have a licensed copy of SQL Server 2000, you may run
Reporting Services on the same server for no additional license fee. If you want to run
Reporting Services on a server that is not licensed for SQL Server 2000, you will need to
obtain a SQL Server 2000 license for that additional server.

For example, if you install Reporting Services on the same server as your SQL Server 2000
instance, no additional licensing is required. However, if you want to have SQL Server
2000 and Reporting Services on separate servers, for example, you want to have your
CIMS Server database on one server and Reporting Services and IIS on a separate Web
server, you will need to obtain a separate SQL Server 2000 license and install SQL Server
2000 on the second server.

Overview of Reporting Services Components
Reporting Services is composed for four main components:

B Report Server. A Web service that handles report management and processing. It
connects to a SQL Server database for report metadata and caching,.

B Report Server Database. A SQL Server database used for report metadata and
caching.

m Report Manager. A Web-based tool for managing Report Server.

m Report Designer. A graphical report-authoring tool that is integrated with Microsoft
Visual Studio .NET 2003.

Report Server requires a local or remote connection to the Report Server Database. If you
have Report Server on one server and Report Server Database on another server, a
separate SQL Server 2000 license is required for each server.
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System Requirements for Reporting Services

B 2-16

For the Server Running Reporting Services:

SQL Server 2000.

SQL Server 2000 Service Pack 3 or later. To download the service pack, go to http://
www.microsoft.com/sql/downloads/servicepacks.asp.

ASP.NET. If you are using Microsoft Windows 2000 Server, ASP.NET is installed by
default as part of the I1S installation. If you are using Windows Server 2003, make sure
that ASP.NET is installed and enabled (see Installing and Enabling ASP.Net (Windows
2003 Only) on page 2-14).

SQL Server 2000 Reporting Services Service Pack 1 (see Installing Reporting Services on
page 2-17).

For the Web Server:

You must enable Windows authenticated access for IIS. (See page 2-50 for more
information about setting the IIS authentication method).

For the browser used with Reporting Services Report Manager:

For the browser used to access and manage Report Server using Report Manager, the
client computer must have Microsoft Internet Explorer 6.0 with Service Pack 1 (SP1),
with scripting enabled.
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Installing Reporting Services

The following steps reflect installing Reporting Services from a CD. To perform the
installation from another source, refer to the Microsoft documentation. You must have
SQL Server 2000 installed on the server to install Reporting Services.

To install Reporting Services From a CD:
1 Logon to Windows as a user in the Administrators group.

2 Insert the Reporting Services CD. If the CD does not start automatically, browse to
your CD-ROM drive and double-click setup.exe.

3 Follow the instructions in the Reporting Services installation wizard.

Install SQL Server 2000 Reporting Services Service Pack 1 after you install Reporting
Services. To download this service pack, go to http://www.microsoft.com/downloads/
details.aspx?Familyld=580FEBF7-2972-40E7-BCCF-6CD90AC2F464 &displaylang=en.

Note ¢ If you do not have Visual Studio .NET 2003 or another product that provides
the Visual Studio 2003 shell installed, you will receive notification when the installer
checks for Reporting Services prerequisites. Visual Studio 2003 is not required unless
you want to use Report Designer.

Configuring CIMS Server and Reporting Services

After you have installed Reporting Services, you need to perform the following
configuration steps.

Edit the Web.config File

The CIMS Server installation includes an XML configuration file for Web reporting
named Web.config. (If you installed CIMS Server in the default location, this file is in
C:\Program Files\CIMSLab\Server\Web\CIMSReporting.) You need to edit this file as
follows:

1 Locate the following line:

<add key="CIMSReporting.localhost.ReportingService" value="http://
localhost/ReportServer/ReportService.asmx"/></appSettings>

2 Change Tocalhost to the name of the server on which Reporting Services is installed.

Example: <add key="CIMSReporting.localhost.ReportingService" value="http://
roca/ReportServer/ReportService.asmx"/></appSettings>

In this example, the server name is roca.

3 Ifyou chose a folder for the Report Server other than the default folder named
ReportServer during installation, you also need to change the folder name.

Example: <add key="CIMSReporting.localhost.ReportingService" value="http://
roca/ReportServerFin/ReportService.asmx"/></appSettings>

In this example, the Report Server directory name is ReportServerFin.

CIMS Server Administrator's Guide 2-17 N


http://www.microsoft.com/downloads/details.aspx?FamilyId=580FEBF7-2972-40E7-BCCF-6CD90AC2F464&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=580FEBF7-2972-40E7-BCCF-6CD90AC2F464&displaylang=en

B Installing CIMS Server and Getting Started

Installing and Configuring SQL Server Reporting Services

H 2-18

Deploy a Reporting Services Report and the Report Logo

In CIMS Server Administrator, you need to do the following:

Add a Reporting Services report to the Report List Maintenance dialog box as
described in Adding Reports to the CIMS Server Report List on page 4-5. This
automatically creates the required CIMSReporting folder in Reporting Services Report
Manager.

Deploy the logo image that appears in reports. You can use the default CIMS logo or
use a custom logo.

To use the default logo image, click System Administration » Reporting » Deploy
Reporting Services Report Image in the CIMS Server Administrator main window.
To use a custom logo, see Changing the Logo in Reports on page 4-10.

Create a Role in Reporting Services

Reporting Services uses a role definition to define which tasks a user is allowed to
perform in connection with a folder, report, or other item. In Reporting Services Report
Manager, you need to create one role definition for all CIMS Server Web Reporting users
and set the user options for that role as described in the following sections.

To create a role:

1

Start Report Manager.

If Reporting Services is installed on a remote computer, you must access Report
Manager through the browser using the Report Manager URL. For example:

http://roca/Reports

If Reporting Services is installed on the local computer, you can click
Start » Programs » Microsoft SQL Server » Reporting Services » Report Manager.

Click Site Settings in the upper right corner of the Report Manager home page.

On the Site Settings page, click Configure item-level role definitions under Security.
On the Item-Level Roles page, click New Role.

On the New Role page, do the following:

e In the Name box, type a name for the role. The name CIMSUser is used in this
guide, but you can use any name.

¢ Inthe Description box, type a description for the role. For example, Role used for
CIMS users to view/deploy reports.

¢ Click the following tasks:

e Manage data sources
e Manage folders

e Manage reports
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e Manage resources
e View reports
e View resources

6 Click OK.

The role is saved to the Reporting Services Report Server Database. The role name and
description appears on the Item-Level Roles page as shown in example Figure 2-1.

= | Report Manager - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

@Back Y \ﬂ \ELI _;\J /..-‘JSearch ‘:_;:{Favorites 6\* - .,'_,’. @ 4 ﬁ :’3 A'

—

Address |2:| http: firoca-deborahzkiReports/PagesiRoles, aspx?System=False

Home | My Subscriptions | Site
[= SqQL Server Reporting Services
% ltem-Level Roles Search for:| |
L Mew Role
Raoled Description
Browser

May view folders, reports and subscribe to reports,

| CIMSUser Role used for CIMS users to view/deploy reports,
Content Manager May manage content in the Report Server. This includes folders, reports and resources,
My Reports May publish reports and linked reports; manage folders, reports and resources in a users My Rep
Publisher May publish reports and linked reports to the Report Server,

@ Done

Figure 2-1 « Report Manager Item-Level Roles Page
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Assign Users to the CIMSUser Role

The users that you can add to the CIMSUser role are dependent on whether you are
running Reporting Services on the Web server or another server.

m If you are running Reporting Services on the Web server, you can add the following
local Windows user account to the role. These accounts enable all users to access
Reporting Services.

e computername\ASPNET (Windows 2000)
Or
e NT AUTHORITY\NETWORK SERVICE (Windows 2003)

m If you are running Reporting Services on a server other than the Web server, you
cannot use the local user account ASPNET or NETWORK SERVICE. In this situation, you
need to add Windows user or group accounts to the role. For convenience, you can
create a Windows group account for all users and add the group account to the role.

If you add user or group accounts to the role other than ASPNET or NETWORK SERVICE,
you must add the following line <identity impersonate="true"/> after the end of the
authorization element in the Web.config file as follows:

<authorization>
<allow users="*"/> <l-- Allow all users -->

<I-- <allow users="[comma separated list of users]"
roles="[comma separated 1ist of roles]"/>
<deny users="[comma separated 1ist of users]"

roles="[comma separated list of roles]"/>
-
</authorization>
<identity impersonate="true"/>

To assign users to a role:

1 On the Report Manager home page, click the CIMSReporting folder.
On the CIMSReporting page, click the Properties tab.

Click the Security link in the left frame.

B W N

Click New Role Assignment.

Note ¢ If New Role Assignment does not appear immediately, click Edit Item
Security, and then click OK in the message box.

5 In the Group or user name box, type the Windows account name for the user. For
example, type roca\ASPNET for the ASPNET account on the server roca.

6 Select the check box for the role that you created in To create a role:.
7 Click OK.

The user is saved to the Reporting Services Report Server database. The user name and
role appears on the Properties tab as shown in example Figure 2-2 on page 2-21.
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Installing Crystal Reports

Note ¢ This section is applicable only if you want to use Crystal Reports for
reporting. The installation procedures in this section apply to Crystal Reports 9.
For information regarding using Crystal Reports 8.5, see page 7-10. If you want to use
Crystal Reports 10, contact CIMS Lab (see Contacting Technical Support on page 7-10).

CIMS Lab provides Crystal Reports 9 Advanced Developer Edition for new CIMS Server
4.0 installations. This edition includes Crystal Enterprise 9 Report Application Server
Edition. You need to install both of these components and Crystal Reports 9 Service Pack
2 in the following order:

1 Crystal Reports 9 Advanced Developer Edition (provided on the CD labeled Crystal
Reports)

2 Crystal Enterprise 9 Report Application Server Edition (provided on a separate CD
labeled Crystal Enterprise Report Application Server)

Note * Make sure that you install the Report Application Server Edition. Crystal
Reports 9 Advanced Developer Edition also includes a Crystal Enterprise 9
Standard Edition CD. Do not install the Standard Edition.

3 Crystal Reports 9 Service Pack 2

To install Crystal Reports 9 Advanced Developer Edition:
1 Logon to Windows as a user in the Administrators group.
2 Do one of the following:

e Ifyou are installing from the installation CD, insert the Crystal Reports CD. If the
CD does not start automatically, browse to your CD-ROM drive and double-click
Setup.exe.

e Ifyou are installing from another location, for example from a network drive,
double-click Setup.exe.

3 Click Install and follow the instructions in the Installation Wizard. CIMS Lab
recommends that you select the Typical installation in the Select Installation Type
dialog box.

To install Crystal Enterprise 9 Report Application Server Edition:

Follow the same steps provided for installing Crystal Reports. However, install Crystal
Enterprise Report Application Server Edition rather than Crystal Reports. CIMS Lab
recommends that you select the Full installation in the Installation Type dialog box.

To install Crystal Reports 9 Service Pack 2:

Crystal Reports 9 Service Pack 2 is available on the CIMS Lab FTP site (ftp://
ftp.cimslab.com) and CIMS Product CD. The path on both the FTP site and CIMS
Product CD is CIMSServer\CrystalPatches\Crystal 9 Patches\cr90win_en_sp2.exe).

Double-click cr90win_en_sp2.exe and follow the instructions in the InstallShield
wizard.
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Installing CIMS Server

This section describes the steps required to install CIMS Server. (Before you begin the
installation, make sure that you have installed and configured the components described
in System Setup Checklist on page 2-8.)

Note ¢ You can install the CIMS Server Administrator component of CIMS Server on
a client or clients (see Client Specifications on page 2-5) in addition to installation on
the server. You can also install CIMS Processing Engine on a client. However, if

possible, it is recommended that you install CIMS Processing Engine on the server.

To begin the CIMS Server installation:

1 Logon to Windows as a user in the Administrators group.
2 Click the Windows Start button, and then click Run.

3 Enter the path to the CIMS Server setup program (Setup. version&release.exe), and
then click OK. (The path depends on the location of the setup program, i.e., CIMS
Product CD, network drive, etc. For example, if you are installing from the CIMS
Product CD on drive D, the path is D: \CIMSServer\Setup. version&release.exe.)

4 Follow the steps provided in the InstallShield Wizard as described in the following
sections. The steps differ depending on whether you are performing a new
installation or modifying an existing installation. To modify an existing installation,
see Modifying an Existing Installation on page 2-27.

Performing a New Installation

Note ¢ The CIMS Server 4.0 installation includes Microsoft Data Access Components
(MDAC) 2.8. This is the current MDAC version as of this CIMS Server release. If a
later MDAC version is available at the time that you install CIMS Server 4.0, you can
download the new version from http://msdn.microsoft.com/data/downloads/
updates/default.aspx#MDACDownloads.

The InstallShield Wizard contains the following steps that guide you through the
installation.

Choose the Destination Location

Choose the default location for installation (C: \Program Files\CIMSLab) or click Browse
to choose another location. Click Next after making your selection.

Note ¢ The folder in which you install CIMS Server (CIMSLab or other) should be
periodically backed up
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Select the Features That You Want to Install

Select the CIMS Server components that you want to install or clear the components that
you do not want to install. For a detailed description of these components, see Chapter 1,
About CIMS Server.

CIMS Administrator. This option installs CIMS Server Administrator. CIMS Server
Administrator is a graphical interface that enables you to create and maintain
administrative and processing settings.

CIMS Processing Engine. This option installs CIMS Processing Engine components
including CIMSACCT.d11, CIMSBILL.d11, CIMSSORT.d11, and CIMSAdminLib.d11. These
components process the CIMS Server Resource (CSR) or CIMS Server Resource Plus
(CSR+) files and load the output into the CIMS Server database. This option also
installs CIMS Aggregation Engine (CIMSAggregation.d11) used by CIMS Data
Collectors.

CIMS Web Reporting. This option installs the CIMS Server Web Reporting
component, which allows end users to view reports from a Web browser.

Scripts. This option installs scripts that can be used to automate tasks in CIMS Server.
For example, scripts that enable batch reporting, scripts used by CIMS Data
Collectors, etc. For a description of these scripts, see Appendix C, Scripts.

CIMS Conversion Engine. This option installs CIMS Conversion Engine. CIMS
Conversion Engine is a utility that converts data collected by CIMS Universal Data
Collector and converts it into CSR files. For more information about CIMS
Conversion Engine and the CIMS Universal Data Collector, refer to the CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

CIMS Collectors & Processors. This option installs the collector and process
components of CIMS Data Collectors for Windows. These components enable you to
gather usage data from many different sources such as operating systems, databases,
and applications for input into CIMS Server.

By default, the CIMS Collectors & Processors check box is selected and all individual
collectors other than the Windows Print Usage collector are selected. (CIMS Lab
recommends that you use the Windows Event Log collector to collect print usage
data.)

To install individual collectors and processes, expand CIMS Collectors & Processors,
and then select the collectors that you want.

MSDE—Microsoft SQL Server 2000 Desktop Data Engine. This option installs
MSDE 2000. In a production environment, it is strongly recommended that you use
Microsoft SQL Server instead of MSDE to manage your database. However, in other
situations, MSDE might meet your requirements. For more information, see CIMS
Server Professional Edition on page 1-13.

Click Next after you have made your selections.

CIMS Server Administrator's Guide



Installing CIMS Server and Getting Started H
Installing CIMS Server

Select the Program Folder

Choose the program folder. Use the default (CIMS Server), type a new program folder
name, or select one from the list. Click Next when you are finished.

Start Copying Files

Click Next to begin copying program files to your system. If IIS is running, a message
appears asking you to confirm that is okay to shut down the program. Click Yes to quit
IIS. Note that the installer restarts IIS before finishing installation.

Install Microsoft .NET Framework 1.1 (If Applicable)

If you have not installed Microsoft .NET Framework 1.1, the Microsoft .NET Framework
1.1 Setup appears. Follow the instructions in the setup, and then click OK when the
installation is complete.

Note ¢ If the message Files In Use appears during the installation, click Ignore. The
.NET Framework will continue to install.

Install Fujitsu COBOL Workstation Run-time

The InstallShield Wizard for the Fujitsu COBOL Workstation Run-time program
appears. This program is necessary for execution of the key processing programs
CIMSACCT and CIMSBILL. Click Next, and then click Install. When the installation is
complete, click Finish.

Install CIMS Windows Process Collector (If Applicable)

If the CIMS Windows Process collector was selected under CIMS Collectors &
Processors (see Select the Features That You Want to Install on page 2-24), the
InstallShield Wizard for CIMSWinProcess appears. If you want to collect process usage
data from this server, you can install the executable and administrative programs for the
collector as shown in the following steps. If you do not want to collect process data from
this server, click Cancel and then click Yes.

Note * The following instructions are also applicable if you are installing the CIMS
Windows Print Usage collector. By default, the CIMS Windows Print Usage collector
option is not selected under CIMS Collectors & Processors and you will not be
prompted to install the collector.

1 Choose the default location for installation (C:\Program Files\CIMSLab) or click
Change to choose another location. Click Next after making your selection.

2 Accept the default selection for the collector, Process Collector-Service, and then
click Next. Do not select the other components. (If you are installing the Windows
Print Usage Collector, accept the default, Print Collector.)

3 Click Install, and then click Finish when the installation is complete.
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CIMS Lab provides a separate setup program for installing the CIMS Windows Process
collector on other computers. For more information, refer to the CIMS Data Collectors for
Microsoft Windows Installation and User Guide.

Enter the 1IS Web User Name

There are two options for controlling user access to the CIMS Server Web Reporting Web
site: anonymous access and Windows authenticated access. Anonymous access allows
remote access by the IUSR_computername account. I1S user access is described in detail in
Set the User Authentication Method for the CIMS Server Web Reporting Web Site on

page 2-50.

The InstallShield Wizard allows you to enter the IUSR_computername. This name is used
for granting security permissions for CIMS Server folders as described in Assign CIMS
Server Folder Security Permissions on page 2-52.

In most situations, the IUSR_computername account that appears is correct and you can
click Next to continue. If you want to confirm that it is correct, follow the instructions in
To set anonymous access: on page 2-50 to locate the IUSR_computername. If the
IUSR_computername is not correct (for example, you changed your computer name after
installing IIS), you can change it here and then click Next.

If you do not enter the correct IUSR_computername here, you can assign the required
folder privileges manually (see page 2-52). A series of error messages will appear. Click
OK for each message.

Complete the Installation

Follow the instructions in the Setup Complete—Reboot Required dialog box, and then
click Finish.
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Modifying an Existing Installation

Follow the steps in this section to modify an existing installation. For example, you have
already installed certain CIMS Data Collectors but now want to install others.

1 Run the CIMS Server setup program.
Or

In Windows Control Panel, click Add or Remove Programs, and then click Change
for CIMS Server.

The InstallShield Wizard appears.
2 Click Moditfy, and then click Next.

Note ¢ Do not click Repair to modify the installation. The Repair option should
be ignored.

3 Select the check boxes for the components that you want to install. (For a description
of all components, see Select the Features That You Want to Install on page 2-24.) Do
not clear a check box unless you want to delete that component.

4 Follow the instructions presented in the wizard to complete the installation.

Note ¢ If you are installing the CIMS Windows Process or CIMS Windows Print
Usage collector, the InstallShield Wizard for CIMSWinProcess or InstallShield
Wizard for CIMSWinPrint appears. Complete these wizards as described in Install
CIMS Windows Process Collector (If Applicable) on page 2-25.
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Important! ¢ If you are performing an upgrade, you should back up the Program
Files\CIMSLab folder before you upgrade to a new version of CIMS Server. If you have
made changes to files in this folder and have not renamed these files, the files will
be overwritten when you upgrade to a new version or release of CIMS Server.

You should also confirm that you have a regular backup schedule for the CIMSLab
folder, the folder that contains your process definitions (referred to as Processes in
this guide) and your database and that the backup is working.

To upgrade to a new release of CIMS Server:

1 Follow the steps in To begin the CIMS Server installation: on page 2-23 to start the
InstallShield Wizard.

2 In the InstallShield Wizard, a message appears asking you to confirm that is okay to
uninstall the existing CIMS Server version. Click Yes.

3 When prompted to modify, repair, or remove the existing installation, make sure that
Remove is selected, and then click Next.

4 Click OK in the Confirm Uninstall message box.

5 IfIIS is running, a message appears asking you to confirm that is okay to shut down
the program. Click Yes to quit IIS. Note that IIS is automatically restarted.

6 The Remove ODBC Data Source message appears asking you to confirm that it is okay
to remove the CIMSServer data source. Click Yes.

7 Choose the default location for upgrade (C:\Program Files\CIMSLab) or click Browse
to choose another folder if CIMS Server is installed in another location. Click Next
after making your selection.

Important! « When you upgrade to a new version or release of CIMS Server, make
sure that you install the program in the same folder as the existing CIMS Server
installation. If there is a reason that you want to keep your previous CIMS Server
version and install the upgrade, contact CIMS Lab (see Contacting Technical Support
on page 7-10).

8 Select the check boxes for the components that you want to upgrade. (For a
description of all components, see Select the Features That You Want to Install on
page 2-24.) Do not clear a check box unless you want to delete that component.

9 Choose the program folder. Use the default (CIMS Server), type a new program folder
name, or select one from the list. Click Next when you are finished.

10 Click Next to begin copying program files to your system. If IIS is running, a message
appears asking you to confirm that is okay to shut down the program. Click Yes to
quit IIS. Note that IS is automatically restarted.
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11 Ifthe CIMS Windows Process and/or CIMS Windows Print Usage collector is installed
on this server, you will prompted to modify each collector installation separately. Do
the following for each collector:

a Make sure that Modify is selected and click Next.

b Accept the default feature selection for the collector, Process Collector-Service or
Print Collector, and then click Next. Do not select the other components.

¢ Click Finish when the upgrade is complete.

12 Accept the default IIS Web user name or enter a new name as described in Enter the
IIS Web User Name on page 2-26, and then click Next.

13 Follow the instructions in the Setup Complete—Reboot Required dialog box, and
then click Finish.
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Getting Started

This section takes you through the steps required to set up and use CIMS Server. You
should follow these steps in the order presented.

To help you to get started quickly, this section does not contain the detailed information
found in other chapters in this guide. Where applicable, references to more detailed
information are provided.

Before getting started, make sure that you have installed the system components
required by CIMS Server as shown in System Setup Checklist on page 2-8.

About the Configuration of Microsoft SQL Server and IIS
for the CIMS Server Web Reporting Web Site

The CIMS Server Web Reporting Web site is an ASP application that runs under IIS and
uses an SQL Server database. The database and IIS may be on one server or on separate
servers. To set up SQL Server and IIS for CIMS Server Web Reporting, you must configure
user access for both the SQL Server database and IIS.

The user access methods that you can use for the database and IIS are described in the
following sections.

SQL Server Database User Access

There are two options for controlling user access to the SQL Server database. These
options are set in SQL Server Enterprise Manager as described in Creating User Logins for
the Database on page 2-34.

® Windows authentication. Windows authentication verifies the database user using
the Windows user account.

m SQL Server authentication. SQL Server authentication verifies the database user
using the SQL Server login ID and password.

The user authentication method that you should use is dependent on the IIS and SQL
Server configuration for your organization as shown in Table 2-1 on page 2-32.
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IIS Web Site User Access

There are two options for controlling user access to the CIMS Server Web Reporting Web
site. These options are set in Internet Information Services Manager as described in Set
the User Authentication Method for the CIMS Server Web Reporting Web Site on page 2-50.

B Anonymous access. Anonymous access allows remote access by the user ID
IUSR_computername. Users can connect to the CIMS Server Web Reporting Web site
without a Windows user name or password.

m Authenticated access. Authenticated access uses the current Windows user
information on the client computer to allow users to connect to the Web site.

If you are using a MSDE database, you need to use authenticated access.

If you are using a SQL Server 2000 database, you can use anonymous access or
authenticated access depending on the IIS and SQL Server configuration for your
organization as shown in Table 2-1 on page 2-32.

Features Not Available With Anonymous Access

m SQL Server Reporting Services. If you use Reporting Services as your reporting tool,
you cannot use anonymous access.

m CIMS Server Web Reporting auto logon. The auto logon feature for CIMS Server Web
Reporting is not available if you use anonymous access for IIS. This feature enables
end users to use CIMS Server Web Reporting without entering a CIMS user ID and
password on the Login page. To enable this feature, see Web Settings on page 3-47.

In addition, if you use anonymous access and are using the transaction audit feature, the
user ID associated with the transaction will not reflect the actual user. The transaction
audit feature enables CIMS Server administrators to track miscellaneous, recurring, and
credit transactions created in CIMS Server Web Reporting. (For more information about
transactions, refer to the CIMS Server Web Reporting User’s Guide). To enable transaction
audits and other audits such as client and rate, see Table Audit Settings on page 3-52.
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User Access Requirements by IIS and SQL Server Configuration

The user authentication that you can use for IIS and the SQL Server database is
dependent on whether you have IIS and SQL Server running on one server or separate
servers and whether CIMS Server Web Reporting is running on an Internet or intranet
site.

An intranet site is accessible only to computers connected to an organization’s internal
network. An Internet site is accessible to all computers connected to the Internet.

Table 2-1 shows the allowed user authentication options by the different IIS and SQL
Server configurations your organization might have.

Required IIS Required SQL Server

1IS and SQL Server Configuration User Authentication  User Authentication

IIS and SQL Server on the same Authenticated access Windows authentication
server. CIMS Server Web Reporting o
on an intranet site. r

Authenticated access SQL Server authentication
Or

Anonymous access  SQL Server authentication

I1S and SQL Server on separate Authenticated access SQL Server authentication
servers. CIMS Server Web o
Reporting on an intranet site. f

Anonymous access  SQL Server authentication

IIS and SQL Server on same or Anonymous access SQL Server authentication
separate servers. CIMS Server Web
Reporting on an Internet site.

Table 2-1 - IIS and SQL Server User Authentication Requirements
The steps required to configure user access for the database and IIS are provided in the
following sections:

m Creating User Logins for the Database on page 2-34. Note that this is not required if you
are using an MSDE database.

m Select and Configure the Database As an ODBC Data Source on page 2-36.

m Set the User Authentication Method for the CIMS Server Web Reporting Web Site on
page 2-50.

It is important that review the information in these sections carefully to set the best user
access options for your organization.
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Create a Database

The database stores administration information as well as the output records produced
by CIMS Processing Engine. These records are called the Ident, Detail, and Summary
records and contain data processed from CSR or CSR+ records. Each process definition
in the Processes folder produces separate Ident, Detail and Summary files (see
Chapter 6, Processing Data, for more information about these records).

The following sections provide steps for creating a database in MSDE 2000 or Microsoft
SQL Server 2000.

Note * You can use more than one database with CIMS Server. For example, you
might have a production database and a development database. For more
information about creating multiple databases and configuring the databases as
ODBC data sources, see Chapter 5, Database Administration.

Creating an MSDE 2000 Database

When you install MSDE 2000, a default master database (master.mdf) is created. You can
use this database “as is”.

Note « MSDE is installed in Mixed Mode. Mixed Mode authentication permits you to
log on to MSDE by using Windows authentication or SQL Server authentication.
However, using both authentication methods is unusual and usually not
recommended.

The master database is created in C:\Program Files\Microsoft SQL Server\MSSQL\Data
(if you installed CIMS Server, including MSDE, in the default location). You should
include the Data folder in your backup schedule.

Creating a Microsoft SQL Server 2000 Database

You can create a database using SQL Server Enterprise Manager or the OSQL or ISQL
command-line interface. The following are the steps needed to create a database using
Enterprise Manager:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » computername » Databases.

3 Right-click the Databases folder, and then click New Database.

4 In the Database Properties dialog box, enter the configuration information for the
new database as follows:

¢ On the General tab do the following:

¢ In the Name box, type a name for the database. The name CIMSServer is used in
this guide, but you can use any name.
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* In the Collation name box, click SQL_Latinl_General_CP1_CI_AS. Make sure
that you select only this database collation type and not a type that looks
similar. CIMS Server currently does not support other collation types.

e Unless you need to change the default settings for the database, you do not need
to reset values in the Data File or Transaction Log tabs.

5 Click OK when you are finished.

Creating User Logins for the Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. After you create the database,
you need to create a database login for these users. You can create one login for both user
types or separate logins. For example, you can create a login for the end users that has
fewer database permissions than the login for the administrator(s).

Note ¢ You can also create a separate login for the CIMS Job Runner application.
This application runs CIMS Data Collectors in batch. The login for CIMS Job Runner
must have the same database permissions as the CIMS Server administrator.

The user login includes the user authentication method for the database (Windows
authentication or SQL Server authentication). When creating a login, consider the
following when choosing the authentication method:

m Windows authentication verifies the SQL Server user using the Windows user
account. If the user is the CIMS Server administrator, SQL Server uses the account on
the computer running CIMS Server Administrator.

m SQL Server authentication verifies the user using the SQL Server login ID and
password. Using this authentication method, you could create a single login for all
CIMS Server administrators, a login for all CIMS Server Web Reporting end users, or
a login for both administrators and end users.

Note ¢ CIMS Server provides an optional table audit feature that enables you to
track changes that have been made to the data in certain database tables (see Table
Audit Settings on page 3-52). This information includes the user ID of the person
who made the change. If you use SQL Server authentication for multiple users,
you will not be able to identify the actual user who made the change.

B You need to set up an ODBC data source for the database. If you use the same
authentication method for both the CIMS Server administrator login and the CIMS
Server Web Reporting end users login, you need to create only one ODBC data source
for the database.

If you create a Windows authentication login for one user type and a SQL Server
authentication login for the other, you need to create two data sources for the
database. For more information, see Select and Configure the Database As an ODBC
Data Source on page 2-306.
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To create a user login:

Note ¢ For example purposes, the following steps reflect creating a separate user
login for CIMS Server administrators and CIMS Server Web Reporting end users. To
create one login for both user types, follow the steps as if you are creating an
administrator login.

1 In the SQL Server Enterprise Manager, right-click the CIMSServer database.
2 Click New » Database User.
The Database User Properties—New User dialog box appears.
3 In the Login name box, click <new>.
The SQL Server Login Properties—New Login dialog box appears.
4 On the General tab, do the following:
¢ In the Name box, do one of the following:

e To use Windows user authentication, enter the user name. To browse for a user,

click the Browse button EI

e To use SQL Server user authentication, type a user login name, for example
CIMSAdmin or CIMSUser.

e In the Authentication area, click either Windows Authentication or SQL Server
Authentication. If you select SQL Server Authentication, type a password.

e In the Defaults area, enter the CIMSServer database in the Database box.

5 If you are creating a login for a CIMS Server administrator, on the Server Roles tab,
select the System Administrators check box.

6 On the Database Access tab, select the Permit check box for the CIMSServer database.
A list of database permits appears with the public check box selected.
7 Leave the public check box selected and do one of the following:

e Ifyou are creating a login for a CIMS Server administrator, select the db_owner
check box, and then click OK.

e If you are creating a login for CIMS Server Web Reporting end users, select the
db_datareader and db_datawriter check boxes, and then click OK.

8 Ifyou selected SQL Server authentication, in the Confirm Password dialog box, type
the login password again, and then click OK.

9 Click OK to close the SQL Server Login Properties—New Login dialog box, and then

click the Close button [¥] to close the Database User Properties—New User dialog
box.

To confirm that the user login has been added, expand the database and click Users.
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Follow the steps in this section to set up CIMS Server.

Select and Configure the Database As an ODBC Data Source

Note ¢ If you are using MSDE, start CIMS Server Administrator

(Start » Programs » CIMS Server » Administrator if you installed CIMS Server in the
default location). Make sure that the default CIMSServer data source is selected and
click OK to close the Select ODBC Data Source dialog box. Keep CIMS Server
Administrator open, and continue to Initialize the Database on page 2-39.

To access the CIMSServer database using CIMS Server Administrator, you need to add an
ODBC data source for the database. If you created one login for the database or created
separate logins that use the same authentication method (i..e, Windows or SQL Server),
only one data source is required for the database. A data source named CIMSServer is
created by default and you can configure this data source for the database as described
in To configure the CIMSServer data source: on page 2-37.

If the database has a Windows authentication login and a SQL Server authentication
login (for example, the CIMS Server administrator uses Windows authentication and the
CIMS Server Web Reporting end users use SQL Server authentication), you need to create
a separate data source for each login. You can use the default CIMSServer data source for
one login and then create a second data source as described in To add a data source: on
page 5-5.

Note ¢ If you create multiple data sources, you need to create IDs for the data
sources. For more information, see Working With Data Source IDs on page 5-9.
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To configure the CIMSServer data source:

1 Start CIMS Server Administrator (Start » Programs » CIMS Server » Administrator if
you installed CIMS Server in the default location).

The Select ODBC Data Source dialog box appears as shown in example Figure 2-3. (If
this box does not appear automatically, click Select ODBC Data Source.)

ans Select ODBC Data Source

Wigw

Machine: J

System Data Sources:

Data Source MName

[ User Infa]

Uszer ID: Pazsword:

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 2-3 « Select ODBC Data Source Dialog Box

2 Ifyou enabled SQL Server authentication for the database user login in Creating User
Logins for the Database on page 2-34, make sure that the CIMSServer data source is
selected and type the SQL Server user ID and password in the Login ID and Password
boxes. If you enabled Windows authentication, leave these boxes blank.

3 Double-click the CIMSServer data source.

4 The DSN configuration wizard appears. Follow the steps provided in the wizard to
point to the CIMSServer database. Consult your SQL Server DBA to determine the
settings that you should select in the wizard. Note the following:

e The wizard prompts you with the following: How should SQL Server verify the
authenticity of the login ID? Click the correct authentication method (Windows
or SQL Server). If you select SQL Server authentication, type the SQL Server user
ID and password in the Login ID and Password boxes. If there are multiple SQL
Server logins for the database, you can use the ID and password for any of the
logins.

CIMS Server Administrator's Guide 2-37 N



B Installing CIMS Server and Getting Started
Getting Started

e For Internationalization Only. To select the language for the data source other
than the default language, select the Change Language of SQL Server Messages
to check box and click the language that you want from the list.

Important! « Do not select the Use regional settings when outputting currency,
numbers, dates, and times check box (the default for this check box is
unselected). CIMS Server does not support this option. Regional settings are
supplied by the regional options for the user logged on to the computer (see
Internationalization Setup on page 2-11).

5 When the wizard completes, click Test Data Source to make sure that the
configuration was successful, and then click OK until the wizard closes.

6 Click OK to close the Select ODBC Data Source dialog box. Keep CIMS Server
Administrator open and complete the steps shown in the following sections.
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Initialize the Database

Initializing the database performs the following tasks:
m Creates new database tables
m Populates these tables with an initial set of data

m Creates necessary database objects

Note ¢ Initializing the database should be performed only after installing CIMS
Server for the first time. Do not initialize the database after performing an upgrade—
initializing will overwrite your existing data.

To initialize the database:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Initialize Database.

The Database Initialization dialog box appears as shown in Figure 2-4.

=2 Database Initialization

Initialization Results:
Choose the 'Initialize Database' hutton to start.

Ohject Prefi |gpa.

i Initialize Databaze Cloze |

Figure 2-4 - Database Initialization Dialog Box

CIMS Lab strongly recommends that you leave dbo. in the Object Prefix box. This
prefix sets the owner of CIMSServer database objects to dbo in SQL Server allowing any
authorized database user to view the objects. For more information about CIMS
Server database objects, see Chapter 5, Database Administration.
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2 Click Initialize Database to populate the database with the necessary defaults.

Note ¢ If the SQL Server user ID that you are using to access the database does not
have sufficient system administration authority, CIMS Server might not be able to
create database objects or to create objects with the appropriate permissions
during database initialization. In this situation, a warning message appears
recommending that you contact your database administrator or CIMS Lab before
continuing.

3 In the Select Web Reports Version dialog box, click the report version that you are
using for Web reporting (Crystal Reports 8.5, 9, 10, or Reporting Services), and then
click OK. The report version that you select determines the default report paths that
appear in the Configuration dialog box (see Reporting Tab on page 2-42).

Note « Although you are asked to choose a Crystal Reports version or SQL Server
Reporting Services, you can use both. For more information, see Storing All Reports
in the Same Folder on page 4-2.

4 Click OK when the initialization is complete.

Create a Processes Folder

In Windows, rename and/or move the Sample Processes folder. This folder is in
C:\Program Files\CIMSLab if you installed CIMS Server in the default location.

CIMS Lab recommends that you rename this folder Processes and move it to a location
where you keep data that is backed up. However, you can give this folder any name and
move it to any location. This folder is referred to as Processes in this guide.

The Processes folder is used to store process definitions. A process definition is a folder
that contains the files required to process usage data from a particular source such as a
database, operating system, or application. For more information about process
definitions, see CIMS Server Administrator Processing on page 6-17.

Note that the Processes folder contains sample process definitions. These process
definitions contain sample CSR or CSR+ files that you can process and load into the
CIMSServer database. Process a Sample Resource File (Optional) on page 2-46 provides the
steps for processing these files.
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Enter CIMS Server Configuration Settings

You need to set the configuration settings for CIMS Server in CIMS Server Administrator.
To configure the settings:

1 In the main window, click System Administration » Configuration Information.

The Configuration dialog box appears.

2 For the purpose of getting started, complete the Organization, Processing,
Reporting, and License tabs as shown in the following sections. For information
about the remaining tabs, see Configuring System Settings on page 3-40.

Organization Tab

Enter your organization name and address (maximum of 255 characters in each line).
This information appears on the standard invoices that are provided with CIMS Server.
Processing Tab

In the Process Definition Path box, enter the path to the Processes folder as shown in
example Figure 2-5.

Wigw

Organization Processing l Reporting ] Database ] License ] Weh ] Aud'rting] Archiving ] Ciption List]

Path l Options] Closing]

Pracess Definition Path: |E:\Processes Browse ...

Reset To Defaultts

Figure 2-5 « Configuration Dialog Box—Processing Tab

For more information about the Processing tab, see Processing Settings on page 3-42.
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Reporting Tab

The Reporting tab contains the settings for CIMS Server Web Reporting. The default
report paths that appear on the Paths subtab are determined by the report type that you
selected when you initialized the database. The Paths subtab contains the paths to the
following report folders:

m Standard. CIMS Server produces chargeback and resource accounting reports based
on IT usage data from your organization. This folder contains a variety of standard
reports that you can use as templates to create custom reports for your organization.
For a description of each of the standard reports, refer to the CIMS Server Web
Reporting User’s Guide.

m Custom. This folder contains custom reports. Custom reports are those that your
report developer creates either independently or from the standard reports.

m Published. This folder contains published reports. Published reports are reports that
have been saved with the data that was generated at the time the reports were run.
Publishing a report enables users to view a report without having to regenerate it.

CIMS Server provides a batch reporting feature that creates and distributes published
reports. This feature includes the option of distributing reports via a Universal
Naming Convention ([/NC) link in an e-mail message. If you want to use this option,
you need to type a UNC path in this box. For example, if you are using the default
Published folder for published reports, the UNC path might be
\\servername\Pub11ished.

For more information about creating and distributing published reports in batch, see
Working With Batch Reporting/Published Reports on page 4-11.

Note ¢ End user access to published reports is dependent on the security
permissions described in Folder Permissions Required for Publishing and Viewing Batch
Reports on page 4-34.

CIMS Lab recommends that you keep the Standard folder in the default location because
standard reports might be updated and/or added with a new version or release of CIMS
Server. (A list of new and updated reports is included in the release notes that accompany
the new CIMS Server version or release. You can also view all of the available standard

reports at http://www.cimsserver.com.)

You can keep the Customand Published report folders in the default location or you can
rename and/or move the folders to any location. The reports in the Customand Pub1ished
report folders are not overwritten when you upgrade to a new version or release of CIMS
Server. CIMS Lab recommends that if you move the Customand Pub1ished report folders,
you move the folders to a location where you keep data that is backed up.
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Enter the paths for storing your reports or accept the default locations as shown in
example Figure 2-6.

Wigw

Organizaﬁon] Processing  Reporting l Database ] License ] Weh ] Aud'rting] Archiving ] Ciption List]

Paths l Options] Invaoice ]

Path to standard reports folder:

|C:\Pr0gram Filez\ZIMSLabiServer'Reports DStandard, Browwse...
Path to custom reports folder:

|C:\Pr0gram Filez\ZIMSLabiServerReports1 MCustom), Browwse...

Path to publizhed reports folder:

|C:\Pr0gram Filez\ZIMSLabiServer Reports DPublished) Browwse...

Reset To Defaultts

Figure 2-6 - Configuration Dialog Box—Reporting Tab

For more information about the Reporting tab, see Reporting Settings on page 3-43.
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License Tab

CIMS Server requires a license key that is provided by CIMS Lab. If you do not have your
license key, contact CIMS Lab (see Contacting Technical Support on page 7-10).

To enter licensing information:

1 Click the appropriate workstation (machine) and enter the license key as shown in
example Figure 2-7.

Wigw

Organizaﬁon] Processing ] Reporting ] Database License ]Web ] Aud'rting] Archiving ] Ciption List]

Machine: | (LOCAL) ﬂ

e [EEEEEEEEEEE

Expiration Date: 12i31/2005

Update License | Remove License

Reset To Defaultts

Figure 2-7 « Configuration Dialog Box—License Tab

2 Click Update License.
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Set the Account Code Structure

CIMS Server uses an account code to identify entities for billing and reporting. This code
determines how CIMS Server interprets and reports input data. The account code
structure defines the account code levels that appear on invoices and other reports.

To define the account code structure:

1 Click Chargeback Administration » Chargeback Table Maintenance » Account
Code Structure.

The Account Code Structure List Maintenance dialog box appears.
2 Click Edit.

The Account Code Structure Maintenance dialog box appears as shown in Figure 2-8.

242 Account Code Structure Maintenance |:||E| rz|

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Lewel Description Lencth Full Lencth
1| Application 4 4
2 Resource Group 16 20
3| Platform 16 36
4| Server 20 a6

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

Figure 2-8 « Account Code Structure Maintenance Dialog Box

3 Edit the example account code levels (descriptions and lengths) for your site and then
click OK. You can add or delete levels as needed. For detailed instructions on how to
define the account code levels, see Setting Up the Account Code Structure on page 3-3.
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Process a Sample Resource File (Optional)

Note ¢ This is an optional step intended to provide a quick introduction to
processing CSR and CSR+ files. For more information about processing these files,
see Chapter 6, Processing Data.

The primary method for input into CIMS Server is the CSR or CSR+ file. The CSR file is
produced by CIMS Data Collectors for Windows and UNIX. The CSR file is also
produced by CIMS Mainframe Data Collector and Chargeback System 11.6 and earlier.

The CSR+ file is produced by CIMS Mainframe Data Collector and Chargeback System
12.0 and later.

CIMS Server includes sample CSR and CSR+ files from different databases, operating
systems, and applications. The files are contained in process definition subfolders within
the Processes folder that you created in Create a Processes Folder on page 2-40.

To process a sample resource file:

1 In the CIMS Server Administrator main window, click Chargeback Administration »
Processing » Process Definitions.

The Process Definitions List Maintenance dialog box appears as shown in Figure 2-9.

an5 Process Definitions List Maintenance

Wigw

Process Definitions -~
Apache
CIMSWinDisk
CIMSAMINEventLog
CIMSWinPrint
CISWinProcess
DBESpace
Mainframe
MainframeCICS
MainframeDB2
MainframeDisk
MainframeshFE
MSExchange
MSExchangehb
MSIS-ieh
MSSEL2000
Prorate
Tranzactions
Universal
UnixDE2
UnixDB2Storage

......

: -
CProgram Files\CIMSLabiSample Processes)

A | Remave

Ediit | Rename Process |

Close

Figure 2-9 « Process Definitions List Maintenance Dialog Box

2 Click the process definition that contains the resource file that you want to process,
and then click Process.
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3 If processing is successful, the data loads to the database and the Process CIMS was
successful message appears. Click Yes to view the event log (the Event Viewer appears
showing the files processed) or No to skip the event log.

To view the processing results, make sure that the process definition is selected, and then
click Edit. Click the Process Results tab to view the results. (For more information, see
Process Results Tab on page 6-33).

If You Are Installing CIMS Server on Multiple Computers

If you install CIMS Server components on multiple computers (server or client) and the
CIMS Server Administrator application on each computer points to the same database,
you should use Universal Naming Convention (UNC) names for the Processes and
Reports folder path (see Enter CIMS Server Configuration Settings on page 2-41). The use
of logical drive names is not recommended when using multiple computers.

Note that if you are running CIMSACCT or CIMSBILL on a client and the database is on
a server, the data is stored in the database but physical processing occurs on your
computer. This can result in slower performance because large amounts of data need to
be transferred over the network during processing. Therefore, it is recommended that
you perform all CIMSACCT or CIMSBILL processing directly on the server using terminal
emulation software.

Increase the Event Viewer Maximum Log Size

CIMS Server logs all events (successful and unsuccessful) to the Windows Event Viewer.
To accommodate the large number of data loads generated by CIMS Server, you need to
increase the maximum log size in the Event Viewer as shown in the following steps.
(Note that these steps are for the Microsoft Windows Server 2000 operating system. If
you are using another operating system, refer to the Microsoft documentation if needed.)

1 In Windows Control Panel, double-click Administrative Tools » Event Viewer.
The Event Viewer window appears.

2 Right-click Application, and then click Properties.
The Application Properties dialog box appears.

3 On the General tab, increase the Maximum log size to at least 16000 KB.

4 Choose one of the following options under When maximum log size is reached:
e (Click Overwrite events older than and enter 45 days.

¢ Click Do not overwrite events. This option requires that you clear the log
manually rather than automatically when the log is full.

To avoid deleting older events, do not click Overwrite events as needed.

5 Click OK when you are finished.
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Follow the steps in this section to set up the Web server. The Web server may reside on
the same server as the CIMS Server application server or on a separate server. Note that
these steps are for IIS 5.1 on the Microsoft Windows 2000 Server operating system. If you
are using another operating system, refer to the Microsoft documentation or contact
CIMS Lab (see Contacting Technical Support on page 7-10).

Install CIMS Server Administrator and Web Reporting on the
Web Server (If Using a Separate Server)

Note  If the Web server resides on the same server as the CIMS Server application
server, skip this section and continue to Set the Home Directory for the CIMS Server Web
Reporting Web Site.

If you are installing the Web server on a separate server than the CIMS Server application
server, you need to install the CIMS Server Administrator and CIMS Server Web
Reporting components on the Web server.

To install CIMS Server Administrator and CIMS Server Web Reporting, run the CIMS
Server setup program and choose the CIMS Administrator and CIMS Web Reporting
options (see Performing a New Installation on page 2-23).

When installation is complete, start CIMS Server Administrator, click Select ODBC Data
Source, and point to the CIMSServer database.

Set the Home Directory for the CIMS Server Web Reporting Web
Site

This section provides steps for setting the home directory for the CIMS Server Web
Reporting Web server. For further assistance, consult your IIS administrator.

1 In IIS Manager, navigate to Default Web Site.
2 Right-click Default Web Site, and then click Properties.
The Default Web Site Properties dialog box appears.

3 Click the Home Directory tab (see Figure 2-10 on page 2-49).
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| Default Web Site Properties

Diirectory Security I HTTP Headers I Custom Errors | Server Extenzions I

21|

[ Directary browsing

‘wieb Site I Operators I Performance I IS4P Filters  Home Directory | Documents

‘wihen connecting to this resource, the content should come from:
& & directory located on this computer
" & share located on another computer
A redirection to a URL

Local Path: C:\Program Files\CIMSLab\Serverwieb Browse... |

™ Script source access V' Log visits

¥ Read ¥ Imdes this resource

[~ white

Application Settings

Application name: IDefauIt Application

Starting point: <Default ‘Web Site>

E=ecute Permissions: IScripts only

-

Application Pratection: IMedium [Pooled)

I~

Remove

Configuratian...

Al

Wrlaad

()3 I Cancel |

Apply |

Help

Getting Started

Figure 2-10 + Default Web Site Properties Dialog Box—Home Directory Tab

4 Enter the CIMS Server Web Reporting path in the Local Path box (or accept the
default), and then click Apply. If you installed CIMS Server in the default location,

the location is C:\Program Files\CIMSLab\Server\Web.

Note ¢ You must use a local drive path rather than a UNC path (e.g.,
\\servername\sharename) in the Local Path box. A UNC path can result in
unpredictable behavior on the CIMS Server Web Reporting Web site.

5 Leave the Default Web Site Properties dialog box open and continue to the next

section.
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Set the User Authentication Method for the CIMS Server Web
Reporting Web Site

There are two options for controlling user access to the CIMS Server Web Reporting Web
site: anonymous access and authenticated access. Anonymous access allows remote
access by the IUSR_computername account. Users can connect to the CIMS Server Web
Reporting Web site without a user name or password. Authenticated access uses the
current Windows user information on the client computer to allow users to connect to
the Web site.

If you are using a MSDE database, you need to use authenticated access.

If you are using a SQL Server 2000 database, you can use anonymous access or
authenticated access depending on the IIS and SQL Server configuration for your
organization as shown in Table 2-1 on page 2-32. Note that some CIMS Server features
are not available when you use anonymous access as described in Features Not Available
With Anonymous Access on page 2-51.

The following sections provide the steps required to enable both authentication types.
To set anonymous access:
1 In the Default Web Site Properties dialog box, click the Directory Security tab.

2 In the Anonymous access and authentication control area click Edit. The
Authentication Methods dialog box appears

3 Click the Anonymous access check box and clear all other check boxes.
4 Click Edit and do the following in the Anonymous User Account dialog box:

a Enter the Windows account IUSR_computername in the Username box. If the [USR
name does not appear, click Browse to find it.

b Select the Allow IIS to control password check box. CIMS Lab recommends this
option because it enables IIS to change the password for each access to the CIMS
Server Web Reporting Web site.

Anonymous User Accounkt ] ll

Anonymous Uzer

Select the Windows Uszer Account used to access this computer when an
anonymous uger connects to this site.

Usermame: IIUSH_computemameI Browse... |

Bassword: I xxxxxxxxxx

¥ &llow 115 to control password

QK I Cancel | Help |

Figure 2-11 + Anonymous User Account Dialog Box

5 Click OK until the Default Web Site Properties dialog box closes.

6 Restart IIS (see page 7-4).
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To set authenticated access:
1 In the Default Web Site Properties dialog box, click the Directory Security tab.

2 In the Anonymous access and authentication control area click Edit. The
Authentication Methods dialog box appears

3 Select the Integrated Windows authentication check box and clear all other check
boxes.

4 Click OK until the Default Web Site Properties dialog box closes.
5 Restart IIS (see page 7-4).

Features Not Available With Anonymous Access

m SQL Server Reporting Services. If you use Reporting Services as your reporting tool,
you cannot use anonymous access.

m CIMS Server Web Reporting auto logon. The auto logon feature for CIMS Server Web
Reporting is not available if you use anonymous access for IIS. This feature enables
end users to use CIMS Server Web Reporting without entering a CIMS user ID and
password on the Login page. To enable this feature, see Web Settings on page 3-47.

In addition, if you use anonymous access and are using the transaction audit feature, the
user ID associated with the transaction will not reflect the actual user. The transaction
audit feature enables CIMS Server administrators to track miscellaneous, recurring, and
credit transactions created in CIMS Server Web Reporting. (For more information about
transactions, refer to the CIMS Server Web Reporting User’s Guide). To enable transaction
audits and other audits such as client and rate, see Table Audit Settings on page 3-52.
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Assign CIMS Server Folder Security Permissions

The CIMS Server Web Reporting users must have the following security permissions for
the CIMS Server folders shown. If you installed CIMS Server in the default location, the
folders are in C:\Program Files\CIMSLab.

Folder Required Permissions

Server Read & Execute
Server/Web/temp Full Control
Server/Reports/Published Read & Execute, Write
Admin Read & Execute

If you selected anonymous access for IIS on page page 2-50, the user is
IUSR_computername and that user name must be provided with these permissions. If you
selected Windows authenticated access, each Windows user that will be accessing the
CIMS Server Web Reporting Web site must be provided with these permissions.

Note ¢ If the user is IUSR _computername and you entered the correct
IUSR_computername account during installation, CIMS Server automatically sets the
folder security permissions for the user. See Enter the IIS Web User Name on page 2-26.
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Enable Secure Sockets Layer (SSL) for the
CIMS Server Web Reporting Web Site (Optional)

CIMS Server provides an optional auto log on feature that enables users to access the
CIMS Server Web Reporting Web site without entering a user ID and password (see Web
Settings on page 3-47). If you use this feature, Secure Sockets Layer (SSL) is not needed.

If you do not use the auto log on feature, you can enable SSL to protect the user ID and
password needed to access the Web site. SSL is a protocol for ensuring security and
privacy in internet communications via encryption. When SSL is enabled, https://
rather than http:// appears in the URL when a user accesses the Login page of the CIMS
Server Web Reporting Web site.

To set up and enable SSL for the Web site, you need to first obtain a SSL certificate from
a third-party certificate authority and install the certificate for the site. For the steps
required to obtain and install the certificate, refer to the Microsoft Knowledge Base
Article 298805.

Once you have installed the SSL certificate, complete the following steps to enable SSL
for the login ID and password and then restart IIS. (To restart IIS, see page 7-4.)

In the 1IS Manager Window:

1 Navigate to Default Web Site and expand it.

2 Right-click the Secure folder, and then click Properties.

3 On the Directory Security tab, click Edit in the Secure communications area.

4 In the Secure Communications dialog box, select the Require secure channel (SSL)
check box, and then click OK.

In CIMS Server Administrator:

1 Click System Administration » Configuration Information » Web tab » General
subtab.

2 Select the Secure Login check box.

3 Ifyou are using an SSL port other than the default port 443 for the Web site, type the
port number in the Secure Port check box.

4 Click OK when you are finished.
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Start CIMS Server Web Reporting

1 In the Web browser, enter the address for the server running CIMS Server Web
Reporting. This is the server that you set up in Set Up the Web Server on page 2-48. If
you are running the browser on the same computer as the Web server, enter Tocalhost
or the computer name.

2 Click Login to open the Login page.

3 Typetheuser ID adminand the password password, and then click OK. This is a default
user and password created by CIMS Server (see About Users and Groups on page 2-55).

Note ¢ You can enable the auto log on feature that allows users to access CIMS
Server Web Reporting without entering a user ID and password. For more
information, see Web Settings on page 3-47.

If you have successfully loaded sample data from the Processes folder, you should be
able to create reports from the Reports » Run Reports menu (see Figure 2-12). For
instructions, refer to the CIMS Server Web Reporting User’s Guide.

<A http:/localhost/TReports.asp?select=1 - Microsoft Internet Explorer,

File Edit View Favorites Tools  Help

@Back @ _) \ﬂ @ ih /'f__j Search ‘ip;/Favorites @Media @ ﬁ}{v :_\', E @ .‘3

Address @ http: fflocalhostf TReports, aspPselect=1

CIMS

Server

Login Spreadsheets Favorites Admin Help Logout Home

RepO Vie‘bPuhlished Reports

Create a Report

Invoices

Account Reports
Top Usage Reports
Yariance Reports
Trend

Resource Detail
Audit

Other

&) TReparts.asprselect=1

Figure 2-12 + CIMS Server Web Reporting—Reports Menu
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Note ¢ If you are using Crystal Reports for Web reporting, you can select the Crystal
Report viewer that you want to use to view reports (see Web Settings on page 3-47). If
you are using Crystal Reports 9 or 10, the default is the HTML viewer. If you are using
Crystal Reports 8.5, the default is the ActiveX viewer.

If you select the ActiveX or Java viewer, you will receive a warning message asking if
you want to install and run Crystal Smart Viewer for ActiveX or Java when you
attempt to run a report after installing CIMS Server for the first time. Click Yes. It is
also advisable that you select the Always trust content from Crystal Decisions, Inc
check box.

About Users and Groups

A user is an individual with access rights to CIMS Server Web Reporting. Each user can
belong to only one user group. Users are granted the rights and privileges granted to the
group. This system of users and groups allows you to control which reports a user can
access, the clients that the user can view in reports, and the administrative privileges for
the user.

When you initialized the database (see page 2-39), CIMS Server added the default
administrator user admin that belongs to the user group Admin. The group Admin has
administrative privileges in CIMS Server Web Reporting and can view all reports and
clients.

For instructions on how to create users and groups, see Working With Users and Groups
on page 3-27.
Troubleshooting

For troubleshooting information, see Chapter 7, Troubleshooting and
Additional Information.

Moving and Resizing Dialog Boxes

You can the move and resize the dialog boxes in CIMS Server Administrator. To move a
dialog box, simply drag the box. To resize the box, point to the horizontal or vertical edge
of the box. When the double arrow appears, click the edge of the box and drag it to the
size that you want.

To return a dialog box to its original position and size, click View » Reset Form Position
to Default where this command is available. Where this command is not available, the
dialog box returns to its original location and size when it is closed and reopened.

Viewing Online Help

To view context-sensitive online help in CIMS Server Administrator, press <F1>.
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Downloading Product Updates

You can download product updates by visiting the CIMS Lab Web site (http://
www.cimslab.com) and clicking Customer Area » Product Updates. Note that you need
to provide your CIMS Server license key as a password.
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Setting Up the System

This chapter describes how to use CIMS Server Administrator to set up the CIMS Server
system, including defining the account code structure, entering rates and rate groups,
creating users and groups, and setting reporting options.

Setting Up the Account Code StrUCtUre .......oviiiiiiiiiiiieiiiiieieieiieienecenenenens 3-3
Account Code Structure Example . ... e 3-3
Defining the Account Code Structure ......... ... . . i 3-4
Defining Alternate Account Code Structures ........... .. ... ... i i 3-8
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Setting Up the Account Code Structure

CIMS Server uses an account code to identify entities for billing and reporting. This code
determines how CIMS Server interprets and reports input data.

One of the first steps in implementing CIMS Server is defining the account code
structure. This structure defines the account code levels that appear on invoices and other
reports.

For more information about account codes, see Setting Up Account Codes and Performing
Account Code Conversion on page 6-35.

Account Code Structure Example

An account code can contain up to 128 bytes. The structure of the account code reflects
the chargeback hierarchy for your organization arranged from highest to lowest level
(e.g., company, division, department). You can define as many account code levels as
necessary within the maximum available 128-byte field length.

For example, the following 17-byte account code contains four levels:

AABBBBCCCDDDDDDDD

Level 1, AA
Full Length = 2 bytes
Description = Company

Level 2, AABBBB
Full Length = 6 bytes
Description = Division

Level 3, AABBBBCCC
Full Length = 9 bytes
Description = Department

Level 4, AABBBBCCCDDDDDDDD
Full Length = 17 bytes
Description = User

To see how you would define this account code for CIMS Server, see Figure 3-3 on
page 3-6.
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Defining the Account Code Structure

CIMS Server includes a default account code structure called Standard. Use this structure
to define your account code.

If you need to create additional account code structures for reporting, see Defining
Alternate Account Code Structures on page 3-8.

To create account code levels:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Account Code Structure.

The Account Code Structure List Maintenance dialog box appears as shown in
Figure 3-1.

an5 Account Code Structure List Maintenance

Wigw

Account Code Structure

A | Remave | Ediit | Rename

Figure 3-1 « Account Code Structure List Maintenance Dialog Box
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2 Click Edit.

The Account Code Structure Maintenance dialog box appears as shown in Figure 3-2.

242 Account Code Structure Maintenance |:||E| rz|

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Lewel Description Lencth Full Lencth
1| Application 4 4
2 Resource Group 16 20
3| Platform 16 36
4| Server 20 a6

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

Figure 3-2 « Account Code Structure Maintenance Dialog Box

3 In the Starting Offset into Account Code box, accept the default to begin reporting
from the first account code level or enter another starting position to begin reporting
at another level (see To set the starting offset number: on page 3-7).

4 In the Description and Length boxes, edit the sample description and length for each
level of the account code (maximum of 128 levels where each level is a length of 1).
To add a level to the end of the account code structure, click Add Entry. To add a level
above an existing level, click the level, and then click Insert Entry.

For example, the account codes structure shown in Account Code Structure Example on
page 3-3 is entered as shown in Figure 3-3 on page 3-6.
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an5 Account Code Structure Maintenance

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Lewel Description Lencth Full Lencth
1| Company
2 | Divigion
3 Department

2
4
3
g

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

Figure 3-3 < Example Account Code Structure

Note the difference between the length and full length. The length is the number of
bytes representing the specific entity. For example, the 4-byte BBBB in Level 2
represents the division.

The full length is automatically calculated and represents the total number of bytes
for the level. For example, Level 2 includes 2 bytes for the company and 4 bytes for
the division for a total of 6 bytes.

5 Click OK when you are finished.
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To set the starting offset number:

The starting offset number determines the account code levels that are presented in
reports. If you want to begin reporting from a level other than Level 1, enter the offset
position for the level at which you want to begin reporting.

For example, if you have two user groups and one group wants to begin reporting at the
User level shown in Figure 3-3 on page 3-6, you could set up a second account code
structure with one level for User and an offset of 10 (the position where the User level
begins in the account code structure) as shown in Figure 3-4.

an5 Account Code Structure Maintenance

Account Code Structure: Group B
Starting Offzet into Account Code: 10

Define Account Code Levels

Lewel Description Lencth Full Lencth
1 |Uszer g g

Adld Entry | RemoveEntry| In=ert Entry |

Figure 3-4 « Adding a Second Account Code Structure with Different Starting Offset

Note that in this situation, users in groups using this account code structure cannot view
any account code levels other than User in CIMS Server Web Reporting. To avoid this
restriction, your report developer could create a report for the User level rather than
create an additional account code structure. For more information, contact CIMS Lab
(see Contacting Technical Support on page 7-10).

To remove an account code level:
Click the level, and then click Remove Entry.
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Defining Alternate Account Code Structures

B 3-8

If needed, you can create additional account code structures. For example, you may need
account codes with different levels or different offset positions.

Note * You can assign multiple account code structures to a user group. This enables
users of the group to select the account code structure that they want to use for
reports on the CIMS Server Web Reporting Web site. For more information, see To
add a user group: on page 3-31.

To add an alternate account code structure:

1

6

In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Account Code Structure.

The Account Code Structure List Maintenance dialog box appears.
Click Add.

In the Add Account Code Structure dialog box, enter the name of the new account
code structure (maximum of 32 characters), and then click OK.

The Account Code Structure Maintenance dialog box appears.

In the Starting Offset into Account Code box, accept the default or enter a starting
offset number (see To set the starting offset number: on page 3-7).

Click Add Entry to add each level. (To add a level above an existing level, click the
level, and then click Insert Entry).

Click OK when you are finished.

To rename an alternate account code structure:

1

2

Click the structure, and then click Rename.

In the Change Account Code Structure Name dialog box, enter the new name of the
account code structure, and then click OK.

To remove an alternate account code structure:

Click the structure, and then click Remove.
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Working With Rates

CIMS Server uses a rate to calculate a cost for each resource being reported. Rates are
organized by rate codes, tables, and groups as described in the following sections.

Defining Rate Codes

The CIMS Server Resource (CSR) and CIMS Server Resource Plus (CSR+) files used by
CIMS Server contain rate codes. Rate codes represent the resource units being reported
(CPU time used, jobs started, data received or sent, disk space used, lines printed, etc.).

To enable CIMS Server to process and report the rate codes in the CSR or CSR+ file, the
codes must be defined in the CIMSRate table. The definition for each rate code includes
a monetary value for the rate code and other rate processing information.

CIMS Lab pre-loads the rate codes produced by many of the data collectors in the
STANDARD rate code table within the CIMSRate table. You can then use CIMS Server
Administrator to modify, delete, or add rate codes in the STANDARD table to reflect the
rate codes in your CSR or CSR+ files. You can also use CIMS Server Administrator to add
rate codes that are not included in the STANDARD table by default.

If you need to perform differential costing, for example, you want to charge Client A
different rates than Client B, you can create other rate code tables in addition to the
STANDARD table (see Defining Alternate Rate Code Tables on page 3-15).

Each rate code belongs to one rate group. Rate groups are logical groups that are used for
grouping resources on invoices and other reports and for drill down (detailed) reporting.
For more information about rate groups, see Defining Rate Groups on page 3-16.

To add a rate code:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

The Rate Code List Maintenance dialog box appeatrs.

2 If the Rate Table list contains multiple tables, click the rate code table that you want
to add the rate to. (If there are multiple tables, All appears in the Rate Table list by
default.)

3 Click Add Rate.

4 In the Add New Rate Code dialog box, enter the new rate code (maximum of eight
characters), and then click OK.

Important! < Rate codes are case-sensitive. Type the rate code exactly as it appears
in the CSR or CSR+ file.

The Rate Code Maintenance dialog box appears as shown in example Figure 3-5 on
page 3-10.
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“n5 Rate Code Maintenance

[ STANDARD f Z003 ]
[ General |

Description: |Mainframe Cpu Minutes
Yalue: 10 Rate Index: ’—5
Rate Group:  |wainframe Batch Add rate group ..
[ Dretail 1
Iv Use 4 decimals for rate Resource Conversion: |Divide By 60 j
[ Rate iz per thousand Conversion Factor:
™ Do not adjust for zero cost Resource Decimals: 2 =
[ Flat fee money charges
v CPU Value Report Flag 1: |1—
Repart Flag 2: |—
Currency Symbal: ’—
Detail Description: |Mainframe Cpu Minutes
Comments: |
Edit Rate Shifts | Remaove Rate Shifts | OK | Cancel

Figure 3-5 « Rate Code Maintenance Dialog Box

5 Edit the rate code settings as follows:

e Description. Enter a meaningful description of the rate code (maximum of 40
characters). The description appears on reports, graphs, and spreadsheets. CIMS
Lab recommends that you include units of measurement (GB, MB, hours,

minutes, etc.) as applicable.

e Value. Enter the amount to be charged for the consumption of the resource

represented by this rate code. Keep in mind:

e Rate value corresponds to the specified rate code.

Note ¢ The following currency values are for example purposes only. CIMS

Server supports all currencies.

e $25isinput as 25.

e $1.25is input as 1.25.

» Negative values are preceded by a minus (e.g., -1).

e Maximum Rate is 9999999v99999999.

e The value is multiplied by the resource amount contained in matching CSR or
CSR+ file. For example, if the rate code value is 25 and a matching resource file
contains a value of 5 hours, then the total charge would be $125.

B 3-10
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¢ Rate Index. The rate index defaults to the order in which the rate code appears in
reports. You can change the order; however, you cannot enter an index number
that is already in use.

¢ Rate Group. Click the rate group for the rate code or click Add rate group to create
a new rate group. All rate codes must be assigned to a group.

Note * You can also create rate groups and assign rate codes using the Rate
Group Maintenance dialog box (see Defining Rate Groups on page 3-16).

e Use 4 decimals for rate. This option determines the number of decimal digits that
appear in the rate value in reports. If this check box is selected, the rate value
includes four decimal digits. If this check box is not selected, the rate value
includes eight decimal digits.

* Rate is per thousand. Select this check box to change the rate in reports from per
resource unit to per thousand units.

e Do notadjust for zero cost. Select this check box if you do not want the associated
rate code to be included in zero cost calculations.

About Zero Costing

It is possible within CIMS Server Web Reporting to enter a target recovery amount
for the billing period. (See the CIMS Server Web Reporting User’s Guide for
information about the CIMS Server Zero Cost Center Invoice). CIMS Server then
makes the appropriate adjustments to recover the targeted amount rather than the
amount reflected by the standard multiplication of rate by resource units. This
zero costing allows IT departments to recover a specified amount each billing
period rather than show a profit or loss.

It is not always desirable to apply zero costing to all rates. Often, fixed cost items
such as leased line charges, delivery services, or license fees are excluded from zero
costing. The cost of these items is used as part of the overall calculation, but the
specific rate is not adjusted.

» Flat fee money charges. Select this check box if the resource units for the rate code
are considered a monetary amount rather than units of utilization. In this
situation, the resource units and the charges are the same in reports.

Note * When this check box is selected, the Value box does not appear and any
rate value previously entered in the Value box is ignored. However, the value

does appear in the rate column in CIMS standard reports. You can customize

the standard reports to remove or modify this value as needed.

e CPU Value. Select this check box to normalize CPU usage for this rate (see
Normalizing CPU Values on page 6-51).
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e Resource Conversion. You can adjust the total resource units value in reports
using the following conversion factors:

e Default. No conversion is performed.

* Divide By or Multiply By. The total resource units are divided or multiplied by
a set conversion factor (e.g., Divide by 1000, Multiply by 60, etc.).

e Multiply By Conversion Factor. The total resource units are multiplied by the
factor in the Conversion Factor box.

e Conversion Factor. This box is available only when Multiply By Conversion
Factor is selected in the Resource Conversion box. Type a number by which you
would like to multiply the total resource units for the rate code. This factor can be
up to 16 digits including a decimal.

e Resource Decimals. This option determines the number of decimal digits that
appear in the resource units value in reports (e.g., 0= 99, 4 = 99.9999). The default
is two decimal digits.

e Report Flag 1 and 2. The use of these boxes is user-specified. These boxes allow
you to type a one-character value that you can use in custom reports.

e Currency Symbol. The use of this box is user-specified. This box allows you to type
a currency symbol (maximum of three characters) that you can use in custom
reports.

e Detail Description. The use of this box is user-specified. This box allows you to
type a description of the rate code that you can use in custom reports.

e Comments. Type any comments regarding the rate code.
6 Click OK when you are finished.

You cannot add duplicate rate codes to a rate code table. Each rate code in a table must
be unique. If you want to use the same rate code more than once, e.g., you charge
different clients different rates for the same resource, you must create separate tables (see
Defining Alternate Rate Code Tables on page 3-15).

Note ¢ Rates in the Rate Code List Maintenance dialog box are sorted by the index
number. To sort the rates by rate code, rate group, description, etc., click the
appropriate column header. To reverse the sort order, click the column header again.

To edit a rate code:

1 Double-click the code, or click the code and then click Edit Rate.
The Rate Code Maintenance dialog box appears.

2 Follow the steps in To add a rate code: beginning with Step 5 on page 3-10.

To remove a rate code:

Click the rate code, and then click Remove Rate.
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Setting Rate Shifts

Rate shifts allow you to set different rates based on the time of day. For example, if a user
is using a computer's resources at 4 a.m., you might charge the user less than if he uses
these resources at 1 p.m. By default, every rate code has one shift. If your CSR or CSR+

files contain multiple shift codes, you can define up to eight additional rate shifts for rate
code for a total of nine shifts.

You can set rate shifts by clicking the Edit Rate Shifts button from either of the following
locations:

m From the Rate Code List Maintenance dialog box. First click the rate code that you
want to apply rate shifts to.

m From the Rate Code Maintenance dialog box for a specific rate code.
The Rate Shift Maintenance dialog box appears. Complete this dialog box as follows:

1 Click the Rate Value box next to the shift number and enter a monetary value. In the
adjacent Description box, enter an optional short description of the rate shift. See
example Figure 3-6.

an Rate Shift Maintenance

[ STANDARD FLLAT10]

Rate Yalue | Description

Shift #2 75 Might

Shift #3 5 Swving
Shift #4 1]

Shift #5 1]

Shift #6 1]

Shift #7 1]

Shift #5 1]

Shift #9 1]

Kevboard Usage: Press the Enter key to edit 2 cell. Use the arrow keys to navigate between celis.

OK | Cancel

Figure 3-6 - Rate Shift Maintenance Dialog Box

2 Click OK when you are finished.

Note ¢ To enable CIMS Server to use rate shift values to calculate costs for a rate
code, you must have the Use Shift Codes option enabled in the Edit Process
Definitions dialog box (see page 6-29). If you do not have this option enabled, the
default rate shift 1 is used for processing regardless of the rate codes that appear in
the CSR or CSR+ file.
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Removing Rate Shifts

Once you click OK in the Rate Shift Maintenance dialog box, the rate values for the shifts
are applied as applicable when CSR or CSR+ files are processed. Therefore, if a rate shift
value is set to 0, a rate of 0 will appear in reports for the applicable rate code and shift.

If you decide that you do not want to use rate shifts after you have saved them for a rate
code, you can remove the shifts by clicking the Remove Rate Shifts button from either
of the following locations:

m From the Rate Code List Maintenance dialog box. First click the rate code that you
want to remove the rate shifts from.

m From the Rate Code Maintenance dialog box for a specific rate code.
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Defining Alternate Rate Code Tables

If needed, you can create rate code tables in addition to the STANDARD table. For
example, you might have clients who are charged different rates for the same resource
usage (the Finance department is charged $20 per hour of CPU usage while the
Marketing department is charged $5 per hour). In this case, you could use the
STANDARD table for the Finance department and create a second rate code table with
the same rate codes but different values for the Marketing department.

To add a rate code table:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

The Rate Code List Maintenance dialog box appears.
2 Click Add Table at the top of the dialog box.

3 Inthe Add New Rate Table dialog box, enter a name (maximum of eight characters),
and then click OK.

The new rate code table appears in the Rate Code List Maintenance dialog box.

4 To add rates to the table, follow the steps for adding a rate code in To add a rate code:
on page 3-9.

To duplicate a rate code table:

1 Click a table in the Rate Table list, and then click Duplicate Table.

2 In the Duplicate Rate Table dialog box, enter a name (maximum of eight characters),
and then click OK.

The new rate code table appears in the Rate Code List Maintenance dialog box. The
new table contains all of the rate codes contained in the original rate code table.

3 To edit the rates in the table, double-click the code, or click the code and then click
Edit Rate, and follow the steps in To add a rate code: beginning with Step 5 on
page 3-10.

To remove a rate code table:

Click the table in the Rate Table list, and then click Remove Table.

WARNING - When you remove a rate code table, you lose all rate codes with their
associated rates specific to that table.
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Tip * When working with rate groups, you can access commands for an item by
clicking the appropriate button, or you can access the same commands by right-
clicking the item.

Creating and using rate groups lets you create rate subtotals in reports, graphs, and
spreadsheets. Grouping rates such as CPU charges, Windows charges, and UNIX charges
allows reports to be summarized in a way that is meaningful. It also allows users to create
reports based on grouping rates that have the same identifier or identifiers.

All rate codes must be assigned to a group. For more information, see Adding an
Unassigned Rate Code to a Rate Group on page 3-18.

Note ¢ Itis recommended that you do not assign rate codes with different identifiers
to the same rate group. Combining rate codes with different identifiers within the
same group results in reporting anomalies.

Suggestion: Create a separate rate group for each resource file type. For example a
Unix charges group for Unix resource files with the same identifiers. This ensures
that the rate codes within the group have the same identifiers.

To add a rate group:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Groups.

The Rate Group Maintenance dialog box appears displaying an expandable hierarchy
of existing rate groups. Individual rate codes appear within each rate group. See
example Figure 3-7 on page 3-17.
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v Rate Group Maintenance |:||E|g|

Wigw

[ Feate Groug | —|--Rate Groups ~
+-Unix interactive job type charges
Unix background job type charges
Unix DB/2 charges

Unix Software Package charges
Unix print charges

Unix filesystem

Unix Cracle charges

O%/390 Batch charges

05390 Storage charges

0 P Sty

Remove Rate Group |

Change Rate Group Title

Change Rate Group Description

[N e R e R i e N e

=0 charges

Z020 - Tso Cpu Minutes

021 - Tso Inputs

[ Rate Code ] 022 - Tso Outputs

Z034 - Tso Cpu Minutes (Tch)
Z035 - Tso Cpu Minutes (Intistor)
F036 - Tso Cpu Minutes (AN

‘ ZI04 - Tzo Connect Minutes

Change Rate Group Sequence

Add Unassigned Rates to Group

+--- 05390 Service Unit charges
- 0S390 Input’Dutput charges

Tl VS R0 Deirdar Paadar rharoos

Rate Group Title: 05390 T=o
Rate Group Description: 05/390 T=o charges

Close

Figure 3-7 « Rate Group Maintenance Dialog Box

2 Click Rate Groups at the top of the group list (if it is not selected), and then click Add
Rate Group.

3 Inthe Add Rate Group dialog box, enter a description of the rate group (maximum of
32 characters), and then click OK.
To remove a rate group:

Click the rate group, and then click Remove Rate Group. If the rate group contains rate
codes, you must delete the codes before you can delete the group.

Changing the Rate Group Description and Title

When you add a rate group, the description and title default to the description that you
assigned to the group. You can change both the description and title of the rate group.
In most cases you do not need to change the title unless you require a shorter field length
for custom reports. Standard reports show the description field, not the title field.

To change the rate group description:
1 Click the group and click Change Rate Group Description.

2 In the Change Rate Group Description dialog box, enter the new description of the
rate group (maximum of 255 characters), and then click OK.
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To change the rate group title:

1 Click the group and click Change Rate Group Title.

2 In the Change Rate Group Title dialog box, enter the new title of the rate group
(maximum of 32 characters), and then click OK.

Changing the Rate Group Sequence

The sequence in which the rate groups appear in the tree is the sequence that the groups
will appear in reports. You can sequence the rate groups in any order.

To change the group sequence:
1 Click Change Rate Group Sequence.
The Rate Group Display Sequence dialog box appears.
2 Click a group, and then click the up or down arrow to reposition the group.

3 Click OK when you are finished.

Adding an Unassigned Rate Code to a Rate Group

To add an unassigned rate code to a rate group:

1 Click the group, and then click Add Unassigned Rates to Group.
The Select Rate Code dialog box appears.

2 Choose the code or codes that you want to add, and then click OK.

Note * In most cases, rate codes are assigned to a rate group when the rate code
is added (see Defining Rate Codes on page 3-9).

Moving an Assigned Rate Code to Another Rate Group

To move a rate code from one group to another, click the rate code that you want to
move and drag it to the desired rate code description.

Removing a Rate Code from a Rate Group

To remove a rate code from a rate group, click the rate code, and then click Remove Rate
From Group.
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Working With Clients

Once you have created the account code structure (see Setting Up the Account Code
Structure on page 3-3), you can assign descriptions for the clients represented by your
structure. These descriptions appear in place of the client’s account code in invoices and
other reports. For example, if account code AABBBBCCC represents the Marketing
department, you might assign the description Marketing Department for this code.

You can also specify the rate code table used for the client and set up budget and contact

and information.

Note ¢ CIMS Server provides sample clients. You should remove these sample clients
before adding clients for your organization (see To remove a client: on page 3-21).

Defining Clients

To add a client:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears as shown in example Figure 3-8.

Note ¢ Clients in the Client List Maintenance dialog box are sorted by account
code. To sort the clients by account name, rate code table, etc., click the
appropriate column header. To reverse the sort order, click the column header

again.

ans Client List Maintenance

Tools  Wiew

Account Code | Account Mame

Rate Table | Aternate Account Code

AL Company A4
AABBEBE Ciper ati v
Purc

A | Remave |

STAMNDARD

Eclit Budgets | Contacts | Close |

Figure 3-8 « Client List Maintenance Dialog Box
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2 Click Add.

3 Inthe Add Account Code dialog box, enter the account code for the client (maximum

of

128 characters), and then click OK. The Client Maintenance dialog box appears.

4 Edit the client settings as follows:

Account Name. Enter the name of the client as you want it to appear in invoices
and other reports. Maximum of 255 characters.

Alternate Account Code. Enter an alternate account code if used for reporting to
a General Ledger system or other types of reporting where the standard account
code is different. Maximum of 128 characters.

Rate table. If other than STANDARD, click the rate code table used for calculating
the client’s charges. Alternate rate code tables are used for clients who are charged
different rates for the same resource usage. For example, the Finance department
is charged $20 per hour of CPU usage, while the Marketing department is charged
$5 per hour. For more information, see Defining Alternate Rate Code Tables on
page 3-15.

Invoice Contact. If a contact is available for this client, the contact appears in this
list box (see Defining Client Contacts on page 3-24). If there are multiple contacts
for this client, click the appropriate contact from the list.

Action Codes. CIMS Server does not use action codes. These codes are strictly for
reporting purposes and can be used in the custom reporting process for selecting
data.

5 Click OK when you are finished.

An example of a configured Client Maintenance dialog box is shown in Figure 3-9.

ans Client Maintenance

Codle:

Account Code: A4

Account MName: |C0mpany Mame

Alternste Account |

Rate Tahble: STAMDARD =

Invoice Contact 000001 - Brian Jones |

Action Codes: |— |— |— |— |— |— |— |_

Contacts | Budgets | Ok | Cancel
Figure 3-9 + Client Maintenance Dialog Box
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For information on adding a budget and contact for the client, see Setting Up Client
Budgets on page 3-21 and Defining Client Contacts on page 3-24.

To edit a client:
1 Double-click the client or click the client, and then click Edit.
The Client Maintenance dialog box appears.
2 Follow the steps in To add a client: beginning with Step 4 on page 3-20.

To remove a client:

Click the client, and then click Remove.

Setting Up Client Budgets

Using CIMS Server’s powerful budgeting feature, you can establish budgets by amount
or units for the individual resources used and/or all resources used by a client. These
budgets allow users to report on client actual vs. budget information.

CIMS Server includes reports that you can use as templates to create custom account level
and resource level budget reports for your organization. For more information about the
CIMS Server budget reports, Account Budget for Period and YTD and Line Item Budget,
see the CIMS Server Web Reporting User’s Guide.

To create a budget:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears.
2 Click the client that you want to establish a budget for, and then click Budgets.
The Client Budget Maintenance dialog box appeatrs.
3 Edit the budget settings as follows:
e Year. Click the appropriate year. If the year is not listed, click Budget » Add Year.

e Overall Account Budget. You can set both an overall account budget and budgets
for individual resources.

To set an overall budget for an account, click Overall Account Budget.

To set a budget for individual resources, click Budget » Add Resource Budget or
right-click Overall Account Budget, and then click Add Resource Budget. The
Select Rate Codes dialog box appears. Select the rate code or codes for the
resources that you want, and then click OK. The rate codes appear under Overall
Account Budget.
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¢ Budget Amount/Budget Units. You can budget by the monetary amount of
consumed resources (Budget Amount) or the unit amount of consumed resources
(Budget Units). You can enter a total budget and a budget for each month
(period) within the year.

Enter the total budget amount or budget units for the year in the Total box and the
budget amount for each period in the Period boxes (1 through 12/13). (To use 13
month periods, see page 3-26.)

e Divide Total (Budget Amount and Budget Units). Click Divide Total to divide
the total budget amount of budget units by the number of periods and
automatically populate the Period boxes with the result. Note that if you change
a total, you must perform this step again.

e Sum Periods (Budget Amount and Budget Units). Click Sum Periods to add the
amounts entered in Period boxes and automatically enter the sum in the Budget
Amount Total or Budget Units Total boxes. Note that if you change the amount
for a period or periods, you must perform this step again.

4 Click Apply to save the changes or click OK to save the changes and close the dialog
box.

An example of a configured Client Budget Maintenance dialog box is shown in
Figure 3-10.

@42 Client Budget Maintenance

Budget  View
Account: A4 - Company A4 ear: |anno =
[ Budget Detail ]

Overall Accaunt Budget Busget Amount  Budget Units
LLAT0S - Unix user CPU Total a7E00 0
LL&106 - Linix system CPU ) | |
LLA107 - Unix tatal CPU Divicle Total | Divicle: Total |
LLT101 - MS Windowes logins Sum Periods | Sum Periods |
LLT102 - MS Windows connect time PP
LLT103 - MS Windaws image count Lo | 7300 | o
Z001 - O5390 Jobs Started Period 2 | 7300 | 0
Z002 - 054390 Steps Started :

o Period 3 | 7300 | 0
Period 4: | 7300 | 0
Period 5 | 7300 | 0
Period 6: | 7300 | 0
Period 7: | 7300 | 0
Period & | 7300 | 0
Period 9: | 7300 | 0
Period 10: | 7300 | 0
Petiod 11: | 7300 | 0
Petiod 12: | 7300 | 0

Ok | Cancel | Apply

Figure 3-10 « Client Budget Maintenance Dialog Box
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To remove a budget:

To remove all budget information for a year, click Budget » Remove Year. This removes
the overall budget and all individual resource budgets for the year selected in the Year
box.

To remove an individual resource budget, click the budget, and then click
Budget » Remove Resource Budget, or right-click the budget, and then click Remove
Resource Budget. The budget is removed from all years.
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B 3-24

You can create contact information (e.g., name, street and e-mail addresses, phone
numbers, and department) for each client. This information appears on CIMS Server
standard invoices.

To add a contact:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears.

2 Click the client that you want to establish a contact for, and then click Contacts.
The Client Contact List Maintenance dialog box appears.

3 Click Add.

4 In the Client Contact Maintenance dialog box, edit the contact settings as follows:

e Address tab. Type the contact’s name and company and e-mail addresses. You can
type the street address on any address line or lines. However, if want to use the
View Address Map button to view a map for the address, you need to enter the
address in the following order:

e Address Line 1: Street Address
¢ Address Line 3: City, State, Zip
¢ Phone tab. Enter the contact’s phone numbers.

e Other tab. Enter other contact information such as department, comments, and
Web site URL.

5 Click OK when you are finished. Note that the contact will not appear in the Invoice
Contact drop-down box until you close and re-open the Client Maintenance dialog
box.

To edit a contact:

Click the contact, and then click Edit.

To remove a contact:

Click the contact, and then click Remove.

Importing and Exporting Client Data

Client information is contained in the CIMS Client table. You can load and unload data
to/from the CIMS Client table via a number of custom scripts that are provided with
CIMS Server. For more information, see Appendix C, Scripts or contact CIMS Lab (see
Contacting Technical Support on page 7-10).
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CIMS Server Administrator includes a default calendar with the standard 12 monthly
periods (the first day of the month to the last day) by year. Organizations using standard

monthly/yearly periods do not need to change the calendar.

Setting Up a Calendar

If you do not want to run billings using standard monthly/yearly periods, you can
change the period start and end dates and optionally include 13 periods per year (see
page 3-26).

Setting Up Calendar Information

1 Click Chargeback Administration » Chargeback Table Maintenance » Calendar.

The Setup Calendar dialog box appears as shown in example Figure 3-11.
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Figure 3-11 + Setup Calendar Dialog Box

2 Edit the calendar as follows:

In the Year list, click the appropriate year.

Set the Beginning Date and Ending Date for each period as needed.

To have all periods proceed sequentially from the first period, click Set From
Period 1.

To add a new year, click Add Year.

To remove the currently displayed year, click Remove Year.
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Note that the Close Date for the period appears if a close date has been set (see
page 3-42). The close date appears for the period in which it was set, the previous
period, and future periods. In example Figure 3-11 on page 3-25, a first of the month
close date was set in Period 7 (July). Therefore Period 6 and all future periods show a
close date.

Click Apply to save the changes or click OK to save the changes and close the dialog
box.

Using 13 Accounting Periods

If your organization uses 13 accounting periods, you can set this calendar format as
follows:

1

2

3

In the CIMS Server Administrator main window, click System
Administration » Configuration Information.

In the Configuration dialog box, click the Processing tab.

On the Options subtab, select the Use 13 Periods check box, and then click OK.

Calendar Considerations

B 3-26

The maximum entries that CIMSACCT or CIMSBILL reads from the CIMSCalendar
table is 52. (See page A-14 for more information about the CIMSCalendar table.)
Therefore, you need to delete periods from previous years as they pass.

The periods for a particular year must be entered in date sequence.

The CIMSCalendar table must have the current and previous periods defined.
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Working With Users and Groups

A user is an individual with access rights to CIMS Server Web Reporting. Each user can
belong to only one user group. Users are granted the rights and privileges granted to the
group.

This system of users and groups allows you to control the following:

m The reports that a user can access in CIMS Server Web Reporting. A user can access
only those reports that are assigned to the user’s group.

B The clients (account codes) that a user can view in reports. A user can view only those
clients that are assigned to the user’s group.

B Theadministrative privileges for a user. A user assigned to a group with administrative
privileges can update configuration and other information in CIMS Server Web
Reporting.

Default Administrator User and Group

When you initialize the database during the setup process (see Initialize the Database on
page 2-39), CIMS Server adds a default user and user group. This group has
administrative privileges in CIMS Server Web Reporting and can view all reports and
clients.

The ID for the default user is admin and the password is password. The ID for the default
user group is Admin.
Defining Users

You can use CIMS Server Administrator to create and maintain user information such as
e-mail address, ID, password, and other user-specific options used for CIMS Server Web
Reporting.

To add a user:

1 In the CIMS Server Administrator main window, click System
Administration » Users and Groups » Users.

The User List Maintenance dialog box appears as shown in example Figure 3-12 on
page 3-28.
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Figure 3-12 « User List Maintenance Dialog Box

2 Click Add.

3 In the Add New User dialog box, enter an ID for the user (maximum of eight
characters) and the click OK. The User Maintenance dialog box appears.

4 Edit the user settings as follows.

B 3-28

Full Name. Type the user’s full name.

Email Address: CIMS Server includes an automatic report distribution feature (see
Distributing Published Reports on page 4-12). To enable the user to receive reports
using this feature, type the user’s e-mail address.

Display full path on Favorites page. Select this check box to display the full path
for favorite reports on the Favorites page of CIMS Server Web Reporting. For more
information, refer to the CIMS Server Web Reporting User’s Guide.

Display full path on Published Reports page. Select this check box to display the
full path for published reports on the Published Reports page of CIMS Server Web
Reporting. For more information, refer to the CIMS Server Web Reporting User’s
Guide.

Crystal Viewer. Click the Crystal viewer used for this user of CIMS Server Web
Reporting. (To set this option for all users, see Web Settings on page 3-47.) If you
are using SQL Server Reporting Services for reporting, leave this box set to Default.

You can choose one of the following. For the advantages and disadvantages of
each viewer, see page 3-47.

e Default. This option uses the viewer set on the Web tab of the Configuration
dialog box.
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e ActiveX. This option works only in Internet Explorer.

e Java using Browser JVM. This option works in Internet Explorer or Netscape
Navigator. This viewer requires the Java Virtual Machine. Because this viewer
might be more difficult to set up, CIMS Lab recommends that you use the HTML
or ActiveX viewer.

e HTML. This option works in Internet Explorer or Netscape Navigator.

e Group. Click the group that you want to add the user to or accept the default Admin
group. Note that if you need to add a new group for the user, you can create the
group and add the user as described in Defining User Groups on page 3-31.

¢ Configuration Options Maintenance. When you click this button, the User
Configuration Options List Maintenance dialog box appears. You can add user
configuration options that can be used for custom reports and Web pages in this
dialog box. See To add configuration options: on page 3-54.

CIMS Lab recommends that you consult technical support for assistance in adding
user configuration options (see Contacting Technical Support on page 7-10).

e Domain Name/Domain User ID. CIMS Server Web Reporting provides an
automatic log on feature. To enable a user to use this feature, you need to enter the
user's Windows domain name and user ID. You also need to enable auto log on
(see Web Settings on page 3-47) and set IIS security for the CIMS Server Web
Reporting Web site to Integrated Windows authentication (see page 2-51).

You can click Browse to select the domain and user from the Select Domain Name
and User ID dialog box. To find a domain and user in the Select Location and
Select User lists:

a Type a complete or partial value in the text box and then click Find or use the
scroll bar.

b Click OK when you are finished.

e New Password. If you are not using the automatic log on feature for CIMS Server
Web Reporting, use this box to enter a password for the user or to change an
existing password as follows:

a Type the password. The password is alphanumeric and case-sensitive and can
be a maximum of 16 characters.

b Click OK.

¢ In the Confirm New Password dialog box, type the password again, and then
click OK.

d Click OK to confirm that the password has been changed.

5 Click OK when you have finished editing the user settings.
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An example of a configured User Maintenance dialog box is shown in Figure 3-13.
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Figure 3-13 « User Maintenance Dialog Box

To edit a user:

1 Click the user, and then click Edit.

The User Maintenance dialog box appears.

2 Follow the steps in To add a user: beginning with Step 4 on page 3-28.

To remove a user:

Click the user, and then click Remove.

B 3-30
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Defining User Groups

You can use CIMS Server Administrator to create and maintain user groups including
adding users to groups, defining one or multiple account code structures for the group,
and assigning group access to reports and clients.

Tip * When working with groups, you can access commands for an item from the
menu bar, or you can access the same commands by right-clicking the item.

Note ¢ A user can belong to only one group. If you need to place a user in more than
one group, create a new group for the user. For example, a user who needs access to
the reports assigned to Group A and Group B should be assigned to Group C that has
access to the combined reports of Group A and Group B. Assigning a user to only one
group makes it easier to determine the user’s full access rights.

To add a user group:

1 In the CIMS Server Administrator main window, click System
Administration » Users and Groups » Groups. The Group List Maintenance dialog
box appears as shown in example Figure 3-14.

1{ Group List Maintenance

GEroups View

Accounts Payable
B Acmin

Group - ROOT

List Mairtenance

Users Reports Clients

Figure 3-14 + Group List Maintenance Dialog Box

1 Click Groups » Add Group on the menu bar.

2 In the Add Group dialog box, enter an ID for the group (maximum of eight
characters), and then click OK.

The Group Maintenance dialog box appears.

CIMS Server Administrator's Guide 3-31 N



B Setting Up the System
Working With Users and Groups

3 Edit the group settings as follows:

e Description. Use this box to change the description of the group (the default is the
group ID followed by “Group”). Note that if you add a description, the description
rather than the group ID appears in the Group List Maintenance dialog box.

¢ Selected Account Code Structures/Available Account Code Structures. Use these
boxes to define the account code structure or structures that the users of the group
can use for reporting.

You can add and remove structures from one box to the other boxes. All structures
that appear in the Selected Account Code Structures box are available to users in
the group from the CIMS Server Web Reporting Web site. This feature enables
users to dynamically select the account code structure that they want to use to
generate reports.

If you have multiple account code structures in the Selected Account Code
Structures box, you need to set one of the structures as the default structure by
clicking the structure and then clicking Make Default. The default structure
appears on the Set User Options page of the CIMS Server Web Reporting Web site
until another structure is selected from the Web site. The default structure is also
used when publishing reports in batch for a user or group (see Working With Batch
Reporting/Published Reports on page 4-11).

Note ¢ The account code structure selected as the default in the Select Account
Code Structures box initially determines the structure that appears on the Web
site when the site is accessed by a user within the group. However, once the
user selects another account code structure on the Web site, that structure is
stored in a cookie and not the CIMS Server database. Changing the default
structure in CIMS Server Administrator does not change default structure on
the Web site.

e Allow Transaction Maintenance. Select this check box to allow the users within
this group to perform transaction maintenance in CIMS Server Web Reporting. For
more information, refer to the CIMS Server Web Reporting User’s Guide.

e Administrative Access. Select this check box to give the users within this group
administrative configuration options in CIMS Server Web Reporting. For more
information, refer to the CIMS Server Web Reporting User’s Guide.
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e Split Account Code on Transaction Entry. If this check box is selected (the
default), users within this group are allowed to enter account codes by levels when
adding account codes in the Miscellaneous, Recurring, and Credit Transaction
pages in CIMS Server Web Reporting. Users can either type the account code in the
box for each level or select the code if an accompanying select box is available. The
following option, Max Levels of Account Code to Display, determines the
number of account code levels that include a select box.

The account code levels displayed are dependent on the levels defined in the
account code structure selected for the group.

For more information about using transactions in CIMS Server Web Reporting,
refer to the CIMS Server Web Reporting User’s Guide.

¢ Max Level of Account Code to Display. If the Split Account Code on Transaction
Entry check box is selected, type the number of levels that you want to include
select boxes for. For example, if you have five account code levels, but only want
to include select boxes for the three highest levels, type 3 in this box. The
remaining two levels will have a text box in which users can type the account code,
but no select box to browse for the account code.

The data loaded in the select boxes is pulled from the CIMSClient table. If the
CIMSClient table is large, the transaction page can take more time to load if
multiple select boxes are included. Limiting the number of select boxes can reduce
the amount of time required for the transaction page to load.

The default, 0, specifies that all account code levels include select boxes.

¢ Configuration Options Maintenance. When you click this button, the Group
Configuration Options List Maintenance dialog box appears. This dialog box
contains entries for some of the group configuration options that you have set. For
example, the option TransSplitAccountCode represents the Split Account Code
on Transaction Entry check box. Do not delete these entries.

You can add group configuration options that can be used for custom reports and
Web pages in this dialog box. See To add configuration options: on page 3-54.

CIMS Lab recommends that you consult technical support for assistance in adding
group configuration options (see Contacting Technical Support on page 7-10).

4 Click OK when you are finished editing the group settings.

An example of a configured Group Maintenance dialog box is shown in Figure 3-15 on
page 3-34. In this example, transaction maintenance and administrative privileges are
not enabled.
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Figure 3-15 + Group Maintenance Dialog Box

To edit a user group:
1 Click the group and click Groups » Edit on the menu bar.

The Group Maintenance dialog box appears.
2 Follow the steps in To add a user group: beginning with Step 3 on page 3-32.
To add a user to a user group:
1 Click the group, and then click Groups » Add User on the menu bar.

The Select User dialog box appears.

2 Choose the user or users, and then click OK.

Note ¢ You can edit a user’s settings by double-clicking the user in the Group List
Maintenance dialog box.
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To remove a user from a user group:

Click the user, and then click Users » Remove on the menu bar.

To remove a user group:

Click the group, and then click Groups » Remove on the menu bar.

Adding or Removing Report Access to/from a Group

By default, new users are added to the Admin group, which has administrative access
enabled and full access to all reports. If you want to restrict user access to reports, you
need to do the following:

m Select the Use Report Access Security check box on the Configuration dialog box
Reporting/Options subtab (see page 3-43). If this check box is not selected, all users
can access all reports regardless of whether administrative access is enabled for their

group.

m Create a group or groups that do not have administrative access enabled (the
Administrative Access check box is not selected) and add the appropriate users.
(Users that belong to a group that has administrative access enabled have access to all
reports.)

B Add reports to the group as described in To add access to reports:.

Note  If you change the Use Report Access Security option (i.e., you select the check
box or clear it), the change will not take effect in CIMS Server Web Reporting until
you click Upgrade Configuration on the Edit Configuration page or restart IIS.

To add access to reports:

Expand the group, click Reports Allowed, and do one of the following:

m To allow all reports, click Reports » Allow All Reports on the menu bar. When you
add a group, this is the default.

m To allow certain reports, click Reports » Add on the menu bar. In the Select Report
dialog box, choose the report or reports that you want to add, and then click OK.

Reports Allowed expands to show All Reports or the reports that you added.

To remove access to a ri epor t
1 Expand Reports Allowed.

2 Click the report, and then click Reports » Remove on the menu bar.
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Adding or Removing Client Access to/from a Group

You can add access to clients to each group. This allows members of the group to see
these client account codes in reports. For more information about clients, see Working
With Clients on page 3-19.

To add access to clients:

1 Expand the group, click Clients Allowed, and do one of the following:

e To allow all clients, click Clients » Allow All Clients on the menu bar. When you
add a group, this is the default.

e To allow certain clients, click Clients » Add on the menu bar. In the Select Client
dialog box, choose the client or clients that you want to add, and then click OK.

Note ¢ To prevent duplicate data in reports, you cannot add a client with an
account code that overlaps an existing client account code in the Clients
Allowed list. For example, if you add client AABBB you cannot add client AA or
AABBBCC.

2 Expand Clients Allowed to view the clients that you added.

Note that the account code structure selected for the group might have an offset position
greater than 1. However, client access is always determined by the first position in the
account code, regardless of the offset position. The clients that you add will contain the
full account code as assigned for the clients in the CIMSClient table.

Although the full account code appears for the clients in the Clients Allowed list for the
group, the users assigned to the group will be able to view data for only the account code
level(s) specified by the offset.

For example, assume that you have the following account codes:

AABBB
AACCC

In the account code structure selected for the group, the first level of the account code is
defined as a length of 2 and the second level is defined as a length of 3. The offset
position for the account code is 3, which determines that users assigned to the group can
view data for clients BBB and CCC only. However, the complete client account codes AABBB
and AACCC appear in the Clients Allowed list.

For more information about the account code structure, see Setting Up the Account Code
Structure on page 3-3.

To remove access to clients:
1 Double-click Clients Allowed.

2 Click the client, and then click Clients » Remove on the menu bar.
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Using Web Reporting Headlines

You can edit user, report, and client settings by clicking Users, Reports, or Clients in the
Group List Maintenance dialog box.

Using Web Reporting Headlines

Headlines are links that appear in the home page of the CIMS Server Web Reporting Web
site. A headline can link to any URL. This feature has many uses including displaying
announcements such as the latest CIMS chargeback data is available, a new report is

available, etc.

To add a headline:

1 In the CIMS Server Administrator main window, click System
Administration » Reporting » Web Reporting Headlines.

The Web Reporting Headline Maintenance dialog box appears.

2 Click Add.

The Headline Maintenance dialog box appears.

3 Enter the headline settings as follows:

e Date. Click the date that you want to assign to the headline. Note that this is not
the date that the headline appears on the Web site—the headline appears as soon
as it is created.

e Headline. Enter the text of the headline.

¢ Headline Link. Enter the URL for the headline (the headline appears as a link).

4 Click OK when you are finished.

An example of a configured Headline Maintenance dialog box is shown in Figure 3-16.
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Figure 3-16 -
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To edit a headline:

1

2

Click the headline and in the Web Reporting Headline Maintenance dialog box, and
then click Edit.

The Headline Maintenance dialog box appears.

Follow the steps in To add a headline: beginning with Step 3 on page 3-37.

To remove a headline:

Click the headline in Web Reporting Headline Maintenance dialog box, and then click
Remove.

Maintaining Identifiers

When you process a CSR or CSR+ file, the identifier names within that file are stored in
the CIMSIdent table. You can perform the following maintenance tasks for the
identifiers:

B 3-38

Add a description for the identifier. By default, the identifier description is the same
as the identifier name. For reporting purposes, you can add detailed descriptions for
identifiers that are difficult to decipher such as alphanumeric strings. In reports that
provide drill down by identifier, the identifier descriptions appear in the Identifier
list to enable drill down of units or rates by identifier.

Remove unused identifiers. You can remove any unused identifiers from the
CIMSIdent table. Unused identifiers are those that are not contained in the
CIMSDetailldent table. For more information about the CIMSIdent and
CIMSDetailldent tables, see Appendix A, Database Tables.

Enable options for custom reporting. You set options for each identifier, such as flags,
for custom reporting.

To add an identifier description:

1

In the CIMS Server Administrator main window, click System
Administration » Identifiers Maintenance. The Identifier List Maintenance dialog
box appears.

Click the identifier that you want to edit, and then click Edit.
The Identifier Maintenance dialog box appears.
Enter the identifier settings as follows:

¢ Name. This is the name of the identifier as it appears in the CSR or CSR+ file. Do
not change the name unless you want to assign a new identifier to the same
description. For example, the identifier ABC has been changed to ABCD. The
identifier name has changed, but the description remains the same.

e Description. Enter a description for the identifier (maximum of 255 characters).

CIMS Server Administrator's Guide



Setting Up the System W
Maintaining Identifiers

e Active/Inactive. These options are available for custom reports. The use of these
options is user-specified.

¢ Report Flag. This box allows you to enter a one-character value that you can use
in custom reports. The value for this flag is user-specified.

An example of a configured Identifier Maintenance dialog box is shown in Figure 3-17.

== |dentifier Maintenance

Identifier I g + Active
" Inactive

Mame: |C_IP

Description: |Client IP Address

Report Flag:

OK | Cancel ‘

Figure 3-17 - Identifier Maintenance Dialog Box

To remove unused identifiers:

Click Remove Unused Identifiers.
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Configuring System Settings

You can configure the following system settings using CIMS Server Administrator:

B 3-40

Organization information. Name and address of your organization.

Processing settings. Global processing settings for the system such as the path to the
Processes folder and whether a close date is used for processing.

Reporting settings. Report-related settings such as file location, invoice numbering,
and security.

Database settings. Database-related settings such as time-out period and load
priority.

License information. Product license key.

Web settings. Web site settings for CIMS Server Web Reporting.
Table audit settings. Table audit options.

Database load archive settings. Settings for archiving database loads.

Configuration options. Additional settings for custom reports and Web pages.

Important! ¢ If you change any of these settings in CIMS Server Administrator, the
changes will not take effect in CIMS Server Web Reporting until you click Upgrade
Configuration on the Edit Configuration page or restart IIS.

In addition, some of these settings can be configured in CIMS Server Administrator
or CIMS Server Web Reporting. If CIMS Server Web Reporting is open when you
make these changes, click Refresh before you click Upgrade Configuration. This
ensures that the settings are populated with the values that you set in CIMS Server
Administrator.
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To configure the system settings:

1 In the CIMS Server Administrator main window, click System
Administration » Configuration Information.

The Configuration dialog box appears as shown in example Figure 3-18.

Wigw

Organization l Processing ] Reporting ] Databasze ] License ] Wiek ] Aud'rting] Archiving ] Option List]

Organization MName: |The Biig Titme Comparty

Address Line 1: |C0rp0rate Headouarters

AddressLine 2 {3013 Douglas Blvd.

AddressLine 3 Rosevile, CA 95561

Address Line 4: |Un'rted States of America

Reset To Defaultts

Figure 3-18 + Configuration Dialog Box

2 Complete the tabs in the dialog box as shown in the following sections, and then click
OK to save the settings and close the dialog box.

Note ¢ To return the settings in all tabs to the original default settings, click Reset
To Defaults.

Organization Information

Use the Organization tab to type the name and address of your organization (maximum
of 255 characters in each line), and then click OK. This information appears on the
standard invoices that ship with CIMS Server.

You can also type this information on the Edit Configuration page in CIMS Server Web
Reporting.
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Processing Settings
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Use the Path, Options, and Closing subtabs on the Processing tab to set the processing
settings for CIMS Server.

Path Subtab

B Process Definition Path. Enter the path for the process definitions (maximum of 255
characters). For more information about process definitions, see CIMS Server
Administrator Processing on page 6-17.

Options Subtab

m Use 13 Periods. Select this check box if your organization uses 13 accounting periods.
For more information, see Using 13 Accounting Periods on page 3-26.

Closing Subtab

m Close Date. You can set an optional close date for processing input file records.
Records that contain dates before or after this date are processed as described in How
Accounting Dates are Calculated on page 6-16. You can also set close dates for an
individual process definition or definitions (see page 6-28). If you set a close date for
an individual process definition, it overrides the date that you set here.

Click one of the following:
¢ No Close Date. No close date is set.
e Use Specific Date. Enter a specific close date.

e Use Day Of Month. Click the day of the month that you want to set as the close
date. For example, click 15 if you want a close date of the fifteenth of each month.
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Reporting Settings

Use the Paths, Options, and Invoice subtabs on the Reporting tab to set the report
settings for CIMS Server Web Reporting.

Note ¢ You can also enter some of these settings on the Edit Configuration page in
CIMS Server Web Reporting.

Paths Subtab

m Path to standard reports folder. Enter the path for standard reports (maximum of
255 characters). Standard reports are those that are provided with CIMS Server. In
most cases, standard reports require customizing for your organization.

CIMS Lab recommends that you keep the Standard folder in the default location
because standard reports may be updated and/or added with a new version or release
of CIMS Server.

m Path to custom reports folder. Enter the path for custom reports (maximum of 255
characters). Custom reports are those that your report developer creates either
independently or from the standard reports provided with CIMS Server. Custom and
standard (if applicable) reports are available to users via the Reports or Spreadsheets
page of CIMS Server Web Reporting.

m Path to published reports folder. Enter the path for published reports (maximum of
255 characters). Published reports are reports that have been saved with the data that
was generated at the time the reports were run. Publishing a report enables users to
view a report without having to regenerate it.

CIMS Server provides a batch reporting feature that creates and distributes published
reports. This feature includes the option of distributing reports via a UNC link in an
e-mail message. If you want to use this option, you need to type a UNC path in this
box. For example, if you are using the default Pub1ished folder for published reports,
the UNC path might be \\servername\Pub1ished.

For more information about creating and distributing published reports in batch, see
Working With Batch Reporting/Published Reports on page 4-11.

Note * End user access to published reports is dependent on the share
permissions described in Folder Permissions Required for Publishing and Viewing Batch
Reports on page 4-34.
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m Path to Advanced Spreadsheet Install folder. Enter the path for CIMS Advanced
Spreadsheets (maximum of 255 characters). Note that if the CIMS Advanced
Spreadsheets application is not installed, this folder is not created and the folder path
does not appear in this box.

The AdvSpreadsheets folder contains a Standard subfolder to store the standard
spreadsheets that are provided with CIMS Server. CIMS Lab recommends that you
keep the Standard subfolder in the default location because standard spreadsheets
may be updated and/or added with a new version or release of CIMS Server.

Options Subtab

m Last Reporting Date. Enter the last reporting date for reports that CIMS Server Web
Reporting users who do not have administrative privileges can view. For example, if
you do not want non-administrator users to view reports for dates after March 2004,
enter 03/31/2004. Users with administrative privileges can view reports for any date.

m Rate Drilldown Report Name. This setting defaults to the file name for the Multilevel
Drilldown on Rate report (IINXC006). This report enables you to drill down on up to
five identifiers concurrently when you drill down on the units for a rate in a Web
report. If you are using a custom version of this report, enter the file name for the
custom report.

Note ¢ Consult CIMS Lab before replacing this report with a custom report (see
Contacting Technical Support on page 7-10). The report must follow certain rules.

m Rate Group Drilldown Report Name. Type the file name for the Multilevel
Drilldown on Rate Group report (I1INXC007). This report enables you to drill down on
up to five identifiers concurrently when you drill down on the units for a rate group
in a Web report. If you are using a custom version of this report, type the file name
for the custom report.

Note ¢ Consult CIMS Lab before replacing this report with a custom report (see
Contacting Technical Support on page 7-10). The report must follow certain rules.

m Report Script Timeout. Enter the length of time in seconds that the ASP page will
allow a script to generate a report before timing out. The default is 900 seconds (15
minutes). The minimum value for this setting is 600 seconds (10 minutes) and the
maximum value is 2700 seconds (45 minutes).

Note ¢ IIS allows you to set the time-out value for ASP scripts. The value set for
Report Script Timeout overrides the time set in IIS only for scripts that are
generating reports. All other scripts use the time-out value set in IIS.
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m Currency Symbol. The use of this box is user-specified. This box allows you to enter
a currency symbol that you can use in custom reports (maximum of three characters).

B Currency Description. The use of this box is user-specified. This box allows you to
enter a currency description that you can use in custom reports (maximum of 255
characters).

m Use Report Access Security. Select this check box to set access to reports by user
group (see Adding or Removing Report Access to/from a Group on page 3-35). If this
check box is not selected, users within a group can view all reports regardless of
whether the report is allowed for the group.

m Use only 1 Crystal Report License on drilldown reports.

Note  This check box works only with Crystal Reports 8.5. This feature does not
provide a benefit for the Crystal Reports 9 or 10 licensing structure.

By default, when you open a second window in Crystal Reports (for example, when
you drill down on resource units or a rate group in a Web report), a second Crystal
Reports license is used.

When this check box is selected, all report information appears in the same window
and only one Crystal Reports license is used.

Invoice Subtab

m Invoice Number Automation. When this check box is selected, invoice numbers in
CIMS Server Web Reporting increase sequentially from the number set in the Invoice
Number box. The number in the Invoice Number box is then automatically updated
to the number of the invoice that was last run.

For example, if the invoice number is initially set to 1, and you run a report that
contains 20 invoices by account code, the invoice number will be automatically
updated to 20. If you run another report containing 5 invoices, the invoice number
will be updated to 25.

When this check box is selected, the parameter Invoice Number does not appear as a
report parameter in CIMS Server Web Reporting. For more information about Web
report parameters, refer to the CIMS Server Web Reporting User’s Guide.

® Invoice Number. If the Invoice Number Automation check box is selected, use this
box to set the number at which you want invoice numbers to begin. Invoices numbers
increase in sequential order from this number. If the Invoice Number Automation
check box is not selected, the invoice number entered as a report parameter in CIMS
Server Web Reporting is used.
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Database Settings

Use the Database tab to set the following:

m Connection Timeout (seconds). Type the maximum number of seconds (maximum

0f 9999) that a database may respond to a query before timing out. If this time period
is exceeded, CIMS Server Administrator assumes that the database server is not
responding and returns an error message.

If you accept the default (0), no time-out period is applied.

Database Load—Process Priority Class. This setting determines the priority in which
CIMS Server processes are run (CIMSACCT, CIMSBILL, database loads, etc.). Because
these processes can use a large amount of CPU time, CIMS Lab recommends that you
accept the default, Below Normal, which allows other processes (for example, IIS and
SQL Server tasks) to take precedence. Consult CIMS Lab before using a priority other
than Below Normal.

Note ¢ Below Normal will not cause processes to run longer if the system is idle.
However, if other tasks are running, processes will take longer to run.

Database Object Prefix. CIMS Lab strongly recommends that you do not change the
dbo.value for this option. This prefix sets the owner of CIMS Server database objects
to dbo in SQL Server allowing any authorized database user to view the objects.

License Information

B 3-46

Use the License tab to enter the license key provided by CIMS Lab. If you do not have

your license key, contact CIMS Lab (see Contacting Technical Support on page 7-10).
To enter a license:

1 Enter the appropriate workstation (machine) and type the license key.

2 Click Update License.

To remove a license for a workstation:

1 Enter the workstation.

2 Click Remove License.
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Web Settings

Use the General, User Logging, and Customization subtabs on the Web tab to set the
Web site settings for CIMS Server Web Reporting, including optional custom settings.

General Subtab

m Session Timeout Minutes. Enter the number of minutes of inactivity that are allowed
before a CIMS Server Web Reporting user is automatically logged off the system. The
minimum is 1 minute and the maximum is 9999 minutes. The default is 60 minutes.

m Display Account Code Selection to Level. This setting determines the level of
account codes that appear in the Starting Account Code and Ending Account Code
parameter lists in CIMS Server Web Reporting. For example, if you type 1, only the
top level account codes appear. However, if you type 3, the first, second, and third
level account codes appear. For more information, about using starting and ending
account codes, refer to the CIMS Server Web Reporting User’s Guide.

You can also enter this setting on the Edit Configuration page in CIMS Server Web
Reporting.

m Crystal Report Viewer. Click the Crystal viewer used for CIMS Server Web Reporting.
If you are using SQL Server Reporting Services for reporting, leave this box set to
Default.

You can also enter this setting on the Edit Configuration page in CIMS Server Web
Reporting.

Note ¢ You can set different viewers for individual users. CIMS Server Web
Reporting uses the viewer set for the user if it differs from the viewer set here. To
set this option for an individual user, see page 3-27.

You can choose the following:

e Default. If you are using Crystal Reports 9 or 10, the default is the HTML viewer.
If you are using Crystal Reports 8.5, the default is the ActiveX viewer.

e ActiveX. This option works only in Internet Explorer. This viewer has the following
advantages and disadvantages:

Advantage: This viewer provides more features than the HTML viewer provides.

Disadvantage: This viewer requires that the Crystal Smart Viewer for ActiveX be
installed on the user’s computer (see Start CIMS Server Web Reporting on

page 2-54). The user might not have the administrative privileges required to
install and run the viewer.

e Java using Browser JVM. This option works in Netscape Navigator or Internet
Explorer. This viewer requires the Java Virtual Machine. Because this viewer might
be more difficult to set up, CIMS Lab recommends that you use the HTML or
ActiveX viewer.
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e HTML. This option works in Internet Explorer or Netscape Navigator. This viewer
has the following advantages and disadvantages:

Advantage: This viewer works with any browser and does not require any
additional files or set up.

Disadvantage: This viewer provides less features than the ActiveX viewer provides.

Crystal Release. Click the Crystal Reports release that you are using for Web
reporting: 85, 90, or 10. This box is not applicable if you are using SQL Server
Reporting Services.

Port Number. If SSL is not enabled for the CIMS Server Web Reporting Web site and
a port other than port 80 is used, type the port number.

Secure Port. If SSL is enabled for the CIMS Server Web Reporting Web site and a port
other than port 443 is used, type the port number.

Site Localization ID (LCID): If you want to use regional settings other than US
English for CIMS Server Web Reporting Web site, type the locale ID for the settings
that you want to use. This must be one of the decimal values provided at http://
msdn.microsoft.com/library/en-us/script56/html/vsmsclcid.asp. Do not use the
short string or hex values. For more information about setting CIMS Server up for
internationalization, see page 2-11.

Enable Intranet Auto Logon. Select this check box to enable users to automatically
log on to CIMS Server Web Reporting. This feature saves time for users and eliminates
the need to maintain user passwords in the CIMS Server database.

To use this feature, the Windows domain name and user ID for the user must be
entered in the User Maintenance dialog box (see page 3-27) and IIS security for the
CIMS Server Web Reporting Web site must be set to Integrated Windows
authentication (see page 2-51).

Secure Login. Select this check box if SSL is enabled for the CIMS Server Web
Reporting Web site. For more information about enabling SSL, see page 2-53.

Allow Password Change. Select this check box to enable users to change their user
password on the CIMS Server Web Reporting Login page.

Display Account Name on Account Code drop downs. Select this check box to
display the account code description in the Starting Account Code and Ending
Account Code parameter lists in CIMS Server Web Reporting. If you do not select this
check box, the account code description does not appear with the account code.

Enable Client Dropdown Exact Length. When this check box is selected, only
account codes of the level set in the Display Account Code Selection to Level box
appear as parameters in CIMS Server Web Reporting.

For example, assume that you have an account code of AABBBCCCC, where AA is
level 1, AABBB is level 2, and AABBBCCCC is level 3. If Display Account Code
Selection to Level is set to 3, only code AABBBCCCC appears in the Starting Account
Code and Ending Account Code parameter lists in CIMS Server Web Reporting.

Note that if you select this check box and you do not have clients defined in the
CIMSClient table for the level set in Display Account Code Selection to Level, no
account codes will appear in the parameter lists.
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User Logging Subtab

m Log File. If you are logging the usage of CIMS Server Web Reporting, enter the path
for the log file.

m Log IP Address To Skip. If you are logging the usage of CIMS Server Web Reporting,
type the IP address of any client that you do not want to track in the log file. If you
enter only the first number or numbers of an address, any address that begins with
the number(s) will not appear in the log file. For example, if you enter 127.0.0, the
addresses 127.0.0.0 and 127.0.0.1 are not included.

B Require Company Name on login. When this check box is selected, the user must
enter a company or organization name when logging on to CIMS Server Web
Reporting. A text box for the name appears on the Login page.
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Customization Subtab

CIMS Server enables you to create custom Web site settings for CIMS Server Web
Reporting. For example, you might want the Web site to conform to your corporate
standards or to use a custom startup ASP page.

You can use the custom settings feature to select the cascading style sheets, images,
background color, and menu alignment for the Web site.

To use custom Web site settings, you need to first set up the appropriate folders and files
in Windows.

In Windows:

1 Make sure that you have a Custom folder in C:\Program Files\CIMSLab\Server\Web.
(This is the default location. The location of the Web folder might differ on your
system.) The Custom folder should contain an images folder. See example Figure 3-19.
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Figure 3-19 « Web Folder Contents

2 Copy everything in Web/images to Web/Custom/images. (Click Yes to replace the
existing topgraphic.gif file in Custom/images).

3 Copy the CIMS.css file from the Web folder to Web/Custom.
4 Customize the CIMS.css file in the Custom folder as needed.

5 Customize the images in Custom/images as needed.
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6 In Web/Custom/images, replace the topgraphic.gif file with your own image. This is
the image that appears at the top of all Web pages. The image must be named
topgraphic.gif, but it can be in the GIF or JPEG format.

7 1In the Custom folder, customize the default.asp page. This is the home page.

In CIMS Server Administrator:

1 On the Web tab, click Custom in the Custom Site box. Edit the following:
¢ Background Color. Type the hexadecimal number for the background color.
e CSS Location. Type Custom/CIMS.css (do not add beginning or ending slashes).
* Image Location. Type Custom/images (do not add beginning or ending slashes).

e Menu Vertical Start Position. Enter the start position (in pixels) for the menu. The
menu begins at the specified number of pixels from the top of the page. The
number of pixels depends on the size of your topgraphic.gif image. To
determine the number of pixels:

a Right-click the topgraphic.gif file, and then click Properties.
b Click the Summary tab to get the image height.
2 Click OK when you are finished.
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Table Audit Settings
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Important! ¢ Auditing a table can degrade the table’s performance because the audit
feature uses SQL triggers. Do not use this feature for tables that you do not need to
audit.

Use the Auditing tab to audit changes to certain database tables. Auditing tracks changes
that have been made to the data in the tables, including the Windows user ID of the
person who made the change and the date and time that the change occurred.

Note ¢ Transaction audits might reflect the SQL Server login ID rather than the
Windows user ID. For more information, see Creating User Logins for the Database on
page 2-34.

To audit tables, select the appropriate check boxes in the Select audit types area. Audit
data for a table is stored in an additional table named CIMSAudit<audit type>. For
example, the CIMSAuditRate table tracks changes to the CIMSRate table.

You can also view changes to the CIMSClient, CIMSRate, and CIMSTransaction tables via
the following standard Web reports.

m Client Audit Report (file name RACLX001. rpt)
m Rate Audit Report (file name RARTX001.rpt)
m Transaction Audit Report (file name RATRX001.rpt)

For more information about these reports, including examples, refer to the CIMS Server
Web Reporting User’s Guide.

Note ¢ You need to add these reports to the reports list in the Report List
Maintenance Dialog box and to a report group in the Report Group Maintenance
Dialog box if the reports are not already present (see Adding Reports to the CIMS Server
Report List on page 4-5 and Defining Report Groups on page 4-7).
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Database Load Archive Settings

Use the Archiving tab to set the archiving options for database loads. Archiving saves
selected database loads in a format that you can reload (restore) into the database if the
loads are purged.

m Archive Path. Enter the path for storing the archived database loads. The default path
is C:\Program Files\CIMSLab\Admin\Archive\DSNname, where DSNname is the name of
the data source selected in the Select ODBC Data Source dialog box. If you are using
multiple databases with CIMS Server, you should store the archived loads from each
database in separate folders. The archived database loads are stored in a Zip file and
you cannot determine the data source by the Zip file name.

m Compression Type. Click the compression type that you want to use for the archive
files or None. The default, Deflate, is recommended; however, Deflate64 and
BurrowsWheeler may be used for Zip tools that support them.

m Compression Level. Move the slider to set the compression level. The compression
level controls the amount of compression to be applied when compressing data. The
greater the amount of compression applied, the greater the time it takes to perform
the compression.

For more information about archiving database loads, see Archiving, Purging, and
Restoring Database Loads on page 5-22.
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The Option List tab stores the following variables used by CIMS Server for batch
reporting. These variables should not be deleted or changed without consulting CIMS
Lab (see Contacting Technical Support on page 7-10).

m BatchPortNumber
B BatchServerNode
m BatchVirtualDir

You can also use this tab to add optional configuration settings as documented in other
sections in this guide and to add options for use in custom reports. CIMS Lab
recommends that you consult CIMS Lab for assistance in adding configuration settings
for custom reports.

To add configuration options:

1 Click Add.

2 Inthe Add New Configuration Option dialog box, enter the name for the new option
(maximum of 80 characters), and then click OK. The Configuration Option
Maintenance dialog box appears.

3 Enter the following information for the option:
e Description. An optional description of the setting. Maximum of 80 characters.

e Value. The value for the setting (e.g., a folder path or a flag value). Maximum of
255 characters.

e Data Type. The data type for the value: String, Integer, Floating Point, or Date/
Time.
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This chapter describes how to use CIMS Server Administrator to define and group the
reports that appear on the CIMS Server Web Reporting Web site. This chapter also
describes how to generate and distribute published reports in batch mode.
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About CIMS Server Reports

CIMS Server processes data contained in an input CIMS Server Resource (CSR) or CIMS
Server Resource Plus (CSR+) file and produces CIMS Ident, Detail, and Summary files.

These files are loaded into the CIMSDetailldent, CIMSDetail, and CIMSSummary tables
in the CIMS Server database. The data in these tables is then used for reporting.

CIMS Server includes a variety of standard reports that can be used “as is” or can be
customized for your organization. For a description of each of the standard reports, refer
to the CIMS Server Web Reporting User’s Guide.

This section describes the folder hierarchy for storing CIMS Server reports and describes
the types or reports available.

Location of CIMS Server Reports

If you installed CIMS Server in the default location, reports are located in the following
folders. Each of these folders contains the following subfolders: Standard, Custom, and
Published. For example, Reports90\Standard, Reports90\Custom, and
Reports90\Published.

Crystal Reports
m C:\ProgramFiles\CIMSLab\Server\Reports (contains Crystal 8.5 reports)

B ...\Reports90 (contains Crystal 9 reports)

B ...\ReportslO (contains Crystal 10 reports)

SQL Server Reporting Services Reports
m C:\Program Files\CIMSLab\Server\MSRptServReports

CIMS Advanced Spreadsheets
B C:\Program Files\CIMSLab\Server\AdvSpreadsheets

The report version that was selected during the database initialization process (see
Initialize the Database on page 2-39) determines the default report folder that CIMS
Server uses uses for reporting.

If you move this report folder to another location or move the Standard, Custom, or
Published subfolders, you need to change the paths on the Reporting tab in the
Configuration dialog box (see Reporting Settings on page 3-43).

Storing All Reports in the Same Folder

You need to use one Standard, Custom, and Published folder for all report types. For
example, if your report folder is Reports90 (which contains Crystal 9 reports) and you
also want to use Reporting Services and CIMS Advanced Spreadsheets, you need to copy
the Reporting Services reports and advanced spreadsheets to the corresponding
subfolder in the Reports90 folder. That is, copy the reports in MSRptServReports\
Standard to Reports90\Standard, etc.
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Types of CIMS Server Reports
There are four types of reports available with CIMS Server:

m Standard or Custom Reports. CIMS Server includes a variety of standard Crystal and
SQL Server Reporting Services reports. These standard reports include invoice, budget,
summary, trend, and variance reports in report, graph, and spreadsheet format.
Standard reports are available as . rpt files for Crystal Reports and .rd1 files for SQL
Server Reporting Services.

Standard Crystal and Reporting Services reports are stored in the Reports<version>\
Standard folder and the MSRptServReports\Standard folder, respectively. If you want
to use both types of standard reports, all reports must be in the same Standard folder
that is defined in the Configuration dialog box.

For a description of each of the standard reports, refer to the CIMS Server Web
Reporting User’s Guide.

Note ¢ As of the release of CIMS Server 4.0, there are more standard Crystal
reports than Reporting Services reports. However, standard Reporting Services
reports will be added in future CIMS Server releases.

Typically, your report developer will customize the CIMS standard reports for your
organization or will create new reports. The CIMS Server installation includes a
default Reports<version>\Custom or MSRptServReports\Custom folder that you can
use to store these custom reports. If are using custom Crystal reports and Reporting
Services reports, all reports must be in the same Custom folder that is defined in the
Configuration dialog box.

If a report of the same name is in both the Standard and Custom folder, CIMS Server
will use the report in the Custom folder.

One you have the standard and custom reports in the appropriate folders, you need
to specify which of the reports that you want to use with CIMS Server (see Adding
Reports to the CIMS Server Report List on page 4-5 and Defining Report Groups on
page 4-7). Users can then run these reports from the CIMS Server Web Reporting Web
site.

m CIMS Web User Created Reports. Web reporting end users create these reports
directly within the CIMS Server Web Reporting Web site using report templates that
are supplied with CIMS Server or developed by your Crystal Reports developer. These
templates are stored in the Standard/Templates folder. For more information about
these reports, refer to the CIMS Server Web Reporting User’s Guide.

By default, Web user-created reports are placed in the Custom or Custom
Spreadsheets report groups. However, you can use CIMS Server Administrator to
define any report group as the default group for user-created reports (see To set the
default group for reports created by CIMS Web users: on page 4-9).
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m Published Reports. Published reports are standard or custom reports that have been

saved with the data that was generated at the time the reports were run. Publishing a
report enables users to view a report without having to regenerate it. Published
reports are stored in the Published folder that is defined in the Configuration dialog
box.

Users can publish reports from the CIMS Server Web Reporting Web site or you can
use CIMS Server Administrator and the batch reporting scripts described in Batch
Reporting Scripts on page C-28 to automatically generate and publish reports. For
more information about generating and publishing reports in batch, see Working
With Batch Reporting/Published Reports on page 4-11.

CIMS Advanced Spreadsheets. CIMS Advanced Spreadsheets have more advanced
features than Crystal Reports or SQL Server Reporting Services spreadsheets,
including drill down and sorting capability.

CIMS Advanced Spreadsheets are XML definition files that are contained in the
C:\Program Files\CIMSLab\Server\AdvSpreadsheets folder (if you installed CIMS
Server in the default location). CIMS Server includes a variety of standard XML files
in the AdvSpreadsheets\Standard file. You can use these files “as is” or your report
developer can customize these files for your organization or can create new files.

Although the standard advanced spreadsheets are installed in the
Server\AdvSpreadsheets\Standard folder, you need to copy the standard
spreadsheets that you want to use to the Standard or Custom folder that is defined in
the Configuration dialog box (see Reporting Settings on page 3-43). You can choose
either folder; however, you might want to use the Standard folder for consistency.

Likewise, you need to place any custom advanced spreadsheets in the Custom folder
defined in the Configuration dialog box and not in the Server\AdvSpreadsheets\
Custom folder.

As with all CIMS Server reports, if a spreadsheet of the same name is in both the
Standard and Custom folder, CIMS Server will use the spreadsheet in the Customfolder.

To copy the standard advanced spreadsheets to the appropriate folder, do the
following:

1 In the Configuration dialog box, click the Reporting tab to view the paths to the
report folders that have been defined for your standard and custom reports. The
paths appear in the Path to standard reports folder and Path to custom reports
folders boxes.

2 In Windows Explorer, copy the advanced spreadsheets from the
AdvSpreadsheets\Standard folder to either the Standard or Custom folder that is
defined in the Configuration dialog box. For example, copy the spreadsheets from
the AdvSpreadsheets\Standard folder to Reports90\Standard folder.

3 Define the advanced spreadsheets that you want to use with CIMS Server (see
Adding Reports to the CIMS Server Report List on page 4-5 and Defining Report Groups
on page 4-7). Users can then run these spreadsheets from the CIMS Server Web
Reporting Web site.

For more information about CIMS Advanced Spreadsheets, refer to the CIMS Server
Web Reporting User’s Guide.
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Adding Reports to the CIMS Server Report List

The report list in conjunction with the reports assigned to the user groups (see Defining
User Groups on page 3-31) determines the reports that users can access from the CIMS
Server Web Reporting Web site. You need to add a report to this list before it can appear
on the Web site or be assigned to a user group.

By default, the report list contains CIMS standard reports (either Crystal or SQL Server
Reporting Services reports). If you are using custom reports, you can remove the standard
reports (see To remove a report: on page 4-6). If a standard report is in a report group, you
must first remove the report from the group (see To remove a report from a report group: on
page 4-8).

Note ¢ If you want to use more than one report type, for example, Crystal Reports
and Advanced Spreadsheets, make sure that all reports are in the same report folder
and that the folder is defined in the Configuration dialog box. For more information
about the location of CIMS reports, see page 4-2.

To add a report:

1 In the CIMS Server Administrator main window, click System Administration »
Reporting » Reports.

The Reports List Maintenance dialog box appears as shown in example Figure 4-1 on
page 4-5.

Note  Reports in the Report List Maintenance dialog box are sorted by ID
number. To sort the reports by name or description, click the appropriate column
header. To reverse the sort order, click the column header again.

=42 Report List Maintenance

Wigw

I # | [Maime | Description | Report Type | Report File .
000000001 Invoice RIMYC CrystalReports  RINWCOOT7 rpt
000000002 Bucdget RBDGT CrystalReports  RBGTCO01 rpt

| e | |

Figure 4-1 « Reports List Maintenance Dialog Box

2 Click Add.
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3 Inthe Add New Report dialog box, enter the name of the report (e.g., Cost Variance),
and then click OK. Maximum of 32 characters.

The Report Maintenance dialog box appears.
4 Enter the report settings as follows:
e Name. Use this box to change the name of the report.
¢ File Name. The name of the report file without the path. To browse for a report file,
click the Browse button E Maximum of 255 characters.

¢ Template File Name. Consult CIMS Lab before using this option (see Contacting
Technical Support on page 7-10).

e Description. Enter a description of the report. Maximum of 255 characters.
5 Click OK when you are finished.

If you added a SQL Server Reporting Services report, the report is automatically deployed
to the Reporting Services Report Server. This is required to run the report. Click OK in
the notification message.

An example of a configured Report Maintenance dialog box is shown in Figure 4-2.

= Report Maintenance |-_|E|Pz|
Report ID: 3
Iame: |C031 Wariance
File Mame: [RvvARCO01 rpt
(Exclode the path name)
Template File Narme: | j
Description: |RVARC

OK | Cancel

Figure 4-2 - Report Maintenance Dialog Box

To edit the settings for a report:
1 Click the report, and then click Edit.
The Report Maintenance dialog box appears.
2 Follow the steps in To add a report: beginning with Step 4.

To remove a report:

Click the report, and then click Remove. If the report is in a report group, you must first
remove the report from the group (see To remove a report from a report group: on page 4-8).
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Defining Report Groups

Tip * When working with report groups, you can access commands for an item from
the menu bar, or you can access the same commands by right-clicking the item.

Report groups are useful in CIMS Server Web Reporting because they allow you to
categorize related reports in a single group. For example, you might create groups by
report type (e.g., invoice, variance, account) or by data type (e.g., CPU, UNIX,
Windows).

There are two types of report groups:
e Start Groups. These are the larger groups that contain other groups.

e Groups. These are the standard report groups that are contained in a Start Group.
Groups contain reports.

There are three default Start Groups: Reports, Graphs, and Spreadsheets. Although you
can add other Start Groups, only the default groups appear on the CIMS Server Web
Reporting Web site. To use Start Groups other than the default groups, you need to create
a customized Web site.

The default Start Groups (Reports, Graphs, and Spreadsheets) are required for CIMS
Server Web Reporting and must be ordered 1, 2, and 3 as shown Figure 4-3. Do not
remove, rename, or reorder these groups.

To add a report group:

1 In the CIMS Server Administrator main window, click System
Administration » Reporting » Report Groups. The Report Group Maintenance
dialog box appears as shown in example Figure 4-3.

=42 Report Group Maintenance

Group View

= % 1 - Reports

+ % Invoices
% Account Reports
% “ariance Reports
% Trend
% Resource Detail
% Cither

% Custom

F-[- -

2 - Graphs

3 - Spreadsheets
% Standard Spreadshests
% Custom Spreadsheets

+ P

Start Group Description: Root

Report List Maintenance

Figure 4-3 - Report Group Maintenance Dialog Box
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2 Do one of the following:

e To add a Start Group, click Group » Add Start Group on the menu bar. In the Add
Start Group dialog box, enter the name of the Start Group, and then click OK.

e Toadd a group to a Start Group, click the Start Group, and then click Group » Add
Group on the menu bar. In the Add Group dialog box, enter the name of the
group, and then click OK.

To add a report to a report group:

1 To add areport to a report group, click the group, and then click Group » Add Report
on the menu bar. Note that you cannot add a report to a Start Group.

The Select Report dialog box appears.
2 Choose the report or reports that you want to add, and then click OK.

To view the reports that you added, double-click the group.

Note * Report groups that do not contain at least one report will not appear on the
Reports page on the CIMS Server Web Reporting Web site.

To remove a report from a report group:

Click the report, and then click Report » Remove Report from Group on the menu bar.

Note ¢ Removing a report deletes the report from the report group, not from the
system.

To remove a report group:

Click the group, and then click Group » Remove Group on the menu bar. If the report
group contains groups and/or reports, you must delete the groups and reports before you
can delete the group.

Other Report Group Options

Once you have created a report group, you can:

m Rename the group or change its description

m Re-sort the group or report display order

m Make a group the default group for reports created by CIMS Web users

To rename a report group or change its description:

1 Click the group, and then click Group » Change Group Name or Change Group
Description on the menu bar.

2 In the Change Group Name/Description dialog, box enter the new name or
description. Note that the description is the same as the group name by default.
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To re-sort the group or report display order:

1 Click the group that contains the groups or reports that you want to re-sort, and then
click Group » Change Group Display Order or Change Report Display Order on
the menu bar.

The Report Group/Report Display Sequence dialog box appears.
2 Click a group/report, and then click the up or down arrow to reposition the item.

3 Click OK when you are finished.

To set the default group for reports created by CIMS Web users:

In CIMS Server Web Reporting, end users can create reports using the standard templates
provided with CIMS Server or custom templates developed by your Crystal Reports
developer. For more information about these reports and descriptions of the standard
templates, refer to the CIMS Server Web Reporting User’s Guide.

To make a group the default group for reports or spreadsheets created by end users, click
the group, and then click Group » Default Report/Spreadsheet Group on the menu bar.
The default group appears bold and is designated by *Reports/Spreadsheet Default in
the lower right corner of the Report Group Maintenance dialog box.

The user-defined reports or spreadsheets appear in the group selected as the default
group on the Reports or Spreadsheets page of the CIMS Server Web Reporting Web site.

The default group for user-defined reports is Custom and the default group for user-
defined spreadsheets is Custom Spreadsheets.
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Changing the Logo in Reports

By default, the CIMS logo appears in reports. If you want to replace this logo with a
custom logo, you need to complete the following steps. The steps differ depending on
whether you are using Crystal or SQL Server Reporting Services reports.

For Crystal reports, you must modify each report file to include the logo that you want.

For Reporting Services, all reports automatically use the report image that is published
to the Reporting Services Report Server.

To change the logo for Crystal reports:
1 In Crystal Reports, open the report that you want to change.

N

Right-click logo, and then click Delete.

3 On the menu bar, click Insert » Picture.

=

Locate the file for the logo that you want to use and place it in the report.
5 Save the report in the Custom reports folder.

To change the logo for Reporting Services reports:

1 Ifyou installed CIMS Server in the default location, locate the ReportlLogo. jpg file in
C:\Program Files\CIMSLab\Server\Web\Images.

2 Rename the ReportlLogo. jpg file CIMSReportLogo. jpg.

3 Place the file for the logo that you want to use in the Images folder. The file must be
named ReportlLogo. jpg, but it can be in the JPEG or GIF format.

4 In the CIMS Server Administrator main window, click System
Administration » Reporting » Deploy Reporting Services Report Image. This
publishes the new logo file to the Reporting Services Report Server where it is used by
all CIMS reports that use Reporting Services.
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Working With Batch Reporting/Published Reports

Note ¢ This section is not applicable for SQL Server Reporting Services reports. The
batch reporting feature will be supported for Reporting Services in a future CIMS
Server release.

Batch reporting enables you to automate the generation of published reports. A
published report is a report that has been saved with the data that was generated at the
time the report was run.

Publishing a report enables users to view a report without having to regenerate it. The
report displays quickly because the data has already been read from the database and
formatted.

Batch reporting also enables you to provide published reports to end users in a way that
best meets the users’ needs, including attaching the report to an e-mail or including a
link to the report in an e-mail. The distribution methods for published reports are
described in detail in Distributing Published Reports on page 4-12.

This section describes how to create and distribute published reports in batch using
CIMS Server Administrator in conjunction with the ReportDistribution.wsf script. If
you installed CIMS Server in the default location, this script is in C: \Program
Files\CIMSLab\Scripts\Batch Reporting.

Creating Published Reports
Published reports can be created in either of the following ways:

B From the CIMS Server Web Reporting Web site. This method requires that users
publish reports from the Web site by clicking Publish after the report is generated.
This method is described in detail in the CIMS Server Web Reporting User’s Guide.

m In batch. CIMS Lab provides the ReportDistribution.wsf script that you can use to
automatically create, publish, and distribute reports. To publish reports using this
script, you need to do the following:

e Create a report cycle in CIMS Server Administrator for the report or reports that
you want to publish. The ReportDistribution.wsf script uses the definitions in the
report cycle to generate and distribute the reports. For more information about
distributing published reports and creating report cycles, see Distributing Published
Reports on page 4-12 and Creating a Report Cycle on page 4-13.

e Set up and run the ReportDistribution.wsf as described in Running a Report Cycle
on page 4-28.
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Distributing Published Reports

H 4-12

To best meet your users’ needs, CIMS Server provides you with the flexibility to distribute
published reports in any of the following ways.

Distribute reports from the CIMS Server Web Reporting Web site. This method
requires that users search for and access published reports from the Web site by
clicking Reports » View Published Reports. This method is described in detail in the
CIMS Server Web Reporting User's Guide.

You can use this distribution method with or without the following e-mail
distribution feature. E-mail distribution notifies a user or users that the report is
available and provides a link to the CIMS Server Web Reporting Web site.

Distribute reports via e-mail. This method enables you to “push” published reports
to users. You can deliver the reports in any of the following ways:

Attach the report to the e-mail. A benefit of this method is that the user receives
the report directly. A disadvantage is that large reports included as attachments can
affect the performance of your e-mail system.

Provide a link to the report in the e-mail subject or body. This method saves e-
mail space and enables the user to easily access the report by clicking the link.
Published reports are stored in subfolders within the Pub1ished folder on the
CIMS Server application server. (See Storing Published Reports Using the Published
Folder Structure on page 4-32.)

Provide a link to the CIMS Server Web Reporting Web site in the e-mail subject
or body. You can use this method to provide a link to the Web site home page or
a link directly to the report on the Web site (if auto logon is enabled for the user
[see Web Settings on page 3-47]). A benefit of this method is that the security set

up for the Web site is used to control user access to published reports (see Security
Requirements for Viewing Reports on page 4-34).

To use the e-mail report distribution feature, you need to create a report cycle in CIMS
Server Administrator as described in Creating a Report Cycle on page 4-13.
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Creating a Report Cycle

The report cycle defines such information as the reports that you want to publish, the
output format for the reports, how you want to distribute the reports (attachment or
link), and the user or user group that you want to distribute the reports to.

To add a report cycle:

1 In the CIMS Server Administrator main window, click System
Administration » Reporting » Report Distribution.

The Report Cycle List Maintenance dialog box appears as shown in example
Figure 4-4.

@42 Report Cycle List Maintenance [Z| [E| PZ|

D # Mame | Report Cycle Description

Add Eemee | it | Bl

Figure 4-4 « Report Cycle List Maintenance Dialog Box

2 Click Add.

3 In the Add New Report Cycle dialog box, enter the name of the report cycle (e.g.,
Budget), and then click OK. Maximum of 8 characters.

The Report Cycle Maintenance dialog box appears.

4 Enter the report distribution settings as follows. For an example, see Figure 4-5 on
page 4-26.

e Report Cycle ID. The report cycle ID number is automatically assigned to the
report cycle. Report cycle IDs are assigned in sequential order.

e Name. Use this box to change the name of the report cycle if needed.
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e Description. Enter a description of the report cycle (e.g., Budget Report).
Maximum of 255 characters.

e Link type. If you want to distribute a report by providing a link directly to the
report, you need to click the type of link that you want to use: UNC or URL. The
Link type box is applicable only if one of the following formats is selected in the
Report format box on the Report Cycle Distribution Request dialog box (see
Step 6 on page 4-16):

e PDF : E-mail with link to report

¢ Excel : E-mail with link to file

e CSV: E-mail with link to file

If any other format is selected, the value in this box is ignored.

If you click UNC, the UNC path for the Published folder must be entered in the
Path to published reports box on the Reporting tab of the Configuration dialog
box (see Reporting Settings on page 3-43). An example of the use of a UNC path is
for in-house users on the same network as the Web server.

If you click URL, a virtual directory must exist for the Pub1ished folder. For more
information, see Creating a Virtual Directory for the Published Folder on page 4-35.
An example of the use of a URL path is to enable users who cannot access the
reports through the network to access reports through the intranet.

e CIMS Server URL. If you want to distribute a report by providing a link to the
CIMS Server Web Reporting Web site, type the URL for the site in this box.

This box is applicable only if one of the following formats is selected in the Report
format box in the Report Cycle Distribution Request dialog box (see Step 6 on
page 4-16):

e Crystal : E-mail with link to report (this provides a direct link to the report on
the Web site)

e Crystal : E-mail with link to Web site (this provides a link to the Web site home
page)

e Excel : E-mail with link to Web site (this provides a link to the Web site home
page)

If any other format is selected, the value in this box is ignored.

e Reports URL. If you selected URL in the Link type box, type the URL for the virtual
directory for the report.
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¢ E-mail from address. Type the fully qualified e-mail address of the sender of the
e-mail.

Note ¢ The “to” address for the recipient of the e-mail is defined by user in the
User Maintenance dialog box. For more information, see To add a user: on
page 3-27.

e Mail server. The name of the SMTP mail server that will be used to send the e-mail
distribution.

¢ E-mail subject and E-mail body. Use these boxes to type the subject and body of
the e-mail.

It is very important that you include an &WebSite or &Location variable in the
subject or body if you select a report format that includes a link. The &WebSite
variable provides the URL link to the CIMS Server Web Reporting Web site. The
&Location variable provides pre-defined text and a URL link to the CIMS Server
Web Reporting Web site or a URL or UNC link to the published report.

To add these variables and other optional variables, click Add variable and then
click the variable that you want to add (see the following descriptions). The
variables will be automatically populated with the correct information in

the e-mail.

e Link to Reporting Web Site (&WebSite). Provides a URL link for the CIMS
Server Web Reporting Web site. For example, http://Tocalhost.

e Link to Location (&Location). Provides text and a UNC or URL link. The link
is provided with the following text depending on whether the link is directly to
the report or to the CIMS Server Web Reporting Web site:

“Report name may be found by using this link:”

Example: Account Budget for Period YTD may be found by using this Tink:
http://Serverl/Published/USER/Joan/200408/PDF/RBGTCO0L . pdf

“Report name has been published at the site:”

Example: Account Budget for Period YTD has been published at the site:
http://Serverl

e User Name (&UserName). The CIMS user name for the user defined for the
report.

e User ID (&UserID). The CIMS user ID for the user defined for the report.
¢ Report Name (&ReportName). The report name.
¢ Report Cycle Name (&CycleName). The report cycle for the report.

e Date report was published (&Date). The date that the report was published
and the e-mail notification sent.
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e Report Period (&ReportPeriod). The period in which the report was published
as defined in the CIMSCalendar table.

e Requests. This box contains requests for the reports that you want to publish. A

report request defines the settings for the report such as the format that you want
to publish the report in, the parameters for the report, and the report recipient(s).

5 Under the Requests box, click Add.
The Report Cycle Distribution Request dialog box appears.

6 In the Report Cycle Distribution Request dialog box, enter the settings for the report
that you want to publish as follows. For an example, see Figure 4-5 on page 4-26.

e Report cycle ID. The report cycle ID number is automatically assigned to the

report cycle.

Request ID. You need to create a separate request for each report that you want to
publish. The request ID number is automatically assigned to the request. Request
IDs are assigned in sequential order.

Report format. Click the format that you want the published report to appear in.
This setting also specifies the distribution method (i.e., link or attachment).

Note ¢ The format that you select in this box should support the report or
spreadsheet that you select in the Report box. For example, if you select a
spreadsheet in the Report box, you might not get the desired results if you
select the Crystal report format in this box.

e PDF : E-mail with report attached. The report is published as a PDF document
and attached to the e-mail. The text “Report name is attached” is placed in the
e-mail body.

Adobe Reader must be installed on the client computer to enable the e-mail
recipient to view the report.

This report format has the following advantages and disadvantages:
Advantages
» The recipient receives the report directly.

* The recipient does not require Windows folder or IIS security privileges to
access the report.

Disadvantages

e Large reports included as attachments can affect the performance of your
e-mail system.

e The report does not appear on the Published Reports page of the CIMS Server
Web Reporting Web site and cannot be accessed from the Web site.
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e PDF : E-mail with link to report. The report is published as a PDF document
and a link to the report is included in the e-mail. The format of the link, UNC
or URL, is determined by the value in the Link type box of the Report Cycle
Maintenance dialog box (see Step 4 on page 4-13).

Adobe Reader must be installed on the client computer to enable the e-mail
recipient to view the report.

This report format has the following advantage and disadvantage:
Advantage

» Enables users to easily access the report without having to attach the report to
the e-mail.

Disadvantage

 If you want to use a URL link for to the report, you must create a virtual
directory for the Published report folder.

¢ Crystal : E-mail with link to report. The report is published as a Crystal report
and a link directly to the report on the CIMS Server Web Reporting Web site is
included in the e-mail. To use this option, the Web site must have Windows
authenticated access enabled and the recipient must be set up to use the auto
logon feature for the CIMS Server Web Reporting Web site (see Web Settings on
page 3-47).

This report format has the following advantage and disadvantage:
Advantage

e Provides a link directly to the report on the Web site.
Disadvantage

e The Web site must have Windows authenticated access enabled and the
recipient must be set up to use the auto logon feature for the CIMS Server Web
Reporting Web site.
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e Crystal : E-mail with link to web site. The report is published as a Crystal report

and a link to the home page of the CIMS Server Web Reporting Web site is
included in the e-mail.

This report format has the following advantage and disadvantage:
Advantage

» Enables recipients who are not set up to use the auto logon feature for the
CIMS Server Web Reporting Web site (see Web Settings on page 3-47), to go
to the Web site home page via a link. The recipient can then log on to CIMS
Server Web Reporting and view the published report.

Disadvantage

 Links to the home page for the CIMS Server Web Reporting Web site rather
than directly to the published report on the Web site.

Crystal : No e-mail. The report is published as a Crystal report, but an e-mail
containing the report or a link to the report is not sent.

Excel : E-mail with file attached. The report is published as an Excel
spreadsheet and attached to the e-mail. The text “Spreadsheet name is attached”
is placed in the e-mail body.

Excel must be installed on the client computer to enable the e-mail recipient to
view the spreadsheet.

This report format has the following advantages and disadvantages:
Advantages
e The recipient receives the spreadsheet directly.

* The recipient does not require Windows folder or IIS security privileges to
access the spreadsheet.

Disadvantages

 Large spreadsheets included as attachments can affect the performance of
your e-mail system.

* The spreadsheet does not appear on the Published Spreadsheets page of the
the CIMS Server Web Reporting Web site and cannot be accessed from the
Web site.
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¢ Excel : E-mail with link to file. The report is published as an Excel spreadsheet
and a link to the report is included in the e-mail. The format of the link, UNC
or URL, is determined by the value in the Link type box of the Report Cycle
Maintenance dialog box (see Step 4 on page 4-13).

Excel must be installed on the client computer to enable the e-mail recipient to
view the spreadsheet.

This report format has the following advantage and disadvantage:
Advantage

* Enables users to easily access the spreadsheet without having to attach the
report to the e-mail.

Disadvantage

¢ Ifyou want to use a URL link for to the spreadsheet, you must create a virtual
directory for the Published report folder.

¢ Excel : E-mail with link to web site. The report is published as an Excel
spreadsheet and a link to the home page of CIMS Server Web Reporting Web site
is included in the e-mail.

This report format has the following advantage and disadvantage:
Advantage

e Enables recipients to go to the Web site home page via a link. The recipient
can then log on to CIMS Server Web Reporting and view the published
spreadsheet.

Disadvantage

e Links to the home page for the CIMS Server Web Reporting Web site rather
than directly to the published spreadsheet.

e Excel : No e-mail. The report is published as an Excel spreadsheet, but an e-mail
containing the spreadsheet or a link to the spreadsheet is not sent.
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e CSV : E-mail with file attached. The report is published a a comma-separated

values (CSV) file and attached to the e-mail. The text “Report name is attached”
is placed in the e-mail body.

This report format has the following advantages and disadvantages:
Advantages
¢ The recipient receives the CSV file directly.

* The recipient does not require Windows folder or IIS security privileges to
access the CSV file.

Disadvantages

¢ Large CSV files included as attachments can affect the performance of your e-
mail system.

» The CSV file does not appear on the Published Reports or Published
Spreadsheets page of the CIMS Server Web Reporting Web site and cannot be
accessed from the Web site.

CSV : E-mail with link to file. The report is published as a CSV file and a link
to the report is included in the e-mail. The format of the link, UNC or URL, is
determined by the value in the Link type box of the Report Cycle Maintenance
dialog box (see Step 4 on page 4-13).

This report format has the following advantage and disadvantage:
Advantage

e Enables users to easily access the CSV file without having to attach the report
to the e-mail.

Disadvantage

 If you want to use a URL link for to the CSV file, you must create a virtual
directory for the Published report folder.

e Report. Click the report that you want to publish. For a description of each of the
reports including examples, refer to the CIMS Server Web Reporting User’s Guide.

Set default parameters for all users of this report. Click this button to set the
parameters for the report. These parameters will be applied to reports for all users
unless you set override parameters by user or user group (see Set optional
override parameters for this user/user group). For a description of all report
parameters, see Setiing Report Parameters on page 4-21.

User Type—User or User group. This setting determines the user or user group
that you want to send the published report to and where the published report is
stored. If you click User, the report is stored in the Published\user folder in a
subfolder with the same name as the user. For example, Published\user\Joan.
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If you click User group, the report is stored in Published\group folder in a
subfolder with the same name as the user group. For example,
Published\group\AP.

Note * Make sure that you have entered an e-mail address for each user that
you want to send the report to as described in To add a user: on page 3-27.

e Set optional override parameters for this user/user group. Click this button to
set any parameters that are specific to a user or user group. These parameters will
override the parameters set for all users. For a description of all report parameters,
see Setting Report Parameters on page 4-21.

7 Click OK when you are finished and then click OK again to close the Report Cycle
Maintenance dialog box.

The report request appears in the Requests area of the Report Cycle Maintenance dialog
box. A separate e-mail is sent for each report defined in the Requests area.

To edit a report cycle:

1 Click the report cycle, and then click Edit. The Report Cycle Maintenance dialog box
appears.

2 Follow the steps in Creating a Report Cycle on page 4-13 beginning with Step 4.

To remove a report cycle:

Click the report cycle, and then click Remove.

Setting Report Parameters

Note ¢ This section describes the parameters for the standard reports provided by
CIMS Lab. Your reports might use other parameters that are custom for your
organization.

The standard reports provided with CIMS Server use the parameters shown in Report
Parameters for CIMS Standard Reports.

To set the parameters for a report:

1 Click Set Default Parameters for all users of this report in the Report Cycle
Distribution Request dialog box.

The Report Distribution Request Parameters dialog box appears.

2 Type the parameters values that you want to use for the report. Click OK when you
are finished. A description of each of the parameters is provided in Report Parameters
for CIMS Standard Reports on page 4-22.

3 Click OK when you are finished.

CIMS Server Administrator's Guide 4-21 N



B Report Administration
Working With Batch Reporting/Published Reports

These parameters will be applied to reports for all users unless you set override
parameters by user or user group. To set override parameters for a specific user or user

group:
1 Click User or User Group and then click the user or group that you want to apply the
override parameters to.

2 Click Set Optional Override Parameters for this User/User Group.
The Report Distribution Request Parameters dialog box appears.

3 Type values for only those parameters that you want to override. All other parameters
will remain the same as the parameters for all users.

4 Click OK when you are finished.

Report Parameters for CIMS Standard Reports

The following are the parameters for the standard reports provided with CIMS Server.
The parameters are presented in alphabetical order with the exception of InvoiceLevel,
which is the first parameter for many reports.

Note ¢ Parameters vary by report.

Parameter Description

InvoiceLevel The account code level that you want to view in the report.
For example, the account code AABBBBCCC might
contain the following levels:

(This parameter is
synonymous with
Account Code Level onthe m Level 1, the two-digit company code AA

CIMS Server Web
Reporting Web site.) m Level 2, the 6-digit division code AABBBB
m Level 3, the 9-digit department code AABBBBCCC
In this example, the account code level that you can select
is 1, 2, or 3. The resource use and charge data will reflect
the level that you select.
AccountCodeStart and These parameters work in conjunction with the
AccountCodeEnd InvoiceLevel parameter to specify the account codes for

that level that appear in the report.

For example, if the InvoiceLevel parameter is set to 1 (level
1), and level one of the account code is the 2-digit
company code, only 2-digit account codes in the range
specified by these parameters appear in the report.

If you want all account codes for the account code level to
appear in the report, you can leave these parameters blank
or set the AccountCodeStart parameter to the lowest
account code (for example, AA) and AccountCodeEnd to
the highest account code (for example, ZZ).

Table 4-1 - Standard Report Parameters
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Parameter Description

AuditType The type of changes that you want to view in CIMSClient,
CIMSRate, and CIMSTransaction table audit reports.

Valid values are:

m Aorblank. View all table changes.
m . View table additions.

m U. View table updates.

m D. View table deletions.

DateStart and DateEnd The start and end dates for the data that you want to
appear in the report. You can use a CIMS date keyword or
a date value for either the start or end date. The dates for
the keywords are calculated using the date the report is
published.

CIMS date keywords:

RNDATE  If used for either the start or end date, the date
is the current day.

CURDAY  Ifused for the start date, the date is the previous
day. If used for the end date, the day is the
current day.

CURWEK  Tfused for the start date, the date is the first day
of the current week (Sun-Sat). If used for the
end date, the date is the last day of the current
week.

CURMON  If used for the start date, the date is the first day
of the current month. If used for the end date,
the date is the last day of the current month.

PREDAY If used for either the start or end date, the date
is the previous day.

PREWEK  Ifused for the start date, the date is the first day
of the current week (Sun-Sat). If used for the
end date, the date is the last day of the previous
week.

PREMON  Ifused for the start date, the date is the first day
of the previous month. If used for the end date,
the date is the last day of the previous month.

Table 4-1 « Standard Report Parameters (Continued)
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Parameter Description

DateStart and DateEnd CURRENT  If used for the start date, the date is the first day

(continued) of the current period as defined in the
CIMSCalendar table. If used for the end date,
the date is the last day of the current period.

PREVIOUS Ifused for the start date, the date is the first day
of the previous period as defined in the
CIMSCalendar table. If used for the end date,
the date is the last day of the previous period.

Date value:
The date must be in month/day/year format as follows:

m month and day with or without a leading 0
m 2 or 4-digit year

For example, 9/16/2004, 09/16/2004, 9/16/04, or
09/16/04.

Graph This parameter specifies whether a graph appears on the
first page of the report. Valid values are:

®m Y (a graph appears)

m N or blank (a graph does not appear)

Identifier or Allldent The name of the identifier that you want to retrieve data
for.
InvoiceNumber Some invoice reports contain separate invoices for the

account codes selected. If you leave this parameter blank,
the invoice numbering begins with the invoice number
defined in the CIMSConfigOptions table.

If you provide an invoice number for this parameter,
invoice numbering begins with that number.

Month The month for the data that you want to appear in the
report. The format is numeric, 1-12.

Period The period (1-13) for the data that you want to appear in
the report. Periods are defined in the CIMSCalendar table
(see Setting Up a Calendar on page 3-25).

Prorate The amount that you want to prorate across accounts in
proration reports.

RateCode The rate code that you want to retrieve data for.

RateGroup, The rate group that you want to retrieve data for. This can
RateGroup4DetRpts, or be the rate group title, description, or index number.
RateGroupwithlIdentifiers

Table 4-1 « Standard Report Parameters (Continued)
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Parameter Description

Start_Value and This parameter provides data by the selected identifier

End_Value value range. For example, if you want data for the
following three identifier values: Server1, Server2, and
Server3, type Serverl as the start and Server3 as the end.

Trans_ID_Start and This parameter provides data by the selected CICS

Trans_ID_Start End transaction ID range. For example, if you want data for the
following three transaction IDs: CESF, DEGV, and TINQ,
type CESF as the start and TINQ as the end.

TopN This parameter specifies the number of account codes that
appear in a report or the drill down for a report. For
example, if you type 1, only the account code that used the
most resources or incurred the most charges appears. If
you type 2, the highest and second highest account codes
appear.

TransactionType The transaction type that you want to retrieve data for.
Valid values are:

m A or blank. All transactions.

m M Miscellaneous transactions.
B R. Recurring transactions.

m C. Credit transactions.

For more information about transactions, refer to the
CIMS Server Web Reporting User’s Guide.

Year The two or four-digit year for the data that you want to
appear in the report.

ZeroCostOption The Zero Cost Invoice report may be processed in two
ways:

m Factor total. This factors the invoice total by the zero
costamount. To factor by total, type A for this
parameter.

m Factor rates. This factors each resource rate by the zero
cost amount. To factor by rate, type B or leave the
parameter blank.

For more information about zero cost, see page 3-11.

ZeroValue The zero cost amount. You can type this amount with or
without the decimal point. For example, 100000 or
100000.00.

Table 4-1 - Standard Report Parameters (Continued)
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Creating a Report Cycle Example
Figure 4-5 shows configured report cycle dialog boxes for the example report cycle

Budget.
(B ReportCycle Mrintenance BEE]  Reports generated using this report cycle are
distributed via a URL link to the virtual directory
Repatopcke D 2 Published (see Creating a Virtual Directory for the
e [rwice Published Folderon page 4-35).
peseipton IImcie by Accourt ———"The variables &ReportName in the subject and
Link typs URL hd

: &Location in the body are automatically updated with
R - the report name and a link to the report as shown in
N Figure 4-6 on page 4-27.

E-mail from address:

[mail.apzeo.com

Mail server
E-mail subject [&Fiepantame for October 2004 Add varisble.
E-mail body: ELocation Add variable...

IF you haws any questions about this 1epot, please contact
Chistine Sanchez [csanchez@xyzco.com).

The report Invoice by Account Level is published as a
PDF file and distributed via a URL link in the e-mail.

The e-mail will be sent to the CIMS user Joan. The user’s

Flequesis Requeet 1D # | User or Group [ Report ID e-mail address is defined in the User Maintenance
dialog box (see page 3-238).

=% Report Cycle Distribution Request |L|\E\E|
Add | |
Report cycle [D: 2 Invoice
I Pequest ID: 1
| Report farmst: [POF - E-mail with report attached =]
L [ Report Parameters |
T
Repoit 1. invel07.1pt - Invoice by dccount Level ~|
L - —_ -
et deault parameters for allusers of s eport |
t b
[User Type | I
Cue o
" User group | I J
St plfonal ovepide parametes or this user ‘
1
port Distribution Request Parameters, I
Set default parameters for all users of report finve007.rat I
Fiepart cycle I 2 Invoice
Fiequest I 0 I
Fiepart ID: 1 rinveDO7.pt - Invoice by Account Level I
Parameter Name Parameter Value I
InvoiceLevel 1
Invoicenumber 1 S |
N
An
cc

preman
premon

Only first level account codes between AA and CC
| appear in the report. The data presented for the
report is for resources used during the previous
month. Periods are defined in the CIMSCalendar
table.

Figure 4-5 « Report Cycle Settings Example
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The e-mail generated from the settings in the report cycle appears as shown in Figure 4-6.
The e-mail includes a URL link to the report.

B Invoice by Account Level for 107172004 - 10/31/2004 - Message (Plain Text) [ [=1[E3]
i Ghgeply | CiReply o sl | B Forwerd | | 4| ¥ S P X a0 e n A0 ©

i Fle Edt Wew Insert Format Tools  Actions Help

From: ‘b ciws. serwerfixyzro. con Senk  Fri 10/8/2004 3:02 PM
To: Joan Watson

Ce:

Subject: Invoice by Account Level for Dctober 2004

Invoice by Account Level may be found by using this link:
hetp:// localhost/ Fublished/ GROUP/ Admin/ 200410/ PDF/ rinve007. pdf

If you have any gquestions sbout this report, please contact Christine Sanchez (csanchezBxyzeo.com) .

Figure 4-6 < E-mail Report Distribution Example
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Running a Report Cycle

Once you have created a report cycle, you need to run the ReportDistribution.wsf script
to create, publish, and distribute the reports defined in the cycle. If you installed CIMS
Server in the default location, this scriptisin C: \Program Files\CIMSLab\Scripts\Batch
Reporting.

Note ¢ The ReportDistribution.bat script calls and passes parameters to other
scripts used in the batch reporting process. For more information about these
scripts, see Baich Reporting Scripts on page C-28.

Defining the Web Server (If Applicable)

Note  This section is not applicable if you are using Crystal Reports 8.5.

Crystal Reports 9 and 10 use the Crystal Report Application Server (RAS) interface, which
is installed on the Web server. If you are using Crystal Reports 9 or 10 and are not running
the ReportDistribution.wsf script on the Web server, you need to create a configuration
option in CIMS Server Administrator to define the name of the Web server that contains
the RAS interface. To set this option:

1 In the main CIMS Server Administrator window, click System
Administration » Configuration Information.

2 On the Option List tab, click Add.

3 Inthe Add New Configuration Option dialog box, type RASServer and click OK. The
Configuration Option Maintenance dialog box appears.

4 Enter the following information as shown in example figure Figure 4-7:
e Description. An optional description of this option. Maximum of 80 characters.
¢ Value. The name of the Web server.

e Data Type. String.

=42 Configuration Option Maintenance

RASServer

Dezcription: |Web SErver name

Wl |Server1

Data Type: |String j

OK | Cancel |

Figure 4-7 « Configuration Option Maintenance Dialog Box
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Running the ReportDistribution.wsf Script

To run the ReportDistribution.wsf script, you should use the CIMS Job Runner console
application and an XML job file as used for the data collection process for CIMS Server.
The CIMS Job Runner application and its related architecture are described in detail
CIMS Data Collectors for Microsoft Windows Installation and User Guide. This architecture
provides the following benefits:

B You can run the ReportDistribution.wsf script automatically on a scheduled basis
(daily, monthly, etc.) using Windows Task Scheduler.

B You can receive a log file via e-mail that provides the results of the report generation
and distribution process. If a warning or failure occurs during processing, the file
indicates at which point the warning/failure occurred. The log file can be sent to
multiple recipients.

To run the ReportDistribution.wsf script via CIMS Job Runner, you need to create a job
file for the script and then schedule CIMS Job Runner to run the job as shown in the
following steps.

Create a Job File for the ReportDistribution.wsf Script

In the JobFiles folder, create an XML job file for the script using the structure shown in
the following example file. (If you installed CIMS Server in the default location, this
folder is in C:\Program Files\CIMSLab.) For a complete description of the components
of a job file, refer to the CIMS Data Collectors for Microsoft Windows Installation and User
Guide.

<?xml version="1.0" encoding="utf-8"7>
<Jobs xmIns="http://www.cimslab.com/CIMSJobs.xsd">
<Job id="Monthly Report Distribution"”
description="Monthly Report Distribution"
processPriorityClass="Low"
smtpSendJoblog="true"
smtpServer="mail.cimslab.com"
smtpFrom="CIMSProcessResults@cimslab.com"
smtpTo="CIMSProcessResults@cimslab.com"
stopOnProcessFailure="false"
jobTogWriteToXMLFiTe="false"
JjobTogShowStepOutput="true"
JjoblogShowStepParameters="true"
active="true">
<Process id="Monthly Report Distribution"
description="Monthly Report Distribution"
buildProcessFolder="false"
JjobTogShowStepOutput="true"
JjobTogShowStepParameters="true"
active="true">
<{Steps>
<{Step id="Report Distribution"
description="Report Distribution"
type="Process"
programName="Batch Reporting\ReportDistribution.wsf"
programlype="wsf"
active="true">
<Parameters>
<{Parameter Cycle="Budget"/>
</Parameters>
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</Step>
</Steps>
</Process>
</Job>
</Jobs>

In the preceding job file example, only the required parameter Cycle is provided for the
ReportDistribution.wsf script. Table 4-2 describes the required and optional
parameters for the script.

Parameter Description/Values

Cycle (required) The name of the report cycle that you want to run.

DataSourcelD (optional) The ODBC data source or data source ID for the CIMS
Server database.

If you are using only one database with CIMS Server, do
not include this parameter. The data source selected in
the Select ODBC Data Source dialog box is used as the
data source (see To add a data source: on page 5-5).

If you are using multiple databases with CIMS Server,
enter the ID for the data source. The data source ID is
entered in the Data Source List Maintenance dialog box
(see Working With Data Source IDs on page 5-9).

Email (optional) This parameter is helpful in testing or other situations in
which you want to publish reports but do not want to
distribute the reports via e-mail or you want to send an
e-mail for reports that have already been published.

Valid values are:

B Trial. An e-mail message containing the reports is a
not sent, but the reports are published.

m Only. An e-mail is message is sent, but reports are not
published. The e-mail contains a link to the
previously published report.

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not included, this information does not appear in the
log file.

Table 4-2 « ReportDistribution Script Parameters
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Schedule CIMS Job Runner to Run the Job File

Once you have created a job file, you can schedule CIMS Job Runner to run the file using
Windows Task Scheduler as follows:

1 In Windows Control Panel, double-click Scheduled Tasks.
2 Double-click Add Scheduled Task.
3 The Scheduled Task Wizard appears. Click Next.

4 Click Browse to find the program CIMSJobRunner.exe, and then double click the
program. If you installed CIMS Server in the default location, this program is in
C:\Program Files\CIMSLab\Process Engine.

5 Type aname for the task or accept the default and click the schedule for the task. Click
Next.

6 Select the time and day to start the task, and then click Next.

7 Type the password for the user account under which you want the scheduled task to
run. The password cannot be blank. Click Next.

Note ¢ Make sure that the user account has a security permission of Full Contro]l
for the folder.

8 Select the Open advanced properties for this task when I click Finish check box,
and then click Finish.

9 In the Task tab, type following in the Run box where jobf7ilename.xml is the name of
the job file that you want to run:

"C:\Program Files\CIMSLab\Process Engine\CIMSJobRunner.exe" jobfilename.xm]

10 Click OK.

11 In the Set Account Information dialog box, type the password for the user account
again, and then click OK.

The task appears in the Scheduled Task list. To execute CIMSJobRunner . exe immediately,
right-click the task, and then click Run. For more information about Task Scheduler,
refer to the Microsoft documentation.
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Storing Published Reports Using the Published Folder Structure

B 4-32

The Published folder contains the following subfolders for storing published reports.
The folder in which a report is stored is specified by the CIMS Web end users if the report
is published from the CIMS Server Web Reporting Web site or is defined in the report
cycle if the report was produced in batch (see Creating a Report Cycle on page 4-13).

The security and access rights for the published reports differ depending on whether
users are accessing a published report from the Web site or directly from a link (see Folder
Permissions Required for Publishing and Viewing Batch Reports on page 4-34).

m user. This folder contains subfolders for specific users. Each subfolder name reflects
a CIMS user ID. The following is the structure for the user folder. Note that the
structure of the lowest two subfolders within the user folder is the same for the group,
account, and global folders.

PubTished\user\userid\periodpublished\reports (contains Crystal Reports)

Published\user\userid\periodpublished\spreadsheets (contains Excel
spreadsheets)

Published\user\userid\periodpublished\PDF (contains reports and spreadsheets
published as PDF files).

Published\user\userid\periodpublished\CSV (contains reports and spreadsheets
published as CSV files).

For example, user\Joan\200407\reports contains reports for the user Joan that were
published in July 2004 (if you are using the default periods in the CIMSCalendar
table).

Note ¢ Published reports in the PDF or CSV subfolders are not accessible from the
CIMS Server Web Reporting Web site.

m group. This folder contains subfolders for specific user groups. Each subfolder name
reflects a CIMS user group ID. The following is the structure for the group folder:

Published\group\groupid\periodpublished\<reports/spreadsheets/PDF/CSV>

For example, group\AP\200407\spreadsheets contains Excel spreadsheets for the
group AP that were published in July 2004 (if you are using the default periods in the
CIMSCalendar table).

m account. This folder contains subfolders for specific account codes. The following is
the structure for the account folder:

Published\account\accountcode\periodpublished\<reports/spreadsheets/PDF/
CSV>

For example, account\AABBCCC\200407\PDF contains reports and spreadsheets
published as PDF files for the account code AABBCCC in July 2004 (if you are using the
default periods in the CIMSCalendar table).

You cannot publish reports to this folder if you are using a report cycle.
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m global. Reports in this folder are for all users, groups, and accounts. The following is
the structure for the global folder:

Published\global\datepublished\<reports/spreadsheets/PDF/CSV>

For example, g1obal\200407\reports contains Crystal reports that were published in
July 2004 (if you are using the default periods in the CIMSCalendar table).

You cannot publish reports to this folder if you are using a report cycle.
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Folder Permissions Required for Publishing and Viewing Batch Reports

The following sections describe the folder permissions required for the person who is
publishing reports in batch mode and for the users accessing reports.

Permissions for Publishing Reports

To publish a report to a folder, the Windows account of the person who is
publishing the report must have a security permission of Full Control for the folder.

If the folder is shared and is on a server other than the server where you are running the
ReportDistribution.wsf script, the Windows account must also have a share permission
of Full Control. If you are using Windows 2000, the default is to assign Full Contro]
to the Everyone group. However, if you are using Windows XP with Service Pack 2 or
Windows 2003, the default is to assign only the Read permission to the Everyone group.

Security Requirements for Viewing Reports

The security for accessing published reports is dependent on whether a user is viewing
the report from the CIMS Server Web Reporting Web site or directly from a folder via a
link.

Web Site Security

If a user is accessing published reports from the Web site, the CIMS user ID that the user
logs on with determines which reports the user can view. For example, if the user Joan of
the group AP logs on to the Web site, the user can view reports in the
Published\user\Joan folder and the Published\group\AP folder. The user can also view
reports in any Published\group\account\accountcode folder if the account code for
which the folder is named is assigned to the AP group.

Folder Security

If a user is accessing a published report directly from a folder via a link, the permissions
set for the folder determines whether the user can view the report.

If the link is a UNC path, the Windows account must have a minimum security and share
permission of Read for the folder.

If the link is a URL path to a virtual directory with Windows authenticated access
enabled, the user's Windows account is used to determine whether the user can view a
report in a folder. The user's Windows account must have a minimum security
permission of Read for the folder.

If the link is a URL path to a virtual directory with Anonymous access enabled, the
Windows account IUSR_computername is used for all users. To enable users to access
reports using this account, the account must have a minimum security permission of
Read for all applicable folders.
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Creating a Virtual Directory for the Published Folder

Important! ¢ This section is applicable only if you are providing a URL link directly
to a published report. It is not applicable of you are providing a link to the CIMS
Server Web Reporting Web site.

If you are providing a URL link directly to a published report, you need to create a virtual
directory for the Published folder. CIMS Lab recommends that you create the virtual
directory under the CIMS Server Web Reporting Web site (usually Default Web Site) as
follows:

1 In Windows Control Panel, double-click Administrative Tools » Computer
Management.

2 Expand Services and Applications and navigate to Internet Information
Services » Default Web Site.

3 Right-click Default Web Site, and then click New » Virtual Directory.
The Virtual Directory Creation Wizard appears. Complete the wizard as follows:
a Click Next at the welcome screen.
b Type an alias for the virtual directory, and then click Next.
¢ Enter the path for the Published folder, and then click Next.

d When prompted for access permissions, CIMS Lab recommends that you click
only the Read access permission. You can optionally also click the Browse
permission if you want users to be able to browse the entire directory (i.e., the
entire contents of the Published folder) from a browser.

e Click Next and then click Finish to create the virtual directory.
The virtual directory appears below Default Web Site.

4 Right-click the virtual directory, and then click the Directory Security tab in the
properties dialog box.

5 In the Anonymous access and authentication control area click Edit. The
Authentication Methods dialog box appears

6 Click Anonymous access or Integrated Windows access (see Folder Security on
page 4-34).

7 Click OK until the properties dialog box closes.
8 Restart IIS (see page 7-4).

For additional assistance, consult your IIS administrator.

CIMS Server Administrator's Guide 4-35 N



B Report Administration
Working With Batch Reporting/Published Reports

Drilling Down in Published Reports

A key feature of CIMS Server Web Reporting is the ability to drill down on items in a
report to view more detailed information.

Depending on the report, you can drill down on items in reports published as a Crystal
report or as a PDF document. Drill down is not available for CSV files for spreadsheets
regardless of the format in which the spreadsheet is published.

If a report is published as a PDF, it is not accessible via the CIMS Server Web Reporting
Web site and does not have all of the drill down options that are available from the Web
site.

However, if the cursor icon becomes a hand {b when the user points to an item in a PDF
report, the user can drill down on that item. In this case, the applicable page on the CIMS
Server Web Reporting Web site is opened to allow drill down.

For more information about drilling down in reports, including drill down options by
report, refer to the CIMS Server Web Reporting User’s Guide.
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This chapter describes how to use CIMS Server Administrator to create and administer
CIMS Server databases.
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Creating a Database

You might have already created a database using the steps in Getting Started on
page 2-30. However, you can use more than one database with CIMS Server. For
example, you might have a production database and a development database. The
following sections provide steps for creating additional databases in Microsoft SQL
Server or MSDE.

Note ¢ Consult your SQL Server DBA for further assistance in creating a database.

Creating a Database in Microsoft SQL Server 2000
To create a database in SQL Server 2000:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » computername » Databases.

3 Right-click the Databases folder, and then click New Database.

4 In the Database Properties dialog box, enter the configuration information for the
new database as follows:

¢ On the General tab do the following:

¢ In the Name box, type a name for the database. The name CIMSServer is used in
this guide, but you can use any name.

¢ In the Collation name box, click SQL_Latinl_General_CP1_CI_AS. Make sure
that you select only this database collation type and not a type that looks
similar. CIMS Server currently does not support other collation types.

e Unless you need to change the default settings for the database, you do not need
to reset values in the Data File or Transaction Log tabs.

5 Click OK when you are finished.

Creating User Logins for the Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. After you create the database,
you need to create database logins for these users as described in To create a user login: on
page 2-35.
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Creating a Database in MSDE 2000

When you install MSDE 2000, a default master database (master.mdf) is created. You can
use this database “as is”.

To create additional MSDE databases, use either the OSQL or ISQL command-line
interface as follows. Press <Enter> after each command.

1 At the command prompt, log on to the database server. For example:
osql -S servera-test -E

Where -S servera-test indicates the server name and -E indicates use a trusted
connection. Note that there are other switches that you may have to use depending
on your environment. For example, you may have to specify the login ID (-U) and
password ( -P) switches. To view the OSQL switches, type osql /? at the command
prompt.

2 At the 1> prompt, type:

create database database name

Where database name is the name that you want to give the database.
3 At the 2> prompt, type:

go

The following messages appear:

The CREATE DATABASE process is allocating 0.63 MB on disk ‘database name .
The CREATE DATABASE process is allocating 0.49 MB on disk 'database name_log .

4 Atthe 1> prompt, type:
quit

The database is created in C: \Program Files\Microsoft SQL Server\MSSQL\Data (if you
installed CIMS Server, including MSDE, in the default location). This is also the location
of the master database. You should include the Data folder in your backup schedule.

Creating a Data Source and Initializing the Database

Once you have created a database, do the following:

1 Create an ODBC data source for the new database and select the data source (see To
add a data source: on page 5-5 and To select a data source: on page 5-6).

2 Perform the steps in Set Up CIMS Server on page 2-36 (i.e., initialize the database,
enter the configuration settings, etc.).

WARNING - Before you initialize the database, make sure that you have selected the
correct database by clicking Show Connection Information in the CIMS Server
Administrator main window. Initializing overwrites any existing data in a database.
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Backing Up and Maintaining Databases

It is extremely important that you back up your CIMS Server database(s) so that you can
recover your data in case of media failure or natural disaster. CIMS Lab recommends that
you back up your database(s) weekly and that you back up to a different server at another
site.

CIMS Lab also recommends that you use the Database Maintenance Plan feature
included with SQL Server to schedule and perform backup up and maintenance tasks for
databases. To use this feature:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » computername » Management » Database Maintenance Plans.

3 Right-click Database Maintenance Plans, and then click New Maintenance Plan.

4 Follow the steps provided in the Database Maintenance Plan Wizard.

Setting the Database Recovery Model

CIMS Lab recommends that you change the SQL Server recovery model from Full, the
default, to Simple.

Full recovery allows the database to be recovered to the point of failure. Simple recovery
allows the database to be recovered to the most recent backup. Because any lost data can
be recovered and reloaded from the CIMS Server Resource (CSR) or CIMS Server

Resource Plus (CSR+) files, the benefit offered by the Full recovery is not as beneficial as
the smaller SQL Server log file size and disk space savings provided by Simple recovery.

To set the database recovery model.:

1 In Enterprise, navigate to the database that you want.

2 Right-click the database, and then click Properties.

3 On the Options tab, click Simple in the Recovery Model list.
4 Click OK.
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Managing ODBC Data Sources

Note ¢ To use multiple databases with CIMS Server, you need to create an ODBC data
source for each database as described in this section and then create an ID for each
data source as described in Working With Data Source IDs on page 5-9.

To access the databases that you create for CIMS Server, you need to add an ODBC data
source for each database as described in this section.

If you created one login for the database or created separate logins that use the same
authentication method (i.e, Windows or SQL Server), only one data source is required
for the database.

If the database has both Windows and SQL Server authenticated logins (for example, the
CIMS Server administrator uses Windows authentication and the CIMS Server Web
Reporting end users use SQL Server authentication), you need to add a separate data
source for each login.

To add a data source:

1 In the CIMS Server Administrator main window, click Select ODBC Data Source.
The Select ODBC Data Source dialog box appears.

2 Click ODBC Data Source Administrator.
The ODBC Data Source Administrator dialog box appears.

3 Click the System DSN tab.

4 Click Add and follow the steps provided by the DSN creation wizard to add the data
source. Consult your SQL Server DBA to determine the settings that you should select
in the wizard. Note the following:

e The wizard prompts you with the following: How should SQL Server verify the
authenticity of the login ID? Click the correct authentication method (Windows
or SQL Server). If you select SQL Server authentication, enter the SQL Server user
ID and password in the Login ID and Password boxes. If there are multiple SQL
Server logins for the database, you can use the ID and password for any of the
logins.

e For Internationalization Only. To select the language for the data source other
than the default language, select the Change Language of SQL Server Messages
to check box and click the language that you want from the list.

Important! « Do not select the Use regional settings when outputting currency,
numbers, dates, and times check box (the default for this check box is
unselected). CIMS Server does not support this option. Regional settings are
supplied by the regional options for the user logged on to the computer (see
Internationalization Setup on page 2-11).
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5 When the wizard completes, click Test Data Source to make sure that the
configuration was successful, and then click OK until the Select ODBC Data Source
dialog box closes. Note that when you add a data source, it does not appear in the
Select ODBC Data Source dialog box until you close and re-open the dialog box.

6 Click Select ODBC Data Source again, click the new data source, and then click OK.

7 Perform the steps in Set Up CIMS Server on page 2-36 (i.e., initialize the database,
enter the configuration settings, etc.).

To edit a data source:
1 Double-click the data source.
2 Follow the steps in the DSN configuration wizard to edit the data source.

3 When the wizard completes, click Test Data Source, and then click OK until the
wizard closes.

To select a data source:

In the Select ODBC Data Source dialog box, click the data source, and then click OK.

If the data source requires a SQL Server ID and password, type the ID and password in
the User ID and Password boxes of the Select ODBC Data Source dialog as shown in
example Figure 5-1.

ans Select ODBC Data Source

Wigw

Machine: | J

System Data Sources:

| Data Source Mame | Data Type

[ User Infa]

Uszer I zims Pazsword: [saee

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 5-1 « Select ODBC Data Source Dialog Box With ID and Password
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To remove a data source:

Important! < Before you remove a data source, make sure that the data source is not
used for any of the purposes specified in Working With Data Source IDs. For example,
you are using multiple databases for Web reporting.

1 Follow Steps 1 through 3 in To add a data source: on page 5-5.
2 Click the data source that you want remove, and then click Remove.

3 Click OK until the Select ODBC Data Source dialog box closes.
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About Data Source IDs

If you have created multiple data sources for use with CIMS Server, you need to create
IDs for the data sources. Data source IDs enable the CIMS Server Web Reporting Web site
and CIMS Data Collectors to identify and use the correct data source.

A key benefit of data source IDs is that they store the SQL Server user password for the

data source (if applicable) in an encrypted format. CIMS scripts then use the data source
ID, which includes the password, as a parameter. This protects the password from being
viewed because you do not need to include the password as a separate script parameter.

The number of IDs that you need to create for a data source depends on the number of
logins that have been created for the database and the type of logins. Table 5-1 shows the
different database login configurations that might be used and the data source(s) and
data source ID(s) required for each configuration.

ODBC Data

Database Login(s) Source(s) Data Source ID(s)

One login (Windows or SQL » One data source. 4 One data source ID.
Server authentication).

(This is a common
configuration.)

x number of SQL Server 4 One data source. » Separate data source IDs
authenticated logins. for each login.

(This is a common For example, if you
configuration.) have one login for the

the CIMS Server
administrator and one
login for the Web
reporting end users, you
need to create two data
source IDs for the same
data source. The data
source IDs store the SQL
server ID and password
for each login.

x number of SQL Server 4 Onedatasourcefor » Separate data source IDs
authenticated logins. the SQL Server for each login.
authenticated
logins.
And
y number of Windows > Onedata sourcefor » One data source ID for
authenticated logins. the Windows all logins.
authenticated

(This configuration is

uncommon.) logins.
y number of Windows 4 One data source. 4 One data source ID for
authenticated logins. all logins.

(This configuration is very rare.)

Table 5-1 « Possible ODBC Data Source and Data Source ID Configurations
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You must also create a data source ID for any data source associated with a CIMS Data
Collector. For example, to collect data from a Citrix database, a data source and data
source ID must be created for the database. For the requirements for each data collector,
refer to the CIMS Data Collectors for Microsoft Windows Installation and User Guide.

Important! ¢« CIMS Server Administrator provides an option to set a default data
source ID (see Setting a Default Data Source ID on page 5-10). If you have data source
IDs for both CIMS and non-CIMS databases, make sure that you set the ID for a CIMS
database as the default. This will ensure that the CIMS Server Web Reporting Web site
and CIMS Data Collectors are not pointing to a database that does not contain CIMS
Server data.

How Is a Data Source ID Selected?

The data source ID that is used by the CIMS Server Web Reporting Web site and CIMS
Data Collectors is determined in the following order:

m If multiple data source IDs are set in the Data Source List Maintenance dialog box, the
ID set as the default is used (see Setting a Default Data Source 1D).

Or

If a single data source ID is set in the Data Source List Maintenance dialog box, that
ID is used.

m If there are multiple data source IDs and there is no default ID set or there are no data
source IDs, the data source selected in the Select ODBC Data Source dialog box is
used.

Working With Data Source IDs

To add a data source ID:

1 In the CIMS Server Administrator main window, click System Administration »
Data Sources.

The Data Source List Maintenance dialog box appears.
2 Click Add.

3 In the Add Data Source dialog box, type an ID for the data source, and then click OK.
For convenience, you might want to use the data source name as the ID. For example,
if the data source name for the database is CSDEV, you can also use CSDEV as the ID.

The Select ODBC Data Source dialog box appears.
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4 Click the data source that you want to assign the ID to (if the data source does not
appear, add the source as shown in To add a data source: on page 5-5), and then do
one of the following:

¢ If the data source does not require a SQL Server user ID and password, click OK.

e If the data source does require a SQL Server user ID and password, type the ID and
password in the User ID and Password boxes, and then click OK.

Note ¢ If additional parameters are required to enable connection to the
database, type the parameters in the Additional Parameters box. For more
information, consult your SQL Server DBA.

5 Repeat these steps for each data source ID that you want to add. (For an example of
a configured Data Source List Maintenance dialog box, see Figure 5-2 on page 5-11.)

To edit a data source ID, user ID, and password:

1 Click the data source ID, and then click Edit.

The Select ODBC Data Source dialog box appears.

2 Edit the data source user ID, password, or parameters or click ODBC Data Source
Administrator to change the data source configuration settings as shown in To edit a
data source: on page 5-6.

To remove a data source ID:

Click the data source ID, and then click Remove.

Setting a Default Data Source ID

You can set one data source ID as the default ID to be used by CIMS Server Web
Reporting and CIMS Data Collectors.

This option is required if you are using multiple databases for CIMS Server Web
Reporting. For more information, see Using Multiple Databases for CIMS Server Web
Reporting on page 5-11.

This option is also required if you have created data source IDs for both CIMS Server
databases and for databases that you are collecting data from using CIMS Data
Collectors. In this situation, you need to make sure that a CIMS Server database is set as
the default.

To set a data source ID as the default:

Click the data source ID, and then click Set as Default.
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Using Multiple Databases for
CIMS Server Web Reporting

There are two scenarios for using multiple databases for Web reporting:

m One Web server with one virtual directory. This scenario allows you to point your
Web site to the default database set in CIMS Server Administrator. You can change the
default database as needed and then update CIMS Server Web Reporting to connect
that database.

B One Web server with multiple virtual directories. This scenario allows you to access
multiple databases without changing the settings in CIMS Server Administrator. You
can access multiple databases during a CIMS Server Web Reporting session by
creating individual virtual directories for each database other than the default
database.

Both scenarios can be used for development, testing, and upgrade purposes. However,
the second scenario is more commonly used.

To use one Web server and one virtual directory:

1 In the CIMS Server Administrator main window, click System Administration »
Data Sources.

The Data Source List Maintenance dialog box appears.

2 Click the ID for the database that you want to use, and then click Set As Default. See
example Figure 5-2.

ans Site Data Source List Maintenance

Wigw

Machine: | (LoCAL) j

| Data Source D | Data Source MName | Uszer ID | Parameters
CIMServer CIMSServer
CSDeyv

A | Remave | Ediit | Set az Default

Figure 5-2 « Data Source List Maintenance Dialog Box—Set As Default
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4

Click Upgrade Configuration on the Edit Configuration page of CIMS Server Web
Reporting or restart IIS. The correct data source should appear in the ODBC DSN field
on the Edit Configuration page.

Repeat this procedure each time you want to use a different database.

To use one Web server and multiple virtual directories:

A typical configuration for multiple virtual directories is one in which the default
directory is pointing to the production database and another directory is created to point
to a development database. Using this scenario as an example:

1

In CIMS Server Administrator, set the production database as the default data source
(see the steps in To use one Web server and one virtual directory: on page 5-11).

In Windows, copy the CIMS Web folder and its contents to create a Web site that will
point to the development database. If you installed CIMS Server in the default
location, the Web folder is in C:\Program Files\CIMSLab\Server.

In the new folder, do the following:

e Open the WebReportingDataSource.asp file and enter the data source ID for the
development database as follows:

Application("WebSiteUID") = "UID" (where UID is the data source ID for the
development database [see To add a data source ID: on page 5-9]).

e Expand the CIMSReporting subfolder. Right click the data subfolder and assign
Read, Write, and Modify permissions for the following user:

e computername\ASPNET (Windows 2000 or XP)
Or
e NT AUTHORITY\NETWORK SERVICE (Windows 2003)

In IIS Manager, create a virtual directory that points to the development Web site
folder. For assistance, consult your IIS administrator.

Expand the new virtual directory and do the following:

a Right-click the CIMSReporting folder, and then click Properties.
b Click the Create button next to the Application name box.

¢ Click OK when you are finished.

To access the database that you want, enter the address that points to the virtual
directory for that database in the Address bar of the browser. For example, http://
Serverl/development.

Important! ¢ The files and subfolders in the Web folder might change from one
CIMS Server release to the next. If you upgrade to a new release of CIMS Server, you
need to delete all Web site folders that you have created and repeat Step 2 and Step 3.
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Managing Database Tables

CIMS Server Administrator includes many powerful tools for managing database tables
used with the CIMS Server system. You can easily create, drop, load, export, and view
database tables.

About Exporting, Loading, Dropping, and Creating Tables

The following is a description of the drop, create, export, and load functions used for
database tables:

m Exporting a table from the database creates a comma-delimited text file with the same
name as the table, but does not remove the table or its data. Exporting a table is useful
as a means of backup—the file can be reloaded into the database.

B Loading a table into the database first deletes all data currently in the table and then
loads the table from the file in the directory that you specify. You can load files that
were previously exported from the database or you can load files from another source
such as a mainframe file.

The file must have the same name as the table (e.g., CIMSRate. txt for the CIMSRate
table) and must contain the following:

e The table column heads in the first record of the file.

e All required fields for the table provided in comma-delimited format. To
determine whether a field is required, view the table properties in SQL Server
Enterprise Manager. All fields that do not have the Null check box selected must
be included in file.

For an example of the required format for a file, you can export the table to a file. For
a description of the fields in the file, see the applicable table description in
Appendix A, Database Tables.

WARNING - Extreme caution should be used when loading a table. Deleting or
overwriting data can cause unexpected results. Be sure a backup exists before
performing this procedure.

m Dropping a table removes the table and its data from the database. You should consult
CIMS Lab before dropping a table (see Contacting Technical Support on page 7-10).

m Creating a table creates the table with no data in the database after the table is
dropped.
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Loading and Exporting Tables

To load or export a table:

1 In the main CIMS Server Administrator window, click System
Administration » Database » Database Table.

The Database Table dialog box appears as shown in Figure 5-3.

@44 Database Table Manager

Tools  Wiew

[ Select Takbles |

Tahle Exists in Databaze | Owner  #

At - Client Yes dhao Create selected tables
O it - Rate Yes dho
O Aucit - Transaction Yes dho Drop selected tables
D Calendar Yes dbo
O cliert Yes dho
O cliert Bucget ves dba Load selected tables
D CI!ent Contact Ves too Export selected tables
D Client Contact Mumber Yes dbo

D Configuration - General Yes dbo
D Configuration - Account Levels Yes dbo
O cPU Mormalization Yes dho
D Configuration Options Yes dbo
M Detail Yes dbo b

Ohiject Prefic: Select all tables

Figure 5-3 « Database Table Dialog Box

Note * CIMS Lab strongly recommends that you leave dbo. in the Object Prefix
box. This prefix sets the owner of the tables to dbo in SQL Server allowing any
authorized database user to view the tables.

2 Toload atable, select it in the list of tables. To select all table check boxes, click Select
all tables. Note that the ability to select all tables is dependent on the privileges
assigned by the SQL Server DBA.

3 Click Load selected tables or Export selected tables. A dialog box appears,
prompting you to select the location that you want to load tables from or export
tables to. Select the correct folder, and then click OK.
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Loading and Exporting Client and Rate Tables

The most commonly exported and loaded tables are the CIMSClient and CIMSRate
tables and their related tables. You can export and load these tables from the Database
Table or you can use the Chargeback Tables dialog box. This dialog box includes only
client and rate-related tables.

Note ¢ You can also use the Table.wsf script to load the CIMSClient and CIMSRate
tables in batch. For more information about this script, see Table.wsf Script on
page C-26.

To load or export a client or rate table:

1 In the main CIMS Server Administrator window, click Chargeback
Administration » Chargeback Table Maintenance » Table.

The Chargeback Tables dialog box appears.

2 Select the tables that you want to export or load as shown in example Figure 5-4.
(Note that if you select Client or Rate, all related tables are selected by default. You
can clear those tables that you do not want.)

@42 Chargeback Tables |:|[E| g|

Wigw

[ Select Takbles |

v Clierit W Rate:

¥ Cliert Budget ¥ Rate Group
[v Client Contact [v Rate To Rate Group
[v Client Contact Mumber Iv Rate Shift

Export Selected Tables Load Selected Tables | Close |

Figure 5-4 « Chargeback Tables Dialog Box

3 Click Export Selected Tables or Load Selected Tables. A dialog box appears,
prompting you to select the location that you want to load tables from or export
tables to. Select the correct folder, and then click OK.
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Creating and Dropping Tables

To create or drop a table:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Table.

The Database Table dialog box appears.

2 Select the table(s) you want to create or drop. To select all tables, click Select all
tables.

3 Click Create selected tables or Drop selected tables. A confirmation message
appears. Click Yes.

Converting Daily Summary Tables to a Monthly Summary Table

You can consolidate your daily CIMS Summary records so that data is stored in an
aggregated monthly record. This consolidation minimizes storage (there is typically a 90
percent or greater reduction in records) and decreases the time required to generate
monthly reports. A drawback to this consolidation is that you cannot run costed daily
reports against the CIMSSummary table.

To perform the consolidation process, use the ConvertSummaryDailyToMonthly.wsf
script. For more information about this script, see page C-9.

Important! ¢ You should consult CIMS Lab before using this script (see Contacting
Technical Support on page 7-10).

Updating the Rate Identifiers Table

A key feature of viewing invoices in CIMS Server Web Reporting is the ability to drill
down on the units consumed for a resource by identifier. This feature uses the
CIMSRateldentifiers table, which contains the rate codes that are processed from the CSR
or CSR+ files and correlates them to their corresponding identifier names in the
CIMSIdent table.

If the identifiers in the CSR or CSR+ files have changed and/or a rate code or codes in the
resource files have changed, the CIMSRateldentifiers table will retain unused data in
addition to the current data. Although this does not cause processing problems, the table
can accumulate a large amount of data. To update the table so that it contains only the
current data, in the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Update Rate Identifiers.
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Viewing Tables

To view tables, in the CIMS Server Administrator main window, click System
Administration » Database » Table Viewers » Table Name.

Note * To view other details about a table, see Managing Database Objects on
page 5-18.
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Managing Database Objects

WARNING - Certain reports are dependent on database objects. Dropping or altering
database objects could disable these reports.

In addition to tables, there are three types of database objects in CIMS Server:

m Views. Each view is essentially a saved SQL statement that performs a query that
allows the system to generate a report or reports.

m Stored Procedures. Each procedure is set of SQL statements that can perform both
queries and actions that allow the system to generate a report or reports. Stored
procedures can accept parameters at runtime, whereas views cannot.

m Indexes. These are files that contain the SQL statements that define how a table index
is created. A table index allows the database program to find data in a table without
scanning the entire table. There can be multiple indexes per table or no index at all.

All three types of database objects are XML files. The standard database objects that are
included with CIMS Server are located in C:\Program Files\CIMSLab\Admin\
DBObjects\Standard (if you installed CIMS Server in the default location). You can also
create custom objects and store them in the Custom folder. If you create a custom object
with the same name as a standard object, CIMS Server uses the custom object.

Creating and Dropping Database Objects

You can create or drop (completely remove) standard or custom database objects in the
database.

To create or drop database objects:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Objects.

The Database Objects Maintenance dialog box appears as shown in Figure 5-5 on
page 5-19.
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1{ Database Objects Maintenance

Wigw

Object Location:  |standard - Object Type: |AII j
Definition File | Type “ersion | Exists | Cvner | Description #
D CIMSSp_Account_Summary Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_AuditClient Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_AuditClientContact Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_AuditClientContacthumber Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_AuditRate Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_AuditTransaction Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_BATCH Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_CAP1 Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_CICS Procedure  01.000000 Yes dbo Implemeritst
DCIMSSp_ConvertSummaryDainToMonthly Procedure  01.000000 Yes dbo Implemeritst
D CIMZSp_DB2 Procedure  01.000000 Yes dbo Implemeritst
D CIMZSp_Detail_by_RateGroup Procedure  01.000000 Yes dbo Implemeritst
<|_| CIMSSn Detail by RateGroon Idertifier Procedure 01 ODOOON. Yes rbhn Imnlﬁmﬁrﬂ)ﬂt b,
COhject Prefix: '7 C:\Pragram Files\CIMSLab\&dminDBObjects\Standard

Select Al Drop Selected Ohjects | Create Selected Ohjects |

Figure 5-5 « Database Objects Maintenance Dialog Box

Note ¢ CIMS Lab strongly recommends that you leave dbo. in the Object Prefix
box. This prefix sets the owner of the objects to dbo in SQL Server allowing any
authorized database user to view the objects.

2 In the Object Location list, click the location of the database objects that you want to
create or drop (i.e., the Standard or Custom folder).

3 In the Object Type list, click the object type (Index, Stored Procedure, or View) or
accept the default (All).

4 Select the object(s) that you want to create or drop. To select all object check boxes,
click Select All.

5 Click Create Selected Objects or Drop Selected Objects. A confirmation message
appears. Click Yes.

Note ¢ If the user ID that you are using to access the database does not have
sufficient system administration authority, you might not be able to create
database objects or to create objects with the appropriate permissions. In this
situation, a warning message appears recommending that you contact your
database administrator or CIMS Lab before continuing.

To confirm that an object exists in the database, make sure that Yes appears in the Exists
column for that object.
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Loading, Archiving, and Purging the Database

This section provides the procedures for loading, archiving, and purging the CIMS Server
database using the CIMS Server Administrator. You can also perform much of the
functionality described in this section via scripts as described in Appendix C, Scripts.

Loading the Database

B 5-20

If you are using CIMS Data Collectors for Windows, Mainframe, or UNIX, the batch
collection process automatically creates the Ident, Detail, and Summary files used for
reporting and loads them into the CIMS Server database on a defined schedule (daily,
monthly, etc.). For more information about scheduling data collection for CIMS Server,
refer to the CIMS Data Collectors for Microsoft Windows Installation and User Guide.

However, for testing and debugging purposes, you might want to load an individual file
or files into the database. You can load files from the Edit Process definition dialog box
(see CIMS Server Administrator Processing on page 6-17) or you can use the dialog boxes
described in the following sections.

Note ¢ If you receive a warning stating that a file with the same date range has
already been loaded, you are probably loading duplicate data. You can click Yes to
continue to load the data, but you should delete the previous load immediately after
the current load is completed (see Tracking the History of Database Loads on page 5-25).

Loading from CIMS Server

This section describes how to load Ident, Detail, and Summary files into the CIMS Server
database. Note that this process is normally not required because the files are
automatically loaded at the end of batch processing.

To load a database from CIMS Server:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » From CIMS Server. The CIMS Server File
Load dialog box appears as shown in example Figure 5-6.

ans CIMS Server, File Load

Wigw

[ CIMS File Type ]

(* jdert: " CIMSACCT Detail CIMSBILL Detail " Summary

[ File Infarmeation |

File: Mame: |

Wiewy File Select File ...

Destination:  CIMSServer

Jv Use bulk load interface

Load Data | Close |

Figure 5-6  CIMS Server File Load Dialog Box
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2 Complete the dialog box as follows:

e CIMS File Type. Click one of the following:

Ident. This file is created by CIMSACCT. This is the identification file that
contains fields such as User ID, department code, division code, server name,
etc. These fields are used during account code conversion to create your account
code structure.

CIMSACCT Detail. This file is created by CIMSACCT. This file provides an
account code for each input file record processed. This file is used as an input
into CIMSBILL. You will rarely need to load this file.

CIMSBILL Detail. This file is created by CIMSBILL. This file is loaded into the
database for use in the drill down reports. This file contains resource utilization
data.

The CIMSBILL Detail file differs from the CIMSACCT Detail file in that the
CIMSBILL Detail file reflects any proration, CPU normalization, or include/
exclude processing that was performed. The CIMSBILL Detail file also includes
accounting dates.

Summary. This file is created by CIMSBILL. This file contains summarized usage
records with applied rates. You can load any number of Summary files
individually.

For more information about these files, see Chapter 6, Processing Data.

¢ File Name. Enter the path of the database file that you want to load. To browse for
a file, click Select File. To view the file in Windows Notepad, click View File.

e Use Bulk Load Interface. Select this check box to perform a bulk load when
loading the database. This option is recommended because it increases the speed
of loads. A disadvantage is that if there is an error in the data, a generic rather than
specific error message appears. In this case, clear this check box and reload to view
the specific error message.

3 C(Click Load Data.

Loading from CIMS Mainframe or CIMS Desktop

The CIMS Mainframe File Load and CIMS Desktop Table Load dialog boxes are provided
for legacy purposes only. Consult CIMS Lab before using these dialog boxes (see
Contacting Technical Support on page 7-10).
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Archiving and purging database loads is a powerful feature that enables you to remove
space and performance consuming data from the database and to store the data in
compressed zip files. You can then easily restore the archived data to the database if
needed.

Archiving, purging, and restoring loads in the database are defined as follows:

B Archive. Saves selected CIMS Summary, CIMSBILL Detail, CIMS Ident, and/or
CIMSACCT Detail loads in a format that you can reload (restore) into the database.
Archiving does not delete the load from the database.

m Purge. Deletes selected loads from the database.

m Restore. Reloads selected purged loads into the database. To use this feature, the
loads must be archived.

You can archive loads, archive and purge loads, or purge loads without archiving them.
To view a history of the loads that have been archived or purged (deleted), see Tracking
the History of Database Loads on page 5-25.

Note ¢ You can also use the Purgeloads.wsf script to purge loads in batch. However,
you should contact CIMS Lab before using this script because it does not archive the
loads before purging them (see Contacting Technical Support on page 7-10). For more
information about this script, see Purgeloads.wsf Script on page C-16.

To archive database loads:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Load Archiving & Purging.

The Load Archive dialog box appears as shown in example Figure 5-7 on page 5-23.
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=3 | pad Archive

Wigw

[ Loads Fitter]

End Date Range: [Use &1 Dates =] || e | =]
Load Types: ¥ Summary [ CIMSBILL Detail W ldert ¥ CIMSACCT Detail
Source File Location: ‘A\I j Apply Fiters
[ Show Archived Loacds
Archive ] Restore 1 Purge 1
[ Matching Loads -9
CProgram Fi ol ] 3F
000000021 Ident C:'Program FilesiCIMSLab\Sample Processes\2E3900dent txd 3
000000013 Sumimary CProgram FilesiCIMSL: ple Procs ebiBillSummary tx 3
000000014 CIMSBILL Detail  C:'Program FilesiCIMSLabiSample ProcessesMSIS- Wk BillDetail 3F
00000001 5 Icent C:'Program FilesiCIMSLab\Sample Processes\WSIS-YWebildent txd 3
000000010 Sumimary C'Program FilesiCIMSLabiSample Processes\CIMSWinEventLogBilSummary B 534
000000011 CIMSBILL Detail  C:'Program FilesiCIMSLab\Sample Proceszes\CIMEWinEventLog Bil Detail 3
000000012 Ickent CProgram FilesiCIMSLab\Sample Processes\CIMSWIinEventLogident txt 3
< >
Archive Storage Path: CProgram FilesiCIMSLab W dminirchive CIMSServer
Select &1 ‘ Archive |
™ Purge loads after archiving

Close

Ready

Figure 5-7 « Load Archive Dialog Box

2 Inthe Loads Filter area, set the following filters. These filters determine the loads that
appear on the Archive tab. For example, you can select only CIMSBILL Detail loads
or only those loads with end dates that are in a certain date range.

¢ End Date Range. Loads are selected by the end date stored in the
CIMSLoadTracking table. Click Use All Dates, Use Specific Dates, or a date
keyword to select loads with end dates that fall within the specified date range. For
example, if you click Current Month, loads with end dates in the current month
are selected. If you select Use Specific Dates, enter the dates in the from/to boxes.

e Load Types. Select the check box or boxes for the load types that you want to
archive. These are the loads created by CIMS Processing Engine. For more
information, see Chapter 6, Processing Data.

¢ Source File Location. Click All to select loads from all applicable process
definitions or click a specific process definition (see CIMS Server Administrator
Processing on page 6-17).

e Show archived loads. Select this check box to show loads that have been archived.
This filter appears only when the Archive tab is active.

3 Click Apply Filters to retrieve the loads that match the filter criteria. (Note that you
need to click Apply Filters each time that you change the filter settings.)
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4 If you want to purge the loads after they are archived, select the Purge loads after
archiving check box.

5 On the Archive tab, click the load or loads that you want to archive or click Select All
to archive all loads, and then click Archive.

The archived loads are stored in a Zip file in the folder specified on the Archiving tab of
the Configuration dialog box (see Database Load Archive Settings on page 3-53). The
naming convention for the Zip file is CIMSArchive_StartDate EndDate_
SequenceNumber.zip.

Important! ¢ Ifyou initialize a database, you should delete any archived files for that
database. Errors can occur if you try to reload these files to the originating database
or another database.

To purge database loads:

Important! « Purging removes database loads from the database. If the loads are not
archived before they are purged, you cannot restore the loads to the database.

To purge loads automatically after they are archived, click the Purge loads after
archiving check box on the Archive tab.

To purge loads independently of archiving:

1 Setand apply the filters for the loads that you want to purge as described in To archive
database loads: on page 5-22.

2 On the Purge tab, click the load or loads that you want to purge or click Select All to
purge all loads, and then click Purge.

To restore database loads:

1 Setand apply the filters for the loads that you want to restore as described in To archive
database loads: on page 5-22.

2 Onthe Restore tab, click the individual load or loads that you want to restore or click
Select All to restore all loads, and then click Restore.
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Tracking the History of Database Loads

You can track the history of CIMS Summary, CIMSBILL Detail, CIMS Ident, and
CIMSACCT Detail files that have been loaded to and/or deleted from the database.

To track loads:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Load Tracking.

The Load Tracking dialog box appears as shown in example Figure 5-8.

=49 Load Tracking

View  Edit

Fiters Loads ]

Matching Loads: 9

Load ID | Load Type

g Summary g 0

20 CIMSBILL Detail  ©S5390 3MEB2004  3M802004 580 302202004 10:45:18 &AM
| Ident Q5380 3MEB2004  3M802004 216 32202004 10:45:18 &AM
13 Summary MSIS-ieh 3MEB2004  3M802004 6 32202004 10:4217 &AM
14 CIMSBILL Detail  MSIS-Veh 3MEB2004  3M802004 278 32202004 10:4217 &AM
15 Ident MSIS-ieh 3MEB2004  3M802004 1958 32202004 10:42:18 &AM
10 Summary CIMSWinEventLog  3M8/2004 34852004 2 32202004 10:42:10 &AM
(A CIMSBILL Detail  CIMSWinEventLog 31572004 3018/2004 6 32202004 10:42:11 AW
12 Ident CIMSWinEventLog  3M8/2004 34852004 18 32202004 10:42:11 &AM

£ >

Delete Load Select Al | Wiewy Load |

Close

Figure 5-8 + Load Tracking Dialog Box

2 Use the Loads tab to track the files that have been loaded to the database. This tab
provides information such as the type of files loaded, the earliest accounting start date
and the latest accounting end date in the files, the date the files were loaded to the
database, and whether the files have been archived. You can delete and view loads as
follows:

¢ Delete Load. To remove a load or loads from the database, click the load(s) or
click Select All to select all loads, and then click Delete Load.

¢ Delete Load Entry. To remove a deleted load or loads from the database, click the
load(s), and then click Delete Load Entry. Deleted loads appear when using the
Show deleted loads filter on the Filters tab.

e Select All. To select all loads, click Select All.

e View Load. To view a load, click the load, and then click View Load.
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3 Use the Filters tab to determine the loads that appear on the Loads tab. For example,
you can choose to track only CIMSBILL Detail file loads or only files that were loaded
during a certain date range.

Load Types. Select the check box or boxes for the load types that you want to view.
These are the loads created by CIMS Processing Engine. For more information, see
Chapter 6, Processing Data.

Source File Location. Click All to view loads from all applicable process
definitions or click a specific process definition (see CIMS Server Administrator
Processing on page 6-17).

End Date Range. Loads are selected by the accounting end date of the data in the
loads. (Note that CIMSACCT Detail loads are selected by the usage end date.)
Click Show All Dates, Use Specific Dates, or a date keyword to select loads with
end dates that fall within the specified date range. If you select Use Specific Dates,
enter the dates in the from/to boxes.

Date Loaded Range. Click Show All Dates, Use Specific Dates, or a date keyword
to select loads that were loaded within the specified date range.

Show deleted loads. Select this check box to view loads that have been deleted.

Apply Filters. Click this button to view the loads that match the filter criteria.
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Profiling the Database and Tables

You can view profiles of the database and tables. These profiles provide detailed
attributes of the data.

To view profiles of a database or table:

1 In the CIMS Server Administrator main window, click System

Administration » Database » Database Profiler.

The Database Profiler dialog box appears.

2 Under Database, you can navigate to view attributes of the database. Under Tables,
you can navigate to a specific table and view Dates (created or modified), Columns,
Indexes, or Properties information. See Figure 5-9.

an Database Profiler

T

T

F- - - F-F-E - - - E -

Connection
S0L Server Detailz

= Tables (41]

CIMSCalendar
CIMSClient
+- Dates
+--Columns (14)
= Indexes (3]
+ P __CIMSClient__G7FEGS14
+o D _CLNT_ACCTHAME
+ D _CLMT_ALTCODE
Properties (1)
CIMSClientBudget
CIMSClientContact
CIMSCliertContacthlumber
CIMSConfig
CIMSConfigdoccountLevel
CIMSConfigOptions
CIMSCPUNormalization
CIMSDetail
CIMSDetaillcent
CliSHeadline

Performance Monitar Refresh

| Close |

Figure 5-9 « Database Profiler Dialog Box
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Important! ¢ Back up the database or make sure that it has recently been backed up
before you upgrade the database.

The new version or release of CIMS Server might contain a new database version. In this
case, you will receive notification that a database upgrade is available when you start
CIMS Server Administrator. Click Yes, and then click Upgrade Database. If you have
more than one database, you will receive this notification each time that you select a
database that is not the latest version in the Select ODBC Data Source dialog box.

To view the version of a database at any time, make sure that the database is selected in
the ODBC Data Source dialog box and then click System Administration » Database »
Upgrade Database.

Note ¢ CIMS Lab strongly recommends that you leave dbo. in the Object Prefix box
of the Upgrade Database dialog box. This prefix sets the owner of CIMS Server
database objects to dbo in SQL Server allowing any authorized database user to view
the objects.
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This chapter provides an overview of the data processing cycle and components and
describes how to use CIMS Server Administrator to set processing options.
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About Processing Data

CIMS Server processes IT resource usage data from any application, system, or operating
system on any platform. The primary method for loading this data into CIMS Server is
the CIMS Server Resource (CSR) or CIMS Server Resource Plus (CSR+) file. The file type
depends on the collector that created the file (see CIMS Data Collectors on page 1-5).

Note ¢ Although the CIMS External Transaction file is also supported, CIMS Lab
recommends that you use the more flexible and efficient CSR or CSR+ file.

The CIMS Data Collector(s) that you are using to collect your system data automate the
data processing cycle. Using the console application CIMS Job Runner, the collectors can
be run in batch mode on a defined schedule (daily, monthly, etc.) to convert usage
metering data created by your system into CSR or CSR+ files. Once the CSR or CSR+ files
are created, the collector processes the data in the files and loads the resulting output files
into the database using the CIMS Processing Engine components CIMSACCT.d11,
CIMSBILL.d11, CIMSSORT.d11, CIMSAdminLib.d11, and CIMSResrl.d11. For more
information about CIMS Data Collectors and CIMS Job Runner, refer to the CIMS
Desktop Installation and Getting Started Guide.

Although not intended for daily processing, you can also process CSR and CSR+ files
using CIMS Server Administrator. For example, you can use CIMS Server Administrator
to process the sample files that are provided with CIMS Server for demonstration
purposes. To process files using CIMS Server Administrator, see Processing Data Using
CIMS Server Administrator on page 6-34.

The primary use of CIMS Server Administrator in regards to processing is to set the
processing options required by the key processing programs, CIMSACCT and CIMSBILL.
These programs are responsible for assigning accountability and cost for resources
consumed, respectively. The process settings for CIMSACCT and CIMSBILL are described
in CIMS Server Administrator Processing on page 6-17.
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Data Processing Frequency

The preferred method of processing is to run the full data processing cycle as the data
becomes available. The data produced by the various operating systems (z/OS, UNIX,
Windows, Open VMS, etc.) and applications/databases (CICS, DB2, Oracle, IIS,
Exchange Server, etc.) are usually made available for processing on a daily basis. Other
feeds such as manpower accounting, voice telephone, dedicated lines, etc., are normally
produced on a monthly basis.

There are several advantages to running the full costing cycle on a daily or data
availability basis:

m The volume of data created makes it more practical to process daily. A single mid-
sized Proxy Server might produce millions of records each day. It is more efficient to
process these records each day of the month rather than try to run many millions of
records through the processing cycle at month end.

m [t is easier to catch processing errors when the data is reviewed on a daily basis. It is
more difficult to troubleshoot a problem when it is discovered at month end. If an
unusual increase in utilization is observed for a specific resource at month end, the
entire month'’s records must be checked to determine when the increase first took
place.

Because there are fewer jobs, transactions, or records to review, the task of
determining what caused the utilization spike is much simpler if caught on the day
in which it occurred.

m [f the program CIMSBILL is run monthly, the start date is the first day of the month
and the end date is the last day of the month. Because of this date range, it is not
possible to view CIMS Summary records for a single day or week. The smallest time
range that may be used is the entire month.

Required Folder Permissions for Data Processing

The administrator that executes processes using CIMS Data Collectors or CIMS Server
Administrator requires full access to files in the Processes folder (that is, the ability to
create, modify, delete, overwrite, etc.). Therefore, the Windows user account or group
account for the administrator must have Full Control security permissions for the
Processes folder and all subfolders.
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CIMS Processing Engine

CIMS Processing Engine is composed of COM components. Each component performs
particular functions in the processing cycle. Table 6-1 describes the CIMS Processing
Engine COM components in the order that they appear in the processing cycle and the

output files created by the objects as applicable.

COM Object

Description

Output Files

CIMSACCT.d11 Performs account code conversion,
shift determination, date selection,
and identifier extraction on the data
contained in the CSR or CSR+ file.
The input file could also be the
CIMSACCT Detail File previously

produced by CIMSACCT.

For more information about
CIMSACCT, including a description
if its input and output files, see
page 6-6.
CIMSSORT.d11 Sorts the CIMSACCT Detalil file and
produces a version of the file that is
ready to be processed by CIMSBILL.

CIMSBILL.d11 Processes the sorted CIMSACCT
Detail file from CIMSSORT and
performs shift processing, CPU
normalization, proration, and
include/exclude processing and
creates files that contain the billing
information used to generate

invoices and reports.

For more information about
CIMSBILL, including a description
of its input and output files, see
page 6-11.

CIMS Ident. This file is
loaded into the
database.

CIMSACCT Detail. This
file is input into
CIMSSORT or can be
reprocessed through
CIMSACCT.

Sorted CIMSACCT
Detail. This file is input
into CIMSBILL.

CIMSBILL Detail. This
file is loaded into the
database or can be
reprocessed through
CIMSBILL.

m CIMS Summary. This

file is loaded into the
database or can be
reprocessed through
CIMSACCT.

CIMSAdminLib.d11 Contains the class CCIMSCBSLoad that
loads the output files from
CIMSACCT and CIMSBILL into the

database.

For more information about
CIMSAdminlLib, see page 6-15.

CIMSResrl.dl11 Supports CIMSACCT and

CIMSBILL.

Table 6-1  CIMS Processing Engine Components
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CIMSACCT

CIMSACCT is the first data processing program that is executed. CIMSACCT processes
the records in the input file (see CIMSACCT Input on page 6-7) and performs the
following:

m Identifier extraction and account code conversion. CIMSACCT extracts the
identifiers from the input file records and creates the CIMS Ident file, which is loaded
into the database. It also uses specified identifiers to build the account code and
perform account code conversion if required. For more information, see Setting Up
Account Codes and Performing Account Code Conversion on page 6-35.

m Date selection. CIMSACCT selects the input file records to be processed based on the
specified date range. For more information, see Date Selection on page 6-23.

m Shift determination. CIMSACCT can determine the shift to be used for processing in
either of the following ways:

e Use the shift code from the input file records. If a shift code is not included, the
default shift code is 1.

¢ Recalculate the shift using the start date/time in the records. For more information,
see Shifts Subtab on page 6-25.

CIMSACCT produces the CIMSACCT Detail file, which contains records that are
properly formatted for input into CIMSBILL.

Reprocessing CIMSACCT and CIMSBILL Output Files

You can reprocess the CIMSACCT Detail file and the CIMS Summary file from CIMSBILL
through CIMSACCT. This is usually done to reprocess data for further account code
conversion. To reprocess either of these files during the data collection process, you need
specify the file name in the XML job file used for data collection. For more information,
refer to the documentation on the CIMSACCT parameter attribute inputFile in the
CIMS Data Collectors for Microsoft Windows Installation and User Guide.
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CIMSACCT Input

Table 6-2 lists the input and processing files used by CIMSACCT. These files are in the
process definition subfolders in the Processes folder.

The file names in Table 6-2 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type File Name Description
Input Files (CIMSACCT can process usage data from any of the following sources)

CSR or CSR+ file CurrentCSR.txt  These are the most commonly used files for
processing data through CIMS Server.

To view the record layout for these files, see
Appendix B, File Layouts.

CIMS External User determined Although the CIMS External Transaction file

Transaction file is supported, CIMS Lab recommends that
you use the CSR or CSR+ file for input into
CIMS Server. This format is more flexible
and efficient than the CIMS External
Transaction file.

CIMSACCT Detail.txt This file is the output from a previous run of
Detail file CIMSACCT.

This file provides an account code for each
input file record. This file is input into the
CIMSSORT process.

When used as input into CIMSACCT, this
file is used primarily in the reprocessing of
data for date selection or further account
code conversion.

The records within this file are also referred
to as maintenance or 991 records.

CIMS Summary file  BillSummary.txt This file is the output from a previous run of
CIMSBILL. When used as input into
CIMSACKCT, this file is used primarily for
reprocessing data for further account code
conversion.

Table 6-2 + CIMSACCT Input
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File Type File Name Description

Processing Files

Control file AcctCntl.txt This file contains the CIMSACCT control
statements (see CIMSACCT Control
Statements on page D-3).

Account Code AcctTabl.txt This optional file contains the account code
Conversion Table conversion table (see Creating an Account
Code Conversion Table on page 6-40).

Process Control file  ProcessCntl.txt This file contains the processing statements
used by CIMS Server Administrator (see
Processing Control Statements on page D-27).

Table 6-2 « CIMSACCT Input (Continued)
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CIMSACCT Output

Table 6-3 lists the CIMSACCT output files. These files are in the process definition
subfolders in the Processes folder.

The file names in Table 6-3 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type File Name Description

CIMSACCT Detail.txt This file provides an account code for each

Detail file input file record. This file is input into
CIMSSORT.

CIMS Ident file Ident.txt This file contains all the identifiers (such as

as user ID, jobname, department code,
server name, etc.) that are contained in the
input records. These identifiers are used
during account code conversion to create
your target account code structure.

This file is loaded into the database.

CIMSACCT AcctMsg.txt This file contains processing messages

Message file related to CIMSACCT.

CIMSACCT AcctMsg_cob.txt This file contains any runtime COBOL

COBOL Message file messages related to CIMSACCT. If there are
no errors, this file is blank.

CIMSACCT AcctResults.txt This file contains the CIMSACCT processing

Results file results.

Exception file Exception.txt This is an optional file in CSR or CSR+

format that contains all records that did not
match during account code conversion.
These files can be reprocessed through the
processing cycle as described in About
Exception File Processing on page 6-15.

To produce this file, you must have
exception file processing enabled (see
page 6-37).

Table 6-3 « CIMSACCT Output
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File Type File Name Description

CSR+ file CSRPFiTe.txt The output of a CSR+ file from CIMSACCT
is optional. For example, you might want to
create a CSR+ file to be processed by CIMS
Mainframe Data Collector and Chargeback

System.
Windows Message Events are written to the Windows Event
Events Viewer when the CIMSACCT process starts

and ends and when and warnings or errors
are encountered while processing.

Table 6-3 « CIMSACCT Output
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CIMSSORT

CIMSBILL

CIMSSORT sorts the CIMSACCT Detail file and produces a version of the file that is
ready to be processed by CIMSBILL.

The cost of information services, and which departments are using the services, is of
considerable interest to an organization. When users are made aware of the costs and are
held financially responsible for those costs, they are more likely to use the resources in
a prudent manner. CIMS Server provides comprehensive computer center billing
through the program CIMSBILL.

The primary function of CIMSBILL is to perform cost extensions within CIMS Server and
to summarize cost and resource utilization by account code. CIMSBILL uses the rate code
table assigned to the client (see Working With Clients on page 3-19) to determine the
amount to be charged for each resource consumed. It is possible to have a unique rate
code table for each client.

There are specific rules that CIMSBILL follows when charging resource consumption:

m Ifaresource has a corresponding entry with a monetary amount in the rate code table,
the number of resource units are multiplied by this amount. The result appears in the
CIMS Summary records.

m If a resource has a corresponding entry with no or zero currency amount in the rate
code table, a zero cost appears in the CIMS Summary records for that resource.

m If a resource does not have a corresponding entry in the rate code table, the data for
that resource does not appear in the CIMS Summary records.

m If none of the resources in the CIMSBILL input file have a corresponding entry in the
rate code table, the CIMS Summary file will contain no records. If the Load Summary
records check box is selected in CIMS Server Administrator (see page 6-20), the CIMS
Ident file, CIMSBILL Detail file, and CIMS Summary file are not loaded to the
database—the process fails and a failure message is issued. You must have at least one
rate code from the input file in the rate code table to produce CIMS Summary records.

If the Load Summary records check box is not selected, the CIMS Ident file and
CIMSBILL Detail file load to the database if the Load Ident records and Load
CIMSBILL Detail records check boxes are selected.
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In addition to standard costing, CIMSBILL also performs the following:

B Processes non-standard costs such as miscellaneous, recurring, and credit
transactions. For more information about creating and using transactions, refer to the
CIMS Server Web Reporting User’s Guide.

m Performs proration. See Prorating Resources on page 6-45.

Note ¢ Although you can perform proration using CIMSBILL, CIMS Lab
recommends that you use the CIMSPRAT program. CIMSPRAT provides more
options for proration and enables you to prorate resources multiple times. For
more information about proration using CIMSPRAT, refer to the CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

CIMS Server will continue to support proration using CIMSPRAT or CIMSBILL.

m Performs CPU Normalization. See Normalizing CPU Values on page 6-51.

m Performs include/exclude processing. See Include/Exclude Processing on page 6-54.
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Table 6-4 lists the input and processing files used by CIMSBILL. These files are in the
process definition subfolders in the Processes folder.

The file names in Table 6-4 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type File Name
Input File

CIMSSORT/ Detail.txt
CIMSACCT Detail

file

CIMSBILL Detail file BillDetail.txt

CIMS Summary file ~ BillSummary.txt

Processing Files

Control file Bil1Cnt1.txt

Process Control file  ProcessCntl.txt

Proration Table User determined

Description

This is the sorted Detail file from
CIMSACCT.

This file is the output from a previous run of
CIMSBILL. When used as input into
CIMSBILL, this file is used primarily for
performing additional proration functions.

To reprocess this file during the data
collection process, you need to define the
file as an input to CIMSBILL in the XML job
file. For more information, refer to the CIMS
Data Collectors for Microsoft Windows
Installation and User Guide.

This file is the output from a previous run of
CIMSBILL. When used as input into
CIMSBILL, this file is used primarily for
performing additional proration functions.

To reprocess this file during the data
collection process, you need to define the
file as an input to CIMSBILL in the XML job
file. For more information, refer to the CIMS
Data Collectors for Microsoft Windows
Installation and User Guide.

This file contains the CIMSBILL control
statements (see CIMSBILL Control Statements
on page D-14).

This file contains the processing statements
used by CIMS Server Administrator (see
Processing Control Statements on page D-27).

This optional file contains the proration
table (see To create a proration table: on
page 6-46).

Table 6-4 « CIMSBILL Input
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CIMSBILL Output

Table 6-5 lists the CIMSBILL output files. These files are in the process definition
subfolders in the Processes folder.

The file names in Table 6-5 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type

CIMSBILL Detail file

CIMS Summary file

Prorate Report

CIMSBILL
Message file

CIMSBILL
COBOL Message file

CIMSBILL
Results file

Windows Message
Events

File Name Description

BillDetail.txt This file is loaded into the database for use
in drill down reports. This file contains
resource utilization data.

The CIMSBILL Detail file differs from the
CIMSACCT Detail file in that the CIMSBILL
Detail file reflects any proration, CPU
normalization, or include/exclude
processing that was performed. The
CIMSBILL Detail file also includes
accounting dates.

Bil1Summary.txt This file is loaded into the database for use
in producing reports. This file contains both
resource utilization and cost data.

ProrateRep.txt  This is an optional report that contains the
original record and all subsequently-
generated prorated records. To enable this
report, see page 6-45.

BillMsg.txt This file contains processing messages
related to CIMSBILL.

Bi11Msg_cob.txt This file contains any runtime COBOL
messages related to CIMSBILL. If there are
no errors, this file is blank.

BilTResults.txt This file that contains the CIMSBILL
processing results.

Events are written to the Windows Event
Viewer when the CIMSBILL process starts
and ends and when and warnings or errors
are encountered while processing.

Table 6-5 « CIMSBILL Output
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CIMSAdminLib

CIMSAdminLib is the central controlling library for all Windows-based CIMS Server
functions. It contains all the COM objects used to manipulate CIMS data. These objects
are called from CIMS Server Administrator and Windows Script Host (. wsf) scripts used
by CIMS Data Collectors and CIMS Server.

CIMSAdminLib contains the class CCIMSCBSLoad that loads the output files from
CIMSACCT and CIMSBILL into the database.

Account Codes and Account Code Conversion

Within chargeback and resource accounting, an account code uniquely identifies an
individual, billing, or reporting entity. The actual definition of what the account code
represents depends on how CIMS Server is used. For example, an account code can
represent an organization, a department in an organization, or an individual.

A key feature of CIMSACCT is its ability to convert the identifier values in the CSR or
CSR+ files into account codes. In some cases, the identifier value in the CIMS Server
Resource file is the actual account code. However, in most cases, the identifier value
represents the source of the consumed resources (i.e., a user ID, IP address, server name,
jobname, transaction ID, terminal ID, etc.).

CIMSACCT uses an account code conversion table to convert identifier values into an
account code. For example, an IP address of 10.26.12.255 is converted to the account
code for Human Resources while an address of 10.26.12.260 is converted to the account
code for Accounts Payable. These departments can then be charged for the consumption
of the resources associated with their IP addresses.

For the steps required to set up account code conversion, see page 6-35. For an example
of these steps, see page 6-42.

About Exception File Processing

During account code conversion, CIMSACCT might encounter input file records that do
not match any entry in the account code conversion table. CIMSACCT includes an
optional exception file processing feature that automatically identifies and removes
unmatched records so that they can be reprocessed with the correct accounting
information.

When this feature is enabled, all unmatched records are output to an exception file in the
process definition subfolder. You can use the exception file to identify the information
that needs to be corrected, either in the records in the exception file or in the account
code conversion table, and then reprocess the exception file.

To enable the exception file processing feature, see Setting the Account Code Conversion
Options on page 6-37. For assistance in processing exception files, contact CIMS Lab (see
Contacting Technical Support on page 7-10).
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Accounting Dates

CIMS Server input records contain a usage start date and end date that specify the date
range in which the resources in the record were consumed. CIMSBILL uses the usage end
date to calculate accounting start and end dates, which are used for billing and reporting.
The accounting start and end dates may be the same as or different than the usage end
date (see How Accounting Dates are Calculated).

The accounting start and end dates are stored in the following fields in the CIMSBILL
output files:

m CIMSBILL Detail file. The accounting dates are in the ACCOUNTING-START-DATE and
ACCOUNTING-END-DATE fields (starting positions 159 and 168, respectively).

m CIMS Summary file. The accounting dates are in the AccountingFromDate and
AccountingToDate fields (starting positions 167 and 175, respectively). The Period
and Year fields also reflect the accounting end dates. (These fields are at starting
positions 282 and 284, respectively.) For example, if the end date is 20040916 and the
date falls within the 9th period in the CIMSCalendar table, the Period field would
contain 09 and the Year field 2004.

About the Close Date

You can set an optional close date for processing input file records. Records that contain
usage end dates before or after this date are processed as described in How Accounting
Dates are Calculated. The close date can be a specific date or a day of the month (the first,
fifteenth, thirtieth, etc.). To set a system-wide close date, see page 3-42. To set close dates
for an individual process definition or definitions, see page 6-28.

How Accounting Dates are Calculated

The accounting dates are calculated according to the usage end dates and the close date
(see About the Close Date). The accounting dates and usage end date are always the same
in the following situations:

m If no close date is set.

m If both the CIMSBILL run date and the usage end date are in the same period (as set
in the CIMSCalendar table), regardless of the close date.

m [f the CIMSBILL run date is prior to the close date and the usage end date is in the
previous period.

m If the CIMSBILL run date and the usage end date are after the close date.
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The accounting dates and usage end date are different in the following situations:

m If the CIMSBILL run date is after the close date, but the usage end date is prior to the
close date, the accounting dates are set to the previous day from the day CIMSBILL
was run.

For example, if the first of each month is your close date and you process an input file
with a usage end date of 20040930 (September 30) on October 15, the accounting start
and end dates will be 20041014 (October 14).

m If the CIMSBILL run date is prior to the close date and the usage end date is in a period
prior to the previous period, the accounting dates are set to the last day of the previous
period.

For example, assume that the periods in the CIMSCalendar table are defined as the
first day of the month to the last day of the month and that the fifteenth of each
month is your close date. If you process an input file with a usage end date of
20040827 (August 27) on November 1, the accounting start and end dates will be
20041031 (October 31). October 31 is the last day of the previous period.

CIMS Server Administrator Processing

In CIMS Server Administrator, you can set processing definitions that instruct CIMS
Server how to execute processing jobs for different types of input resource data. A process
definition is a folder that contains the files required to process usage data from a
particular source such as a database, operating system, or application.

Note ¢ If you are using CIMS Data Collectors, process definition folders and
required processing files are created automatically.

The settings that you select for the process definition are stored in the AcctCntl1.txt,
Bi11Cnt1.txt, and ProcessCnt1.txt files in the process definition folder. AcctCnt1.txt
and Bi11Cnt1.txt contain the CIMSACCT and CIMSBILL control statements,
respectively. (For a list of these statements, see page D-3 and page D-14).
ProcessCntl.txt contains process settings used by CIMS Server Administrator (see
page D-27).

You can edit these files using a text editor or through CIMS Server Administrator. For
example, if you select the Perform Account Code Conversion check box in CIMS Server
Administrator (see page 6-37), the control statement ACCOUNT CODE CONVERSION is
automatically added to the AcctCnt1.txt file.
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Adding Process Definitions

When you add a process definition, CIMS Server Administrator builds a folder within the
process definition path (see Processing Settings on page 3-42) and creates the necessary
process definition files within this new folder. The folder shares the name of the process

definition.

To add a process definition:

1 In the main CIMS Server Administrator window, click Chargeback
Administration » Processing » Process Definitions. The Process Definitions List
Maintenance dialog box appears as shown in example Figure 6-1.

@44 Process Definitions List Maintenance

iew

Process Definitions

Apache
CIMSWinDisk
CIMSVWinEwentlog
CIMSinPrint
CMSNiInProcess
DBSpace
Mainframe
MainframeCiCs
MainframeDB2
MainframeDisk
MainframeSMFE
MSE=change
MSExchangeti::
MEIE-¥ish
MSSQL2000
Prorate
Transactions
Universal
UnixDE2
UnixDB25torage

.\I;;u'gram Files\CIMSLabizample Processes)

Add | Remove | Exiit ‘

Rename

Process ‘

Close

Figure 6-1 * Process Definitions List Maintenance Dialog Box

2 Click Add.

3 Type a name for the process definition in the Add New Process Definition dialog box,

and then click OK.

The Edit Process Definition dialog box appears.

4 Edit the new process definition as needed (see Setting Process Definition Options).

To remove or rename a process definition, click the definition in the Process Definitions

Maintenance List dialog box and click Remove or Rename.
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Setting Process Definition Options

The Edit Process Definition dialog box includes a number of tabs and subtabs that
contain settings for the process definition. The main tabs are:

B Process Options

m CIMS Account Options
m CIMS Bill Options

m Process Results

B Versions

The following sections describe the options that are available on these tabs by subtab.
Where applicable, the correlating control or processing statement for each option is also
provided.

Process Options Tab

This tab contains the following subtabs: General, Processing, and Database.

General Subtab

This subtab displays the name and path of the process definition. You can also use this
tab to add a description of the process definition.

Setting Correlating Control File and Statement

Process Definition Path None

The path for the process definition folders.
The use of a UNC path is recommended
(e.g., \\CIMS-SRVI\D$\Processes).

Process Name None

The process name. This name is also shared
by the folder that contains the process
definition files.

Process Description File: ProcessCntl.txt
Type an optional short description of the Statement:

rocess definition. s L
P Description description
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B 6-20

Processing Subtab

Use this subtab to specify the processing options such as processing programs that you
want to run and the output files that you want to load to the database.

Setting Correlating Control File and Statement

Run CIMS Account

Select this check box to instruct the system
to run CIMSACCT as part of this process.

Run CIMS Bill

Select this check box to instruct the system
to run CIMSBILL as part of this process.

Remove output files before processing

Select this check box if you want to delete
previous output files from the process
definition folder. This ensures that old data
is not loaded into the database. This check
box should be selected unless you are
running CIMSBILL or database loads only.

Archive process files

Select this check box to archive previous
output files before processing. Archived files
contain a date in the file name. Archived
files for the same date are indicated by a
number (1, 2, 3...) at the end of the file
name. Note that if you select this option,
you can potentially have a large number of
archived files in the process definition
folder.

Note: This option is not related to the
archive database loads feature described in
Archiving, Purging, and Restoring Database
Loads on page 5-22.

Load Ident records

Select this check box to load CIMS Ident files
from CIMSACCT into the database.

Load Summary records

Select this check box to load CIMS Summary
files from CIMSBILL into the database.

File: ProcessCnt1.txt

Statement:
RunCIMSAcct Yes/No

File: ProcessCnt1.txt

Statement:
RunCIMSBi11 Yes/No

File: ProcessCnt1.txt

Statement:
RemoveFilesBeforeProcessing Yes/No

File: ProcessCnt1.txt

Statement:
ArchiveProcessFiles Yes/No

File: ProcessCntl.txt

Statement:
AutolLoadIdentFile Yes/No

File: ProcessCnt1.txt

Statement:
AutoLoadSummaryFile Yes/No
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Setting Correlating Control File and Statement

Load CIMSBILL Detail records File: ProcessCnt1.txt

Select this check box to load CIMSBILL Statement:
Detail files into the database. AutoloadDetailFile Yes/No

Load CIMSACCT Detail records File: ProcessCntl.txt

Select this check box to load the CIMSACCT  Statement:
Detail files into the database. Consult CIMS
Lab before using this option (see Contacting
Technical Support on page 7-10).

AutolLoadResourceFile Yes/No

Use bulk load interface File: ProcessCnt1.txt

Select this check box to perform a bulkload Statement:

when loading the database (this is a SQL UseBulklLoadInterface Yes/No
Server feature). This option is recommended

because it increases the speed of loads. A

disadvantage is that if there is an error in the

data, a generic rather than specific error

message appears. In this case, clear this

check box and reprocess to view the specific

eITor message.
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Database Subtab

Use this subtab to select the data source for the CIMS Server database that you want
to use for processing the data and storing the output Ident, Detail, and Summary files.
In most cases, this will be the database that CIMS Server Administrator is currently
pointing to (i.e., the data source selected in the Select ODBC Data Source dialog box).

Setting Correlating Control File and Statement

Use same database connection File: ProcessCnt1.txt

information as CIMS Administrator
Statement:

Leave this check box selected (the default) if
you want to use the database that CIMS
Server Administrator is currently pointing
to.

DSN name

Automatically generate ODBC INF file File: ProcessCnt1.txt

Leave this check box selected (the default). Statement:

This file is required by the Fujitsu COBOL GenerateODBCINF Yes/No
Workstation Run-time program required by

CIMS Processing Engine.

Data Source Name File: ProcessCntl.txt

If you want to use a database other than the Statement:
data source selected in the Select ODBC
Data Source dialog box, type the DSN or
click Browse to search for the DSN.

DSN name

To use this option, the Use same database
connection information as CIMS
Administrator check box must be
unselected.

Database User ID/Password File: ProcessCnt1.txt

Type the user ID and password necessary for Statements:
the system to access the data source. For

. . . . DSNUID user ID
security purposes, this password is stored in
an encrypted format. DSNPWD password
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This tab contains the following subtabs: General, Files, Account Codes, Shifts, and

Trace.

General Subtab

Use this subtab to specify general CIMSACCT settings such as the record type and date

range for the input records to be processed.

Setting Correlating Control File and Statement

Process Type

Click the input record type to be processed
(CIMS Server Resource Records [this
includes CSR+ records], External Trans
Records, CIMS Maintenance Records from
CIMSACCT, or CIMS Summary Records).

Date Selection

Click the date range for records to be
processed by CIMSACCT. Records are
selected by the end date in the record (the
accounting end date for CIMS Summary
Records and the usage end date for all other
record types). Click one of the following:

m No Date Selection

m Use Specific Dates. Enter the dates in the
Start Date and End Date boxes

B Run Date (Today). Selects records based
on the run date

m Previous Day to Current Day. Selects
records based on the run date and the run
date less one day

B Current Week. Selects records based on
the run week (Sat-Sun)

m Current Month. Selects records based on
the run month

m Previous Day. Selects records based on
the run date, less one day

m Previous Week. Selects records based on
the previous week (Sat-Sun)

m Previous Month. Selects records based on
the previous month.

File: AcctCntl.txt

Statement:

Process record type (see page D-11)

File: AcctCntl.txt

Statement:

DATE SELECTION YYYYMMDD YYYYMMDD/
keyword (see page D-6)
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Setting Correlating Control File and Statement

B Current Period from Calendar. Selects
records based on the current period from
the CIMSCalendar table.

B Previous Period from Calendar. Selects
records based on the previous period
from the CIMSCalendar table.

For example, if you click Current Month,
records with end dates in the current month
are processed.

Include Fields File: AcctCntl.txt

These fields allow you to move identifiers ~ Statement:
into an area that can be later used by

. . INCLUDE FIELD D-10
CIMSBILL for include/exclude processing. (see page )
For a complete description of this option
and include/exclude processing, see Include/
Exclude Processing on page 6-54.

Files Subtab
Use this subtab to define the CIMSACCT input and output files.

Setting Correlating Control File and Statement

Input File File: ProcessCnt1.txt

The input file to be processed by Statement:
CIMSACCT. The default is CurrentCSR.txt.
To select another file, click Browse. To edit
the file in Windows Notepad, click Edit.

AcctInputFile filename

Output Files File: ProcessCntl.txt

The names of the CIMSACCT output files  Statement:
(the CIMSACCT Detail, CIMS Ident,

Exception, and CSR+ [optional] files). ) ‘
CIMSACCT writes these files to the path AcctOutputldentFile fiTename

AcctOutputDetailFile filename

listed above the file names. CIMS Lab AcctOutputExceptionFile filename
recommends that you use the default file CSRPFile £ilename

names.

Create CSR+ File: ProcessCnt1.txt

The creation of a CSR+ file is optional. Select Statement:
this check box to create a CSR+ file. CreateCSRPFile Yes
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Setting Correlating Control File and Statement

Eliminate duplicates None

If the input file contains duplicate
identifiers, selecting this check box
eliminates the duplicate identifiers from the
CIMS Ident file. Consult CIMS Lab before
using this option (see Contacting Technical
Support on page 7-10).

Account Codes Subtab

This subtab allows you to build the account code from the identifiers in the input file
and to convert the account code if needed. For a description of the options on this subtab
and an explanation of account codes and account code conversion, see Setting Up Account
Codes and Performing Account Code Conversion on page 6-35.

Shifts Subtab

As described in Setting Rate Shifts on page 3-13, you can set different rates for a rate code
by shift. This feature enables you to set different rates for a rate code based on the time
of day.

If you want CIMS Server to use the shift codes that appear in the input records to process
the rate codes in the record, leave this tab blank. The shift codes that appear in the input
records will appear in the CIMSACCT Detail file. If there is no shift code in the input
record, the default shift code is 1.

If you do not want to use the shift codes in the input record for processing, you can use
this subtab to recalculate the shifts using the start date/time in the records. For each shift
that you want to create, enter a shift number and a time for the end of the shift.
CIMSACCT compares the start dates and times in the input records to the daily shifts that
you specify on this subtab and calculates new shift codes.

You can enter up to nine shifts per day. The shift end times must be listed in 4-character,
24-hour format (see example Figure 6-2 on page 6-26). The recalculated shift codes
rather than the original shift codes appear in the CIMSACCT Detail file.

Note ¢ CIMSACCT will not recalculate the shift codes for CSR or CSR+ files produced
by CIMS Mainframe Data Collector and Chargeback System. CIMS mainframe
records are aggregated using the shift code as one of the aggregation points.
Therefore, the time in the aggregated record is not representative of every record
within the aggregation. For more information, refer to the CIMS Mainframe Data
Collector and Chargeback System User Guide.

Regardless of whether you use the rate codes from the input file or recalculate the rate
codes, you must select the Use Shift Codes check box on the CIMS Bill Options/
General subtab (see page 6-28). If you do not select this check box, CIMSBILL uses the
default rate shift 1 regardless of the shift code that appears in the CIMSACCT Detail file.

For the related AcctCnt1.txt control statements for setting up shifts, see page D-11.
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In the following example, shift 3 is from midnight to 8 a.m., shift 1 is from 8 a.m. to 4

p.m., and shift 2 is from 4 p.m. to midnight.

ans Edit Process Definition, "Mainframe®

Wigw

General ] Files ] Account Codes  Shifts l Trace ]

Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions

Shift # End Time Shift # End Time Shift # End Time Shift # End Time Shift #
Sunday 3 0&:00 1 16:00 2 24:00
Moncay 3 0&:00 1 16:00 2 24:00
Tuesday 3 0&:00 1 16:00 2 24:00
vWednesday |3 0&:00 1 16:00 2 24:00
Thursday 3 0&:00 1 16:00 2 24:00
Friclary 3 05:00 1 16:00 2 24:00
Saturday 3 05:00 1 16:00 2 24:00
£ >

Kevboard Usage: Press the Enter key to edit 2 cell. Use the arrow keys to navigate between celis.

Process

’Tl Cancel Apply

Figure 6-2 « Shifts Subtab
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Trace Subtab

Note ¢ By default, tracing is disabled. Consult CIMS Lab before using one of the
CIMSACCT trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSACCT Message file,
AcctMsg.txt:

m General processing. This is information related to CIMSACCT processing of the
information in the account, define, and move fields.

B Account code conversion. This is information related to the account code
conversion, including the information in the account, define, and move fields and
the account code conversion table, and the number of unmatched records (if

applicable).
Setting Correlating Control File and Statement
Trace flag File: AcctCntl.txt
Click Tracing Disabled, Y - Trace General Statement:
Processipg, or A - Trace Account Code TEST A or Y (see page D-12)
Conversion.
Check for bad file input None

Select this check box to validate each
identifier. Some systems may pass data in
identifier fields that are not valid ASCII
display characters. This can cause
unexpected results during processing. By
pre-validating the data, the system verifies
that the data passes through CIMS Server
successfully.

Note: This option slows down the
processing of CIMSACCT. Consult CIMS
Lab before using this option (see Contacting
Technical Support on page 7-10).
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CIMS Bill Options Tab

This tab contains the following subtabs: General, Files, Define Fields, Include/Exclude
Records, Proration, Client, and Trace.

General Subtab

Use this subtab to specify general CIMSBILL settings such as the record type and date
range for the input and output records, to set the close date if other than the system close
date, and enable other options such as CPU normalization and shift code processing.

Setting Correlating Control File and Statement

Process Type File: BiT1Cnt1.txt

The input record type to be processed (CIMS = Statement:
Detail records or CIMS Summary records).  ppocpss record type (see page D-23)

Default Close Day File: Bi11Cnt1.txt
This option allows you to override the Statement:
system-wide close date set on the DEFAULT CLOSE DAY = nn (see page D-18)

Processing tab of the Configuration dialog
box (see page 3-42). Consult CIMS Lab
before using this option (see Contacting
Technical Support on page 7-10).

For more information about the close date,
see page 6-16.

Input—Date Selection File: Bi11Cnt1.txt
Click the date range for records to be Statement:
processed by CIMSBILL. Records are DATE SELECTION YYYYMMDD YYYYMMDD/

selected by the end date in the record (the
usage end date for CIMSACCT Detail
Records and the accounting end date for all
other record types). Click one of the
following:

keyword (see page D-17)

m No Date Selection

m Use Specific Dates. Enter the dates in the
Start Date and End Date boxes

B Run Date (Today). Selects records based
on the run date

m Previous Day to Current Day. Selects
records based on the run date and the run
date less one day

B Current Week. Selects records based on
the run week (Sun-Sat)

B Current Month. Selects records based on
the run month
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Setting Correlating Control File and Statement

Input—Date Selection (continued)

m Previous Day. Selects records based on
the run date, less one day

B Previous Week. Selects records based on
the previous week (Sun-Sat)

B Previous Month. Selects records based on
the previous month

B Current Period from Calendar. Selects
records based on the current period from
the CIMSCalendar table.

B Previous Period from Calendar. Selects
records based on the previous period
from the CIMSCalendar table.

For example, if you click Current Month,
records with end dates in the current month
are processed.

Output-Summary Date Range None

This setting is used to determine the
accounting dates in the CIMSBILL output
files. To ensure that the accounting dates are
calculated correctly, CIMS Lab strongly
recommends that you use the default
keyword, Auto. This setting enables CIMS
Server to calculate the accounting dates as
described in Accounting Dates on page 6-16.
Consult CIMS Lab before changing this
setting.

Back Load Data File: Bi11Cnt1.txt

When this check box is selected, the close ~ Statement:
dateisignored. The accounting dates created

D-1
by CIMSBILL are the same as the usage end BACKLOAD DATA (see page 0)
date, regardless of the close date.

Normalize CPU Values File: Bi11Cnt1.txt

Select this check box to normalize the Statement:

processing speeds of computers in the RMALIZE CPU VALUE D-22
system (see Normalizing CPU Values on N0 CPU VALUES (see page )
page 6-51).

Use Shift Codes File: Bi11Cnt1.txt

Select this check box to instruct CIMSBILLto  Statement:

use the shift character specified in the USE SHIFT CODES (see page D-26)

CIMSACCT Detail record and apply the
appropriate rate shift value.
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Files Subtab
Use this subtab to define the CIMSBILL input and output files.

Setting Correlating Control File and Statement

Input File File: ProcessCntl.txt

The input file to be processed by CIMSBILL. Statement:
To select another file, click Browse. To edit

BillInputFile filename
the file in Windows Notepad, click Edit. 1 Pt 7

Output Files File: ProcessCnt1.txt

The names of the CIMSBILL output files (the Statement:
CIMSBILL Detail and CIMS Summary files).
CIMSBILL writes these files to the path listed ) ]
above the file names. CIMS Lab BillSummaryFile f7lename
recommends that you use the default file

names.

BillDetailFile filename

Define Fields Subtab and Include/Exclude Records Subtab

These subtabs are used together to define data that you would like to include or exclude
for CIMSBILL processing. This is useful if there is certain data that your organization does
not want to report on. For a description of how to use these tabs, see Include/Exclude
Processing on page 6-54.

Proration Subtab

This subtab allows you to charge resources to more than one account. For a description
of the options on this subtab and how to use proration, see Prorating Resources on
page 6-45.

Note « Although you can perform proration using CIMSBILL, CIMS Lab
recommends that you use the CIMSPRAT program. CIMSPRAT provides more
options for proration and enables you to prorate resources multiple times. For more
information about proration using CIMSPRAT, refer to the CIMS Data Collectors for
Microsoft Windows Installation and User Guide.

CIMS Server will continue to support proration using CIMSPRAT or CIMSBILL.
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Client Subtab

CIMSBILL requires an account code structure to add new clients to the CIMSClient table
(see page 6-28) and to determine the applicable rate code table for a client if the table is
other than STANDARD.

Use this tab to enable the optional client add and search features and to define the
account code structure for the clients. For more information about the account code
structure, see Setting Up the Account Code Structure on page 3-3.

Setting Correlating Control File and Statement

Enable client search File: Bi11Cnt1.txt

Select this check box to enable CIMSBILL to Statement:
search the CIMSClient table for the rate code

D-1
table associated with a client. If this check CLIENT SEARCH ON (see page 0)
box is not selected, the STANDARD rate
code table is used for all clients.

Add new clients to Client table File: Bi11Cnt1.txt

Select this check box to instruct CIMSBILLto  Statement:

insert corresponding client entries in the DYNAMIC CLIENT ADD ON D21
CIMSClient table for all clients that have a (see page )
resource usage charge, but are not entered in

the table.

The inserted client entries will not include
descriptions or contacts.

Note: This option can quickly fill up the
CIMSClient table. Use this option with
caution.

Account Code Search Fields File: Bi11Cnt1.txt

Use these fields to specify the client account Statement:
code structure. In the Account Structure

. DEFINE (see D-19
box, click the account code structure that (see page )
you want to use, and then click Populate
Fields. The account code structure appears
in Fields 1-9.
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Trace Subtab

Note ¢ By default, tracing is disabled. Consult CIMS Lab before using one of the
CIMSBILL trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSBILL Message file,
BiT11Msg.txt:

m Date processing. Includes the CIMSBILL run date, the input file usage end date(s),
and accounting start and end dates.

m Rate processing. Includes rate code information from the rate code tables that are
used during processing.

B General processing. Includes options selected, high-low date calculation, and other
general processing messages.

m Client processing. Includes information related to the clients that are processed.

Setting Correlating Control File and Statement

Trace flag File: Bi11Cnt1.txt

Click Tracing Disabled, D - Trace Date Statement:

Processing, R — Trace Rate Processing, D-2
Y - Trace General Processing, or Z - Trace TEST D, R, Y, or Z (see page 0)
Client Processing.
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Process Results Tab
This tab contains the following subtabs: CIMS Account, CIMS Bill, and Event Viewer.

CIMS Account and CIMS Bill Subtabs

B View Message File. Select this check box to view the most recent version of the
CIMSACCT/CIMSBILL Message file.

m View Results File. Click this to view the CIMSACCT/CIMSBILL Results file, which
describes results of the most recent CIMSACCT/CIMSBILL processing.

m View Detail File. Select this check box to view the CIMSACCT/CIMSBILL Detail file.
m View Ident File (CIMSACCT only). Click this to view the CIMS Ident file.

m View Exception File (CIMSACCT only). Click this to view the exception file. This
button is unavailable if no exception file is available.

m View Summary File (CIMSBILL only). Click this to view the CIMS Summary file.

m View Proration Report (CIMSBILL only). Click this to view the proration report.
This button is unavailable if no proration report is available

m Use External Viewer. When you select this check box and then click one of the
preceding buttons, the files open in Windows Notepad.

m Word Wrap. Select this check box to enable word wrap for the displayed files.

m Copy to Clipboard. Click this to copy the contents of the currently displayed file to
the Windows clipboard

Event Viewer Subtab

m Show Process Events. Click this to view all process events in the Event Viewer (see
page 6-34)

m Show All CIMS Events. Click this to view all CIMS Server-related events in the Event
Viewer

m Start Windows Event Viewer. Click this to open the Windows Event Viewer and view
system-wide events

Versions Tab

This tab provides the version number and path for CIMSACCT, CIMSBILL, and
CIMSORT.
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Processing Data Using CIMS Server Administrator

To process data using CIMS Server Administrator, click the process definition that you
want to process, and then click Process. You can also click Process in the Edit Process

Definition dialog box for the definition.

Note ¢ If you receive a warning stating that a file with the same date range has
already been loaded, you are probably loading duplicate data. You can click Yes to
continue to load the data, but you should delete the previous load immediately after
the current load is completed (see Tracking the History of Database Loads on page 5-25).

Viewing Events

CIMS Server Administrator enables you to view system events related to CIMS Server and
the processing of CIMS data. This is helpful if you want to see details about a processing
job and any associated problems with it. To view these events:

B 6-34

1 In the main CIMS Server Administrator window, click Chargeback

Administration » Processing » Event Viewer. The Event Viewer dialog box appears.

Wigw

Machine: I [LoCAL) j

=0l x|

S Processing

- 11sz/2001
% Ident File Load Process ID: Z00111021411Z2¢
lo/z3/2001
Summary File Load Process ID: Z00110Z3160711
Information: 3:07:11 PM: Load Parameters
€3 1 foruation: 3:07:17 PM: Load Results

Detail File Load Process ID: Z00110231&0700
Ident File Load Process ID: Z0011023160649
CIMEEILL Process ID: Z00Ll10Z3160644Z7

CIMS Sort Process ID: Z0011023160643
CIMEACCT Process ID: Z00L10Z316064Z68
Summary File Load Process ID: Z0O0110Z3160&EZ0

Event Message:

Process: Summary File Load
Process Id: 20011023160711
Load Results

Mumber of Records Loaded: 1534
Source System: Server

Source Feed: CIMS

Load Tracking IC: 217

vyincowes Event Wiewer | Close |

Figure 6-3 « Event Viewer Dialog Box

2 Click any event to view the event message at the bottom of the dialog box. To view

Windows system-wide events, click Windows Event Viewer.

Note ¢ To refresh the list of events in the Event Viewer dialog box, press <F5>.
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Setting Up Account Codes and Performing Account Code
Conversion

This section describes the account codes structure and how to define and convert the
account code.

Defining the Account Code Structure

One of the first steps in implementing CIMS Server is deciding on a final account code
structure. The structure is the chargeback hierarchy for the organization. The levels of this
hierarchy are arranged from highest to lowest level within the account code. The account
code can consist of up to 128 characters.

For example, your final account code structure could consist of:
DDDCCccuuuuuuuu

D = Division (three characters) (highest level)

C = Cost Center (four characters)

U = User (eight characters) (lowest level)

The next step is to set the account code structure in CIMS Server Administrator, see
Setting Up the Account Code Structure on page 3-3.

Once you have set up the account code structure, you can create an account code
conversion table to convert the identifier values in the input file into an account code
that fits within the final hierarchy pattern.
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Defining the Account Code

The account code is derived from an identifier or identifiers in the input file. In CIMS
Server Administrator, you need to specify the identifier(s) that you want to use to define
the account code as follows:

m If the input file contains an Account_Code identifier, the Account_Code identifier value
is automatically used to define the account code. If this value fits your account code
hierarchy, you can use the value as your account code. If this value does not meet your
account code requirements, you can convert the value to the appropriate account
code.

m If the input file meets any of the following criteria, you need to specify an identifier
or identifiers that you want to use to define the account code:

e The input file does not contain an Account_Code identifier.

¢ The input file contains an Account_Code identifier, but you want to use other
identifiers instead.

¢ The input file contains an Account_Code identifier and other identifiers that you
want to use. In this case, you must define the Account_Code identifier in addition
to the other identifiers.

If the identifier values fits your account code hierarchy, you can use the value as your
account code. However, in most cases you will need to convert this value to the
appropriate account code.

The identifiers that you use (either via the Account_Code identifier values or the
identifiers that you specify) are referred to as the account code input field. For an
example of how to define an account code input field, see Figure 6-4 on page 6-43.

To define the account code input field:

Note * You do not need to define the account code input field if the input file
contains the Account_Code identifier and you are using only it to define your account
code.

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Account Options tab.
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4 Complete the Account Codes subtab as follows:

e Account Fields. Define the identifier(s) that you want to use for the account code
input field beginning at Field 0 and continuing sequentially as needed.

If you want to use the full value for an identifier, use an offset of 1 and the length
of the longest identifier value. For example, if the longest identifier value is 7
characters, type 1 as the offset and 7 as the length.

If you want to use a portion of the identifier value, use the offset position at which
you want to start the value and the corresponding length. For example, if you want
to start the 7-character identifier value at the second character, type 2 as the offset
and 6 as the length. You could also select a shorter length if you wanted to further
reduce the identifier value length.

You can define up to 10 account fields (Field 0 - Field 9). The maximum number
of characters for an account field is 255 characters. However, the overall length of
all account fields added together cannot exceed 500 characters.

The corresponding control statement in the AcctCnt1.txt file is ACCOUNT FIELD
(see page D-5).

¢ Convert account fields to uppercase during processing. Select this check box to
convert lowercase account code input field values to uppercase values in the
resulting account code. For example, the value ddic would be converted to DDIC.
By using this option, CIMSACCT account code processing becomes case-
insensitive and makes defining account conversion tables much easier.

The corresponding control statements in the AcctCnt1.txt file is UPPERCASE
ACCOUNT FIELDS (see page D-13).

Setting the Account Code Conversion Options

To perform account conversion, regardless of whether you are using the Account_Code
identifier or another identifier, you need to set the conversion options described in this
section and create an account code conversion table as described on page 6-40. Account
codes are assigned by matching identifier values in the input file records to the values in
the account code conversion table.

For an example of how to set the account code conversion options, see Figure 6-4 on
page 6-43.
To set the account code conversion options:

Complete the Account Codes subtab as follows.

B Perform Account Code Conversion. If this check box is selected, the account code
conversion occurs as defined by the following Define Field and Move Field settings
and the account code conversion table:

The corresponding control statement in the AcctCnt1.txt file is ACCOUNT CODE
CONVERSION (see page D-5).
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B 6-38

m Define Fields. Use this area to specify the offset and length of account code input

field value that you want to use for conversion. Begin at Field 0 and continue
sequentially as needed. Note that if you created the account code input field using
account fields as described in To define the account code input field: on page 6-36, the
define fields correlate to the account field values, not to the original identifier values
in the input file.

For example, if you defined the following two identifiers as account fields, the
resulting account code input field value would be JJJJJJUUUUUUU, where J represents
the Jobname identifier and U represents the User identifier.

e Account Field 0—Jobname offset 2, length 6
e Account Field 1—User offset 1, length 7

You would set the Define Field 0 to offset 1, length 6 and Define Field 1 to offset 7,
length 7. You could also select a shorter length if you wanted to further reduce the
define field value.

You can define up to 10 define fields (Field O - Field 9). The maximum number of
characters for a define field is 128 characters. However, the overall length of all define
fields added together cannot exceed 128 characters.

The corresponding control statement in the AcctCntl1.txt file is DEFINE FIELD (see
page D-7).

Move Fields. Use this optional setting to include either the define field(s) value or a
literal in the output account code.

If you specify a define field as the move field, the define field value will be included
in the account code. For example, if the define field represents the Jobname value DDIC,
DDIC will appear in the at the beginning, end, or within the account code as specified
in the account code conversion table.

If you specify a literal, the literal value will be included in the account code. For
example, if the type a literal value of A/P, A/P will appear in the at the beginning, end,
or within the account code as specified in the account code conversion table. The
literal can be a maximum of 40 characters.

For an example of how move fields are used, see Account Code Conversion Example on
page 6-42.

Begin at Field 0 and continue sequentially as needed. You can define up to 10 move
fields (Field O - Field 9). Each move field value can be a maximum of 128 characters.

Note ¢ Although each move field can be up to 128 characters, keep in mind that
the total output account code, including any literals and move field values, cannot
exceed 128 bytes.

The corresponding control statement in the AcctCnt1.txt file is DEFINE MOVEFLD (see
page D-8).
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m Conversion Table. This is the file name for the account code conversion table. If the
table is located in the definition folder for the process, the file name appears without
the path. If the table is located in a location other than the process definition folder
(e.g., you are using the same table for multiple processes and have the table in a
central location), the file path appears.

To select a table, click Browse. To edit the table, click Edit. To create a table, see
Creating an Account Code Conversion Table on page 6-40.

The corresponding control statement in the ProcessCnt].txt file is
ACCTCODECONVERSIONTABLE f77ename.

m Enable Exception Processing. Select this check box to enable exception file
processing. This instructs the system to write all non-matched records to an exception
file. If this check box is not selected, the records that are not matched are written to
the CIMSACCT Detail file with the unconverted account code input field value.

If you enable exception processing, do not include a default account code as the last
entry in the account code conversion table (e.g., ", ,DEFAULTCODE"). If a default
account number is used, records will not be written to the exception file.

The corresponding control statement in the AcctCnt1.txt file is EXCEPTION FILE
PROCESSING ON (see page D-9).
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Creating an Account Code Conversion Table

The account code conversion table contains the definitions required to convert the
identifier values defined by the account code input field to user-defined output account
codes. For an example of how to create the account code conversion table, see Figure 6-5
on page 6-44.

Consider the following when creating the account code conversion table:

B 6-40

The account code conversion table is case-sensitive. For convenience, you can enter
uppercase values in the table and then select the Convert account fields to uppercase
during processing check box on the Account Codes subtab (see To define the account
code input field:). This is especially helpful it you are using one account code
conversion table for multiple process definitions. This ensures that account code
input field values that are lowercase or mixed case are processed.

Each record in the table can be up to 306 characters (89 for the low identifier, 89 for
the high identifier, and 128 for the new account code). Note that the low and high
identifiers must be entered in fields of 8 bytes each, up to 10 fields, delimited by
commas. See the explanation for Step 3 under To create an account code conversion
table: on page 6-41.

Each 8-character low and high identifier field is compared to the corresponding
account code input field values. If the compares are true, the account code is assigned.

The low identifier fields are padded with x'00” and the high value fields are padded
with x'FF'.

The high identifier field is set equal to the low field plus the high padding when the
high identifier field value is null.

You can include a default account code as the last entry in the account code
conversion table by leaving the low and high identifier fields empty (e.g.,

", ,DEFAULTCODE"). In this case, all records that contain identifier values that do not
match an entry in the account code conversion table will be matched to the default
code.

If you do not include a default account code, input file records that contain identifier
values that do not match an entry in the account code conversion table are written to
the CIMSACCT Detail file with the unconverted account code input field value.

If you want unmatched records to go to an exception file for reprocessing at a later
time, you need select the Enable Exception Processing check box on the Account
Codes subtab (see page 6-37). If you enable exception file processing, make sure that
you have not included a default account code entry in the account code conversion
table.
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m If the PRINT ACCOUNT NO-MATCH statement is included in the AcctCnt1.txt file, a
message is printed in the CIMSACCT Message file showing the identifier values from
the input file that were not matched during account code conversion. If this statement
is not present, only the total number of unmatched records is provided. The system
prints up to 1000 messages.

® The number of definition entries that you can enter in the table is limited only by the
memory available to CIMSACCT.

To create an account code conversion table:

1 In the Conversion Table box, CIMS Lab recommends that you type the default file
name AcctTabl.txt, which is also the default for CIMS Data Collectors. However, you
can type any name in the format 777ename.txt.

2 Click Edit.

3 In the Account Code Conversion Table Maintenance dialog box, click Add Entry and
type the following for each account code input field value that you want to convert.

e The low and high identifier value that you want to use for conversion. You can
enter up to 10 fields of 8 bytes each for the low and high identifiers. Each field
must be delimited by a colon (:).

For example, if you type AA as the low identifier and CC as the high identifier, all
account codes that begin with characters greater than or equal to AA or less than
or equal to CC are converted to the specified account code. If you type
AAAAAAAA:BB as the low identifierand CCCCCCCC:DD as the high identifier, all
account codes that begin with characters greater than or equal to AAAAAAAABB or
less than or equal to CCCCCCCCDD are converted to the specified account code.

The asterisk (*) and the question mark (?) characters can be used as wildcard
characters for both the low and high identifiers. Note that using the wildcard
characters can degrade performance; use them only when needed.

If you do not set a high value, the value is equal to the low value by default.
e The account code value that you want to convert to (maximum of 128 characters).

4 To set additional account code conversion entries, click Insert Row. Click OK when
you are finished.

By default, the table is saved to the process definition folder. But you can move the table
to any location.
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Account Code Conversion Example

B 6-42

Note  This section provides examples to supplement the preceding sections. Please
refer to these sections for more detailed information.

Assume that you want to use the User identifier values in an input file to define your
account code and that your account code is in the following structure:

DDDCCccuuuuuuuu
D = Division (three characters) (highest level)
C = Cost Center (four characters)

U = User (eight characters) (lowest level)

The following table shows the User identifier values that are in the input file records and
the corresponding account code that you want to convert the value to.

User

Identifier Division Cost Center User

Value from Final Account Account Account
Input File Account Code Code Code Code

DDIC = FINACTGDDIC = FIN ACTG DDIC

SAP = ISDDEVPSAP = ISD DEVP SAP
SAPCOMM = OPSMKTGSAPCOMM = OPS MKTG SAPCOMM
SAPSYS = MISPRODSAPSYS = MIS PROD SAPSYS
TEAM718 = MISTESTTEAM718 = MIS TEST TEAM718
TEAMF99 = OPSTESTTEAMEF99 = OPS TEST TEAMF99

To convert the User identifier values to the final account code, you would complete the
steps in the following sections.
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Define the Account Code and Conversion Options for CIMSACCT

In this example, the User identifier is entered for an offset of 1 and length of 7 because
you want to use the entire identifier value and the longest values (SAPCOMM, TEAM718, and
TEAMF99) are 7 characters.

For account code conversion, you need to define the value from the account field (USER)
at the full 7-character length. Because you also want to include the account field value at
the end of the account code, you need to define a move field for the value.

=ns Edit Process Definition "SAP

Wigw

Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions
General ] Filez  Accournt Codes l Shifts ] Trace ]

Account Fields

Identifier Offzet Lencth M
Field O USER 1 7
Field 1
Field 2
Field 3 3
Insert Entry | Remove Ertry

[v Convert account fields to uppercase during processing

Account Code Conversion
[v Perform &ccount Code Conversion

Define Fields: tdove Fields:

Offzet Length | # Offzet Length | Literal .
Field 0 1 7 Field 0 1 7
Fieldl 1 Fieldl 1
Field 2 Field 2
Field 3 & Field 3 &
—_ InsertErtry | Remove Entry Insert Entry | Remove Ertry
Carvversion Table:  |acctTabl tut Browse .. Edlt ..

[v Enable Exception Processing

Process Ok | Cancel | Apply |

Figure 6-4 « Defining the Account Code and Conversion Options Example
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Create the Account Code Conversion Table

The account code conversion table contains the following entries. Note that the high
identification code is not needed in this example because the low and high identification
codes are the same.

The @0 at the end of the account code value specifies that the move field defined in the
previous step will be included at the end of the account code. For example, the resulting
account code for the first table entry would be FINACTGDDIC. If you placed the @0 at the
beginning of the account code value, the resulting account code would be DDIC<three
spaces>FINACTG. You could place the @) anywhere in the account code.

4% Account Code Conversion, Table Maintenance

Tools

Account Table: C\Program FileshWCIMSLABSample ProcessestSAPACCt Tabl txd

Low Identification Code High Identification Code |Account Code Walue
DLDIC FINACTGEO
SAP ISDDEVPREO
SAPCOM OPSMETGEO
SAPETE MISPRODEO
TEAM71E MISTESTEO
TEAMF23 OPSTESTREO

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 6-5 « Creating the Account Code Conversion Table Example

If you had additional move fields defined, they would be represented by @1, @2, @3, etc.
For example, if you had used another identifier for account conversion in addition to
User and had defined move fields for each (move field 0 and move field 1), @ FINACTG@0
would place the value for move field 1 a the beginning of the account code and the value
for move field 0 at the end of the account code.

Process the CIMS Server Resource File

The converted account codes appear in the CIMSACCT Detail, CIMSBILL Detail, and
CIMS Summary files.
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Prorating Resources

Note ° Although you can perform proration using CIMSBILL, CIMS Lab
recommends that you use the CIMSPRAT program. CIMSPRAT provides more
options for proration and enables you to prorate resources multiple times. For more
information about proration using CIMSPRAT, refer to the CIMS Data Collectors for
Microsoft Windows Installation and User Guide.

CIMS Server will continue to support proration using CIMSPRAT or CIMSBILL.

Proration is taking the overall or individual resources used by an account and
distributing those resources and the cost of the resources across multiple accounts at a
specified percentage.

A common use of proration is the equitable allocation of overhead costs across the user
community. An application or system that is normally assigned to the overhead category
tends to be one that does not produce metering data to the end user or account level, or
the processing of such data is considered too expensive to be practical at the end user or
account level.

For example, you have an application that controls print in a centralized environment.
To prorate the costs associated with this application among multiple accounts you need
to do the following:

m Assign the print program resource utilization and cost to a non-billable overhead
account.

m Set the proration options for CIMSBILL.

m Create a proration table assigning the percentage of print program costs for the non-
billable account to the accounts that you want to bill.

To set the proration options:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Bill Options tab.
4 On the Proration subtab, set the following options:

¢ Proration Type. Click type of proration to be performed: Resources or Money. For
a description of each option including its advantages and disadvantages, see
Prorating Resources vs. Prorating Money on page 6-50.

The corresponding control statements in the Bi11Cnt1.txt file are PRORATE MONEY
(see page D-23) and PRORATE RESOURCES (see page D-24).
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¢ Match Length. The level of the account code that you want to match for proration.

For example, if you type 5, accounts AAABB, AAABBBB, and AAABBCC are
prorated. If you type 7, only accounts AAABBBB and AAABBCC are prorated.

This is included in the PRORATE MONEY or PRORATE RESOURCES statement in the
Bi11Cnt1.txt file. For example, PRORATE RESOURCES 5 where 5 is the match length.

Proration Table. This is the file name for the proration table. If the table is located
in the definition folder for the process, the file name appears without the path. If
the table is located in a location other than the process definition folder (e.g., you
are using the same table for multiple processes and have the table in a central
location), the file path appears.

To select a table, click Browse. To edit the table, click Edit. To create a table, see To
create a proration table:.

The corresponding control statement in the ProcessCnt1.txt fileis Bi1TMultFile
filename.

Print Proration Report. Select this check box to create a proration report as part
of the process. The report will reside in the process definition folder.

The corresponding control statement in the Bi11Cnt1.txt file is PRINT PRORATE
REPORT (see page D-25).

To create a proration table:

1 IntheProration Table box, type a name for the table in the format 777ename. txt, and
then click Edit.

2 In the Proration Table Maintenance dialog box, click Add Entry and type the
following for each account that you want to prorate to.

The original account code that you want to prorate from.
The account code that you want to prorate to.

The percentage that you want to prorate to the account code.

Note ¢ You can prorate resource costs at any percentage. The prorate
percentage can be less than or greater than 100 percent.

The individual rate code(s) that you want to prorate or A11 to prorate all rate codes.

3 To set additional proration entries, click Insert Row.

4 Click OK when you are finished.

By default, the table is saved to the process definition folder. But you can move the table
to any location.
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Proration Table Examples

Assume that you want to split all resources used by overhead account code AAABB
among three different accounts: A1, A2, and A3. Al on average uses about 50 percent of

the resources assigned to the AAABB account, A2 uses about 30 percent, and A3 uses
about 20%.

Complete the Proration Table Maintenance dialog box as shown in Figure 6-6.

Proration Table Maintenance

Proration Table:  CProgram Files'CIMSLABSample ProcessesiGeorgeipurple txd

Original Account Code Mewy Account Code Percentage Rate Code
AALBE A1 a0 All
AALBE A2 30 All
AALBB A3 20 All

4| i ] >

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 6-6 * Proration Example 1
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You can also split individual resources among multiple accounts. Using the preceding
example, assume that the only resources from account AAABB that you want to prorate

are represented by the rate codes Z001 and Z002. Create the proration table as shown in
example Figure 6-7.

@44 Praration Table Maintenance

Proration Table:  CProgram Files'CIMSLABSample ProcessesiGeorgeipurple txd

Original Account Code Mewy Account Code Percentage Rate Code
AALBE A1 a0 Zoo1
AALBE A2 30 Zoo1
AALBE A3 20 Zoo1
AALBE 21 a0 ooz
AALBE A2 30 ooz
AALBB A3 20 o0z

1l | >

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 6-7 « Proration Example 2

In this example, all resources other than Z001 and Z002 would still be charged to the
AAABB account.
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If you want to charge account AAABB for a portion of the resources used, for example

you want to charge account AAABB 40 percent and account AACCC 60 percent for all
resources, create the proration table as shown in example Figure 6-8.

@4 Proration Table Maintenance

Praoration Table:

CHProgram Files\CIMSLABSample Processes\Georgeipurple txd
Original Account Code Mewy Account Code Percentage Rate Code
28058 28058
28058 AARCC

B0 All
40 Al

>
e || B 5

iRemove Entry | Insert Entry |

OK Cancel

/d
Figure 6-8 « Proration Example 3
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Prorating Resources vs. Prorating Money

B 6-50

In CIMS Server Administrator, you can set the option to prorate on resources or on
money. Both options display the same prorated units and charges in Web reports.
However, you cannot drill down on resource units by identifier if you prorate by money.
The following describes the advantages and disadvantages of prorating resources and
prorating money:

Prorating resources. The CIMSACCT Detail file from CIMSSORT is prorated before
CIMSBILL applies rates and figures money and a new CIMSACCT Detail file is built with
all the prorated resources. The new CIMSACCT Detail file is then used in the CIMSBILL
process.

An advantage of prorating resources is that the CIMSBILL Detail records match the
records in the CIMS Summary file. Therefore, users can drill down on resource units by
identifier when viewing invoices in CIMS Server Web Reporting. A disadvantage is that
the CIMSBILL Detail file can contain a potentially large number or records.

Prorating money. The CIMS Summary file is prorated just before CIMSBILL ends. A new
CIMS Summary file is built with the prorated values.

An advantage of prorating money is that the CIMSBILL Detail file contains fewer records
than it would if you prorated by resources. A disadvantage is that the CIMSBILL Detail
records do not match the CIMS Summary records and drilling down by identifier will
not produce accurate data.
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Normalizing CPU Values

Computers within an organization have different processing speeds. This speed
difference might cause users to request that their work be run on the faster machine to
reduce costs. This situation could lead to heavy workloads on the faster computers while
the slower units stand idle. To avoid this problem, you can normalize the processing
speeds to more evenly charge for CPU utilization. That is, you can assign a percentage of
the original CPU time used by a system rather than the actual time to be used during the
billing process.

For example, your organization has two z/OS systems, AL90 and AL95. System AL95 is
20 percent faster than AL90. If you use AL95 as the base system, use a factor of .80 to
normalize AL90 to reflect the speed of AL95.

Note ¢ Due to the disparity between the way different operating systems capture
performance statistics, it is not desirable to normalize the processor times between
platforms (e.g., z/OS to UNIX or UNIX to Windows).

To perform normalization, you need to do the following:

m Select the CPU Value option for the rate code or codes for which you want to perform
normalization.

m Set the normalization factor for the applicable system or systems.
m Select the Normalize CPU Values option for the process definition.

To set the rate code as a CPU value:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

2 In the Rate Code Maintenance List dialog box, click the rate code that you want to set
as a CPU value, (for example, OS/390 CPU Minutes [Z003]), and then click Edit.

3 Select CPU Value check box, and then click OK.

Note - If this item is not checked, the rate code value will not be normalized
during CIMSBILL processing.
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To set the normalization factor by system:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » CPU Normalization.

2 Click Add in the CPU Normalization Maintenance List dialog box.
3 Enter the following:

e System ID. The name of the system. For z/OS, this is the four-character System
Model ID, for UNIX and Windows, it is the computer name. Note that the input
file must contain an identifier named System_ID to identify the system name for
CIMSBILL.

e Work ID. The subsystem name. This is any other system value that can narrow the
normalization (i.e., the CICS region name, the DB2 plan name, the Oracle
instance, etc.). Note that the input file must contain an identifier named Work_ID
to identify the subsystem name for CIMSBILL.

e Factor. This is the actual normalization factor. In the example at the beginning of
this section, this would be .80.

4 Click OK.

An example of a configured CPU Normalization Maintenance List dialog is shown
Figure 6-9.

an5 CPL Normalization List Maintenance

Wigw

System ID | Application or Subsystem | Mormalization Factor

| o | |

Figure 6-9 « CPU Normalization Maintenance List Dialog Box

To edit or remove a factor, click the factor, and then click Edit or Remove. Note that you
cannot change the System or Work ID when you edit the factor.
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To set the CPU normalization option for the process definition:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Bill Options tab.
4 On the General subtab, select the Normalize CPU Values check box.

The corresponding control statement in the Bi11Cnt1.txt file is NORMALIZE CPU
VALUES (see page D-22).

About Ghost Machines

Many organizations attempt to perform normalization against a “ghost machine”. This
is the factor applied to all the processors in the enterprise today, using as a base the speed
of the slowest machine running in the environment. In an attempt to keep costing
philosophy as simple as possible, the old technology “ghost” system is kept as the
baseline for processor speed. This concept worked well when processor speeds were
relatively constant. However, as processor speeds continue to increase, it becomes
difficult to relate the higher CPU speeds of today’s computers to older technology. CIMS
Lab recommends that processor speed factors be restricted to those multipliers and
divisors applicable to the existing environment.
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Include/Exclude Processing

By default, CIMSBILL processes all records within the input CIMSACCT Detalil file.
However, you might want to process only certain records or you might want to exclude
certain records. This is useful if there is data that your organization does not want to
report on.

You can exclude records by date using the date selection option in CIMS Server
Administrator. See page 6-23 to set this option for CIMSACCT and page 6-28 to set this
option for CIMSBILL.

You can also include or exclude records by identifier values in the records. For example,
you might want to exclude all records that contain a particular Jobname identifier value.

To include or exclude records by identifier values, you need to do the following in CIMS
Server Administrator:

m Define identifier fields that you want to use.

If the input record identifier fields that you want to include or exclude are other than
System_ID, Work_ID, or Account_Code, you need to define identifier fields that you
want to use. The values for these defined identifiers are stored consecutively
beginning at starting position 301 of the CIMSACCT Detail file (see page B-8 for the
file layout).

If you want to include or exclude System_ID or Work_ID identifier fields, you do not
need to define the fields. The values for these identifiers are always stored at starting
positions 57 and 90 (respectively) of the CIMSACCT Detail file.

If you want to include or exclude the Account_Code identifier field, you do not need
to define the field unless the account code has been converted. If the account code
has been converted, the code (stored in position 163 of the CIMSACCT Detail file)
will not match the Account_Code identifier value in the input record. You need to
define the field so that the original identifier value is used.

B Define the identifier fields for CIMSBILL.

m Specify whether you want CIMSBILL to include or exclude the defined fields.
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To define the input record identifier fields that you want to include or exclude:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Account Options tab.

4 On the General subtab, enter the following in the Include Fields area beginning at
Field 0:

¢ The identifier name that you want to use to include or exclude records. For
example Jobname, Server, User, etc.

e The offset position at which you want to start the identifier value that you want to
include or exclude. If you want to start the identifier value at the first character of
the value, type 1. If you want to start the identifier at the second character, type 2,
etc. For example, you could start the eight-character Jobname identifier value
DFMALEQZ at position 1, which specifies the full value or at any other position such
as position 4, which specifies just ALEQ2. This would specify that only those records
with Jobname identifier values that contain ALEO? are included or excluded from
processing.

¢ The length of the identifier value. This can be the entire length of the identifier
value starting at the offset position, or a shorter length. Using the preceding
example of ALEO2, you might want just ALE. In this case, you would type a length
of 3.

Note * The overall length of all include fields added together can not exceed
60 characters.

The corresponding control statement in the AcctCnt1.txt file is INCLUDE FIELD (see
page D-10).

If you want to specify more than one identifier for include/exclude processing repeat
these steps for each identifier. However, consult CIMS Lab (see Contacting Technical
Support on page 7-10) before doing this to determine if it is necessary.

To insert a row, click the row that you want to add the row above and then click Insert
Entry. To remove a row, click the row that you want to remove, and then click Remove
Entry.
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To define the identifier fields for CIMSBILL:
1 Click the CIMS Bill Options tab.

2 On the Define Fields subtab, click Add Entry and enter the following for each field
that you specified on the CIMS Account Options » General subtab (see page 6-55).

e Atwo-character ID for the identifier. You will use this ID to specify the records that
you want to include or exclude (see To include or exclude the defined fields in
CIMSBILL Processing).

* The offset position at which you want to start the identifier value that you want to
include or exclude. Unlike the offset position 1 through x that you specified for
CIMSACCT processing, this is the position in the CIMSACCT Detail file in which
the identifier value begins. As with the offset position used by CIMSACCT, you can
specify any offset position within the identifier value. For example, if the Jobname
identifier value DFM begins at position 301, you can set the offset at 302 to specify
just FM. This would specify that only those records with Jobname identifier values
that contain FM are included or excluded from processing.

e The length of the identifier value. This can be the entire length of the identifier
value starting at the offset position, or a shorter length.

e An optional description of the field.
The corresponding control statement in the Bi11Cnt1.txt file is Define (see page D-19).

To insert a field, click the field that you want to add the field above and then click Insert
Entry. To remove a field, click the field that you want to remove, and then click Remove
Entry. To add a field to the end of the field list, click Add Entry.

To include or exclude the defined fields in CIMSBILL Processing

On the Include/Exclude Records subtab, click Add Entry and enter the following for
each field that you specified on the CIMS Bill Options » Define Fields subtab:

m Click Include or Exclude.
m Click the identifier ID that you created in To define the identifier fields for CIMSBILL.:.

m In the Low Value and High Value fields, type the range for the identifier values that
you want to include or exclude. For example, if you want to include only those
identifiers that start with ALI type ALI in both fields. If you want identifiers that start
with ALI and ALE, type ALE as the low value and ALT as the high value.

The corresponding control statements in the Bi11Cnt1.txt file are EXCLUDE (see
page D-21) and INCLUDE (see page D-22).

To insert entry, click the entry that you want to add the entry above and then click Add
Entry. To remove an entry, click the entry that you want to remove, and then click
Remove Entry. To add an entry, click Add Entry.
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Include/Exclude Processing Example

Assume that you have a CSR+ from a z/OS system with the following identifiers:

...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999, Jobname,BKMALIOL,Start_date,20040714...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI02,Start_date,20040715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI03,Start_date,20040716...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999, Jobname, DFMALEQO]L, Start_date,20040714. ..
...System ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999, Jobname,DFMALEO2,Start_date,20040715. ..
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999,Jobname,DFMALEO3,Start_date,20040716. ..
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999,Jobname, LCHALUO1,Start_date,20040714...
...System ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999, Jobname, LCHALUOZ,Start_date,20040715. ..

..System_ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999,Jobname, LCHALUO3,Start_date,20040716. ..

You want to exclude those records that contain DFMin the Jobname identifier value. Define

the identifier field as shown in Figures 6-10.

=ns Edit Process Definition '05390°

Wigw

Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions

General l Files ] Account Codes] Shifts ] Trace ]

Process Type: |CIMS Server Resource Records j

Date Selection
_ strtoate: [
Keyword: |N0 Date Selection j aR
Endl Diate:
Include Fields
Identifier Offzet Lencth M
Field 0 JOBMAME 1 3
Fieldl 1
Field 2
Field 3 2
Inzsert Row | Remove Row

Cancel Apply

Process

Figure 6-10 « Edit Process Definition—Include Fields

In this example, only the first three characters of the Jobname identifier value are required.

Therefore, the offset is 1 and the length is 3.
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Next you need to define the identifier field for CIMSBILL as shown in example
Figure 6-11.

=42 Edit Process Definition "05390"

Wigw

Process Options I CIMS Account Optionz  CIMS Bill Options | Process Results I “ersions I

General I Filez= Define Figlds | Include f Exclude Recordsl Prorationl Client Search I Trace I

-~ Define Includes Exclude Fields

|Identifier | Offset |Length | Description
A1 301 3

Adld Entry Remove Entry In=ert Entry

Process | Ok I Cancel Apply |

|

Figure 6-11 « Edit Process Definition—Define Fields Subtab

In this example, the Jobname identifier value is assigned the ID A1 and begins in position
301 of the CIMSACCT Detalil file (the starting position for include/exclude identifier
values).
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Next you need define DFM as the exclude identifier value as shown in example

Include/Exclude Processing

Figure 6-12. Records that contain DFM as the first three characters of the Jobname identifier

value will not be processed.

@ Edit Process Definition ‘05390

Wigw
Process Options I CIMS Account Optionz  CIMS Bill Options | Process Results I “ersions I

General I Files I Define Fields  Include [ Exclude Records | Proraﬁonl Client Search I Trace I

~ Define Includel Exclude Records

[idertifier  [Low value | High value
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Figure 6-12 « Edit Process Definition—Include/Exclude Records Subtab
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Rebilling Rate Codes After Changing Rate Code Values
and/or Conversion Factors

Important! < The following scripts change the data in the CIMS Server database. You
should back up the database before running these scripts.

You can recalculate rate codes that you previously processed and loaded into the CIMS
Server database using a different rate value and/or resource conversion factor without
reprocessing the data. That is, if you change the rate value and/or resource conversion
factor for arate code in the CIMSRate table, you can update the rate value and conversion
factor and recalculate the money value directly in the CIMSSummary table. (For more
information about the rate code value and resource conversion factor, see Working With
Rates on page 3-9.)

CIMS Lab provides the following scripts to perform this process:

B Rebill.wsf. This script updates the rate code value and recalculates the money value
for a rate code or codes in the CIMSSummary table. If you have not changed the
resource conversion factor for a rate code or codes, you do not need to run the
ResourceConversion.wsf script.

B ResourceConversion.wsf. This script updates the rate code resource conversion factor
in the CIMSSummary table. You need to run the Rebi11.wsf script after running this
script to recalculate the money value for the rate code.

Important! « Consult CIMS Lab before using the ResourceConversion.wsf script
(see Contacting Technical Support on page 7-10). If you run this script more than
once for the same rate code or codes, the resource units that are converted are the
units that were converted previously, not the original units. For example, if the
conversion factor for a rate code is Divide by 60 and the resource units are 120,
the resource unit value after calculating once is 2, after calculating twice it is.033
(2+60), etc.

This scenario is not applicable to the Rebill.wsf script—you can run this script
multiple times for the same rate code or codes.

For the parameters required for these scripts, see page C-19.
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Troubleshooting and
Additional Information

This chapter describes problems you may encounter while setting up and using the CIMS
Server system and how to solve them. If you cannot find the answer to your question
here, please feel free to contact CIMS Lab (see Contacting Technical Support on page 7-10).

Data Processing Problems .........c.coeueuiuieieiiiinieieiiiieienenicesenencncncenencnnns 7-2
General data processing problems ............ ... 7-2
When account codes are converted using CIMSACCT, some records seem to be lost ....... 7-2
SYStEM ProbIEMS . ..ottt iiittititeeeeteneseessnsnsesscnsnscnones 7-3
A prompt for the Windows installation CD appears while using CIMS Server Administrator .. 7-3
Performance of the CIMS Server system issSlow ........... ... ... ... 7-3
Computer “locks up’, provides unexpected results, or seems to run very slowly ............ 7-3
Web Reporting ProbIems .....oouvuiiiiiiiiiiiiieiiiiiieieieeeieseeesesescecnsanencncans 7-4
Problems accessing the Web site or generating reports ............ . ... ... . ... ... 7-4
An error message appears when using ActiveX Data Objects (ADO) or ODBC to

open a database connection inan ASP page .............. i i 7-8
Performing Disaster RECOVEIY ....ouvuiiiiiiiiiiieitieiiireeenenesesessescncncsesscscnes 7-9
Executing Stored Procedures to Debug CIMS Server .........covveieieienienencncenencnens 7-9
If You Are Using Crystal Reports Developer 8.5 ........cocvvuiiieiiiieieneneniecenencncens 7-10
Contacting Technical SUPPOIt ......ouininiiiiiiiiiiiiiiiiiiiiiiiiiiiiieieieienencanenes 7-10

CIMS Server Administrator's Guide 7-1 N



B Troubleshooting and Additional Information
Data Processing Problems

Data Processing Problems

General data processing problems
You can use the following tools to diagnose general data processing problems:

m Check the Process Results tab for the process definition (Chargeback
Administration » Processing » Process Definitions). This tab provides message and
results files for both CIMSACCT and CIMSBILL. These files provide information
about errors encountered during processing. Also, click Show All CIMS Events on the
Event Viewer subtab and check for unusual messages.

® When processing data using CIMS Server Administrator, check the status bar in the
lower left corner of the Edit Process Definition dialog box to note the point in the
processing cycle that the error occurs.

m Check the Load Tracking dialog box (Chargeback Administration » Database
Loading » Load Tracking) to see of any database loads have completed.

For database problems:

m Enable the Simple recovery model for SQL Server (see Setting the Database Recovery
Model on page 5-4) to decrease the size of the SQL Server log files.

B View the messages in the SQL Server log (Program Files » Microsoft SQL
Server » MSSQL » Log).

When account codes are converted using CIMSACCT, some records seem
to be lost

Records that do not match any account code entries in the account code conversion table
are written to CIMSACCT Detail file with the unconverted account code. If you want
unmatched records to go to an exception file for reprocessing at a later time, you must
enable exception processing in CIMS Server Administrator (see Setting the Account Code
Conversion Options on page 6-37).
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System Problems

A prompt for the Windows installation CD appears while using CIMS
Server Administrator

In most cases, Windows is calling for dependencies that are not essential for you to run
the application properly. Click Cancel when these messages appear.

Visit the Microsoft Web site and download all updates for your version of Windows and
Microsoft Office (if you use Office). These updates should include the necessary
dependent files.

If problems persist, contact CIMS Lab (see Contacting Technical Support on page 7-10).

Performance of the CIMS Server system is slow

This could be caused by a number of things, including excessive network usage,
problems with the network, excessive CIMS Server usage, etc.

It is also possible that the database you are using has become so large that it is difficult
for the server housing the data to adequately store and access it. In this case, consider
archiving certain data or upgrading the machine. You can also off load non-essential or
non-CIMS-related processing to other machines.

Performance might also be affected by computer-related problems (see the following
problem).

Computer “locks up”, provides unexpected results, or seems to run very
slowly

There could be some type of memory problem. Close CIMS Server Administrator and
any other Windows applications. Reopen CIMS Server Administrator as the only
Windows application and see if the problem corrects itself. If that fails to correct it, close
Windows and then restart it. Open CIMS Server Administrator again and see if the same
results occur.

The computer might not have enough memory to process. Try running the application
on a computer with more memory (preferably 256 MB or more).
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Web Reporting Problems

Problems accessing the Web site or generating reports

The following are problems that might occur as you are using the CIMS Server Web
Reporting Web site to generate reports. The problems are presented in the order are they
are most likely to occur, beginning with accessing the Web site.

Problem Solution(s)

Users cannot access the Web site Verify that the users have appropriate
network permissions and are using
Internet Explorer 5.5 or later.

Web site is not opening properly or is If the following error appears, see
having problems starting page 7-8:

Microsoft OLE DB Provider for ODBC
Drivers error '80004005' [Microsoft]
[ODBC Driver 1 Data source name not
found and no default driver specified.

Otherwise, try the following:

m Restart IIS. Click Start » Run. In the
Open box, type iisreset /restart, and
then click OK.

m Check the security settings on the
computer running the Web server (see
Set the User Authentication Method for the
CIMS Server Web Reporting Web Site on
page 2-50).

m Install Service Pack 3a (SP3a) or later
for Microsoft SQL Server.
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Problem Solution(s)

If using mutiple Web sites, Web sites other In IIS Manager, navigate to the virtual

than the default Web site do not open. The directory for the Web site and do the
following message appears: following:

Server Error in '/virtual directory 1

name' Application Expand the virtual directory.

2 Right-click the CIMSReporting folder,
and then click Properties.

3 Click the Create button next to the
Application name box.

4 Click OK when you are finished.

Make sure that you copied the
...CIMSLab\Server\Web folder to create
the folder for the Web site. You must
recreate the Web site folder from the Web
folder each time that you upgrade to a new
CIMS Server release. For more
information, see Using Multiple Databases
for CIMS Server Web Reporting on

page 5-11.
Report parameters page does not open Make sure that ASP.NET is installed and
when a report is selected—a 405 error enabled as follows:

appears
5 Click Start » Run. In the Open box,

enter aspnet_regiis.exe -i preceded
by the path. For example,
Windows\Microsoft.NET\
Framework\<version number>\
aspnet_regiis.exe -i.

6 Make sure that ASP.NET is enabled as
described in Enabling ASP.NET on
page 2-14. (This is applicable to
Windows 2003 only).

7 Apply any Microsoft critical updates
with latest .NET service pack.
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Web Reporting Problems

Problem Solution(s)

Report parameters page opens, but report
is not generated from the page—one of the
following error occurs:

B A time-out message appears
immediately or the following message
appears:

-2147192179 An error has occurred on

the server in attempting to access
the data source

B A 404 “page not found” error appears.

B A clientdoc.dll failure occurs when
using Crystal Reports 10

In CIMS Server Administrator, click
System Administration »

Database » Database Object. Add any
database objects that do not exist in the
database (i.e., Exists = No). If this does
not solve the problem, drop all objects
and then create them again (see Viewing
Tables on page 5-17).

To view the detailed error message, run the
report directly from Crystal Reports (not
the Web).

Make sure that ASP.NET is installed and
enabled. See the preceding problem Report
parameters page does not open when a report
is selected—a 405 error appears.

In Crystal License Manager, make sure that
the Crystal licenses are entered for the
Crystal Reports Advanced Developer and
Embedded editions.
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Problem Solution(s)

Report is generated, but the following
problems occur:

m General problems viewing the report.
For example, headers and data do not
appear.

m Old or sample data appears in the
report.

m Cannot drill down in reports.

m Cannot print report if using the HTML
viewer with Crystal Reports 9 or 10.
The following message appears:

There was an error opening this
document. This file cannot be found.

Change the viewer used to view reports.
For more information, see Defining Users
on page 3-27 and Web Settings on

page 3-47.

Note: If you are using the Crystal Report
ActiveX viewer, you may not have
administrative privileges to allow the
viewer to be automatically downloaded
and installed on the computer on which
you are trying to run the report. Use the
Crystal HTML or Java viewer instead.

One or more old loads have not been
removed from the database. Unload the
old data. For more information, see
Tracking the History of Database Loads on
page 5-25

Certain items do not have any additional
information available. If you place the
cursor on an item and the cursor icon
becomes a magnifying glass or a hand, you
can drill down. If it does not, there is no
detailed information available about the
item.

When prompted to open or save the file,
click Save and then click Open.
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An error message appears when using ActiveX Data Objects (ADO) or
ODBC to open a database connection in an ASP page

When you use ActiveX Data Objects (ADO) or ODBC to open a database connection in
an ASP page, you may receive the following error message:

Microsoft OLE DB Provider for ODBC Drivers error '80004005' [Microsoft]
[ODBC Driver 1 Data source name not found and no default driver specified.

Solution

Note * Make sure that you have completed the steps in Set the Home Directory for the
CIMS Server Web Reporting Web Site on page 2-48 and Set the User Authentication Method
for the CIMS Server Web Reporting Web Site on page 2-50 before continuing with this
solution.

The Windows 2000/2003 user account that is used to process the request for the ASP
page does not have sufficient permissions to read the registry key that stores the specified
ODBC Driver's configuration information. The Driver parameter in a DSN-less
connection string specifies the ODBC driver that is used to establish the database
connection.

Grant the Windows 2000 user account Read access to the specified ODBC Driver registry
key as follows:

1 Determine which account is used to process the request for the ASP page.

2 From the Start menu, click Run, type regedt32.exe, and then click OK to start
Registry Editor.

3 In the HKEY LOCAL MACHINE window, browse to the
HKLM\SOFTWARE\ODBC\ODBCINST.INI key. The ODBCINST.INI key contains a
subkey for each ODBC Driver that is installed on the server.

4 Click the Driver registry key for the Driver that is specified in the ADO connection
string.

5 From the Security menu, click Permissions.

6 Add the user account that you identified in Step 1 to the list of users who can access
this key, and select the Read check box for this user.

7 Click Apply, and then close Registry Editor.

This information was taken from the Microsoft Knowledge Base Article Q306345.
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Performing Disaster Recovery

In the event that the CIMS Server application server becomes inoperable due to media
failure or natural disaster, the following steps are required to recover the CIMS Server
system (including all databases, reports, folders, and files) to a new server.

Note that these steps reflect CIMS Server application server, the database server, and the
Web server on one computer. If your previous installation included multiple servers, you
need to restore accordingly.

To recover the CIMS Server system on a new server:

1 Install Microsoft SQL Server.

2 Install Microsoft Internet Information Services (IIS).

3 Install CIMS Server with the same options as the previous installation.

4 Restore a full backup of the database or databases that you are using for CIMS Server.

Ut

Restore the backup of the Program Files\CIMSLab folder structure.
6 Restore the backup of the Processes folder.

7 If your Reports folder or any of its subfolders are not installed in the CIMSLab folder,
restore the backup of the Reports folder and/or subfolders.

Executing Stored Procedures to Debug CIMS Server

WARNING - Because some stored procedures update data, you should use care when
executing procedures for debugging. If you are unsure as to whether you should use this
feature, consult CIMS Lab (see Contacting Technical Support on page 7-10).

You can execute stored procedures from CIMS Server Administrator for debugging
purposes. To execute a stored procedure:

1 In the CIMS Server Administrator main window, click System Administration »
Database » Execute Stored Procedure.

The Stored Procedure Execute dialog box appears.

2 On the Stored Procedures tab, click the stored procedure that you want to run, enter
the parameters for the procedure, and then click Execute.

When the stored procedure has finished running, the results appear on the Results tab.
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If You Are Using Crystal Reports Developer 8.5

If You Are Using Crystal Reports Developer 8.5

To use the Help system for Crystal Reports 8.5 on a computer with Internet Explorer 6.0
installed, follow the instructions on the Business Objects Web site (http://
support.businessobjects.com/library/kbase/articles/c2010291.asp).

Crystal Reports 8.5 requires that you set security permissions for certain folders. For
more information, contact CIMS Lab (see Contacting Technical Support on page 7-10).

Important! « You need to install the ActiveX patch for Crystal Reports provided on
the CIMS Lab FTP site (ftp://ftp.cimslab.com) and CIMS Product CD. The path on
both the FTP site and CIMS Product CD is CIMSServer\CrystalPatches\Crystal
Decisions ActiveX Viewer Patch.exe).

Contacting Technical Support

H 7-10

The CIMS Lab Technical Support department is here to answer your questions on any
aspect of CIMS Lab products.

CIMS Lab technical support can be reached in the following ways:

m Telephone: (800) 283-4267 in USA and Canada; 916-783-8525 International
B Email: support@cimslab.com

m Fax request: (916) 783-2090

International customers may contact one of our authorized international partners.
Contact CIMS Lab for more information.

In addition, customers may visit the Customer Area on our Web site for product
downloads, updates, technical documentation, and password information. We are on
the Web at http://www.cimslab.com.
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Database Tables

This appendix describes the layout of all database tables used by CIMS Server and
provides Entity Relationship Diagrams (ERDs) for the tables in the CIMS Server

database.

CIMSAUItClIeNt Table ......c.vuiinininiiiiiiiiiieieiiiieieieieeeesencecesesescncasenencns A-4
CIMSAuditClientContact Table .........cccovuiuieiiiiiiiieiiiiiieieieniieeneneicecenenennns A-5
CIMSAuditClientContactNumber Table ..........ccciviiiiiiiiiiiiiiiiiiieiieieieneeienenens A-7
CIMSAUdItRAte TabI@ .....viuiniiiiiieiiitiienietetersesssnsnsnsosessssssnsssossssssasnes A-9
CIMSAuditTransactionTable ..........cooiiiiiiiiiiiiiiiiiiieieneieieieereecnenenensnnes A-11
CIMSCalendar TabIe ........ccuvuineiiiiiniieneeieneneeeenensnssescscsscssnsssscsanscnes A-14
CIMSClient Table ......ciuiuininiiiiiiiiiiieieneieieeeerereneesesesesscscncscscsssscnes A-15
CIMSClientBudget Table ..........ooiiniiiiiiiiiiiiiiiiiiieiiieiiiieieienseneeenencnnnns A-16
CIMSClientContact TADI@ ......cuvtntninieieiiiiieieniiieieneneeeesenesesesesencncanans A-17
CIMSClientContactNumber Table ..........ociiiiiiiiiiiiiiiiiiiiiiieieieiiiienenennens A-18
CIMSCONSIBTaDbIE ....vuiniiiiiiiiiiiiiiiiiitieiiiieieitneesesescaeasesescacssescscnnans A-19
CIMSConfigOptions Table .....c.vuiniiiiiiiiiiiiieieiiiiiieieieneseseeececncncsessnscnes A-21
CIMSConfigAccountLevel Table ........ciuiiiiiiiiiieiiiiiieieiiiieieienceenenencnenns A-22
CIMSCPUNormalization Table .........ccoeiiuininiuieiiiiieieniiieneneicecenencncenens A-22
CIMSDetailTable .....c.vuieiiiiiiiiiiiiiiiiitieiiiieieieneeieieneseenescncasssencncnnnns A-23
CIMSDetailldent Table ........cciviininiuieiiiiiieiiiieieieneeieteneneececesencncanens A-24
CIMSHeadline TabIe ......ouiuiniiiiiiiiiiiiieieieieieerereneneseseseescscncncsessssnes A-24
(614 L e 1) 41 I 1 ) A-25
CIMSINpSKcCategory Table ........cciuiiiiiiiiiiiiieeieeieieeiecscsocssssecacessescncnns A-25
CIMSInpSrcCategorySource Table .......c.ouvuiiiiiiiiiiiiiiiiieneireneenenenenenennes A-25
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CIMSInpSrcMachineList Table ........coviiiiiiiiiiiiiiiiiiiiiiiiiierieneencccnenscnens A-25
CIMSLanguUage Table ........cciuviiiiiieriiiitieeiereeieeesseceasesssccasesssssascnsones A-26
CIMSLoadTrackingTable ........ccoeuiuiiiiiiiiiiiieieienieieieieneeiencncssenenencanss A-27
(011 2= 1 L - ) A-29
CIMSRateGroup Table .......ciuiiiiiiiieiiiiiiieieeieieeieeseeacssssesscesssssnscnsanes A-32
CIMSRateldentifiers Table .........coeiiiiiiiiiiiiiiiiiiiiiieieiiieeeeiesccecesencncnnns A-32
CIMSRateShift TADIE .....cuiuiiiiiiitieiiiiiiietetersesesaceseroressssssssososessssasns A-33
CIMSRateToORateGroup Table .........ocieiuiiiiiiiiiieiiiiiiririeneneneincacarecnenenns A-34
CIMSREPOIITaDIE ....cuiiiniiiiiiiiiitiieeiieeieeeseeeessseccsscensssnsssnsssnccnnes A-34
CIMSReportCustomFields Table .........cociuiiiiiiiiiiiiiiiiiirieieieieieccnrnenenanss A-35
CIMSReportDistribution Table ..........c.coiiiiiiiiiiiiiiiiiiiiririeicicerererasessnens A-35
CIMSReportDistributionCycle Table .......ccoviiiiiiiiiiiiiiiiiiiieiiienreeienenececnnns A-36
CIMSReportDistributionParm Table ........ccviiiiiiiiiiiiiiiieieieiisererereesssssans A-37
CIMSReportDistributionType Table .........ccciiiiiiiiiiiiiiiieiiiieieieiieenenencanss A-37
CIMSReEpOIGIroUP TabIe .....vuuiniiiiiieiiiiiiieiieieenesnesecsecsesscscescsscccncnnes A-37
CIMSReportStart Table .......ccoieeiiiiiieiiieiiiiiieiiieiieeeeceseccnsssnscsnccsnccnnns A-38
CIMSReportTOReporGroup Table ......civiuiiiiiiiiiiiiiieierierieiecieencsecnccncnnes A-38
CIMSResourceUtilization Table . .........coouiiiiiiiiiiiiiiiiiiiiiiiieieieieieenenencnnes A-39
CIMSSUMMArY Table .....viuiiiiiiiiiiiiiiiitiieiteieieesseseeacssssosscessssssscnsones A-40
CIMSSummaryDaily Table .......cciiiiiiiiiiiiiiiiiiiiiiiiiiiitiieiieieieineenenencnnss A-43
CIMSSummaryToDetail Table .........coiuiiiiiiiiieiiiiiiiiiiiiiieieiiienenenencnnes A-43
CIMSTransaction Table ........c.ouniininiiiiiiiiiiiitieiiieieieieeieiecncncenenencanss A-44
CIMSUSEr TabI@ .. viureiiiiititiiiiinrntitneneeeeseasasasecscsssssssnsssscssnssssnsnnns A-46
CIMSUserConfigOptions Table ..........coiuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieieieaenns A-47
CIMSUserFavorites Table ........cccoeininiiiiiiiieieieiiiieieniieeeeienccecesencncnnns A-48
CIMSUSErGroup Table .........cciuiiuiiiniiiitieeiereeieeessacesssssaseasessssssscnsones A-48
CIMSUserGroupAccountCode Table .......ouiuiiiiiiiiiiiniierereeneessscnsnrereecnns A-49
CIMSUserGroupAccountStructure Table .......oviuviiiiiiiiiiiiiiiiiiiiiiiiiniennennens A-49
CIMSUserGroupConfigOptions Table .........cooiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii i, A-49
CIMSUserGroupReport Table ........coeiuiieiiiiiiiiiieiiiieieceeeeeneceecncsncnncnnes A-51
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Transaction-related Tables . . ... i A-57

CIMS Server Administrator's Guide A-3 N



H Database Tables
CIMSAuditClient Table

CIMSAuditClient Table

If auditing is enabled, this table tracks changes made to the CIMSClient table. To enable
auditing of the CIMSClient table, see page 3-52.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSClient table
(see page A-15).

Field Name Key Type Field Description

TransType char(1) The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

DateTimeChanged datetime The date and time that the
change was made.

UserID char(30) The Windows user ID of the user
who made the change.

01dAccountCode char(128) The old client account code.

NewAccountCode char(128) The new client account code.

OTdATtAccountCode char(128) The old alternate client account
code.

NewAltAccountCode char(128) The new alternate client account
code.

OTdAccountName varchar(255)  The old client name.

NewAccountName varchar(255)  The new client name.

OldLoadTrackingUID int The old load tracking unique

identifier for the client.

NewlLoadTrackingUID int The new load tracking unique
identifier for the client.

OldRateTable char(8) The old rate code table for the
client.

NewRateTable char(8) The new rate code table for the
client.

OldInvoiceContact int The old index number for the

contact name that appears on
the invoice.
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Field Name Field Description

NewInvoiceContact int The new index number for the
contact name that appears on
the invoice.

OldActionCodel- char(1) The old action codes—see the

OldActionCode8 ActionCode field description for
the CIMSClient table.

NewActionCodel- char(1) The new action codes—see the

NewActionCode8 ActionCode field description for
the CIMSClient table.

CIMSAuditClientContact Table

If auditing is enabled, this table tracks changes made to the CIMSClientContact table. To
enable auditing of the CIMSClientContact table, see page 3-52.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSClientContact
table (see page A-17).

Field Name Key Type Field Description

TransType char(1) The type of change that was
made to the table:

m U = update to existing data
m [ = addition of new data

B D =deletion of data

DateTimeChanged datetime The date and time that the
change was made.

UserID char(30) The Windows user ID of the user
who made the change.

OldLoadTrackingUID int The old load tracking unique
identifier for the client.

NewlLoadTrackingUID int The new load tracking unique
identifier for the client.

OTdAccountCode char(128) The old client account code.

NewAccountCode char(128) The new client account code.

OldContactIdx int The old index number for the
contact.
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Field Name Key Type Field Description
NewContactIdx int The new index number for the
contact.
OldAddressLinel- varchar(255)  The old address line by line
0TdAddressLineb number.
NewAddressLinel- varchar(255)  The new address line by line
NewAddresslLineb number.
OldContactName varchar(255)  The old contact name.
NewContactName varchar(255)  The new contact name.
OldDepartment varchar(255)  The old contact department.
NewDepartment varchar(255)  The new contact department.
01dOffice varchar(255)  The old contact office.
NewOffice varchar(255)  The new contact office.
OldComments varchar(255)  The old contact comments.
NewComments varchar(255) The new contact comments.
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CIMSAuditClientContactNumber Table

If auditing is enabled, this table tracks changes made to the CIMSClientContactNumber
table. To enable auditing of the CIMSClientContactNumber table, see page 3-52.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the
CIMSClientContactNumber table (see page A-18).

Field Name

TransType

DateTimeChanged

UserlD

OldLoadTrackingUID

NewlLoadTrackingUID

OTdAccountCode
NewAccountCode
01dContactldx
NewContactldx

0TdNumberIdx

NewNumberIdx

O0ldNumberDescription

NewNumberDescription

Key Type

char(1)

datetime

char(30)

int

int

char(128)
char(128)
int
int

int

int

varchar(255)

varchar(255)

Field Description

The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

The date and time that the
change was made.

The Windows user ID of the user
who made the change.

The old load tracking unique
identifier for the client.

The new load tracking unique
identifier for the client.

The old client account code.
The new client account code.
The old contact index number.
The new contact index number.

The old index number for the
contact number or e-mail
address.

The new index number for the
contact number or e-mail
address.

The old contact number
description.

The new contact number
description.
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Field Name Key Type Field Description
OTdNumberValue varchar(255)  The old contact number.
NewNumberVaTue varchar(255)  The new contact number.
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CIMSAuditRate Table

CIMSAuditRate Table

If auditing is enabled, this table tracks changes made to the CIMSRate table. To enable
auditing of the CIMSRate table, see page 3-52.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSRate table (see

page A-29).
Field Name

TransType

DateTimeChanged

UserlD

OldLoadTrackingUID

NewlLoadTrackingUID

OldRateTable

NewRateTable

0T1dRateCode
NewRateCode

0TdRateIndex

NewRatelIndex

OldRateValue

NewRateValue

01dResourceValue

Key Type
char(1)

datetime

char(30)

int

int

char(8)

char(8)

char(8)
char(8)

int

int

decimal(18,8)

decimal(18,8)

decimal(19,4)

Field Description

The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

The date and time that the
change was made.

The Windows user ID of the user
who made the change.

The old load tracking unique
identifier for the rate code.

The new load tracking unique
identifier for the rate code.

The old rate code table for the
rate code.

The new rate code table for the
rate code.

The old rate code.
The new rate code.

The old index number for the
rate code.

The new index number for the
rate code.

The old per unit value for the
rate code.

The new per unit value for the
rate code.

Deprecated.
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A-9 B



H Database Tables

CIMSAuditRate Table

Field Name

Field Description

NewResourceValue
01dDiscountDollars
NewDiscountDollars
01dDiscount
NewDiscount
01dDiscountIndex
NewDiscountIndex
OldDescription
NewDescription

OldFactor

NewFactor

OTldRateValuel -
OldRateValuell

NewRateValuel -
NewRateValuell

OldEffDate

NewEffDate

0ldTermDate

NewTermDate

01dComments

NewComments

decimal(19,4)
decimal(19,4)
decimal(19,4)
decimal(7,4)
decimal(7,4)
int

int
varchar(255)
varchar(255)

numeric

numeric

char(1)

char(1)

datetime

datetime

datetime

datetime

varchar(255)

varchar(255)

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

The old rate code description.
The new rate code description.

The old resource conversion
factor.

The new resource conversion
factor.

The old rate values—see the
RateValue field descriptions for
the CIMSRate table.

The new rate values—see the
RateValue field descriptions for
the CIMSRate table.

The old effective date for the rate
code. For future use.

The new effective date for the
rate code. For future use.

The old end date for the rate
code. For future use.

The new end date for the rate
code. For future use.

The old comments for the rate
code.

The new comments for the rate
code.

B A-10
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CIMSAuditTransactionTable

If auditing is enabled, this table tracks changes made to the CIMSTransaction table. To
enable auditing of the CIMSTransaction table, see page 3-52.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSTransaction
table (see page A-44).

Field Name Field Description

TransType char(1) The type of change that was
made to the table:

m U =update to existing
data or transaction
marked as deleted

m [ = addition of new data

DateTimeChanged datetime The date and time that the
change was made.

UserID char(30) The user ID of the user who
made the change (usually
the Windows user ID or the

SQL Server login ID).
OldTransactionUID char(32) The old unique identifier for
the transaction.
NewTransactionUID char(32) The new unique identifier
for the transaction.
0ldAccountCode char(128) The old account code for the
transaction.
NewAccountCode char(128) The new account code for

the transaction.

OldTransactionType char(1) The old transaction type—
see the TransactionType
field description for the
CIMSTransaction table.

NewTransactionType char(1) The old transaction type—
see the TransactionType
field description for the

CIMSTransaction table.
01dShiftCode char(1) The old shift code.
NewShiftCode char(1) The new shift code.
OldRateCode char(8) The old rate code.
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CIMSAuditTransactionTable
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Field Name
NewRateCode

0TdResourceAmount

NewResourceAmount

01dFrequencyl-01dFrequency?

NewFrequencyl-NewFrequency?

01dFromDate
NewFromDate
O1dToDate
NewToDate
OldDateTimeSent
NewDateTimeSent

0T1dDateTimeModified

NewDateTimeModified

OldDateTimeEntered

NewDateTimeEntered

OldDateTimeStartProcessing

NewDateTimeStartProcessing

OldDateTimeStopProcessing

NewDateTimeStopProcessing

char(8)
decimal(18,5)

decimal(18,5)

Int

Int

datetime
datetime
datetime
datetime
datetime
datetime

datetime

datetime

datetime

datetime

datetime

datetime

datetime

datetime

Field Description

The new rate code.

The old resource amount for
the transaction.

The new resource amount
for the transaction.

The old frequency number—
see the Frequency field
descriptions for the
CIMSTransaction table.

The new frequency
number—see the Frequency
field descriptions for the
CIMSTransaction table.

The old from date.

The new from date.

The old to date.

The new to date.

The old date and time sent.
The new date and time sent.

The old date and time
modified.

The new date and time
modified.

The old date and time
entered.

The new date and time
entered.

The old processing start date
and time.

The new processing start
date and time.

The old processing end date
and time.

The new processing end date
and time.
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Field Name Key Type Field Description

01dUserID char(8) The old CIMS user ID of the
user who made the change.

NewUserID char(8) The new CIMS user ID of the
user who made the change.

0ldDateTimeDeleted datetime The old date and time that
the transaction was deleted.

NewDateTimeDeleted datetime The new date and time that
the transaction was deleted.

OldNote varchar(255)  The old note for the
transaction.

NewNote varchar(255)  The new note for the
transaction.
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CIMSCalendar Table

This table defines the billing periods for a billing organization.

Field Name Key Type Field Description

Year PKa int The calendar year.

Period PKa int The calendar period (1 - 13).

PeriodBeginDate datetime The beginning date of the
period

PeriodEndDate datetime The ending date of the period

CloseDate datetime The processing close date.

a. PK = Primary Key
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CIMSClient Table

This is the primary table for storing client information. All other client tables are related
to this table.

Field Name Key Type Field Description

AccountCode PKa char(128) The account code for the client.

AltAcctCode char(128) The alternate account code for
the client (optional).

AccountName varchar(255)  The client name.

LoadTrackingUID int A unique identifier that tracks

the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback

System.
RateTable char(8) The rate code table for the client.
InvoiceContact int The index number for the client

contact name that appears on
the invoice.

ActionCodel - ActionCode8 char(1) These user-defined codes are
strictly for reporting purposes
and can be used in the custom
reporting process for selecting
data. CIMS Server does not use
action codes.

a. PK = Primary Key
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CIMSClientBudget Table

This table stores budget and actual information for amounts and resource units by
account code, date, and rate code.

Field Name

LoadTrackingUID

AccountCode

RateCode

Year
Period

BudgetAmt

ActualAmt

BudgetUnits

ActualUnits

Key Type

int
PKa char(128)
PKa char(8)
PKa int
PKa int

decimal(19,4)

decimal(19,4)

decimal(18,5)
decimal(18,5)

Field Description

A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The account code for the client.

A valid rate code for an
individual resource budget or
TOTAL for an overall account
budget.

The budget year.
The budget period (0 - 13).

The budget monetary amount
for the period.

Deprecated. The actual amount
is in the CIMSSummary table.

The budget units for the period.

Deprecated. The actual units
consumed are in the
CIMSSummary table.

a. PK = Primary Key
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CIMSClientContact Table

This table stores client contacts.

Field Name Key Type
LoadTrackingUID int
AccountCode PKa char(128)
Contactldx PKa int
AddressLinel varchar(255)
AddresslLine2 varchar(255)
AddressLine3 varchar(255)
AddressLined varchar(255)
AddresslLine5 varchar(255)
ContactName varchar(255)
Department varchar(255)
Office varchar(255)
Comments varchar(255)

CIMSdientContact Table

Field Description

A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The account code for the client.

The index number for the
contact.

Address Line 1

Address Line 2

Address Line 3

Address Line 4

Address Line 5

The name of the client contact.
The contact department.

The contact office.

Comments related to the
contact.

a. PK = Primary Key
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CIMSClientContactNumber Table

This table stores numbers (phone, fax, etc.) and e-mail addresses for contacts.

Field Name Key Type
LoadTrackingUID int
AccountCode PKa char(128)
Contactldx PKa int
NumberIdx PKa int

NumberDescription

NumberValue

varchar(255)

varchar(255)

Field Description

A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The account code for the client.

The index number for the
contact.

The index number for the
contact number or e-mail
address.

The type of number (VOICE, FAX,
EMAIL, etc.)

The contact number or e-mail
address.

a. PK = Primary Key
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CIMSConfigTable

This table defines configuration options that have a GUI option in CIMS Server
Administrator. One CIMS Config record is allowed per CIMS Server database.

Field Name Key Type Field Description
OrgName varchar(255)  The organization name
AddressLinel varchar(255)  Address Line 1
AddressLine2 varchar(255)  Address Line 2
AddressLine3 varchar(255)  Address Line 3
AddressLine4 varchar(255)  Address Line 4
InvoiceNo int Deprecated. This is stored in the
CIMSConfigOptions table.
InvoiceNumberType char(1) Deprecated.
Usel3Periods char(1) Indicates whether 13 periods are
used:
m Y (Yes)
m N (No)
UseCalender char(1) Indicates whether the CIMS
calendar is used:
m Y (Yes)
m N (No)
ReportAccessSecurity char(1) Indicates whether report security
is used:
m Y (Yes)
m N (No)
LocationStandardReports varchar(255)  The path to the CIMS standard
reports.
LocationCustomReports varchar(255)  The path to custom reports.
LocationSavedReports varchar(255)  The path to published reports.
DatabaseVersion char(7) The CIMS Server database
version number.
LastProcessUID int Used by CIMSACCT and
CIMSBILL.
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Field Name

CustomReportGrouplD

CustomSpreadsheetGroupID

SessionTimeoutMinutes

AccountParameterSelecti
onlLevel

DefaultCrystalViewer

DBConnectionTimeout

WebCustomSite

WebBGColor

WebCSSLocation

WebImagelocation

WebMenuVertStartPos

LastReportingDate

int

int

int

int

int

int

char(1)

varchar(32)

varchar(255)

varchar(255)

int

datetime

Field Description

The unique identifier for the
default report group for user-
defined Web reports.

The unique identifier for the
default report group for user-
defined Web spreadsheets.

The number of minutes before a
CIMS Server Web Reporting
session expires and a new login
is required.

In CIMS Server Web Reporting,
this setting determines the level
of account codes that appear in
the Starting Account Code and
Ending Account Code
parameter lists.

The unique identifier for the
browser viewer used to view
Crystal Reports.

The maximum number of
seconds that a database may
respond to a query before timing
out

Indicates the Web site to be
used:

m D (Default)
m C(Custom)

The hexadecimal number for
the background color of a
custom Web site.

The path to the CSS for a custom
Web site.

The path to the images for a
custom Web site.

The start position (in pixels) for
the menu of a custom Web site.

The last reporting date for
reports that end users who do
not have administrative
privileges can view.
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CIMSConfigOptions Table

This table defines configuration options that the administrator can add manually in
CIMS Server Administrator.

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

PropertyValue varchar(255)  The value for the configuration
option.

PropertyType int The data type of the

configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMSConfigAccountLevel Table

This table defines the account code structure.
Field Name Key Type Field Description

AccountStructureName char(32) The account code structure
name (e.g., Standard).

StartPosition int The starting offset position
for the account code.

AccountlLevel int The account code level.

AccountlLength int The length of the account
code level.

AccountDescription varchar(255) A description of the account
code level.

CIMSCPUNormalization Table

The table allows for differences in CPU speed.

Field Name Key Type Field Description

SystemID PKa char(32) The system identifier for the
computer that you want to
normalize. For z/OS, this is
the four-character System
Model ID. For UNIX and
Windows, it is the computer
name.

WorkID PKa char(32) The subystem name (e.g.,
CICS region name, DB2 plan
name, Oracle instance, etc.).

Factor decimal(10,4) The normalization factor.

a. PK = Primary Key
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CIMSDetail Table

This table stores the information contained in the CIMSBILL Detail file. The table
contains the resource information collected from the records in the input CSR or CSR+
file. Each record in this table represents a single resource used/time period. This is the
most granular form of the resource data stored in the database.

Field Name Key Type Field Description

LoadTrackingUID int The load tracking unique
identifier from the
CIMSLoadTracking table.

DetailUID int The unique identifier that tracks
the CIMSBILL Detail load.

Detailline int The number of the record in the
input CSR or CSR+ file that
contains the resource (i.e., 1 ifit
is the first record, 2 if it is the
second record, etc.).

AccountCode char(128) The account code.

Aggregate int A count of the number of
original input records that have
been aggregated into this record.

StartDate datetime The resource usage start date.

EndDate datetime The resource usage end date.

ShiftCode char(1) The resource usage shift code.

AuditCode varchar(255)  The audit code (CIMS External
Transaction records only).

SourceSystem char(8) The system identifier for this
resource.

RateCode char(8) The rate code of this resource.

Resourcelnits decimal(18,5) The quantity of the resource
used.

AccountingStartDate datetime The accounting start date.

AccountingEndDate datetime The accounting end date.
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CIMSDetailldent Table

This table stores the information contained in the CIMS Ident file. The table contains the
identifier values collected from the records in the input CSR or CSR+ file. The identifier
names are stored in the CIMSIdent table and are represented by a number assigned to
the identifier name.

Field Name Key Type Field Description

LoadTrackingUID int The load tracking unique
identifier from the
CIMSLoadTracking table.

DetailUID PKa int The unique identifier that
tracks the CIMSBILL Detail
load.

DetaillLine PKa int The number of the record in

the input CSR or CSR+ file
that contains the identifier
(i.e., 1ifitis the first record,
2 if it is the second record,

etc.).

IdentNumber PKa int A sequential number
assigned to the identifier in
the CIMSIdent table.

IdentValue varchar(255)  The value of the identifier.

a. PK = Primary Key

CIMSHeadline Table

This table defines the headlines that appear on the CIMS Server Web Reporting home

page.

Field Name Key Key Field Description

HeadlineUID PKa int The sequential UID that
tracks the headline.

HeadlLineDate datetime The date that the headline
was created.

Headline varchar(255)  The headline text.

Headlinelink varchar(255)  The URL for the headline

link.

a. PK = Primary Key
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CiMSIident Table

This table stores all identifier names contained in the input CSR or CSR+ files processed.
As a file is processed, the identifier names in the file records are added to this table. This
table will continue to store identifier names even if the identifiers are no longer used by
records loaded in the database. To delete unused identifier names if needed, see
Maintaining Identifiers on page 3-38.

Field Name Key Type Field Description

IdentNumber PKa int A sequential number
assigned to the identifier.

IdentName varchar(32) A short name for the
identifier.
IdentDescription varchar(255) A full description of the

identifier name (optional).

IdentActiveFlag char(1) Indicates whether Active or
Inactive has been selected for
custom reports:

m Blank (Active)

m I (Inactive)

IdentReportFlag char(1) User-defined report flag.

a. PK = Primary Key

CIMSInpSrcCategory Table

This table is for future use.

CIMSInpSrcCategorySource Table

This table is for future use.

CIMSInpSrcMachineList Table

This table is for future use.
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CIMSLanguage Table
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This table is for future use. It is intended to display GUI options (menus, links, etc.) in
CIMS Server Web Reporting in the required language.

Field Name

StringName

ENG
SPA
FRA
DuT
ITA
GER
FIN
SWE
JPN
POR

OTH

Key Type

PKa

varchar(80)

varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)

varchar(255)

Field Description

The tag name in the Web
reporting ASP page.

The GUI option in English.
The GUI option in Spanish.
The GUI option in French.
The GUI option in Dutch.
The GUI option in Italian.
The GUI option in German.
The GUI option in Finnish.
The GUI option in Swedish.
The GUI option in Japanese.

The GUI option in
Portuguese.

The GUI option in another
language.

a. PK = Primary Key
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CIMSLoadTracking Table

This table records the loading of any data to the database. This enables database loads to

be deleted if required.

Field Name

LoadTrackingUID

FileType

FiTeName

Dateloaded

DateDeleted

TotalRecslLoaded

StartDate

EndDate

SourceSystem

SourcefFeed

Key Type

PKa

int

char(8)

varchar(255)

datetime

datetime

int

datetime

datetime

varchar(32)

varchar(32)

Field Description

The unique identifier for the
database load.

The type of file processed:

B Summary
m Detail (CIMSBILL Detail)
m Ident

m Resource (CIMSACCT
Detail)

The path and name of the
file that was processed

The date and time the input
CSR or CSR+ file was
processed by CIMSACCT.

The date and time the load
was removed from the
database.

The number of records
loaded.

The accounting start date for
CIMS Summary, CIMS
Detail, and CIMS Ident
records. The usage end date
for resource records.

The accounting end date for
CIMS Summary, CIMS
Detail, and CIMS Ident
records. The usage end date
for resource records.

The name of the computer
that produced the data.

The system that produced
the data (e.g., IIS, Exchange,
z/OS, etc.)
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Field Name Key Type Field Description

DateArchived datetime The date and time that the
load was archived.

Archivelocation varchar(255)  The location of the archived
load.

LoadGroupUID int The unique identifier for the
group that the database load
belongs to.

a. PK = Primary Key
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CIMSRate Table

This table stores the rate codes and rates for resource usage.

Field Name

LoadTrackingUID

RateTable

RateCode

RateIndex

RateValue

ResourceValue
DiscountDollars
Discount
DiscountIndex

Description

Factor

RateValuel

Key Type

int

PKa char(8)

PKa char(8)

int

decimal(18,8)

decimal(19,4)
decimal(19,4)
decimal(7,4)
int

varchar(255)

decimal(15,8)

char(1)

Field Description

The unique identifier that
tracks the rate when loaded
to the database from a
location outside of CIMS
Server. For example, from
CIMS Mainframe Data
Collector and Chargeback
System.

The name of the rate code
table that contains the rate
code.

The code for the rate.

The index number for the
rate code.

The per unit value for the
rate code.

Deprecated.
Deprecated.
Deprecated.
Deprecated.

A description of the rate
code.

A user-defined resource
conversion factor value for
the resource unit value in
reports.

Indicates whether four
decimal positions are used
in the rate value in reports:

m  (Four digits are used)

m Blank (Eight digits are
used [the default])
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Field Name

RateValue?2

RateValue3

RateValued

Key Type
char(1)

char(1)

char(1)

Field Description

Indicates whether the rate is
per resource unit or per
thousand units in reports:

m M (Per thousand units)

m Blank (Per unit)

Indicates the resource
conversion factor for the
resource unit value in
reports.

m 1 (Divide total resource
value by 60)

m 2 (Divide total resource
value by 3600)

m 3 (Divide total resource
value by 1000)

m 4 (Multiply total resource
value by 60)

m 5 (Divide total resource
value by 60000)

m {f (Multiple total resource
value by user-defined
number in Factor field.)

m Blank (No conversion
factor)

Indicates whether the rate
code is included in zero cost
calculations:

B N (The rate will not be
included in zero cost
calculations)

m Blank (The rate will be
included in zero cost
calculations)

For more information about
zero cost calculations, see
page 3-11.
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CIMSRate Table
Field Name Key Type Field Description
RateValueb char(1) Indicates the number of

decimal digits that appear in
the resource units value in
reports:

m 1-5(1 through 5 digits)
m Blank (2 digits, the

default)
RateValue6 char(1) For future use.
RateValue7 char(1) Indicates the whether the

resource units for the rate
code are considered a
monetary amount rather
than units if utilization:

m $ (flat fee)
m Blank (not flat fee)

RateValue8 char(1) User-defined report flag.

RateValue9 char(1) For future use.

RateValuelO char(1) User-defined report flag.

RateValuell char(1) Indicates whether the rate
should be included in CPU
normalization:
m Y (Yes)
m N(No)

EffDate datetime The effective date for the rate
code.

TermDate datetime The end date for the rate
code.

Comments varchar(255)  Comments for the rate code.

DetailDescription varchar(255)  User-defined description of
the rate code for custom
reports.

CurrencySymbo]l varchar(3) User-defined currency

symbol for custom reports.

a. PK = Primary Key
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CIMSRateGroup Table

This table defines the rate groups.

Field Name Key Type
RateGroup PKa int
ParentUID int
GroupTitle char(32)
GroupTitlelong varchar(255)
PrintIndex int

Field Description

A sequential number
assigned to the rate group.

For future use.
The rate group title.

A description of the rate
group.

The order in which the rate
group appears in reports.

a. PK = Primary Key

CIMSRateldentifiers Table

This table correlates rate codes to identifiers to enable drill down on the units consumed

for a resource by identifier.

Field Name Key Type
RateCode PKa char(8)
IdentNumber PKa int

Field Description
The rate code.
A sequential number

assigned to the identifier for
the rate code.

a. PK = Primary Key

B A-32
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CIMSRateShift Table
This table defines the optional rate shifts for rate codes.

Field Name Key Type Field Description

RateTable PKa char(8) The name of the rate code
table.

RateCode PKa char(8) The rate code.

ShiftCode PKa char(1) The shift code.

RateValue decimal(18,8) The rate value for the shift.

Description varchar(255) A description of the shift
(Swing, Night, etc.).

RateValuel char(1) For future use.

RateValue2 char(1) For future use.

RateValue3 char(1) For future use.

RateValued char(1) For future use.

RateValueb char(1) For future use.

RateValue6 char(1) For future use.

RateValue7 char(1) For future use.

RateValue8 char(1) For future use.

RateValue9 char(1) For future use.

RateValuelO char(1) For future use.

RateValuell char(1) For future use.

EffDate datetime The effective date for the rate
code.

TermDate datetime The end date for the rate
code.

Comments varchar(255)  For future use.

a. PK = Primary Key
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CIMSRateToRateGroup Table

This table correlates rate codes to rate groups.

Field Name
RateCode

RateGroup

Key Type
PKa char(8)
PKa int

Field Description
The rate code.

A sequential number
assigned to the rate group.

a. PK = Primary Key

CIMSReport Table

This table stores information about the reports used for CIMS Server Web Reporting.
These reports are entered in the Report List Maintenance dialog box (see Adding Reports
to the CIMS Server Report List on page 4-5).

Field Name

Key Type

Field Description

ReportID

ReportName

ReportFile

ReportDescription

UserID

ReportTemplateFile

PKa

int

char(32)
varchar(255)

varchar(255)
char(8)

varchar(255)

The unique identifier for the
report.

The name of the report

The .rpt file name for the
report. Also, the executable
for all reports (except user-
defined reports).

A description of the report.

For a user-defined reports,
the CIMS user ID of the
person who created the
report.

The .rpt file to be used as
the executable for user
defined reports.

a. PK = Primary Key
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CIMSReportCustomFields Table

This table stores the values for the user-defined reports that can be stored in the database
and supplied to the report automatically at run time.

Field Name Key Type Field Description

ReportID PKa int The unique identifier for the
report.

RateCode char(8) The rate code

ReportPosition PKa int The position within the

report where the values are
used beginning with 1 and
continuing sequentially.

DecimalPTlaces int The number of decimal
places to display for the
resource usage amount in
reports.

a. PK = Primary Key

CIMSReportDistribution Table

This table store the values for the report distribution requests. These requests are
associated with a report cycle.

Field Name Key Type Field Description

UserID char(8) The CIMS user ID for the
user assigned to the report.

GrouplID char(8) The CIMS user group ID for
the user group assigned to
the report.

ReportID int The unique identifier for the
report.

ReportCyclelD PKa int The unique identifier for the
report cycle.

RequestID PKa int The unique identifier for the

report distribution request.

ReportFormat int The unique identifier for the
report format.

a. PK = Primary Key
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CIMSReportDistributionCycle Table

This table stores values for report cycles.

Field Name

ReportCyclelD

ReportCycleName
ReportCycleDescription

EmailFromAddress

EmailSubject

EmailText

WebSiteCIMS

WebSiteReports

LinkType

MailServer

UserSelectable

EmailAdminAddress

Key Type

PKa

char(8)

char(8)
int

int

int

int

varchar(80)

varchar(255)

int

varchar(80)

int

varchar(128)

Field Description

The unique identifier for the
report cycle.

The report cycle name.
The report cycle description.

The address of the e-mail
sender.

The text in the e-mail
subject.

The text in the e-mail body.

The URL fo the CIMS Server
Web Reporting Web site.

The URL for the virtual
directory for published
reports.

The link type:
m 1 (UNC)
m 2 (URL)

The name of the SMTP mail
server used to send the
e-mail.

For future use.

The address of the CIMS
Server administrator to
receive the report
distribution log file.

a. PK = Primary Key
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CIMSReportDistributionParm Table

This table stores the values for each report assigned to a report cycle.

Field Name Key Type Field Description

ReportID PKa int The unique identifier for the
report.

ReportCyclelD PKa int The unique identifier for the
report cycle.

RequestID PKa int The unique identifier for the
report distribution request.

ParmName PKa varchar(255) The parameter name.

ParmValue varchar(255)  The parameter value.

a. PK = Primary Key

CIMSReportDistributionType Table

This table stores the values for report formats.

Field Name Key Type Field Description

TypelD PKa int The unique identifier for the
report format.

TypeValue varchar(255)  The description of the report
format.

a. PK = Primary Key

CIMSReportGroup Table

This table stores information about report groups.

Field Name Key Type Field Description

ReportGroupID PKa int The unique identifier for the
report group

ReportGroupName char(32) The report group name

ReportGroupDesc varchar(255) A description of the report
group.

a. PK = Primary Key
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CIMSReportStart Table

This table defines the order in which reports appear in CIMS Server Web Reporting.

Field Name

ReportStartlID

ReportStartGroup

Key Type

int

int

Field Description

A unique identifier for the
start group.

A sequential number that is
assigned to the start group.
The number is dependent on
the order in which the group
was created.

CIMSReportToReportGroup Table

This table relates reports to report groups.

Field Name

MemberID

MemberType

ReportGroupld

Sequence

Key Type

PKa

PKa

PKa

int

char(1)

int

int

Field Description

The unique identifier of the
report.

m R(Report)
m G (Graph)

The unique identifier for the
report group.

The order of the report in the
report group list.

a. PK = Primary Key
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CIMSResourceUtilization Table

This table stores the resource information contained in the CIMSACCT Detail file. In
most cases, you will not need to load the data in CIMSACCT Detail file to the database.

Field Name Field Description

LoadTrackingUID int The load tracking unique
identifier from the
CIMSLoadTracking table.

DetailUID int The unique identifier that
tracks the CIMSACCT Detail
load.

Detailline int The number of the record in

the input CSR or CSR+ file
that contains the resource
(i.e., 1 ifitis the first record,
2 if it is the second record,

etc.)
AccountCode char(128) The account code.
Aggregate int A count of the number of

original input CSR or CSR+
records that have been
aggregated into this record.

StartDate datetime The resource usage start date.

EndDate datetime The resource usage end date.

ShiftCode char(1) The resource usage shift
code.

AuditCode varchar(255)  The audit code (CIMS
External Transaction records
only).

SourceSystem char(8) The system identifier for this
resource.

RateCode char(8) The rate code of this
resource.

Resourcelnits decimal(18,5) The quantity of the resource
used.
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CIMSSummary Table

B A-40

This table stores the information contained in the CIMS Summary file created by
CIMSBILL. This table contains both resource utilization and cost data for reports. Note
the Bi11F1ag fields reflect the flags that were set in the CIMSRate table at the time that

CIMSBILL was run.

Field Name

LoadTrackingUID

Year
Period

Shift

AccountCode

LenLevell

LenLevel?2
LenLevel3
LenlLevel4

RateTable

RateCode

StartDate

EndDate

Key Type

int

int
int

char(1)

char(128)

int

int
int
int

char(8)

char(8)

datetime

datetime

Field Description

The load tracking unique
identifier from the
CIMSLoadTracking table.

The resource usage year.
The resource usage period

The resource usage shift
code.

The account code.

Values are the following:

B 0—The record was created
from a Detail record.

m 1—Therecord was by
created by reprocessing a
CIMS Summary record.

m 2—Therecord was by
created by processing a
Summary record twice. If
the Summary record was
processed more than
twice, the value would be
3,4, 5, etc.

A value of 0.
A value of 0.
A value of 0.

The name of the rate code
table that contains the rate
code.

The rate code for the
resource.

The accounting start date.

The accounting end date.
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CIMSSummary Table
Field Name Key Type Field Description
Bi11Flagl char(1) Indicates whether four

decimal positions are used
in the rate value in reports:

m F (Four digits are used)

m Blank (Eight digits are
used [the default])

Bil1Flag2 char(1) Indicates whether the rate is
per resource unit or per
thousand units in reports:

m M (Per thousand units)

m Blank (Per unit)

Bi11F1ag3 char(1) Indicates the resource
conversion factor for the
resource unit value in
reports:

m 1 (Divide total resource
value by 60)

m 2 (Divide total resource
value by 3600)

m 3 (Divide total resource
value by 1000)

m 4 (Multiply total resource
value by 60)

m 5 (Divide total resource
value by 60000)

m {f (Multiple total resource
value by user-defined
number in Factor field.)

Bil1Flag4 char(1) Indicates whether the rate
code is included in zero cost
calculations:

B N (The rate will notbe
included in zero cost
calculations)

m Blank (The rate will be
included in zero cost
calculations)

For more information about
zero cost calculations, see
page 3-11.
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Field Name Field Description

Bi11F1agb char(1) Indicates the number of
decimal digits that appear in
the resource units value in
reports:

m 1-5(1 through 5 digits)
m Blank (2 digits, the

default)
Bi11F1ag6 char(1) For future use.
Bil1FTag7 char(1) Indicates the whether the

resource units for the rate
code are considered a
monetary amount rather
than units if utilization:

m $ (flat fee)
m Blank (not flat fee)

Bil1Flag8 char(1) User-defined report flag.
Bi11F1ag9 char(1) For future use.
RateValue decimal(18,8) Per unit charge for this rate.
Resourcelnits decimal(18,5) The total units for this rate.
BreakId int Deprecated.
MoneyValue decimal(19,4) The total currency units for
this rate.
UsageStartDate datetime The resource usage start date.
UsageEndDate datetime The resource usage end date.
RunDate datetime The date and time that
CIMSBILL was run.
BiT11F1agl0 char(1) User-defined report flag.
Bil1Flagll char(1) Indicates whether the rate
should be included in CPU
normalization:
m Y (Yes)
m N(No)

a. PK = Primary Key
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CIMSSummaryDaily Table

This table stores the data in the CIMSSummary table at a monthly rather than daily level.
The fields are the same as the CIMSSummary table.

For more information about converting daily records to monthly records, see
ConvertSummaryDailyToMonthly.wsf Script on page C-9.

CIMSSummaryToDetail Table

This table is obsolete.

Field Name Key Type Field Description

SummarylLoadTrackingUID PKa int The load tracking unique
identifier from the CIMS
Load Tracking table.

DetailUID PKa int The unique identifier that
tracks the CIMSBILL Detail
load.

StartDate datetime The accounting start date.

EndDate datetime The accounting end date.

DetailConverted char(1) Indicates whether the

CIMSBILL Detail records
have been converted:

Y (Yes)
Null (No)

SummaryConverted char(1) Indicates whether the CIMS
Summary records have been
converted:

Y (Yes)
Null (No)

a. PK = Primary Key
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CIMSTransaction Table

This table stores miscellaneous, recurring, and credit transactions. For more information
about creating and using transactions, refer to the CIMS Server Web Reporting User’s

B A-44

Guide.
Field Name Key Type
TransactionUID PKa char(32)
AccountCode char(128)
TransactionType char(1)
ShiftCode char(1)
RateCode char(8)
ResourceAmount decimal(18,5)
Frequencyl int

Field Description

The unique identifier for the
transaction.

The account code for the
transaction.

The transaction type:
m M(Miscellaneous)
m R(Recurring)

m C (Credit)

The shift code for the
transaction.

The rate code for the
transaction.

The amount of the
transaction.

Applicable only to recurring
transactions. The frequency
that the transaction should
occur (every month, every 6
months, etc.). Frequency is
based on the calendar year
(January-December)

1 (monthly)

2 (every other month)

3 (every quarter)

4 (every four months)

6 (every six months)

12 (once a year)
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CIMSTransaction Table
Field Name Key Type Field Description
Frequency? int Applicable only to recurring

transactions. The period in
which the transaction
should be processed. This
value corresponds to the
valuein the Frequencyl field.
For example, if the value in
the Frequencyl field is 6, a
value of 1 in this field
indicates the first month of a
6 month period (January or
July).

FromDate/ToDate datetime Applicable only to
miscellaneous and credit
transactions. The date range
that the transaction
occurred.

DateTimeSent datetime The date and time that the

transaction was exported to a
flat file.

DateTimeModified datetime The date and time that the

transaction was last
modified.

DateTimeEntered datetime The date and time that the
transaction was created.

DateTimeStartProcessing datetime Applicable only to recurring
transactions. The first day
that the transaction will be
processed.

DateTimeStopProcessing datetime Applicable only to recurring
transactions. The last day
that the transaction will be
processed.

UserID char(8) The CIMS user ID of the
person who entered the
transaction.

DateTimeDeleted datetime The date and time that the
transaction was deleted.

Note varchar(255) A description of the
transaction.

a. PK = Primary Key

CIMS Server Administrator's Guide A-45 N



H Database Tables

CIMSUser Table

CIMSUser Table

This table stores the user options entered in the User Maintenance dialog box (see

Defining Users on page 3-27).

Field Name
UserID
Password
SessionID
UserFullName

UserFlagl

UserFlag?

CrystalViewer

DomainUserName

EmailToAddress

Key Type

PKa

char(8)

int

int
varchar(255)
char(1)

char(1)

int

varchar(255)

varchar(255)

Field Description

The CIMS user ID.

A hash of the user password.
A unique session identifier.
The full name of the user.

Indicates whether full report
path for published reports is
displayed for the user on
Favorites page in CIMS
Server Web Reporting:

m Y (Yes)

m N(No)

Indicates whether full report
path for published reports is
displayed for the user on

Published Reports page in
CIMS Server Web Reporting:

m Y (Yes)
m N(No)

The unique identifier for the
browser viewer used by the
user to view Crystal Reports.

The Windows domain and
user name for the user.

The e-mail address for the
user.

a. PK = Primary Key

B A-46

CIMS Server Administrator's Guide



Database Tables W
CIMSUserConfigOptions Table

CIMSUserConfigOptions Table

This table stores the user configuration options entered in the User Configuration
Options List Maintenance dialog box (see Defining Users on page 3-27).

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

UserID PKa char(8) The CIMS user ID.

PropertyValue varchar(255)  The value for the configuration
option.

PropertyType int The data type of the

configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMSUserFavorites Table

This table stores information regarding the CIMS Server Web Reporting users favorite
reports. For more information about favorite reports, refer to the CIMS Server Web
Reporting User’s Guide.

Field Name Key Type Field Description
UserID char(8) The CIMS user ID.
FavoriteReportGroup int The unique identifier for the

report group that the favorite
report belongs to.

FavoriteReport int The unique identifier for the
favorite report.

DisplayOrder int The order in which the
favorite report is displayed.

CIMSUserGroup Table

This table relates users to user groups.

Field Name Key Type Field Description
GrouplID PKa char(8) The user group ID.
GroupFullName varchar(255)  The full name of the group.
TransactionSecurity char(1) Indicates whether group has
transaction maintenance
privilege:
9 (Yes)
0 (No)
RateSecurity char(1) For future use.
ClientSecurity char(1) For future use.
GroupType char(1) Type of user:
1 (Client)
9 (Admin)

a. PK = Primary Key
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CIMSUserGroupAccountCode Table

This tables defines user the account codes that users within a user group can view.

Field Name Key Type Field Description
GroupID PKa char(8) The user group ID.
AccountCode PKa char(128) The client account code that

can be viewed. If the group
has access to all clients, this
field is blank.

a. PK = Primary Key

CIMSUserGroupAccountStructure Table

This table stores the account code structures assigned to a user group.

Field Name Key Type Field Description

GroupID PKa char(8) The user group ID.

AccountStructureName PKa char(32) The name of the account
code structure.

GroupDefault int Indicates whether the
account code structure is the
default:

1 (default)
0 (not default)

CIMSUserGroupConfigOptions Table

This table stores the user configuration options entered in the Group Configuration
Options List Maintenance dialog box (see Defining User Groups on page 3-31).

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

GroupID PKa char(8) The CIMS user group ID.

PropertyValue varchar(255)  The value for the configuration
option.
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Field Name Field Description

PropertyType int The data type of the
configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMSUserGroupReport Table

This tables defines the reports that users within a user group can view. If a group has
access to all reports, it is not included in this table.

Field Name Key Type Field Description
GroupID pPKa char(8) The CIMS user group ID.
ReportID PKa int The unique identifier of the
report.
ReportExecute char(1) Permission for users in this
group to run the report:
m Y (Yes)
m N (No)

a. PK = Primary Key
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Database Entity Relationship Diagrams

B A-52

This section provides Entity Relationship Diagrams (ERDs) for most of the tables in the
CIMS Server database. (Tables that do not have explicit relationships are not shown.)

These diagrams show the following:

m The relationships of the client, report, and user tables

m The relationship of the CIMSTransaction and CIMSSummary tables to other tables
The following conventions are used in these diagrams:

m PK = Primary Key

® Bold = A required field

m A double arrow equals a one-to-many relationship. For example, one client can have
many budgets (i.e., budgets for multiple resources).

Note that some tables are shown in more than one diagram.
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Summary-related Tables

Database Entity Relationship Diagrams

The ERD in Figure A-1 shows the relationship of the CIMSSummary table to other tables.

ActionCodes
ActionCodeb
ActionCode?
ActionCode8

Figure A-1 « Summary-related Tables ERD
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Database Entity Relationship Diagrams

Client Tables

The ERD in Figure A-2 shows the relationships of the client tables.

CIMSClient
PK | AccountCode CIMSClientBudget
PK | AccountCode
AltAcctCode PK |RateCode
AccountMame PK |Year
LoadTrackingUID PK |Period
RateTahle -t -
InvoiceContact LoadTrackingUID
ActionCodel BudgetAmt
ActionCode2 ActualAmt
ActionCode3 BudgetUnits
ActionCoded Actuallnits
ActionCodes
ActionCodeb
ActionCode?
ActionCode8
A
k4
h
CIMSClientContact CIMSClientContactMumber
PK | AccountCode PK | AccountCode
PK | Contactldx PK | Contactldx
-= pp PK | Humberldz
LoadTrackingUID
Addresslinel LoadTrackingUID
AddressLine2 MNurberDescription
AddressLined MNumbervalue
AddressLined
AddressLines
ContactMarme
Department
Office
Comments

Figure A-2 + Client Tables ERD
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User Tables

Database Entity Relationship Diagrams

The ERD in Figure A-3 shows the relationships of the user tables.

CIMSUser

PK | UserlD

Password
SessionlD
UserFullMName
UserFlag1
UserFlag2
CrystalViewer
DomainUserMName

|

Y
h 4
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FavoriteReportGroup
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Y
4

CIMSUserGroup

PK
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GroupFullMame
TransactionSecurity
RateSecurity
ClientSecurity
GroupType
AccountStructureName

¥
h 4

CIMSUserGroupReport

PK | GrouplD
PK | ReportlD

ReportExecute

Figure A-3 « User Tables ERD
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Database Entity Relationship Diagrams

Report Tables

The ERD in Figure A-4 shows the relationships of the report tables.

B A-56

Figure A-4 -
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Transaction-related Tables

Database Entity Relationship Diagrams

The ERD in Figure A-5 shows the relationship of the CIMSTransaction table to the

CIMSClient and CIMSRate tables.

Figure A-5 + Transaction-related Tables ERD
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This appendix describes the layout of key files used by CIMS Server.

CIMS Server ResoUrce (CSR) FIlE . .vvviii ittt iiiiitieeieeteneneeeeenceesenssenenscennnas B-2
CIMS Server Resource PIUS (CSRH) Fil@ ......cviieeiiniiirenetiereeeeececensesnsacscancans B-4
CIMS External Transaction File ........oeeiiiitiiineeeeeeeeeeeeerecenacceanssccsnnsaannnns B-7
CIMSACCT Detall File .....cciiiiiieiiietiieeieesoteescssscsssocscssscsssosssosssssscsnsans B-8
L 117 3 T 1<) 3 0 = | (A B-9
CIMSBILL Detail FIl@ ..o viintiieiieeiieeeiateeeesescsososasssscsssosssosssssscsnscsssnns B-10
CIMSBILL Detail File Version 200306 (3.2and Later) ............. ..., .. B-10
CIMSBILL Detail File Version 200106 (3.1 and Earlier) ............ ... ... ... v, B-12
CIMSSUMMAIYFIle ....vieiiiii ittt iiiiieitiiietetttenecenenencnnens B-14
Summary File Version 200306 (3.2 and Later) ............. ..o ittt B-14
Summary File Version 200106 (3.1 and Earlier) ............ ... . i, B-16
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CIMS Server Resource (CSR) File

CIMS Server Resource (CSR) File

H B-2

The primary method for input into CIMS Server is the CIMS Server Resource (CSR) file.
The CSR file is automatically produced by CIMS Data Collectors for Windows, UNIX,
and Mainframe (11.6 and earlier) and can also be produced and read by many other
third-party products.

The CSR records are in a standard ASCII display format (no packed, binary, or bit data)
with commas for delimiters and decimal points included in resource amounts. A
negative sign should precede negative numeric data, with no sign when the data is
positive. When the identifier data contains commas, there must be double quotes
around the identifier character data.

For CIMS Server 3.3 and earlier, CSR records can be up to 5,000 bytes long. For CIMS
Server 4.0 and later, CSR records can be up to 32,000 bytes long. CSR records in all CIMS
Server releases can contain a very large number of identifiers and resources. However, the
maximum length for the records in the output CIMSACCT Detail file is 5,000 bytes with
a limit of 100 resources.

The following table describes the fields in the CSR record.

Pos. Field Name Length Type Description

1 Header 8 Character  Defines the source of data. For
example, DB2 data from OS/
390 contains a header of
S390DB2.

There is no standard for this
header and any unique
combination of characters can

be used.
2 Start Date of 8 Number Date in format YYYYMMDD.
Usage
3 End Date of Usage 8 Number Date in format YYYYMMDD.
4 Start Time of 8 Character  Time in format HH:MM:SS.
Usage
5 End Time of Usage 8 Character  Time in format HH:MM:SS.
6 Shift Code 1 Character  Alphanumeric code denoting
time of day usage occurred.
Allows billing different rates by
shift. If you do not want to
charge by shift, the field should
be blank.
/ Number of 2 Number Number of identifiers in the
Identifiers following fields.
8 Identifier Name 1 32 Character  The name of the identifier.
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Pos. Field Name Length Type Description

9 Identifier Value 1  Variable  Character  Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

10 Identifier Name 2 32 Character The name of the identifier.

11 Identifier Value 2 Variable  Character Includes items such as database
name, server name, LAN ID,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

12 Identifier Name x 32 Character The name of the identifier.

13 Identifier Value x ~ Variable  Character  Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

X Number of 2 Number Number of resources being

Resources tracked in the following fields.
X Rate Code 1 8 Character  The rate code for the resource.
X Resource Value 1  Variable = Number Resource usage value such as

CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

X Rate Code 2 8 Character  The rate code for the resource.

X Resource Value 2 Variable = Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

X Rate Code x 8 Character  The rate code for the resource.

X Resource Valuex  Variable  Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.
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CIMS Server Resource Plus (CSR+) File

Note ¢ The description of the CSR file format and length is also applicable to the
CSR+ file (see page B-2).

The CIMS Server Resource Plus (CSR+) file is produced by CIMS Mainframe Data
Collector and Chargeback System 12.0 and later. The format of the CSR+ file record is
the same as the CIMS Server Resource record with the exception that the CSR+ record
contains an additional header at the beginning of the record. This is a fixed header that
enables the records to be sorted more easily. The header is in the following format:

"CSR+<usage start date><usage end date><account code length><account code><x’40°>",
Note that the quotation marks and comma are included in the header.

Examples

"CSR+2005022820050228010aaaaaaaaa ",S390DB2,20050228, ...
"CSR+2005022820050228010bbbbbbbbb " ,S$390DB2, 20050228, . . .

In these examples, the usage start and end dates are February 28, 2005 (20050228). The
account codes aaaaaaaaa and bbbbbbbbb are 10 characters. The account codes are followed
by a space (x'40"). The information after the header (S90082,20050228, . . .) represents the
remaining fields found in the record. These fields are described in the following table.

Note ¢ The CSR+ record does not supersede the CSR record. CIMS Server uses both
record types.

Pos. Field Name Length Type Description
1 Header 153 Character A fixed header used for sorting.
2 Header 8 Character  Defines the source of data. For

example, DB2 data from OS/
390 contains a header of
S390DB2.

There is no standard for this
header and any unique
combination of characters can

be used.
3 Start Date of 8 Number Date in format YYYYMMDD.
Usage
4 End Date of Usage 8 Number Date in format YYYYMMDD.
5 Start Time of 8 Character  Time in format HH:MM:SS.
Usage
6 End Time of Usage 8 Character  Time in format HH:MM:SS.
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Description

10

11

12

13

14

Shift Code

Number of
Identifiers

Identifier Name 1

Identifier Value 1

Identifier Name 2

Identifier Value 2

Identifier Name x

Identifier Value x

Number of
Resources

Rate Code 1

Resource Value 1

Rate Code 2

32

Variable

32
Variable

32
Variable

8

Variable

8

Character

Number

Character

Character

Character

Character

Character

Character

Number

Character

Number

Character

Alphanumeric code denoting
time of day usage occurred.
Allows billing different rates by
shift. If you do not want to
charge by shift, the field should
be blank.

Number of identifiers in the
following fields.

The name of the identifier.

Includes items such as database
name, server name, LAN ID,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

The name of the identifier.

Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

The name of the identifier.

Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

Number of resources being
tracked in the following fields.

The rate code for the resource.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

The rate code for the resource.

CIMS Server Administrator's Guide
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Field Name Description

X Resource Value 2 Variable = Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

X Rate Code x 8 Character  The rate code for the resource.

X Resource Valuex  Variable  Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.
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CIMS External Transaction File

Although the CIMS External Transaction file is supported, CIMS Lab recommends that
you use the CSR or CSR+ file for input into CIMS Server (see CIMS Server Resource (CSR)
File on page B-2). These files are more flexible and efficient than the CIMS External

Transaction record.

The CIMS External Transaction file contains CIMS External Transaction records. These
records are comma-delimited.

The following table describes the fields in the CIMS External Transaction record.

Pos. Field Name Length
1 TRANS 5
2 Rate Code 8
3 Start Date of 8
Usage
4 End Date of Usage 8
5 Resource Value Variable
6 Account Code 32
7 Audit Code 6

Type

Character

Character

Number

Number

Number

Character

Character

Description

Record header that identifies
the record as an External
Transaction record.

The rate code for the resource.

Date in format YYYYMMDD.

Date in format YYYYMMDD.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

The account code.

Optional and not used in
processing. This can be any code
that helps to identify the record
such as Employee Code, Service
Code, etc.
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CIMSACCT Detail File

This file is created by CIMSACCT and contains all the resource data processed by the
CIMSACCT run. The CIMSACCT Detalil file is basically the same as the CIMSBILL Detail
file (see page B-10), but without CPU normalization, proration, or include/exclude
processing applied to the resources.

The following is the file layout for the CIMSACCT Detail file.

Starting
Position Length Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detail file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-ID 90 32 The work id where the record came

from (could be subsystem name,
could be Oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
DETAIL-END-TIME 150 8 The end time of the record.
DETAIL-SHIFT 159 1 The shift code.

DETAIL-DOW 161 1 The day of week.
DETAIL-ACCOUNT-CODE 163 128 The account code.
DETAIL-AUDIT-CODE 292 8 The audit code.
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Starting
Position Description
DETAIL-INCLEXCL-AREA 301 60 Include/exclude data range.
DETAIL-RES-NUMBER 362 2 Number of resources being tracked
in the following fields.
DETAIL-RES-INFO 365 X Occurs 1 to 100 times depending
DETAIL-RES-NUMBER (see preceding).
DETAIL-RATE-CODE The resources rate code.
DETAIL-RESOURCE-VAL The resource value.
DETAIL-RESOURCE-SIGN This field is blank if the resource is
positive

and '-' if the resource is negative.

CIMS Ident File

This file is created by CIMSACCT and contains all the identifiers (such as user ID,
jobname, department code, server name, etc.) that are contained in the input records.
These identifiers are used during account code conversion to create your target account
code structure. This is a simple, comma-delimited file.

The following is the file layout for the CIMS Ident file.

Field Description

UNIQUE LOAD ID The unique ID for the load.

RECORD NUMBER The record number.

IDENTIFIER NAME The name of the identifier (e.g., Jobname).
IDENTIFIER VALUE The value for the identifier (e.g., ACPSJEFU).
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CIMSBILL Detail File

This file is created by CIMSBILL and is a key component of the drill down feature of
CIMS Server Web Reporting.

The CIMSBILL Detail file differs from the CIMSACCT Detail file in that the CIMSBILL
Detail file reflects any proration, CPU normalization, or include/exclude processing that
was performed. The CIMSBILL Detail file also includes accounting dates.

For CIMS Server 3.2 and later, the file version number for the CIMSBILL Detail file is
200306. Version number 200106 is deprecated. The version number is in the DETATL-

EYE-CATCH field, starting position 14.

CIMSBILL Detail File Version 200306 (3.2 and Later)
The following is the file layout for the CIMSBill Detail for CIMS Server 3.2 and later.

Starting

Position

Length

Description

DETAIL-REC-TYPE

DETAIL-REC-ID

DETAIL-EYE-CATCH

DETAIL-LOAD-ID

DETAIL-REC-NUMBER

DETAIL-NUM-RECS

DETAIL-SORT-ID

DETAIL-SYSTEM-ID

DETAIL-WORK-ID

DETAIL-START-DATE

DETAIL-END-DATE

DETAIL-START-TIME

14

22

33

44

55
57

90

123

132

141

10

10

10

32

32

Always '991".

Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
The version of the record.

The unique ID of the file that
contained this detail record.

The record number within the
original detail file.

The number of records that were
aggregated to make this one record.
This field applies only to mainframe
data.

(Reserved)

The system ID of the source of the
record.

The work id where the record came
from (could be subsystem name,
could be oracle instance name).

The start date of the record.
The end date of the record.

The start time of the record.

H B-10
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Starting
Position Length Description
DETAIL-END-TIME 150 8 The end time of the record.
ACCOUNTING-START-DATE 159 8 The accounting period start date.
ACCOUNTING-END-DATE 168 8 The accounting period end date.
DETAIL-SHIFT 177 1 The shift code.
DETAIL-DOW 179 1 The day of week.
DETAIL-ACCOUNT-CODE 181 128 The account code.
DETAIL-AUDIT-CODE 310 8 The audit code.
DETAIL-INCLEXCL-AREA 319 60 Include/exclude data range.
DETAIL-RES-NUMBER 380 2 Number of resources being tracked in
the following fields.
DETAIL-RES-INFO 383 X Occurs 1 to 100 times depending
detail-res-number (see above).
DETAIL-RATE-CODE The resources rate code.
DETAIL-RESOURCE-VAL The resource value.
DETAIL-RESOURCE-SIGN This field is blank if the resource is
positive

and '-' if the resource is negative.
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CIMSBILL Detail File Version 200106 (3.1 and Earlier)

This file is deprecated as of CIMS Server 3.2, see CIMSBILL Detail File Version 200306 (3.2
and Later) on page B-10.

Starting
Position Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detail file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-ID 90 32 The work ID where the record came

from (could be subsystem name,
could be oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
DETAIL-END-TIME 150 8 The end time of the record.
DETAIL-SHIFT 159 1 The shift code.

DETAIL-DOW 161 1 The day of week.
DETAIL-ACCOUNT-CODE 163 128 The account code.
DETAIL-AUDIT-CODE 292 8 The audit code.
DETAIL-INCLEXCL-AREA 301 60 Include/exclude data range.
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Description

DETAIL-RES-NUMBER

DETAIL-RES-INFO

DETAIL-RATE-CODE
DETAIL-RESOURCE-VAL

DETAIL-RESOURCE-SIGN

Starting

Position  Length
362 2

365 X

Number of resources being tracked
in the following fields.

Occurs 1 to 100 times depending
detail-res-number (see preceding).

The resources rate code.
The resource value.
This field is blank if the resource is

positive
and "-" if the resource is negative.

CIMS Server Administrator's Guide
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CIMS Summary File

This file is created by CIMSBILL and provides resource usage and cost data used for Web
reports or for input to other financial or resource accounting systems.

For CIMS Server 3.2 and later, the file version number for the CIMS Summary file is
200306. Version number 200106 is deprecated. The version number is in the Release 1D

field, starting position 262.

Summary File Version 200306 (3.2 and Later)

The following is the file layout for the CIMS Summary file for CIMS Server 3.2 and later.

B B-14

Field

“SUMMARY”
Version

Reserved
Reserved
Reserved
AccountCode
RateTable
SourceSystem
RateCode
ShiftCode
AccountingFromDate
AccountingToDate
BillFlag1

BillFlag2

BillFlag3

BillFlag4

BillFlag5

BillFlag6

BillFlag7

BillFlag8

Start Position

1

9
12
15
18
21
149
157
158
166
167
175
183
184
185
186
187
188
189
190

Length

8

3

Type
Character
Numeric
Numeric
Numeric
Numeric
Character
Character
Character
Character
Numeric
Numeric
Numeric
Character
Character
Character
Character
Character
Character
Character

Character
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Field Start Position Length Type
BillFlag9 191 1 Character
BillFlag10 192 1 Character
BillFlag11 193 1 Character
RateValue 194 18 Numeric
ResourceUnits 212 18 Numeric
MoneyValue 230 18 Numeric
Breakld 248 1 Character
Conv Factor 249 13 Numeric
Release ID 262 6 Numeric
Date-Century 268 2 Numeric
Date-Year 270 2 Numeric
Date-Month 272 2 Numeric
Date-Day 274 2 Numeric
Time-HH 276 2 Numeric
Time-MM 278 2 Numeric
Time-SS 280 2 Numeric
Period 282 2 Numeric
Year 284 4 Numeric
UsageStartDate 288 8 Numeric
UsageEndDate 296 8 Numeric
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Summary File Version 200106 (3.1 and Earlier)

This file is deprecated as of CIMS Server 3.2, see Summary File Version 200306 (3.2 and
Later) on page B-14.

Field Start Position Length Type
“SUMMARY” 1 8 Character
Version 9 3 Numeric
Reserved 12 3 Numeric
Reserved 15 3 Numeric
Reserved 18 3 Numeric
AccountCode 21 128 Character
RateTable 149 8 Character
SourceSystem 157 1 Character
RateCode 158 8 Character
ShiftCode 166 1 Numeric
FromDate 167 8 Date
ToDate 175 8 Date
BillFlag1 183 1 Character
BillFlag2 184 1 Character
BillFlag3 185 1 Character
BillFlag4 186 1 Character
BillFlag5 187 1 Character
BillFlag6 188 1 Character
BillFlag7 189 1 Character
BillFlag8 190 1 Character
BillFlag9 191 1 Character
RateValue 192 18 Numeric
ResourceUnits 210 18 Numeric
MoneyValue 228 18 Numeric
Breakld 246 1 Character
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Field Start Position Length Type

Period 2 Character

Conv Factor 13 Numeric

Release ID 6 Numeric
Date-Century 2 Numeric

Date-Year 2 Numeric
Date-Month 2 Numeric

Date-Day 2 Numeric

Time-HH 2 Numeric

Time-MM 2 Numeric

Time-SS 2 Numeric
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This appendix describes of the scripts included in the CIMS Server installation. These
scripts are located in the following locations (if you installed CIMS Server in the default
location):

m C:\Program Files\CIMSLab\Scripts
B ...\Scripts\Batch Reporting
B ... \Scripts\Client Load

B ... \Scripts\Desktop

Important! ¢« Some scripts change or purge the data in your database. If you are
unsure whether you should use a particular script, consult CIMS Lab (see Contacting
Technical Support on page 7-10).

If you make changes to a script, make sure that you rename the file. Otherwise, the
file will be overwritten when you upgrade to a new version of CIMS Server.

RUNNING SCHPLS oo viiiiiiiiiiiiiiiiiiiiiiiitititteteeeeseseescscnserscsssscscssncncns Cc-3
Running Scripts Using CIMS JOD RUNNEY . . .. ... . e C-3
Running Scripts Using a Batch File ............. ... ... . ... .. . i C-5
(0 3 T=) = 5o ] Cc-7
BUIldCSRFrOMDB.WST SCript . ... e Cc-7
CIMSLIb.WST SCHipt . . . c8
CIMSULIIS.WSC SCHPt . . oo Cc-8
ClientPropagate.wsf SCript . ... . C-8
ConvertSummaryDailyToMonthly.wsf Script . ... .. ... . c9
CSRAggregator.Wsf SCript . ... ... C-12
DropldentFromDB.wsf SCript .. ... o e c13
DropldentBeforeLoad.wsf Script ......... ... . C-13
ExportClientToMainframe.wsf Script . ... ... C-14
ExportRateToMainframe.wsf Script . ... ... . c-14
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B C-2

FTP.wsc and FTPSample.wsf Scripts ....... ... . i C-15
ListUnusedldentifiers.wsf ... ... . o e C-15
ProRate.Wsf SCript . .. ... C-15
PurgeLoads.wsf SCript . . ... ..o C16
Rebill.wsf and ResourceConversion.wsf SCrpts . . ... .. Cc-18
SampleBulkUserLoad.wsf Script . ....... .. C-21
SampleExportSummary.wsf SCript . ... C-22
SampleSQLMaintenance.bat Script . ... .. . c-23
SaVeDBSQLSEIVELWSS . . . oo e C-25
Schedule wsf . ... C-25
Table.wsf SCHipt . .. .. C-26
ZeroCost.WST SCHiPt . ... o Cc27
Batch Reporting SCrpts ......ooiuiiiiniii ittt i ieeeee C-28
ReportDistribution.wsf Script .......... .. . C29
BatchReport.wsf Script .. ... . C-30
AlTACAS.WSE SCHIPE . . . c37
EmailDistribution.wsf Script . . ... . C-39
Client Load SCHPES . .vivininiiiiiiiiiiiiiiitititieitieenceseeetsesessensecersesssscnnns C-40
MainframeClientContactToServer.wsf Script ............. ... ... ol G40
LoadClientTableFromCSVFilewsf Script ......... . ... ... . C-40
DESKEOP SCHIPES «viiiiiiiiiiiiiiiiiiiiititieieieieeerereressosasasasesessssssasasnsnns C-41
UnloadDesktop<Client/Rate/Summary>ForServerwsf Script . ................. .. ... ... C-41
(00 L S | = 11T () PP C-41
Scripts Used by CIMS Server 3.3 and Earlier .........cccviiiiiiiiiiiiiiiiiiiiinenenenenss C-42
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Running Scripts

CIMS Lab recommends that you run the scripts described in this chapter using CIMS Job
Runner and a job file as used for data collection process for CIMS Server. This
architecture provides the following benefits:

m [t enables you to run the script automatically on scheduled basis (daily, monthly,
etc.) using Windows Task Scheduler.

B You can receive a log file via e-mail that provides the results of the report generation
and distribution process. If a warning or failure occurs during processing, the file
indicates at which point the warning/failure occurred. The log file can be sent to
multiple recipients.

You can also use a .bat file to run a script on a scheduled basis. However, this method
does not provide notification of the success or failure of the script run.

Note ¢ CIMS scripts use the StepRunWSF.d11 file. If you installed CIMS Server in the
default location, this DLL is in C:\Program Files\CIMSLab\Process Engine\
JobLibrary.

Running Scripts Using CIMS Job Runner

To run a script via CIMS Job Runner, you need to create a job file for the script and then
run CIMS Job Runner to execute the job file as shown in the following steps.

Create a Job File for the Script

In the JobFiles folder, create an XML job file for the script using the structure shown in
the following example job file for the ExportRateToMainframe.wsf script (see page C-14).
(Ifyou installed CIMS Server in the default location, the JobFiles folderisin C:\Program
Files\CIMSLab.) For a complete description of the components of a job file, refer to the
CIMS Data Collectors for Microsoft Windows Installation and User Guide.

<2xml version="1.0" encoding="utf-8"7>
<Jobs xmIns="http://www.cimslab.com/CIMSJobs.xsd">
<Job id="Export Rate"

description="Export Rate"
processPriorityClass="Low"
smtpSendJoblLog="true"
smtpServer="mail.cimslab.com"
smtpFrom="CIMSProcessResults@cimslab.com"
smtpTo="CIMSProcessResults@cimslab.com"
stopOnProcessFailure="false"
jobTogWriteToXMLFile="false"
JjobTogShowStepOutput="true"
JjoblogShowStepParameters="true"
active="true">
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<Process id="Export Rate"

description="Export Rate"

buildProcessfFolder="false"

JjobTogShowStepOutput="true"

jobTogShowStepParameters="true"

active="true">

<{Steps>
<Step id="Export Rate"

description="Export Rate"
type="Process"
programName="ExportRateToMainframe.wsf"
programlype="wsf">

<{Parameters>
<Parameter OutputFilename="C:\Rate Files\Rate.txt"/>

</Parameters>

</Step>
</Steps>
</Process>
</Job>
</Jobs>

Note that the required parameter for this script, OutputFilename, is included in the XML.

Run CIMS Job Runner

Once you have created a job file, you can run CIMS Job Runner to execute the file using
Windows command prompt or Windows Task Scheduler.

To run CIMS Job Runner from command prompt:

At the C:\Program Files\CIMSLab\Process Engine> prompt type cimsjobrunner.exe
Jobfilename.xml where jobfilename.xml is the name of the job file, and then press
<Enter>. Or from any prompt, type "C:\Program Files\CIMSLab\Process
Engine\CIMSJobRunner.exe" jobfilename.xml, and then press <Enter>.

Examples
C:\Program Files\CIMSLab\Process Engine>CIMSJobRunner.exe jobfilename.xml

Or

C:\>"C:\Program Files\CIMSLab\Process Engine\CIMSJobRunner.exe"
Jjobfilename.xml

To run CIMS Job Runner from Task Schedular:

1 In Windows Control Panel, double-click Scheduled Tasks.
2 Double-click Add Scheduled Task.

3 The Scheduled Task Wizard appears. Click Next.

4 Click Browse to find the program CIMSJobRunner.exe, and then double-click the
program. If you installed CIMS Server in the default location, this program is in
C:\Program Files\CIMSLab\Process Engine.

5 Type a name for the task or accept the default and click the schedule for the task. Click
Next.
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6 Select the time and day to start the task, and then click Next.

7 Type the password for the user account under which you want the scheduled task to
run. The password cannot be blank. Click Next.

8 Select the Open advanced properties for this task when I click Finish check box,
and then click Finish.

9 In the Task tab, type following in the Run box where jobf7ilename.xml is the name of
the job file that you want to run:

"C:\Program Files\CIMSLab\Process Engine\CIMSJobRunner.exe" jobfilename.xm]
10 Click OK.

11 In the Set Account Information dialog box, type the password for the user account
again, and then click OK.

The task appears in the Scheduled Task list. To execute CIMSJobRunner . exe immediately,
right-click the task, and then click Run. For more information about Task Schedular,
refer to the Microsoft documentation.

Running Scripts Using a Batch File

You can use a batch file to run a script and pass parameters. For example, CIMS Lab
provides a default batch file ExportRateToMainframe.bat for the
ExportRateToMainframe.wsf script. This file contains the following:

cscript ExportRateToMainframe.wsf "c:\Program Files\CIMSLab\Scripts\Rate.txt" "true"

The values in quotation marks are the parameter values for the OutputFilename and
GenerateRateGroups parameters. You can modify these parameters as needed. Note that
only the OutputFilename parameter is required for the ExportRateToMainframe.wsf
script.

If a default batch file is not included for a script, you can copy and modify a similar file.
If you are unsure as to what to include in the batch file, refer to the example that is
provided in each script.

To run a batch file from command prompt:

1 Change the command prompt directory to the path that contains the .bat file that
you want to run. For example, C:\Program Files\CIMSLab\Scripts>.

2 Type the name of the .bat file and then press <Enter>. For example, C:\Program
Files\CIMSLab\Scripts>ExportRateToMainframe.bat.

To run a batch file from Task Scheduler:
1 In Windows Control Panel, double-click Scheduled Tasks.
2 Double-click Add Scheduled Task.

3 The Scheduled Task Wizard appears. Click Next.
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Click Browse to find the .bat file that you want to run, and then double-click the file.

Type a name for the task or accept the default and click the schedule for the task. Click
Next.

Select the time and day to start the task, and then click Next.

Type the password for the user account under which you want the scheduled task to
run. The password cannot be blank. Click Next.

Click Finish.

The task appears in the Scheduled Task list. To execute the script immediately, right-click
the task, and then click Run. For more information about Task Scheduler, refer to the
Microsoft documentation.
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The scripts described in this section are in C:\Program Files\CIMSLab\Scripts (if you
installed CIMS Server in the default location).

BuildCSRFromDB.wsf Script

The BuildCSRFromDB.wsf script extracts information from the CIMSIdent and
CIMSDetail tables and creates an output file containing CIMS Server Resource (CSR)
records for further processing (e.g., to perform account code conversion, proration, and
other processing that requires a CSR file).

BuildCSRFromDB.wsf Script Parameters

The BuildCSRFromDB.wsf script uses the following parameters.

Parameter Description/Values

Start Date and End Date These parameters specify the date range for the records

(required) that you want to select from the CIMSDetail table. Any
records that have accounting start and end dates in this
range are selected for processing.

Valid values are:

m preday (previous day)

m premon (previous month)
B rndate (current day)

m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system'’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

Output Filename (required) The full path and file name for the output CSR file.

Rate Code (optional) The rate code or codes that you want to appear in the
output CSR file records. If you set this parameter to A1l
or do not include the parameter, all rate codes in the
selected CIMSDetail table records are included.

DataSourceID (optional) The ODBC data source or data source ID for the CIMS
Server database. See ODBC Parameters on page C-41.

Table C-1 « BuildCSRFromDB Script Parameters
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CIMSLib.wsf Script

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

CIMSUtils.wsc Script

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

ClientPropagate.wsf Script

The ClientPropagate.wsf script propagates the account name and contact information
of top level account codes to lower level account codes that do not have account names.
This script will not overwrite existing names for lower level account codes that have
names or add contacts to those levels.

For example, the account code AABBBBCCC contains three levels: the two-digit
company code AA, the 6-digit division code AABBBB, and the 9-digit department code
AABBBBCCC. If account name for the account code AA is ABC Headquarters, the name
ABC Headquarters and any contact information will be assigned to account codes
AABBBB and AABBBBCCC.

ClientPropagate.wsf Script Parameters

The ClientPropagate.wsf script uses the following parameters.

Parameter Description/Values

TopLevellength (required) The length of the top level account code. The top level
account code must have a valid account name.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-41.
and ODBCPassword
(optional)

Table C-2 « ClientPropagate Script Parameters
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ConvertSummaryDailyToMonthly.wsf Script

Important! ¢ This script consolidates daily CIMS Summary records into a monthly
record. Consult CIMS Lab before using this script (see Contacting Technical Support on
page 7-10).

The ConvertSummaryDailyToMonthly.wsf script consolidates the daily data in your
CIMSSummary table so that data is stored at a monthly level. (For more information
about the CIMSSummary table, see Chapter 6, Processing Data and CIMSSummary Table
on page A-40). This script calls the CIMSSp_ConvertSummaryDailyToMonthly stored
procedure, which is built in the CIMS Server database. This stored procedure aggregates
the daily summary records and produces a monthly summary record with Monthly
Aggregation listed as the source file name in the CIMSLoadTracking table.

This consolidation process minimizes storage space used (there is typically a 90 percent
or greater reduction in Summary records) and decreases the time required to generate
monthly reports. A drawback to this consolidation is that you cannot run costed daily
reports against the CIMSSummary table.

Note ¢ The ConvertSummaryDailyToMonthly.wsf script is intended primarily to
improve reporting performance. To drastically reduce storage space used by the
database, you can run the Purgeloads.wsf script (see PurgeLoads.wsf Script on
page C-16).

Before the monthly CIMS Summary aggregated data is created, daily data is copied from
the CIMSSummary table to the CIMSSummaryDaily table for archival purposes. You can
then run daily summary reports against the CIMSSummaryDaily table.
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ConvertSummaryDailyToMonthly.wsf Script Parameters

The ConvertSummaryDailyToMonthly.wsf script uses the following parameters.

Parameter Description/Values

StartDate and These parameters specify the date range for the records

EndDate(required) that you want to consolidate from the CIMSSummary
table. Any records that have accounting start and end
dates in this range are consolidated. Typically, the start
date is the first day of the month and the end date is the
last day of the month.

Valid values are:

m preday (previous day)

B premon (previous month)
m rndate (current day)

®m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-41.
and ODBCPassword
(optional)

RemoveSummaryDaily If this parameter is set to true, the daily records that are
(optional) archived in the CIMSSummaryDaily table for this date
range are purged.

If this parameter is set to false or is not included, the
records are maintained in the table.

Table C-3 « ConvertSummaryDailyToMonthly Script Parameters
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ConvertSummaryDailyToMonthly.wsf Script Considerations

m Ifan error occurs while processing the ConvertSummaryDailyToMonthly.wsf script, the
script will back out all database changes. You can then correct the error and run the
script again.

B You cannot run the script with an EndDate parameter equal to or greater than the
current day.

m CIMS Lab recommends that you run the script only once for a particular date range.
Although the script can be run multiple times against the same date range, the
CIMSSummaryDaily table is updated only once. If there is new data in a daily
CIMSSummary table and you run the script a second time, the script will fail and the
update will be backed out of the database because the data in the
CIMSSummaryDaily table does not match the data in the CIMSSummary table. In
this situation, you should run the script with the RemoveSummaryDaily parameter set
to true and then rerun the script with this parameter set to false. For more
information, contact CIMS Lab (see Contacting Technical Support on page 7-10).

B The script could run for more than an hour per month. A status does not appear while
the script is running.
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CSRAggregator.wsf Script

Although CIMS Data Collectors automatically aggregate the records in the output CIMS
Server Resource (CSR) and CIMS Server Resource Plus (CSR+) file records, you might
want to use the CSRAggregator.wsf script to further aggregate the records in the following
situations:

B You want to remove an identifier or identifiers from the aggregated records. For
example, you might want to remove an identifier such as Time from the records to
reduce the size of the CSR or CSR+ file.

B You want to remove a rate code or codes from the aggregated records. For example,
the records contain a rate code that is not contained in the CIMSRate table and you
do not want to receive the CIMSBILL message “One or more rate codes were missing”.

B You want to aggregate the records in a CSR or CSR+ file that was created by a source
other than CIMS Data Collectors. In this situation, all records that contain the same
identifier values are aggregated into one record that contains sum total resource
values for the rate codes within these records.

CSRAggregator.wsf script can read CSR files that have multiple record formats. That is,
records that have different identifier names and rate codes.

CSRAggregator.wsf Script Parameters

The CSRAggregator.wsf script uses the following parameters.

Parameter Description/Values

InputFilename (required)  The full path and file name of the input CSR or CSR+

file.
OutputFilename (required) The full path and file name of the aggregated CSR or
CSR+ file.
ExceptionFilename For future use.
(optional)
IdentifiersToRemove The identifier name or names that you want to remove.
(optional) If you want to remove multiple identifiers, separate the

identifier names by commas (e.g., time, feed, server).
The identifier names can be in any order.

If a record contains any of the specified identifiers, the
identifier or identifiers are removed.

Table C-4 - CSRAggregator Script Parameters
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Parameter Description/Values
ResourcesToRemove The rate code or codes that you want to remove. If you
(optional) want to remove multiple rate codes, separate the codes

by commas (e.g., 2018,2000,7003). The rate codes can
be in any order.

If a record contains any of the specified rate codes, the
rate code or rate codes are removed.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-41.
and ODBCPassword
(optional)

Table C-4 - CSRAggregator Script Parameters

DropldentFromDB.wsf Script

The DropIdentFromDB.wsf script deletes a specified identifier from the CIMSDetailldent
and CIMSIdent tables. You should use the ListUnusedIdentifiers.wsf script (see

page C-15) to determine which identifiers are obsolete before using this script. You need
to run this script for each identifier that you want to delete

WARNING - Because this script irreversibly changes the database, CIMS Lab highly
recommends that you back up the database before you run the script.

DropldentFromDB.wsf Script Parameters

The DropIdentFromDB.wsf script uses the following parameters.

Parameter Description/Values

IdentifierName (required) The name of the identifier that you want to delete.

DataSourcelD (optional) See ODBC Parameters on page C-41.

Table C-5 « DropldentFromDB Script Parameters

DropldentBeforeLoad.wsf Script

The DropIdentBeforeload.wsf script deletes a specified identifier from the Ident. txt file.
Consult CIMS Lab before using this script (see Contacting Technical Support on
page 7-10).
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ExportClientToMainframe.wsf Script

The ExportClientToMainframe.wsf script creates a Client file that you can load into CIMS
Mainframe Data Collector and Chargeback System.

ExportClientToMainframe.wsf Script Parameters

The ExportClientToMainframe.wsf script uses the following parameters.

Parameter Description/Values

OutputFilename (required) The full path and file name of the output Client file.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-41.
and ODBCPassword
(optional)

Table C-6  ExportClientToMainframe Script Parameters

ExportRateToMainframe.wsf Script

B C-14

The ExportRateToMainframe.wsf script creates a Rate file that you can load into CIMS
Mainframe Data Collector and Chargeback System.

ExportRateToMainframe.wsf Script Parameters

The ExportRateToMainframe.wsf script uses the following parameters.

Parameter Description/Values

OutputFilename (required) The full path and file name of the output Rate file.

CreateRateGroups If set to true, rate groups will be created. Warning: The
(optional) rate index will be renumbered if this is set to true.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-41.
and ODBCPassword

(optional)

Table C-7 « ExportRateToMainframe Script Parameters
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FTP.wsc and FTPSample.wsf Scripts

The FTP.wsc and FTPSample.wsf scripts assist in performing FTP transfers from a script.

ListUnusedldentifiers.wsf

The ListUnusedIdentifiers.wsf script creates a list of identifiers in the CIMSDetailldent
table that are unused as of a specified date. You can use this script to determine
identifiers that might be obsolete and then delete the obsolete identifiers using the
DropldentFromDB.wsf script (see page C-13).

The criteria for including an identifier in the list is based on the date entered for the
DateSelection parameter as follows:

m If an identifier is contained in the CIMSDetailldent table with usage end dates before
and after the DateSelection date, the identifier is not included in the list.

m Ifan identifier is contained in the CIMSDetailldent table with usage end dates before
the DateSelection date only, the identifier is included in the list.

ListUnusedldentifiers.wsf Script Parameters

The ListUnusedIdentifiers.wsf script uses the following parameters.

Parameter Description/Values

OutputFilename (required) The full path and file name of the output list file.
DateSelection (required)  The date that you want to use to select identifiers.

DataSourcelD (optional) See ODBC Parameters on page C-41.

Table C-8 « ListUnusedldentifiers Script Parameters

ProRate.wsf Script

The ProRate.wsf script is provided for backward compatibility. If you are using CIMS
Server 4.0 or later, you should use the CIMSPRAT program as described in CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

For assistance in converting your ProRate.wsf script to this new functionality, contact
CIMS Lab (see Contacting Technical Support on page 7-10).
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PurgeLoads.wsf Script

Important! ¢ This script permanently removes data from the CIMSSummary,
CIMSDetail, CIMSDetailldent, and CIMSResourceUtilization tables. Consult CIMS
Lab before using this script (see Contacting Technical Support on page 7-10).

The CIMSSummary, CIMSDetail, CIMSDetailldent, and CIMSResourceUtilization tables
can accumulate a large amount of data. To control the size of these tables, you can use
the Purgeloads.wsf script to delete loads that have accounting start and end dates within
a specified date range. All data loaded to the database within this date range is removed
permanently, not archived.

PurgeLoads.wsf Script Parameters

The Purgeloads.wsf script uses the following parameters.

Parameter Description/Values

StartDate and EndDate These parameters specify the date range for the loads

(required) that you want to delete from the tables. Any loads that
have accounting start and end dates in this range are
deleted.

Valid values are:

m preday (previous day)

m premon (previous month)
m rndate (current day)

m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system'’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

PurgeSummary, These parameters specify whether the CIMSSummary,

PurgeBillDetail, CIMSDetail, CIMSDetailldent, and/or

Purgeldent, and/or CIMSResourceUtilization tables are purged. If set to

PurgeAcctDetail he table i dIf he table i

(required) true, the table is purged. If set to false the table is not
purged.

Table C-9 « PurgeLoads Script Parameters
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Parameter Description/Values
SkipConfirmation If this parameter is set to false or is not included, a
(optional) message appears and confirmation is required before

the script is run. If this parameter is set to true, the
confirmation message does not appear.

DataSourcelID (optional) The ODBC data source or data source ID for the CIMS
Server database. See ODBC Parameters on page C-41.

Table C-9 « PurgeLoads Script Parameters
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Rebill.wsf and ResourceConversion.wsf Scripts

Important! ¢ The following scripts change the data in the CIMS Server database. You
should back up the database before running these scripts.

You can recalculate rate codes that you previously processed and loaded into the CIMS
Server database using a different rate value and/or resource conversion factor without
reprocessing the data. That is, if you change the rate value and/or resource conversion
factor for a rate code in the CIMSRate table, you can update the rate value and conversion
factor and recalculate the money value directly in the CIMSSummary table. (For more
information about the rate code value and resource conversion factor, see Working With
Rates on page 3-9.)

CIMS Lab provides the following scripts to perform this process:

B C-18

Rebill.wsf. This script updates the rate code value and recalculates the money value
for a rate code or codes in the CIMSSummary table. If you have not changed the
resource conversion factor for a rate code or codes, you do not need to run the
ResourceConversion.wsf script.

ResourceConversion.wsf. This script updates the rate code resource conversion factor
in the CIMSSummary table. You need to run the Rebi11.wsf script after running this
script to recalculate the money value for the rate code.

Important! ¢« Consult CIMS Lab before using the ResourceConversion.wsf script
(see Contacting Technical Support on page 7-10). If you run this script more than
once for the same rate code or codes, the resource units that are converted are the
units that were converted previously, not the original units. For example, if the
conversion factor for a rate code is Divide by 60 and the resource units are 120,
the resource unit value after calculating once is 2, after calculating twice it is .033
(2+60), etc.

This scenario is not applicable to the Rebil1.wsf script—you can run this script
multiple times for the same rate code or codes.
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Rebill.wsf and ResourceConversion.wsf Script Parameters

The Rebi11.wsf and ResourceConversion.wsf scripts use the following parameters.

Rebill.wsf Parameters

Parameter Description/Values

StartDate and EndDate These parameters specify the date range for the records

(required) that contain the rate code or codes that you want to
rebill. Typically, the start da